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1 What’s New in This Release
What’s New in Siebel Partner Relationship Management 
Administration Guide, Version 7.8, Rev. A
Table 1 lists changes described in this version of the documentation to support Release 7.8, Rev A of 
the software.

Table 2 lists changes described in this version of the documentation to support Release 7.8 of the 
software.

Table 1. New Product Features in Siebel Partner Relationship Management Administration Guide, 
Version 7.8, Rev. A

Topic Description

“HTIM MDF Period Ending Process 
Workflow” on page 289

Provides the HTIM MDF Period Ending process workflow.

All Enhanced documentation quality.

Table 2. New Product Features in Siebel Partner Relationship Management Administration Guide, 
Version 7.8

Topic Description

“Partner Company Identifier” on 
page 101

Describes the company identifier code feature that allows the 
user to enter the code instead of typing in all the company 
information in a form. Appears on both the Partner Manager 
and the Siebel PRM Portal. 

“Registering the Partner Company” 
on page 108

Provides an updated procedure for registering partner 
companies.

“Partner Programs Administration” 
on page 129

New chapter that discusses the streamlined partner program 
administration. Includes setting up, reviewing, and approving 
partner applications.

“Managing the Advanced MDF 
Option” on page 277

New section in the Using Market Development chapter that 
describes the advanced MDF option.
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A
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2 About Siebel PRM
This chapter is a general overview of the capabilities of Siebel PRM. It summarizes the functionality 
of the Siebel PRM Manager and the Siebel PRM Portal, and it discusses supported platforms. 

This chapter contains the following topics:

■ “What Is Siebel PRM?” on page 13

■ “The Siebel PRM Portal” on page 14

■ “The Siebel PRM Manager” on page 17

■ “The Siebel Mobile Web Client” on page 20

■ “The Siebel PRM Wireless Client” on page 21

What Is Siebel PRM?
Siebel PRM automates and streamlines the relationship between brand owner companies and their 
channel and alliance partners, distributors, resellers, agents, brokers, or dealers. 

Prospective partners can use Siebel PRM to view information about the brand owner company's 
partnership program, and to apply to be partners. The brand owner’s partner manager must approve 
the application, convert the prospective partner into a partner, and give login access to the partner 
company. The brand owner can add partner employees or can assign this task to a delegated 
administrator at the partner company.

Then, the brand owner can treat the partner's employees as members of its extended sales and 
service team. Using Siebel PRM, you can share opportunities, service requests, accounts, solutions, 
and other business information with partners in the same way as you do with your own employees. 
You can either assign this information manually or use Siebel Assignment Manager to assign it 
automatically. Siebel PRM also lets you share master data, such as products and solutions, with 
partner companies.

In addition to letting you share business information, Siebel PRM lets you send alerts, information 
about special promotions, and Web messages to your partners. It also lets you work collaboratively 
with your partners to develop plans to meet strategic goals. It helps you and your partners analyze 
partnership effectiveness, forecast revenue, manage market development funds, and analyze 
partner performance in many ways. 

Siebel PRM is made up of four applications:

■ The Siebel PRM Portal. This is a portal that partner companies use to share business 
information with the brand owner and to do some administrative tasks. 

■ The Siebel PRM Manager. This is the application that the brand owner company uses to share 
business information with partners and to manage partners.
Siebel Partner Relationship Management Administration Guide Version 7.8,
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About Siebel PRM ■  The Siebel PRM Portal
■ Siebel Partner Manager Analytics. These tools allow the brand owner to analyze and manage 
its partners’ performance and its channel go-to-market programs.

■ Siebel PRM Portal Analytics. These tools allow partners to analyze and manage their 
performance.

NOTE: The brand owner company can share business information with partners using Siebel 
applications such as Siebel Sales, Siebel Service, or Siebel Call Center, as well as by using the Siebel 
PRM Manager. These products are integrated with Siebel PRM, though the other products do not 
provide the full functionality of the Siebel PRM Manager. 

The Siebel PRM Portal
The Siebel PRM Portal lets partners communicate, collaborate, and conduct business with the brand 
owner. It supports joint planning and execution between partners and the brand owner by giving 
partners access to market development funds management, opportunity and account management, 
Commerce selling tools, service request management, and many other tools for doing business 
transactions with the brand owner and customers. The Siebel PRM Portal also provides the partner 
with information such as literature, partner alerts, and news. 

Siebel PRM Portal Login Page
The Siebel PRM Portal home and login page is accessible to anyone who enters the URL in a Web 
browser.

This home and login page has several functions. It allows:

■ Public users to learn more about your company and partnership programs.

■ Individuals to register as partners and view the information available to individual partners. 

■ Companies to apply to become partners.

■ Employees of partner companies to log in, so they can use the full functionality of the Siebel PRM 
Portal Web site. 
Siebel Partner Relationship Management Administration Guide Version 7.8, 
Rev. A

14 



About Siebel PRM ■  The Siebel PRM Portal
Siebel PRM Portal Screens
After employees of partner companies log in, a Web site similar to the one shown in Figure 1 appears. 
Partners see only the screens and screen tabs that are appropriate to their roles and responsibilities. 

The home page includes a list of tasks that are associated with the partner’s role. For example, if the 
partner employee has the role Sales Representative, the home page will have a My Tasks list. This 
list has hyperlinks that the employee can click to perform common tasks for sales representatives, 
such as viewing and updating opportunities, which you set up using the Role Administration screen. 
For more information about roles, see “Administering Roles” on page 34

Partners click the tabs of the Siebel PRM Portal to use the Siebel PRM screens. These screens 
generally have many views as screens typically do in your own Siebel application.

NOTE: As an overview, this list includes all the screens of the Siebel PRM Portal. When an employee 
logs in, he or she sees only the screens and screen tabs that are appropriate to that employee’s roles 
and responsibilities. 

Siebel PRM Portal includes the following screens:

■ Home. This screen greets the partner employee by name and provides links to the employee’s 
current work. The partner employee can click any of these items to view more information about 
it. 

■ Opportunities. This screen displays sales opportunities that you assigned to the partner. The 
partner can also enter new opportunities here, which you can view using the Siebel PRM Manager. 

Figure 1. The Siebel PRM Portal Web Site
Siebel Partner Relationship Management Administration Guide Version 7.8,
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About Siebel PRM ■  The Siebel PRM Portal
■ Accounts. This screen displays customer accounts that you assigned to the partner. The partner 
can also enter new companies here, which you can view using the Siebel PRM Manager. 

■ Service Requests. This screen displays customer service requests that you assigned to the 
partner. The partner can also enter new service requests here, which you can view using the 
Siebel PRM Manager.

■ Contacts. This screen displays customer contacts that you assigned to the partner. The partner 
can also enter new contacts here, which you can view using the Siebel PRM Manager.

■ Activities. This screen displays activities that the partner should do to complete sales or fulfill 
service requests. You can assign activities to partners, or partners can schedule and enter 
activities themselves. You can view them using the Siebel PRM Manager.

■ Customer Quotes. The partner can use this screen to generate, review, and modify customer 
quotes, which you can view using the Siebel PRM Manager. 

■ Customer Orders. The partner can use this screen to enter, review, and modify customer 
orders, or you can use it to assign customer orders to the partner for fulfillment. 

■ Product Catalog. This screen displays a catalog of your products that you have made available 
to the partner.

■ Infocenter. This screen displays sales literature, other documents, and other master data that 
you have made available to partner organizations. The partner can download these documents 
or view this master data.

■ Solutions. This screen displays solutions to common service requests. 

■ Funds. This screen displays market development funds in which this partner company is a 
participant, with a checkbook that lists the amount spent and balance available in each fund. 

■ Fund Requests. This screen displays requests made against market development funds in which 
this partner company is a participant. The partner can enter new requests for funding or you can 
enter requests on the partner’s behalf using the Siebel application. Partners can also view the 
status of requests during the approval process. 

■ Assets. This screen displays assets. Field service businesses use it to track assets that field 
engineers must service. 

■ Inventory. This screen displays inventory. Field service businesses use it to track parts that field 
engineers use for service. 

■ Briefings. This screen gives the partner news and up-to-date information on your company, your 
accounts, your competitors, news bulletins, and so on. 

■ Calendar. This screen allows partners to manage their daily, weekly, and monthly activities. 

■ Administration. This screen allows the partner’s delegated administrator to enter positions, to 
add and remove users, and to associate users with responsibilities. 

■ Partner Programs. This screen allows brand owners to set up, approve or reject, and administer 
partner programs. Prospective partners can apply for these partner programs on the Siebel PRM 
Portal. 

■ Partner Locator. This screen allows partners and customers to find the right partner to meet 
their needs. For example, they can find the partners who are located closest to them, or the 
partners who provide the products or services they want.
Siebel Partner Relationship Management Administration Guide Version 7.8, 
Rev. A

16 



About Siebel PRM ■  The Siebel PRM Manager
■ Logout. This screen disconnects the partner from your database. The partner can use this 
feature for security reasons so no one else can use the data after the partner has left the 
computer. 

■ Profile. This screen displays the partner employee’s user and company profile. 

■ Help. This screen displays a help page that includes instructions about using Siebel PRM through 
the Web. 

The Siebel PRM Manager
The Siebel PRM Manager gives the brand owner company a single application to manage partner 
interactions through the entire partner life cycle from recruitment, registration, profiling, 
certification, joint planning, and execution through measurement and analysis of partner 
performance. 

Siebel PRM Manager lets the brand owner manage channel and alliance partners as extended virtual 
sales, marketing, and service teams. It gives the brand owner full visibility into the entire partner 
community, and provides support for multiple partnering models, such as resellers, multitiered global 
distributors, service providers, alliance partners, and many others.

Siebel PRM Manager addresses the needs of everyone who works with partners. For example, vice 
presidents of Channels can use it to analyze partner sales forecasts or partner performance. Channel 
marketing managers can use it to execute marketing programs. Channel operations managers can 
use it to collaborate with partners in customer sales and service. 
Siebel Partner Relationship Management Administration Guide Version 7.8,
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About Siebel PRM ■  The Siebel PRM Manager
Screens the Siebel PRM Manager Shares with Other 
Siebel Applications
When the partner managers at your company use Siebel PRM, they see the Siebel Partner Manager 
Web site, which is similar to the one shown in Figure 2. The actual screens and screen tabs that your 
employees see depend on their roles and responsibilities. 

The home page includes a list of tasks that are associated with the employee’s role. For example, if 
the employee has the role Channel Account Manager, the home page will have a My Tasks list. This 
list has hyperlinks that the employee can click to perform common tasks for channel account 
managers, which you set up using the Role Administration screen. For more information about roles, 
see “Administering Roles” on page 34. 

The Siebel PRM Manager includes virtually all the screens that you use in Siebel Sales, Siebel Service, 
Siebel Call Center, or Siebel Field Service to share information with your employees and to administer 
the Siebel system. You use these screens in the Siebel PRM Manager in the same way you use them 
in other Siebel applications. 

For example, you assign a customer contact to a partner by using the Siebel PRM Manager’s Contacts 
screen in the same way that you assign a contact to an employee by using the Siebel Sales, Siebel 
Service, or Siebel Call Center Contacts screen. 

Figure 2. The Siebel Partner Manager Web Site
Siebel Partner Relationship Management Administration Guide Version 7.8, 
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About Siebel PRM ■  The Siebel PRM Manager
You can also share information with partners using other Siebel applications. For example, you can 
assign a contact to a partner by using the Siebel Sales, Siebel Service, or Siebel Call Center Contacts 
screen. You enter partners in your Siebel database as employees, and you work with them the same 
way you work with your own employees. If you are logged in under the same user name, then you 
can work with the same partner or employee data in the Siebel PRM Manager as in other Siebel 
applications. 

This guide covers features of the Siebel PRM Manager that are particularly useful in working with 
your partners. It does not cover many of the features that the Siebel PRM Manager has in common 
with Siebel Sales, Siebel Service, and Siebel Call Center. 

For more information on these common features, see Siebel Sales User Guide, Siebel Call Center 
User Guide, and Applications Administration Guide.

Screens That Are Specific to the Siebel PRM Manager
In addition to incorporating the functionality of other Siebel applications, the Siebel PRM Manager 
has specific screens that are used only for managing partners:

■ Home. The Siebel PRM Manager home page includes lists of records that you may want to work 
on, such as your prospective partners and your current fund requests. Items on these lists are 
hyperlinks that you can click to display more information about them. The home page is fully 
customizable. 

■ Partners. The Partners screen lets you record general information about your partners and helps 
you manage your relationship with them. For example, it lets you work with the Partner Profile 
and Partnership Profile, it lets you assess your partners' performance, it lets you enter and look 
up partner management activities, contacts, and notes, and it lets you view your partners' 
progress in your training and certification programs. 

■ Partner Programs. The Program Partner screen lets you set up partner programs, view partner 
program applications from the Siebel PRM Portal, and accept or reject those applications. It also 
allows you to set up and maintain eligibility criteria for each partner program.

■ Partner Operations. The Partner Operations screen lets partner managers view the 
transactional data for a given partner, giving an overall view of the partner's operations. You can 
look up a partner and see its accounts, contacts, opportunities, orders, quotes, and service 
requests. 

■ Administration - Partner. The Administration - Partner screen lets you do much of the work 
that you must do to add a new partner company, such as adding a record for the partner, 
assigning user IDs and passwords to partner users, and approving and registering partner 
companies. In this screen you can complete the necessary steps to get a partner company 
started, including creating a new organization and putting it in the proper place in the hierarchy. 
You can also administer partner information, such as adding or changing information about 
users, or about the partner organization.
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About Siebel PRM ■  Supported Browsers
■ CHAMP Planning. Siebel PRM provides tools to support the Channel and Alliance Management 
Process (CHAMP), which helps alliance and partner organizations improve business performance. 
You can use the CHAMP Planning screen to create new initiatives, which are corporate strategies 
for a given period. After you have created an initiative, you can add partners as participants, and 
then create a specific partner plan for working with each participant. Finally, you can add 
objectives that help your partners accomplish the goals of the plan.

■ Certifications. The Certification screen lets you set up programs to certify partners. For 
example, you may require that your partners be certified in a certain product or service that you 
offer to make sure that your partners deliver those products or services in the same way that 
your company delivers them. You can use this screen to define any levels of certification that you 
choose, and any criteria that you choose for each level of certification. 

■ Alert Administration. When partners log in to the Siebel PRM Portal, it displays a personalized 
home page for each partner. This home page includes a partner alert that displays Web messages 
you create for your partners. Using Alert Administration, you can direct these partner alerts to 
all partners or to specific individuals. 

■ Fund Design. Market development funds are funds that are allocated for joint marketing 
activities during a certain period. You use these funds, either directly or indirectly, to help your 
partners with activities that can generate demand for your product or service. The Fund Design 
screen lets you create market development funds by specifying how much is in each fund and 
which partners participate in and can request funding. 

■ Fund Requests. After market development funds have been created, partners or partner 
managers make requests for specific use of these funds, such as paying for a partner to 
participate in a trade show where they will display your product. The Market Development Fund 
Requests screen lets you work with and approve these requests. 

Supported Browsers 
Like other Siebel applications, Siebel PRM is Web-based, which means users can use a Web browser 
to work with Siebel PRM. 

For more information on the browsers supported by Siebel applications, see System Requirements 
and Supported Platforms on Siebel SupportWeb.

The Siebel Mobile Web Client
In addition to working directly through the Web in connected mode, you and your partners can use 
your Siebel applications through the Siebel Mobile Web Client. The Siebel Mobile Web Client lets you 
or your partners work when you are disconnected from the Web and synchronize data with the rest 
of the Siebel database later. 

This is useful if you or your partners want to work on a laptop when you are traveling and synchronize 
with the database when you return to the office.

When you set up mobile users, you must associate a routing model with each mobile user. The 
routing model describes the data that will be synchronized between the user's local database and 
the server database. You must use one of the following:
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About Siebel PRM ■  The Siebel PRM Wireless Client
■ Mobile PRM Manager users must use the routing model named Mobile Client - Standard. 

■ Mobile PRM Portal users must use the routing model named Mobile Partner User.

In addition, a mobile PRM Portal user should have only one responsibility, Partner User - Mobile, to 
prevent the mobile user from seeing views with unsynchronized data.

For security purposes, mobile PRM Portal users must have access to the brand owner’s private 
network or connect through a virtual private network.

For more information about using the Siebel Mobile Web Client, see Siebel Web Client Administration 
Guide.

The Siebel PRM Wireless Client
In addition to using the Siebel PRM Portal on computers through the Siebel Web Client, your partners 
can use the Siebel PRM Portal mobile phones through the Siebel Wireless Client. 

Because of the limited screen size of mobile phones, Siebel Wireless displays only a subset of each 
Siebel Web Client view. 

For example, with the wireless Siebel PRM Portal partners can manage accounts, opportunities, 
service requests, orders, contacts, solutions, activities, correspondence, and general information. 

For more information on the Siebel Wireless Client, see Siebel Wireless Administration Guide. 
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3 Setting Up Siebel PRM
This chapter discusses how to set up Siebel PRM. It summarizes the processes of installation and 
configuration, and it looks at how you set up access to data and user access. It also includes a section 
about configuring visibility.

This chapter contains the following topics:

■ “About Siebel PRM Setup Processes” on page 23

■ “Installing and Configuring Siebel PRM” on page 23

■ “Setting Up Siebel PRM” on page 29

■ “Configuring Visibility” on page 38

■ “Siebel Partner Web Services” on page 42

■ “Siebel Tools for Partner Web Services” on page 44

About Siebel PRM Setup Processes
Before using Siebel PRM, you must set it up by going through two processes:

■ Install and configure Siebel PRM. 

■ Set up access to data, which involves setting up organization hierarchy, access groups, 
responsibilities, and user access. 

Installing and Configuring Siebel PRM
To install and configure Siebel PRM, you go through the following processes:

■ Install Siebel PRM 

■ Activate Workflows

■ Configure Siebel PRM 

■ Configure Web Site Help 

■ Set Up Personalization 

Installing Siebel PRM
To install Siebel PRM, you must: 

■ Install a Web Server. Like other Siebel applications, Siebel PRM includes the Siebel Web Server 
Extension (SWSE). The Web server must be already installed before you install Siebel PRM. 
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

23



Setting Up Siebel PRM ■  Installing and Configuring Siebel PRM
■ Install the Siebel Server. When you install the Siebel Server, you must enable at least the 
following components to use Siebel PRM: 

■ Siebel PRM 

■ Workflow Management 

■ Communications

■ Configure Server Components. After installing the server, you must configure the following 
server components:

■ Siebel Communications Server. For users to send email, fax, or wireless messages you 
must configure the Siebel Communications Server. For information about setting up the 
Siebel Communications Server, see Siebel Communications Server Administration Guide.

■ Chart Server. For users to produce charts, you must configure the Chart Server. For 
information about setting up the Chart Server, see the Siebel Installation Guide for the 
operating system you are using.

■ Actuate Report Server. For users to produce reports, you must configure the Actuate 
Report Server. For information about setting up the Actuate Report Server, see the Siebel 
Installation Guide for the operating system you are using.

■ Documents Server. For users to produce presentations, proposals, or correspondence, you 
must enable eDocuments during installation and configure the Document Server. For 
information about setting up the Document Server, see Applications Administration Guide. 

■ Configure eApps.cfg. After installing, you must edit the file eapps.cfg to use the correct 
anonymous login. The location of this file depends on where you install it, but typically it is in 
the directory ...\SWEApp\bin. Open this file with any text editor and edit it so it has the following 
values:

■ AnonUserName = guestcp

■ AnonPassword = <your password for guestcp>

■ Configure LDAP. In order to use the Siebel PRM new user registration, you must have LDAP 
configured. 

For information about which Web servers are supported, see Siebel System Requirements and 
Supported Platforms. 

For information about installing Siebel applications, see the Siebel Installation Guide for the 
operating system you are using.

For information about configuring LDAP, see Security Guide for Siebel Business Applications.

Activating Workflows
In order to use Siebel PRM, you must activate the Registration and Commerce workflows. Siebel PRM 
also includes other workflows that you may want to activate. 

For more information about workflows, see Siebel Business Process Designer Administration Guide.
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Activating the Registration Workflows
You must activate the Registration workflows to let new partners register through the Siebel PRM 
Portal. 

For more information about partner registration, see Chapter 5, “Working with New Partners.”

To activate the Registration workflow

1 Log in to the Siebel PRM Manager. 

2 Navigate to the Business Process Administration screen. 

Workflow Processes should be selected by default in the Show drop-down list. 

3 Use a query to find these User Registration workflows:

■ User Registration Process

■ User Registration SubProcess

■ User Registration Initial Process

■ User Registration Forgot Password Process

■ User Registration Company Information (SCW)

■ User Registration Individual Information (SCW)

4 Make sure that the version number for each workflow process is 0, and that the status for each 
workflow process is Inactive. 

5 Select the record for one workflow process and do the following:

a Click Revise. 

b When the revise operation is done, click Save.

c In the Workflows list, make sure that a new copy of the process exists with a version number 
greater than 0, and the status is In Progress. 

d Select this new copy of the process, and click Activate to activate the workflow.

6 Repeat Step 5 for each process.

Activating the Commerce Workflows
Activate the Commerce workflows to enable partner commerce. For more information about partner 
commerce, see Chapter 9, “Managing Sales.”

To activate the Commerce workflows

1 Log in to the Siebel PRM Manager. 

2 Navigate to the Business Process Administration screen. 

Workflow Processes should be selected by default in the Show drop-down list. 

3 Find the following workflows, and perform the remaining steps on each of them: 
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a All workflows in which the Group field has the value eSales. 

b The workflow named “eChannel - Cancel Order Process”

c The workflow named “eChannel Go to Current Quote View (eSales)”

d The workflow named “eChannel Shopping Cart Scenarios Workflow”

4 Make sure that the version number for each workflow process is 0, and that the status for each 
workflow process is Inactive. 

5 Select the record for one workflow process and do the following:

a Click Revise. 

b When the revise operation is done, click Save.

c In the Workflows list, make sure that a new copy of the process exists with a version number 
greater than 0, and the status is In Progress. 

d Select this new copy of the process, and click Activate to activate the workflow.

6 Repeat Step 5 for each process.

7 Restart the server if you already have it up.

Activating the Opportunity Management Workflows 
Siebel PRM includes the following workflows that provide email notification about the status of 
opportunities in order to facilitate the sales process. You may choose to activate these, depending 
on your business model. 

These workflows are activated in the same way as the Registration and Commerce workflows 
described previously. Search for the following workflow names: 

■ Email Notification of Assigned Opportunity

■ Email Notification of Pending Opportunity

■ Email Notification of Inactive Opportunity

■ Email Notification of Lost Opportunity

■ Email Notification of Won Opportunity

For more information about these workflows, see the section about opportunity workflows in 
Applications Administration Guide.

Activating Other Workflows
A number of additional workflows are included in the sample data. You can use them as examples or 
activate them in your implementation of Siebel PRM. 

These workflows are activated in the same way as the Registration and Commerce workflows 
described previously. Search for the workflow names in the following list: 

■ Prospect Registration (eChannel). This workflow sends email to prospective partners after 
they register on the Unregistered Partner home page, confirming receipt of their application to 
be partners. 
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■ Send Prospect Partner Application Status Email (eChannel). This workflow sends email to 
prospective partners when the brand owner acts on their applications, telling them they have 
been approved or rejected as partners. 

■ eChannel Partnership Tier Definition and eChannel Partnership Tier Definition Dummy 
Sub Process. These workflows determine the appropriate partnership tier, based on the 
prospective partner's application.

■ CHAMP Update Metrics Workflow. This workflow automatically inserts the actual values for 
revenues generated, market development fund (MDF) spending, and training courses completed 
for objectives defined in a partner's CHAMP Business Plan.

■ CHAMP Plan - Partner Alert and CHAMP Plan - Create Alert Message. This workflow 
automatically generates a partner alert for the appropriate partner when the alliance manager 
publishes the joint CHAMP Business Plan.

Configuring High Interactivity
The Siebel PRM Manager supports high interactivity. 

The Siebel PRM Portal supports both standard interactivity and high interactivity. The default is 
standard interactivity. You should configure the PRM Portal to use high interactivity only if you are 
sure that your partners use Web browsers that support it. 

For more information about high interactivity and standard interactivity and the browsers used for 
each, see Using Siebel Tools.

To configure the Siebel PRM Portal to use high interactivity

1 Use any text editor to open the configuration file for the Siebel PRM Portal, which is <installation 
directory>\siebsrvr\bin\<lang>\scw.cfg. 

2 Add the following lines to the [SWE] section of scw.cfg:

HighInteractivity = True

ShowWriteRecord=TRUE

In addition to the configuration file, responsibilities are used to display the calendar on the Siebel 
PRM Portal home page for high interactivity and standard interactivity. 

■ To display the calendar for high interactivity, use the view HI Activity Calendar View.

■ To display the calendar for standard interactivity, use the views Calendar Daily View, Calendar 
Monthly View, and Calendar Weekly View.

By default, all partner responsibilities include the views that display the calendar for standard 
interactivity. If you configure the Siebel PRM Portal for high interactivity, you must modify all partner 
responsibilities by deleting these views and adding the view that displays the calendar for standard 
interactivity. 

For more information about defining partner responsibilities, see “Defining Partner Responsibilities” 
on page 31. 
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Configuring Siebel PRM
Siebel PRM is fully configurable using Siebel Tools and any HTML editor or Web authoring application. 
You can configure the following:

■ Look and Feel. You can configure the look and feel of Siebel PRM to be consistent with the look 
and feel of your own Web site.

■ Data Presentation. You can configure business objects, business components, and fields 
presented in Siebel PRM in the same way that you do in other Siebel applications. For example, 
you can add special fields or remove fields that are not needed in your business.

■ Architecture and Performance Preferences. You can set logging, file size, timeout, and other 
system preferences.

NOTE: When you configure Siebel PRM, you should not remove the logout page that appears when 
the user clicks Logout, and instead display the anonymous user home page. If you do this, the server 
will not terminate the session. Server sessions could accumulate and exceed the server’s maximum. 

For information about configuring Siebel PRM, see Using Siebel Tools.

Configuring Online Help
As with other Siebel applications, Siebel PRM comes with online help. 

You can change the online help to suit your business model.

For more information on customizing online help, see Siebel Developer’s Reference.

Personalizing Siebel PRM
Personalization means showing customers, employees, and partners what they want and need to 
see. 

Some personalization is built into Siebel PRM. For example, when partners use the Siebel PRM Portal, 
it greets them by name and displays content targeted to their needs and interests.

You can personalize the application further by using Siebel Personalization to define rules to show 
and hide views, applets, and content dynamically. Personalization deployment rules can depend on 
data such as users’ personal profile information, date ranges, their company, geographical 
information, and other parameters.

For information about administering personalization, see Siebel Personalization Administration 
Guide.

NOTE: You can also provide targeted content to partners by using partner alerts, Siebel Briefings, 
and other features of Siebel PRM that are covered in Chapter 15, “Managing Your Partners.”

Setting Up Advanced Search 
Siebel PRM can search for data in two ways:

■ Search. Search lets users search for data in a specific field of a specific business object.
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■ Advanced Search. Advanced search lets users do full text searches of multiple fields in multiple 
data sources.

Advanced Search uses the Hummingbird Ltd. SearchServer engine to scan database tables and 
documents in the Siebel File System. 

To implement Siebel Advanced Search, you must complete the following tasks:

■ Install Hummingbird Ltd. SearchServer.

■ Set up a separate directory for the search indexes for Siebel Search.

■ Set up separate ODBC drivers for Siebel Search.

■ Create and index the search tables.

For information about installing and administering Siebel Search, see Siebel Search Administration 
Guide.

Setting Up Analytics
Both the Siebel PRM Manager and the Siebel PRM Portal use Siebel Analytics to allow partner 
managers and partners to analyze partner performance and many other aspects of business 
performance. 

For information about installing and setting up Siebel Analytics, see Siebel Analytics Installation and 
Configuration Guide. 

Setting Up Siebel PRM
In general, the channel operations manager does the preliminary work of setting up Siebel PRM when 
it is first deployed. After this preliminary planning and administrative work is done, the channel 
manager can add new partner companies and employees. 

To set up Siebel PRM, you go through the following process:

■ Set up the organization structure. Organizations are one way to control the data people can 
see. For example, if a user displays the All Contacts view, the contacts in that user’s organization 
appear. Organizations also provide structure to organize relationships with partners through the 
hierarchy, and provide a way to set up and group partner employees. You must plan the 
organization hierarchy for your own company and your partner companies. 

■ Create responsibilities. Responsibilities determine which views people can see. For example, 
employees have a responsibility that includes the My Contacts view, managers have a 
responsibility that also includes My Team’s Contacts view, and higher managers have a 
responsibility that also includes the All Contacts view. You control which responsibilities are 
available to partners. You should create the appropriate responsibilities so they are available to 
assign to users when you add the users. 
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

29



Setting Up Siebel PRM ■  Setting Up Siebel PRM
■ Create roles. Roles are not required, but they make Siebel PRM easier to use for both brand 
owner and partner employees. When you create roles, by default users only see the screen tabs 
for their roles, which let them access the screens they use most frequently without being 
distracted by the other screens for their responsibilities. Users also have a task list for their role 
on their home page, with hyperlinks that take them directly to the views they use most 
frequently. 

■ Set up access groups and categories. You use access groups and categories to share master 
data, such as literature and products, with partners. Access groups are groups of partner 
companies to which you can assign master data, regardless of their place in the organization 
hierarchy. Categories are groupings of master data. 

■ Create price lists. The channel operations manager must create the appropriate price lists for 
partners, so the channel manager can assign these to new partner companies that are added. 

■ Set up automatic routing of information. Optionally, you use Siebel Business Process 
Designer and Siebel Assignment Manager to route data automatically. For example, you can 
automatically send email to partners when certain application events occur. 

■ Add partner companies and employees. After you have done the preliminary work of setting 
up Siebel PRM, you can add partner companies and employees. 

■ Create CHAMP Metrics. If you are planning to use CHAMP planning to work with your partners, 
you should create CHAMP metrics. 

■ Set up real-time integration. If you are using Siebel Application Network for real-time 
integration, in addition to the setup tasks described in this chapter, you must perform the setup 
tasks described in Chapter 4, “Setting Up Application Services Interfaces.” 

Setting Up the Organization Structure
Siebel applications let you divide your business into organizations. Organizations usually represent 
businesses or divisions of businesses, and they are one way to control visibility to data. For example, 
when users choose All Contacts, they display the contacts in their own organization. 

Each partner company is represented by one or more organizations. If you put multiple partner 
companies in one organization, then employees of one company may see data that belongs to the 
other company. You avoid this problem by putting companies in organizations of their own. 

You can create a hierarchical organization structure, which has one organization under another. 

When you create the organization structure, be aware that it affects visibility in the Pick Partner 
dialog box. Whenever channel managers use a dialog box that lists partners, the dialog box includes 
the partners in their own organization and in suborganizations of that organization. However, if the 
user has access to the All Partners Across Organizations view, then the Pick Partner dialog box will 
include partners in all organizations. This visibility in the Pick Partner dialog box makes it easier for 
partner managers to work with partner records. 

For more information about configuring visibility, see “Configuring Visibility” on page 38. 

You can set up your partner hierarchy in different ways, depending on your business requirements. 
For example, you can:
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■ Set up the organization hierarchy so channel managers are in organizations of their own, and the 
partner companies that report to each manager are in organizations that are below that 
manager’s organization. Then, when channel managers use the Pick Partner dialog box, the 
partner organizations that they manage are visible. 

■ Set up organizations that reflect the structure of your partner programs. For example, you can 
set up one organization for your resellers, another for your service partners and a third for 
alliance partners. Channel manager employees would be placed in the organization for which 
they worked, and would have visibility to the partners belonging to that organization.

■ Set up an organization hierarchy structure where all partners report to the main brand owner 
organization. Channel manager employees would be a part of this main organization, so they 
would be able to see the partners when they use the Pick Partner dialog box.

If a partner company is large, you can create a hierarchical structure with multiple organizations for 
just that company. For example, if you assign opportunities to different regional divisions within a 
partner company, you can create a structure with one organization representing the entire partner 
company and organizations under it in the hierarchy representing its regional divisions. Then, you 
can assign an opportunity to a regional division so only that division can view it. This structure would 
also let you delegate the administration of each region to different administrators, have sales 
representatives and employees associated with the region in which they work, and organize other 
company data by region. 

When your company first deploys Siebel PRM, the channel operations manager uses the 
Administration - Group screen to set up the overall organization structure, and uses the 
Administration - Partner screen to add organizations representing existing partners. 

When your company adds new partners, channel managers use the Administration - Partner screen 
to add organizations representing the new partner companies. 

For more information on working with organizations using the Administration - Group screen, see 
Applications Administration Guide and Security Guide for Siebel Business Applications.

For more information about adding a partner organization using the Administration - Partner screen, 
see Chapter 5, “Working with New Partners.”

NOTE: Always use the Administration - Partner screen to create organizations representing partner 
companies. Use the Administration - Group screen only to set up the overall organization structure—
for example, to set up organizations for consulting partners, software partners, platform partners, 
and so on. Do not use this screen for setting up organizations for individual partner companies. 

Defining Partner Responsibilities
Responsibilities specify which views users can access. 

For example, you can create the responsibilities of Salesperson, which includes the My Opportunities 
view; Sales Manager, which includes both the My Opportunities and My Team’s Opportunities views; 
and Sales Director, which includes the My Opportunities, My Team’s Opportunities, and All 
Opportunities views. 
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If you are using delegated administration, you make one partner employee the delegated 
administrator by assigning that employee the responsibility of Partner Operations Manager, which 
lets that partner employee see the delegated administration views of the Siebel PRM Portal. Then, 
while adding employees, the delegated administrator assigns them responsibilities that you have 
created. 

An employee in your company (usually your system administrator) must create the responsibilities. 
To make sure that partner users are not given access to inappropriate data, delegated administrators 
at partner companies cannot create responsibilities. They can only select from the list of 
responsibilities to which you have given them access.

Use the Administration - Application screen > Responsibilities view to create responsibilities. 
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In the seed data that is distributed with Siebel PRM, all responsibilities on the Siebel PRM Manager 
side begin with “Channel,” and all responsibilities on the Siebel PRM Portal side begin with “Partner.” 
The responsibilities included in the seed data are shown in Table 3 and Table 4.

Table 3. Responsibilities in Siebel PRM Seed Data with Views in Siebel PRM Portal

Responsibility Description

Partner Operations 
Manager

The main administrative role in the partner company, with access to the 
Delegated Administration views and most other views in the Siebel PRM 
Portal. This responsibility will be given to a small number of users in the 
partner company.

Partner Relationship 
Manager

The manager at the partner company responsible for daily interactions 
with the brand owner. Has access to all views in the PRM Portal except 
administrative views, such as the Delegated Administration views.

Partner Sales Manager The sales manager at the partner company. Has access to the My and 
My Team’s views of all sales-related screens, but not to service screens.

Partner Sales Rep The sales agent at the partner company. Reports to the partner sales 
manager. Has access to the My Views of all sales-related screens. 

Partner Service Manager The service manager at the partner company. Has access to the My and 
My Team’s views of all service-related screens, but not to sales screens.

Partner Service Rep The service agent at the partner company. Reports to the partner 
service manager. Has access to the My Views of all service-related 
screens. 

Unregistered Partner 
Agent

An anonymous browser. 

Table 4. Responsibilities in Siebel PRM Seed Data with Views

Responsibility Description

Channel Executive The channel executive at the brand owner. Has access to all views for 
sales and service, including all across organizations views. Also has 
access to partner sales, service and marketing analysis views, and to 
revenues and reports and charts.

Channel Partner 
Manager

The manager at the brand owner company responsible for daily 
interactions with the partner. Has access to the My and My Teams views 
of all sales and service-related screens. 
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Some views used to display the calendar of the Siebel PRM Portal are different for high interactivity 
and for standard interactivity:

■ HI Activity Calendar View. This view is used only for high interactivity. 

■ Calendar Daily View, Calendar Monthly View, and Calendar Weekly View. This view is 
used only for standard interactivity. 

When you are creating or modifying responsibilities for partners, use the appropriate view, 
depending on whether partners use standard interactivity or high interactivity. 

For more information about responsibilities, see Security Guide for Siebel Business Applications.

Administering Roles
Roles are not required, but they can increase the usability of Siebel PRM for both brand owner and 
partner employees. 

Be aware of the following considerations when you create roles and assign users to these roles:

■ By default, users only see the screen tabs and view tabs for their roles. 

■ Users can still go to the site map and see all screens that they have access to in their 
responsibility. 

■ Users have a task list for their role on their home page, with hyperlinks that take them directly 
to the views they use most frequently. 

■ Administrators can base personalization on roles. For example, they can hide appletsor display 
messages in the salutation based on role. 

For information about creating roles, associating tasks with roles, and specifying the screen tab and 
view tab layout for each role, see Security Guide for Siebel Business Applications. 

Assigning Roles to Brand Owner Employees
You associate brand owner employees with roles using the User Administration screen of Siebel PRM 
Manager.

Channel Marketing 
Manager

The manager at the brand owner company responsible for marketing 
activities. Has access to all marketing-related views, including 
marketing administration views and other related views, such as views 
in the MDF, Contacts, and Opportunities screens.

Channel Operations 
Manager

The system administrator at the brand owner company responsible for 
setting up and maintaining Siebel PRM. Has access to all administration 
screens. 

Table 4. Responsibilities in Siebel PRM Seed Data with Views

Responsibility Description
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To associate a brand owner employee with a role

1 Navigate to the Administration - User screen > Employees view.

2 In the Employees list, select the record of the Employee you want to associate with a role. 

3 In the More Info form, click the show more button. 

4 In the More Info form, in the Role field, click the select button. 

5 In the Role dialog box, if the role you want is not already in the Role list, click New and use the 
Add Roles dialog box to select the role. 

6 In the Role dialog box, select the role you want to associate with the employee, make sure it is 
selected as the primary role, and then click OK. 

Assigning Roles to Partner Employees
You can either assign roles to partner employees yourself, or you can make them available to 
delegated administrators at your partner companies. 

After a partner employee is associated with a role, that employee sees his or her role’s tasks on the 
home page and sees the tab layouts defined for that role in the PRM Portal. 

Making Roles Available to Partner-Delegated Administrators
To reduce your company’s administrative burden, you can make roles available to partner-delegated 
administrators, so they can assign the roles to partner employees. 

For information about how the partner-delegated administrators assign roles to partner employees, 
see “Delegated Administration” on page 122. 

NOTE: Alternatively, rather than using the procedure that follows, you can make roles available to 
partner companies by choosing the partner organization in the Organization field of the Role record. 

To make roles available to the delegated administrator at a partner company

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view.

2 In the Partners list, select the partner company you want to give access to the roles. 

3 Click the User Roles view tab. 

4 In the User Roles list, click New to add a new record. 

The Add Roles dialog box appears. 

5 In the Add Roles dialog box, select one or more roles that you want to make available to this 
company and click OK. 
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Associating Users with Roles in the Siebel PRM Manager
In the Siebel PRM Manager, you can associate your partner employees with their roles using the User 
Administration screen, as you do brand owner employees. However, if you are working with multiple 
employees of a single partner company, it is better to use the Administration - Partner screen to 
display all the employees of a partner company. 

NOTE: Alternatively, you can associate an employee with a role using the Employees screen. 

To associate a partner employee with a role 

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view.

2 In the Partners list, select the partner company whose employees you want to associate with 
roles.

3 Click the User Assignments view tab. 

4 In the User Assignments list, in the Role field, click the select button. 

5 In the Role dialog box, if the role you want is not already in the Role list, click New and use the 
Add Roles dialog box to select the role. 

6 In the Role dialog box, select the role you want to associate with the employee, make sure it is 
selected as the primary role, and then click OK. 

Setting Up Access Groups and Categories
Siebel applications include two different types of data:

■ Transactional Data. This is data that users can create, read, edit, and delete—for example 
opportunities, accounts, contacts, and service requests. This data can be assigned to individuals, 
to groups of individuals (such as a sales team), or to organizations. 

■ Master (or Referential) Data. This is data that users can only read, such as sales literature 
and service solutions. It is usually assigned to groups of users through access groups.

Channel managers use access groups and categories as follows to assign master data to partners: 

■ Access groups. These are groups of parties, such as organizations, divisions, user lists or 
positions. Individuals such as contacts or employees cannot be assigned directly to an access 
group. If you want to add an individual partner to an access group, you must add the partner to 
a user list and assign the user list to the access group. 

■ Categories. These are groups of data. For example, you might create a category with your 
product literature and frequently asked questions about a specific product line. 

Before channel managers assign any master data to partner companies, the channel operations 
manager must analyze the way you need to share master data with your partners and create the 
appropriate categories and access groups. 
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For example, you have partners who sell different product lines that your company manufactures, 
such as servers and desktop computers. Some partners do not sell all of the products within a given 
product line; some may sell only the most powerful servers or the low-priced desktops. In this case, 
you can create categories for the product lines you sell, and also create categories for each individual 
product that you sell, for each specific model of server and desktop computer. Then, you would 
associate sales literature, training courses, and other information about an entire product line with 
the appropriate category, and associate information about an individual product with the appropriate 
category. 

Finally, you would create access groups for partners that sell each product line, such as Server 
Resellers and Desktop Resellers. Each of these access groups could have child access groups for each 
product within the product line. The access groups could then be associated with the appropriate 
catalogs and categories; for example, the server access group would be associated with the server 
catalog. The structure would be in place so that when partners are added to the access groups they 
will get information about the product lines and the specific products they sell.

After the channel operations manager has done this initial work of setting up categories and access 
groups, the channel managers can assign data to partner companies. If you create new sales 
literature or a new training course, you associate it with the appropriate category to make it visible 
to the partners who need it. If you enroll a new partner, you associate it with the appropriate access 
groups to give it visibility to the master data it needs. 

For more information about working with categories and access groups, see Security Guide for Siebel 
Business Applications and Siebel eSales Administration Guide.

Creating Price Lists
Price lists are the only type of master data that is not assigned using access groups, because price 
lists are usually assigned to smaller groups of partner companies than other forms of master data. 

For example, you may assign master data to an access group called resellers, but you may have a 
different price list for each reseller, or you may have a standard price list for most resellers but 
special price lists for five of your resellers. 

When you first set up Siebel PRM, your channel operations manager has to set up the appropriate 
price lists for your partners. The channel managers can assign these price lists to new partner 
companies that they add. 

For more information about setting up price lists, see Pricing Administration Guide.

Setting Up Automatic Routing of Information
You can use Siebel Business Process Designer and Siebel Assignment Manager to automatically share 
information with your partners. The sample data shipped with Siebel PRM includes sample workflows 
that you may find useful. 
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Siebel Business Process Designer can provide automatic email or fax notification to partners under 
conditions that you specify. For example, whenever you assign a sales opportunity for more than 
$500,000 to a partner, Siebel Business Process Designer can automatically inform the partner by 
email that there is an important new opportunity. 

Assignment Manager can automatically assign opportunities, service requests, and other data to the 
partner who is best able to work with them. You can create rules based on your partners’ expertise, 
location, work load, and other conditions, and Assignment Manager will automatically assign data to 
the employee or partner who fits those rules. For example, it could assign a new service request to 
the employee or partner who has the required expertise, is in the right location, and also has the 
fewest service requests in the queue.

For information about the workflows included in the Siebel PRM sample data, see “Activating 
Workflows” on page 24. 

For more information about defining rules to enable automatic email notification and customizing 
notification messages, see Siebel Business Process Designer Administration Guide.

For more information creating rules in Assignment Manager, see Siebel Assignment Manager 
Administration Guide.

Adding Partner Companies and Employees
After you have completed the preliminary work of planning the organization structure, creating 
responsibilities, and setting up access groups and categories, then you must add partner companies 
and employees. 

For information about adding new partner companies and employees, see Chapter 5, “Working with 
New Partners.”

Creating CHAMP Metrics
Channel and Alliance Management Process (CHAMP) helps brand owners and partners work 
collaboratively. 

If you will be using CHAMP planning, you should create metrics that let you measure your partners’ 
performance when you are setting up Siebel PRM. 

In your ongoing work with your partners, you will create and execute initiatives and plans that will 
be evaluated using these metrics. 

For more information about CHAMP planning, see Chapter 7, “CHAMP Planning.”

Configuring Visibility
Siebel PRM includes visibility enhancements to support collaboration of partners with the brand 
owner and with other partners, but they do not cover every possible scenario. If your business model 
requires different visibility enhancements, you can configure Siebel PRM with Siebel Tools in the 
following ways: 
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■ Configuring visibility of pop-up or pick applets

■ Configuring visibility of child objects in views

■ Letting users change primary on visibility teams, including position- and organization-based 
teams

This section describes the Siebel PRM visibility enhancements and gives you background information 
that you need to configure visibility. It does not give you detailed instructions for working in Siebel 
Tools. 

For information about using Siebel Tools, see Using Siebel Tools. 

About Visibility Enhancements in Siebel PRM
Visibility is important to Siebel PRM, because it facilitates collaboration between partners and other 
partners or the brand owner. 

To preserve the privacy of each company’s data, partners do not have visibility to all records 
associated with certain business components—only to the records in their organization. 

For example, in other Siebel applications, if you navigate to the Accounts screen, select an Account 
record, and then click the Contacts view tab, you see all the contacts that are associated with that 
account. In the Siebel PRM Portal, the partner sees contacts associated with the account only if it is 
in the partner’s organization. 

This visibility capability applies to information in the following views in the Siebel PRM Portal: 

■ Opportunity screen: Contacts, Quotes, Revenues, Products, Activities

■ Account screen: Opportunity, Quotes, Orders, Revenues, Activities

Siebel PRM also has enhancements that allow partners to collaborate with other partner companies 
by assigning data to positions or organizations in other partner companies. For more information, 
see Chapter 13, “Partner-to-Partner Collaboration.”

If your business model requires other visibility enhancements beyond these, you can configure 
visibility using the methods in the following sections.

Configuring Visibility of Pop-Up or Pick Applets
Pop-up visibility determines what data will be shown when a pop-up pick applet is displayed—for 
example, when a user associates a contact with an account, or adds a sales representative to the 
sales team. 

Pop-up visibility is usually set using the Popup Visibility Type property of the business component 
object in Siebel Tools. When pop-up visibility is set in this way, any pop-up window based on that 
business component will show the same data for all users. 

There are often circumstances where you need greater flexibility when determining what data should 
be shown in pop-up pick applets. For example: 
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■ Most employees of your company need to see only positions for your organizations when they 
are assigning a sales representative to the sales team. 

■ Partner managers need to see positions for your organization, as well as the partner 
organizations that they manage. 

There are also many scenarios where your partners should have more restrictive visibility than your 
employees.

To meet this business requirement, Siebel applications have added the following three capabilities 
that let the developer override the visibility set in the Business Component Popup Visibility Type 
property at the business component level in favor of another setting. The developer can do the 
following: 

■ Set Visibility of the Pick List Object

■ Use the Visibility Auto All Property

■ Use the Special Frame Class and User Property

Setting Visibility of the Pick List Object
Developers can override the visibility set at the business component level by setting a different 
visibility type on the Pick List object, in the Visibility Type property.

When you do this, you override the visibility set at the business component in a specific instance of 
that business component, but for all users of that instance. 

For example, you may want partners to be able to add new fund requests and associate those fund 
requests with campaigns in which they participate. However, you want partners to see only 
campaigns to which they have access. You can configure a special picklist for this use, setting the 
visibility on that picklist to Sales Rep, so that partners can select only from accessible campaigns 
when associating to a fund request. 

Using the Visibility Auto All Property
For both Pick List Visibility Type and Business Component Pop-up Visibility Type there is a new 
property called Visibility Auto All that you can use to override the visibility type property. 

This property will check the current user's responsibility to see if it includes the All Across 
Organizations view based on the same business component. If the view is found, this visibility type 
is overridden and the user gets All visibility on the object in question. Otherwise, the visibility type 
is not overridden. 

For example, if the pop-up visibility on the Opportunities business component is set to Organization 
with Auto All set to true, most users will see all opportunities for their own organization in an 
Opportunity pick applet. Users who also have access to the All Opportunities Across Organizations 
view will see all available Opportunities regardless of organization. 

This property makes visibility consistent across views and pop-up pick applets.

This property can override any other visibility type, including Sales Rep, Manager, Organization, and 
so on. In addition to the Business Component and Pick List properties, this property can be set on 
the Link object as well. 
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This property is often used for executives or administrative users who would usually have access to 
all of the data in your Siebel application.

Using the Special Frame Class and User Property
The developer can use a special frame class and user property to set visibility for a pick applet on 
the applet object based on which application is being used. 

For example, if users are running Siebel Sales, the Pick Positions applet for the sales team shows 
positions for the user’s organization only. If users are running the Siebel PRM Manager, the applet 
shows the positions for the user’s own organization and for the suborganizations (or child 
organizations) of that organization, so that the users can select positions for the partners they 
manage. 

In order to override the pop-up visibility set at the business component level, the developer must do 
the following: 

■ Change the frame class of the applet to CSSSWEFrameListVisibilityPick 

■ Add an applet user property called Override Visibility, with the following values: 

■ Name: Override Visibility: [Application Name]

■ Value: [Visibility Type] where the developer can choose from the standard visibility types

Configuring Visibility of Child Objects in Views
Siebel applications use a number of visibility types to determine what data will be shown on each 
view. 

For example, the My Opportunities view uses Sales Rep visibility; it shows the opportunities for users 
on the Sales Team. If you have access to that Opportunity, you can also see its child objects—for 
example, you can see Activities, Contacts, and Quotes that are associated with that Opportunity.

Sometimes it is important to limit the visibility to the child objects. For example, if you are sharing 
Opportunities with your partners, you might want to show them any Activities, Contacts, and Quotes 
that they have added for that Opportunity, but not ones that you have added.

To meet this business requirement, Siebel applications have added two capabilities. 

You can apply a visibility type to an applet as a property of the View Web Template Item, which is 
where applets are associated with views. However, you cannot apply the Auto All property to the Web 
template item. For parent-child views such as Opportunity > Contacts, placing visibility on the 
Contacts applet on the View Web Template Item object changes the visibility on the Contacts applet 
when it is used in this view. Using this method, you can apply visibility to the applet in the context 
of a specific view, but reuse the applet with no or other visibility applied in another view.

Alternatively, you can set visibility on the link object, and it will be applied in addition to the visibility 
set at the view level. For parent-child views (such as Opportunity/Contacts) you can set a visibility 
type as a property on the Link object that links the Opportunity and Contact business components 
for this view. In addition, the you can set the Auto All property on the Link object to override the 
visibility type set on the Link object. For example, if the visibility on the link is Sales Rep, but Auto 
All is true, administrative users still see all records in the database. Note that once visibility is applied 
to the link, it is applied wherever the link is used throughout the application.
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Allowing Users to Change the Primary on a Visibility 
Team 
Siebel applications use visibility teams to determine what data will be displayed in different views. 
There are both position- and organization-based visibility teams.

For example, the My Opportunity view is position-based; it shows opportunities where the user is on 
the Sales Team. The All Opportunities view is organization-based; it shows opportunities where the 
user's organization is on the organization team. 

Both position- and organization-based visibility teams have primary members. 

On position-based teams, the primary member is the only user who can delete the data. The primary 
member is also used occasionally in Forecasting and Analytics to determine which organization 
should be credited for certain metrics. On organization-based teams, the primary on the organization 
team is also important in measuring results on certain metrics. 

The developer can either restrict the ability to change the primary team member to the manager of 
the primary on the position team, or give this ability to all users. By default, for position-based 
teams, only the primary's manager can change the primary. By default, for organization-based 
teams, any user can change the primary organization.

To change the default behavior, the developer must add a user property to the business component 
called MVG Set Primary Restricted, with the following syntax: 

■ Name: MVG Set Primary Restricted: [visibility mvlink name]

■ Value: TRUE or FALSE

NOTE: Users cannot directly delete the primary record from a position team. To delete the primary 
from the position team, you must go through a two-step process: first, designate a new member of 
the position team as primary, and then delete the original primary from the position team. 

Siebel Partner Web Services 
The webMethods products included with Siebel Partner Web Services and Siebel Tools for Partner Web 
Services are licensed only for use in combination with the Siebel programs, such that 
communications that use the webMethods products must include communication with a Siebel 
Program. Application-to-application integration using the webMethods products included with Siebel 
Partner Web Services and Siebel Tools for Partner Web Services that does not include communication 
with a Siebel program is prohibited. 

For more information about Siebel Partner Web Services, see the webMethods documentation for the 
server infrastructure and adapters. 

Installing Siebel Partner Web Services Servers
Begin the installation process by installing the core server components of Siebel Partner Web 
Services, which includes:

■ webMethods Integration Server
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■ webMethods Trading Networks Server

■ webMethods Business Integrator Service Package

Install these servers in the order listed above. 

Brief instructions for installing on each platform are given below. For more information, see the 
webMethods Integration Server Installation Guide in the third-party documentation section of the 
Siebel Bookshelf.

Installing Under MS Windows 
For the Windows platform, the installations for the webMethods Server processes are located on the 
Windows Server Ancillary Programs (CD 3 of 3). 

To install Siebel Partner Web Services Servers under MS Windows

1 Install the webMethods Integration Server by running the executable 
IntegrationServer46_en_US.exe, located in the directory 
Thirdparty\webmethods\<lang>\integration_server\server. 

■ If you are installing at your site, you will be prompted for your license key. You should enter 
your Hub license key. 

■ If your partners are installing the server at their sites, they will be prompted for a license 
key. They should enter the Partner license key. 

2 Install the Trading Networks Server by running the executable TNServer46_en_US.exe in the 
directory Thirdparty\webmethods\<lang>\trading_networks\server. 

3 Install the Business Integrator Service Package by running the executable 
BusinessIntegrator_46_Services_en_US.exe in the directory 
Thirdparty\webmethods\<lang>\business_integrator directory. 

Installing on a Solaris Platform
For the Solaris Platform, the webMethods Server processes are located on Solaris Server Ancillary 
Programs (CD 2 of 2). 

The installation process and directory structure for Solaris are the same as for the Windows platform. 
However, the installation files are JAR files instead of Windows executables. 

Installing on an AIX Platform
For the AIX Platform, the installations for the webMethods Server processes are located on the AIX 
Server Ancillary Programs (CD 2 of 2). 

The installation process and directory structure for AIX is the same as for the Windows platform. 
However, the installation files are JAR files instead of Windows executables. 
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Siebel Tools for Partner Web Services
The webMethods products included with Siebel Partner Web Services and Siebel Tools for Partner Web 
Services are licensed only for use in combination with the Siebel programs, such that 
communications that use the webMethods products must include communication with a Siebel 
Program. Application-to-application integration using the webMethods products included with Siebel 
Partner Web Services and Siebel Tools for Partner Web Services that does not include communication 
with a Siebel program is prohibited. 

For more information about Siebel Tools for Partner Web Services, see the webMethods 
documentation for the developer product and the administrator consoles for both webMethods 
Trading Networks and webMethods Business Integrator. 

Installing Siebel Tools for Partner Web Services
Siebel Tools for Partner Web Services includes the following components:

■ webMethods Developer

■ webMethods Trading Networks Console

■ webMethods Business Integrator

Brief instructions for installing on each platform are given below. For more information about 
installation, see the webMethods Installation Guide in the directory webmethods\installer in the 
third-party documentation section of the Siebel Bookshelf.

Installing Under MS Windows
For the Windows platform, the installation for Siebel Tools for Partner Web Services is on Web Client 
Ancillary Programs (CD 2 of 2) in the directory Thirdpty\webmethods\<lang>\tools\windows. 

To install Siebel Tools for Partner Web Services under MS Windows 

1 Copy the following files to a temporary writable directory:

a install.bat

b webMethodsimage.zip

c webMethodsInstaller461.exe

2 Execute install.bat. 

Installing on a Solaris Platform
For the Solaris platform, the installation for Siebel Tools for Partner Web Services is located on Web 
Client Ancillary Programs (CD 2 of 2) in the directory 
\Thirdpty\webmethods\<lang>\tools\solaris. 

To install Siebel Tools for Partner Web Services on a Solaris platform

1 Copy the following files to a temporary writable directory:
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a webMethodsImage-Sol.jar

b webMethodsInstaller461.jar

2 Enter the following command: 

java -jar webMethodsInstaller461.jar -launchImage webMethodsImage-Sol.jar 

Installing on an AIX Platform
For the AIX platform, the installation for Siebel Tools for Partner Web Services is located on Web 
Client Ancillary Programs (CD 2 of 2) in the directory \Thirdpty\webmethods\<lang>\tools\aix. 

To install Siebel Tools for Partner Web Services on an AIX platform

1 Copy the following files to a temporary writable directory:

a webMethodsImage-Aix.jar

b webMethodsInstaller461.jar

2 Enter the following command: 

java -jar webMethodsInstaller461.jar -launchImage webMethodsImage-Aix.jar 

Troubleshooting Installation
During the installation of Siebel Tools for Partner Web Services, you should not be prompted for a 
login or a license key. 

If you are prompted for a login or license key, then the installer is having trouble locating the 
webMethods installation image file (specified with the -launchImage parameter). 

If this occurs, when you execute the installer, try specifying the exact directory to which you copied 
the installation image files. 
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4 Setting Up Application Services 
Interfaces
This chapter discusses how to set up Application Services Interfaces (ASIs), which allow integration 
of Siebel PRM with other CRM systems. It describes mandatory initial setup, and it documents 
workflows used by the ASIs.

This chapter contains the following topics:

■ “About Application Services Interfaces” on page 47

■ “Setting Up ASIs” on page 47

■ “ASI Workflows” on page 58

About Application Services Interfaces
Siebel’s Application Services Interfaces (ASIs) allow you to integrate Siebel applications with other 
applications in real time. 

Two features of Siebel PRM use ASIs:

■ Opportunity Transfer. Use this feature if some of your partners have their own CRM systems 
and do not want to use the Siebel PRM Portal to share opportunities. Opportunity transfer 
synchronizes your Siebel database with the partner's CRM system. You can transfer opportunities 
and the contacts, revenues, notes, and activities associated with them to your partner’s CRM 
system, or you can query the partner's system to transfer their opportunities to your Siebel 
system. For more information about how opportunity transfer can be used in your business, see 
Chapter 9, “Managing Sales.” 

■ Shopping Cart Transfer. Use this feature if your company wants to make sales through its own 
Web site but wants distributors or other partners to fulfill the orders. The customer can use Siebel 
Sales on your Web site to create a shopping cart and transfer the shopping cart to a partner’s 
site for fulfillment. For more information about how shopping cart transfer can be used in your 
business, see Chapter 12, “Managing Partner Commerce.” 

For general information about ASIs, see Application Services Interface Reference. This chapter 
provides the following information that is specific to Siebel PRM: 

■ Setting Up ASIs. You must set up the ASIs shipped with Siebel PRM before you can use them. 
This section provides the procedures that you must perform to set up these ASIs. 

■ ASI Workflows. You may want to modify the way that Siebel PRM invokes its ASIs to customize 
it for your business. This section documents the workflows that you may want to modify to 
change the ways that ASIs are invoked. 

Setting Up ASIs
This section covers: 
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■ Setting up opportunity transfer 

■ Setting up shopping cart transfer

After following the specific instructions to set up either of these, you must follow the general 
instructions for setting up ASIs, which applies to both of them. 

Setting Up Opportunity Transfer
To set up real-time opportunity transfer with a partner, you must: 

■ Set up the Web services

■ Assign a port to the partner

■ Do the general setup for ASIs

Setting Up Web Services for Opportunity Transfer
To set up the Web services, you must log into Siebel PRM Manager as a user with system 
administrator privileges. Then, you must set up outbound Web services and set up inbound Web 
services. 

To set up outbound Web services

1 Navigate to the Site Map > Administration - Web Services screen > Outbound Web Service view. 

2 In the Outbound Web Service list, create a query to display all records with “External 
Opportunity*” in the Name field. 

3 Select Active in the Status field of all of these records to activate these Web services. 

4 Select the record with the name External Opportunity Create. 

5 In the Service Ports list, click New, and enter the values in the following table in the fields of the 
new record.

Field Value

Name Enter a name for the port, such as Transfer opportunity. 

Port Type Select External Opportunity Create. 

Transport Select HTTP.
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6 In the Operation Bindings list, click New, and enter the values in the following table in the fields 
of the new record.

7 Follow Step 1 on page 48 through Step 6 on page 49 to define the service port for External 
Opportunity Update, with these exceptions:

a In the Outbound Web Service list, select External Opportunity Update. 

b Add a new record in the Service Ports list with the same values you entered for External 
Opportunity Create, but change the port type value to External Opportunity Update.

c Add a new record in the Operation Bindings list with the same values you entered for External 
Opportunity Create, but change the Operation Name value to 
ExternalOpportunityUpdateExecute.

8 Follow Step 1 on page 48 through Step 6 on page 49 to define the service port for External 
Opportunity Query, with these exceptions: 

a In the Outbound Web Service list, select External Opportunity Query. 

b Add a new record in the Service Ports list with the same values you entered for External 
Opportunity Create, but change the port type value to External Opportunity Query.

c Add a new record in the Operation Bindings list with the same values you entered for External 
Opportunity Create, but change the Operation Name value to ExternalOpportunityQueryExecute.

9 Follow Step 1 on page 48 through Step 6 on page 49 to define the service port for External 
Opportunity Update Response, with these exceptions:

a In the Outbound Web Service list, select External Opportunity Update Response. 

Address Specify the address or URL of the target system with which you are 
communicating.

If you are communicating with another Siebel instance, enter the following: 

http://<machine_address>/eai_<lang>/
start.swe?SWEExtSource=WebService&SWEExtCmd=Execute&UserName=<login for that 
machine>&Password=<password for that machine>

For the values in angle brackets, use the actual values for your system.

Protocol Select SOAP_RPC_ENCODED. 

Comment Enter a comment for your own use. 

Field Value

Operation Name Use the list to select ExternalOpportunityCreateExecute.

Binding Property namespace

Binding Value http://siebel.com/asi/

Field Value
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b Add a new record in the Service Ports list with the same values you entered for External 
Opportunity Create, but change the port type value to External Opportunity Update Response.

c Add a new record in the Operation Bindings list with the same values you entered for External 
Opportunity Create, but change the Operation Name value to 
ExternalOpportunityUpdateResponseExecute.

NOTE: Users must activate the workflows before they set up the Inbound Web services, or they 
cannot select the workflow under the Implementation Name in the Type field. For more information, 
see “Activate Workflows” on page 57. 

To set up inbound Web services

1 From the Show drop-down list, select Inbound Web Service. 

2 In the Inbound Web Service list, create a query to display all records with “Siebel Opportunity*” 
in the Name field. 

3 Select Active in the Status field of all of these records to activate these Web services. 

4 Select the record with the name Siebel Opportunity Create. 

5 In the Service Ports list, click New, and enter the values in the following table in the fields of the 
new record. 

Field Value

Name Enter a name for the port, such as Receive opportunity. 

Type Click the select icon. In the dialog box, click New and enter the following values 
in the new record: 

■ Implementation Type: Workflow Process

■ Implementation Name: Select Opportunity Sharing Siebel Create

■ Name: Siebel Opportunity Create

After creating this record, select it as Type.

Business 
Service

Entered automatically when you select the Type. 

Transport Select HTTP.

Address Enter http://<your_siebel_server_address>/eai_<lang>/
start.swe?SWEExtSource=WebService&SWEExtCmd=Execute&UserName=<login 
for that machine>&Password=<password for that machine>

For the values in angle brackets, use the actual values for your system.

Bindings Select SOAP_RPC_ENCODED. 

Comment Enter a comment for your own use. 
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6 In the Operations list, click New, and enter the values in the following table in the fields of the 
new record. 

7 Follow Step 1 on page 50 through Step 6 on page 51 to define the service port for Siebel 
Opportunity Update, with these exceptions: 

a In the Inbound Web Service list, select Siebel Opportunity Update. 

b Add a new record in the Service Ports list with the same values you entered for External 
Opportunity Create, but use the following values for the Type field when you create the new 
record in the list: 

❏ Implementation Type: Workflow Process

❏ Implementation Name: Select Opportunity Sharing Siebel Update

❏ Name: Siebel Opportunity Update

c Add a new record in the Operations list with the same values you entered for External 
Opportunity Create, but change the Name in the Operations list to 
ExternalOpportunityUpdateExecute. 

8 Follow Step 1 on page 50 through Step 6 on page 51 to define the service port for Siebel 
Opportunity Query, with these exceptions:

a In the Inbound Web Service list, select Siebel Opportunity Query. 

b Add a new record in the Service Ports list with the same values you entered for External 
Opportunity Create, but use the following values for the Type field when you create the new 
record in the list:

❏ Implementation Type: Workflow Process

❏ Implementation Name: Select Opportunity Sharing Siebel Query

❏ Name: Siebel Opportunity Query

c Add a new record in the Operations list with the same values you entered for External 
Opportunity Create, but change the Name in the Operations list to 
ExternalOpportunityQueryExecute. 

9 Follow Step 1 on page 50 through Step 6 on page 51 to define the service port for Siebel 
Opportunity Update Response, with these exceptions: 

a In the Inbound Web Service list, select Siebel Opportunity Update Response. 

b Add a new record in the Service Ports list with the same values you entered for External 
Opportunity Create, but use the following values for the Type field when you create the new 
record in the list: 

❏ Implementation Type: Workflow Process

❏ Implementation Name: Select Opportunity Sharing Receive Update Response

Field Value

Name Enter ExternalOpportunityCreateExecute. 

Business Service Entered automatically when you create a new operation. 
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❏ Name: SiebelOpportunityUpdateResponse

c Add a new record in the Operations list with the same values you entered for External 
Opportunity Create, but change the Name in the Operations list to 
ExternalOpportunityUpdateResponseExecute. 

Assigning a Partner Port for Real-Time Opportunity Transfer
To set up real-time opportunity transfer, in addition to setting up inbound and outbound Web 
services, you must assign a port to the partner. 

To assign a port to the partner for real-time opportunity transfer

1 From the application-level menu, choose Site Map > Administration - Partner screen > Registered 
Partners view. 

2 In the Partners list, select the partner company.

3 Click the Integration view tab. 

4 In the Integration list, click New, and use the list to select one of the ports you created for the 
Outbound Web Services list. 

5 Continue to create a new record in the Integration list for each of the ports you created in the 
Outbound Web Services list that belongs to this partner. 

Additional Setup Tasks
To finish setting up opportunity transfer, you must also complete the tasks described in “General 
Setup for ASIs” on page 57. 

Setting Up the Partner
For testing, you can set up a second system to represent a partner. On the second system, repeat 
the steps above for setting up the Web services and assigning the port. However, when you assign 
the port, as the partner, pick the organization that is the brand owner on the first system you set up.

After you have tested opportunity transfer and are ready to use it with actual partners, you must set 
up outbound ports for every partner to which you plan to transfer. 

In the External Opportunity Create Web service, you must create a separate service port for each 
partner, as described in “Setting Up Web Services for Opportunity Transfer” on page 48. Repeat this 
process for the rest of the outbound Web services. Then, use the Administration - Partner screen to 
assign the partner a port, as described in “Assigning a Partner Port for Real-Time Opportunity Transfer” 
on page 52, where you must add the port with each partner’s URL to that partner’s integration profile. 

In addition, you must talk to your partners to make sure the partners have some structure set up to 
receive a transfer. You must also make sure that partners have your organization listed as a partner 
in their own systems and that they have the correct value for the D-U-N-S number. 

On your system, there is an Internal DUNS Number System Preference. This has to be changed to 
match your company’s D-U-N-S number. 
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If your organization expects to receive transfers from partners, you must also make sure those 
partners are listed as partners and their D-U-N-S numbers are set correctly in your system.

Setting Up Shopping Cart Transfer
To set up real-time shopping cart transfer to a partner, you must:

■ Set up the Web services

■ Assign a port to the partner

■ Change the Siebel PRM Portal configuration file

■ Assign global product identifiers

■ Check setup of ATP 

■ Do the general setup for ASIs

Setting Up Web Services for Shopping Cart Transfer
To set up the Web services, you must log into Siebel PRM Manager as a user with system 
administrator privileges, and then set up outbound Web services and set up inbound Web services. 

To set up outbound Web services

1 Navigate to the Site Map > Administration - Service Administration screen > Outbound Web 
Service view. 

2 In the Outbound Web Service list, create a query to display the records with “External Shopping 
Cart Create” in the Name field. 

3 Select Active in the Status field of this record to activate this Web service. 

4 In the Service Ports list, click New, and enter the values in the following table in the fields of the 
new record.

Field Value

Name Enter a name for the port, such as Transfer Cart. 

Port Type Select External Shopping Cart Create. 

Transport Select HTTP. 
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5 In the Operation Bindings list, click New, and enter the values in the following table in the fields 
of the new record.

NOTE: Users must activate the workflows before they set up the Inbound Web services, or they 
cannot select the workflow under the Implementation Name in the Type field. For more information, 
see “Activate Workflows” on page 57. 

To set up inbound Web services

1 Navigate to the Site Map > Administration - Web Services screen > Inbound Web Service view. 

2 In the Inbound Web Service list, create a query to display the record with “Siebel Shopping Cart 
Create” in the Name field. 

3 Select Active in the Status field of this record to activate this Web service. 

4 Select the record with the name Siebel Shopping Cart Create. 

Address Specify the address or URL of the target system with which you are 
communicating.

If you are communicating with another Siebel instance, enter the following: 

http://<machine_address>/eai_<lang>/
start.swe?SWEExtSource=WebService&SWEExtCmd=Execute&UserName=<login 
for that machine>&Password=<password for that machine>

For the values in angle brackets, use the actual values for your system.

Binding Select SOAP_RPC_ENCODED. 

Comment Enter a comment for your own use. 

Field Value

Operation Name In the picklist, select ExternalShoppingCartCreateSynchronize 

Binding Property namespace

Binding Value http://siebel.com/asi/

Field Value
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5 In the Service Ports list, click New, and enter the values in the following table in the fields of the 
new record.

6 In the Operations list, click New, and enter the values in the following table in the fields of the 
new record. 

Assigning a Partner Port for Real-Time Shopping Cart Transfer
To set up real-time shopping cart transfer, in addition to setting up inbound and outbound Web 
services, you must assign a port to the partner. If you are not using middleware, you may want to 
set up a different port for each partner.

To assign a port to the partner for real-time shopping cart transfer

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view. 

2 In the Partners list, select the partner company.

3 Click the Integration view tab. 

Field Value

Name Enter a name for the port, such as Receive Cart. 

Type Click the select icon. In the dialog box, click New and enter the following 
values in the new record: 

■ Implementation Type: Workflow Process

■ Implementation Name: Select Transfer Cart Inbound Receive Process

■ Name: Siebel Shopping Cart Create

After creating this record, select it as Type.

Business Service Entered automatically when you select the port type. 

Transport Select HTTP. 

Address Enter http://<your_siebel_server_address>/eai_<lang>/
start.swe?SWEExtSource=WebService&SWEExtCmd=Execute&UserName=<l

ogin for that machine>&Password=<password for that machine>

For the values in angle brackets, use the actual values for your system. 

Binding Select SOAP_RPC_ENCODED. 

Comment Enter a comment for your own use. 

Field Value

Name Enter ExternalShoppingCartCreateSynchronize. 

Business Service Entered automatically when you create a new operation. 
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4 In the Integration list, click New, and use the picklist to select the port you created in the 
Outbound Web Services list. 

Change the PRM Portal Configuration File
The final step to enable shopping cart transfer is to change the configuration file for the Siebel PRM 
Portal.

To change the parameters to allow shopping cart transfer

1 Use any text editor to open the configuration file for the Siebel PRM Portal, which is the file 
<installation directory>\siebsrvr\bin\<lang>\scw.cfg. 

2 In the [InfraShoppingService] section of the file, edit the EnableTransferCart parameter as 
follows: 

EnableTransferCart=TRUE

3 Change this parameter in the Server Administration screen as follows: 

a Navigate to the Site Map > Server Administration screen > Components view. 

b Click the Component Parameters view tab. 

c In the Components list, search for eChannel Object Manager in the Name field. 

d In the Component Parameters list, find the parameter EnableTransferCart and select TRUE as its 
value. 

4 Restart your server. 

Global Product Identifiers
The brand owner and partners uniquely identify products using the Global Product Identifier field 
defined in the Product Administration screen of Siebel applications (or the equivalent field of other 
applications that your partners use). 

To receive shopping carts, the partners must have the same products as the brand owner in their 
product databases and they must use the Global Product Identifier. If a partner that is receiving a 
shopping cart transfer does not have a product with a matching Global Product Identifier, the transfer 
will fail. 

Before using shopping cart transfer, make sure the brand owner and partners have defined the 
relevant products in their respective applications. This is generally done as an offline batch process.

Checking Setup of ATP
If you will be using ATP functionality, you must set it up to call your partner's ATP engine (or your 
own internal ATP engineer). 

Alternatively, you can modify the workflows so they do not use the ATP step. For information about 
modifying workflows, see “Shopping Cart Transfer Workflows” on page 78. 
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This section describes how to set up ATP functionality for testing purposes. 

NOTE: Before performing the following procedure, make sure that you are using the ATP ASI Test 
service for the ATP Web Service.

To set up ATP functionality for testing purposes

1 Navigate to the Site Map > Administration - Web Service screen > Outbound Web Service view. 

2 Find the Web service named External ATP Check.

3 Change the value for Address to ATP ASI Test. 

4 Change the value for Transport to Local Business Service.

5 Change the value for Binding to Property Set.

6 Create a new record in the Operation Bindings list with Operation Name=Execute, Bind 
Property=namespace, and Binding Value=http://siebel.com/asi/.

7 If you have tried to run this service before, you must restart the server.

Additional ATP Setup Tasks
To finish setting up shopping cart transfer, you must also complete the tasks described in “General 
Setup for ASIs” on page 57. 

General Setup for ASIs
To set up either opportunity transfer or shopping cart transfer, in addition to the tasks described 
previously, you must also perform the tasks in this section:

■ Activate workflows

■ Assign D-U-N-S numbers

Activate Workflows
For either opportunity transfer or shopping cart transfer, you must activate the workflow processes 
used for real-time integration. 

NOTE: For testing, you must do this on the second system as well. 

To activate workflows

1 Navigate to the Site Map > Administration - Business Process screen > Workflow Processes view.

2 In the Workflow Processes list, use a query to find all processes where the Group field has the 
value PRM ASI. 

3 Activate each of these workflow processes that has the status Inactive: 
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a Select the workflow process record and click Revise.

A copy of the workflow process record is created with a status of In Progress. The copy is 
automatically selected.

b Click Activate. 

c Verify that the Status is Active. 

4 When you are finished activating workflow processes, restart the server. 

Assigning D-U-N-S Numbers
For either opportunity transfer or shopping cart transfer, you must enter a D-U-N-S number for your 
own company and for all partner companies that will use ASIs. The ASIs use the D-U-N-S number to 
uniquely identify the companies that are sending and receiving information. 

Though it is recommended that you use the D-U-N-S number, you can use any unique identification 
number that you and your partners agree on. 

NOTE: You should also assign D-U-N-S numbers for Accounts that you transfer back and forth to 
make sure both systems are referring to the same account. Alternatively, you can change the 
inbound workflows to search for the Account Name instead of the D-U-N-S number when checking 
to see if the Account already exists.

To set D-U-N-S numbers 

1 Set the D-U-N-S number for your own company as follows:

a Navigate to the Site Map > Administration screen > System Preferences view. 

b Search for a preference named Internal DUNS Number and enter its value.

2 Set the D-U-N-S number for all partner companies that will use ASIs as follows:

a Navigate to the Partners screen.

b In the Partners list, select the record for the partner company. 

c In the More Info form, enter the value in the DUNS# field. 

NOTE: The D-U-N-S numbers that your partners use must match the D-U-N-S numbers you use. The 
D-U-N-S number you enter for a partner in your system must match the D-U-N-S number that 
partner uses for itself in its system. The D-U-N-S number you enter for your own company in your 
own system must match the number the partner uses for your company in its system. 

ASI Workflows
This section documents the workflow processes that invoke the ASIs for opportunity transfer and 
shopping cart transfer. You do not need to modify these workflows, but you can modify them to suit 
your business model. 
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Opportunity Transfer Workflows
The workflow processes described in this section are associated with opportunity transfer. They are 
used for the following functions:

■ Transferring an opportunity

■ Updating an opportunity

■ Requesting an opportunity update

Either the brand owner or the partner can transfer an opportunity, update the opportunity, or request 
an update. The descriptions below refer to the two systems involved as “System A” and “System B.” 
These can refer to either the brand owner or the partner’s system, depending on who ran the 
opportunity transfer, updated the opportunity, or requested an update. 

Workflows to Transfer an Opportunity 
The workflows to transfer an opportunity are invoked in the following order: 

■ Opportunity Sharing Pick Partner. When the brand owner or partner clicks the Transfer button 
on the Transfer Opportunity Child form, it calls the Opportunity Sharing Pick Partner workflow. 
This workflow retrieves the partner’s ID and passes it on to the Opportunity Sharing External 
Create workflow, which the Opportunity Sharing Pick Partner workflow calls as a subprocess. 

■ Opportunity Sharing External Create. This workflow captures the object ID of the opportunity 
that is being transferred. It changes the opportunity's transfer status to Transfer In Progress. It 
then creates an internal key that System A uses to reference the opportunity. This workflow 
passes the opportunity ID, opportunity key, and the partner ID to the workflow Build Siebel 
Message, which it calls as a subprocess. 

■ Opportunity Sharing Build Siebel Message. This workflow uses the opportunity ID to gather 
all the necessary information on the opportunity and put it into a Siebel message. Opportunity 
Sharing Build Siebel Message also collects the partner information and System A's organizational 
information, and adds it to the Siebel message. This Siebel message is passed back to 
Opportunity Sharing External Create, which transfers it to system B and waits for a response. 

■ Opportunity Sharing Siebel Create. System B receives the Siebel message and runs the 
Opportunity Sharing Siebel Create workflow. Opportunity Sharing Siebel Create first inserts the 
opportunity's account by calling PRM ANI Inbound Create Account, and then inserts the 
Opportunity's information. If successful, it creates a key that System B uses to reference the 
opportunity, updates the Transfer Status on system B to Transfer Successful, and stores System 
A's key. This workflow then adds System B’s key and the current transfer status to the Siebel 
message and sends the message back to System A. 

■ Opportunity Sharing Receive Create Response. After System A receives the response, it 
calls the Opportunity Sharing Receive Create Response. This workflow updates the status of the 
transfer based on the response. It also stores System B's key. 
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Workflows to Update an Opportunity
After an opportunity has been transferred, the brand owner or partner can click the Update 
Opportunity button to update the transferred opportunity in the other company’s system with new 
information that they have entered in their system. When the brand owner or partner does this, the 
following workflows are invoked in this order: 

■ Opportunity Sharing External Update. This workflow is called when the brand owner clicks 
the Update button on the Transfer Opportunity Child form. Opportunity Sharing External Update 
calls Opportunity Sharing Set Update Status. 

■ Opportunity Sharing Set Update Status. This workflow first calls Opportunity Sharing 
Inbound or Outbound. 

■ Opportunity Sharing Inbound or Outbound. This workflow figures out whether this 
opportunity was originally sent to System B from System A or was originally sent to System A 
by System B. (That is, it determines whether this opportunity was originally an outbound 
opportunity or an inbound opportunity.) It also retrieves System B's key and ID of the partner to 
whom the opportunity was sent, and passes this information back to Opportunity Sharing Set 
Update Status. Opportunity Sharing Set Update Status updates the Transfer Status to Update 
Pending. Then, this workflow calls Opportunity Sharing Build Siebel Message, passing the 
opportunity ID, System A and System B's keys, and the partner ID. (Depending on your setup, 
this workflow might not be necessary. A call to this workflow can be replaced with a Siebel 
operation that queries the ANI Keymap business component.)

■ Opportunity Sharing Create Siebel Message. This workflow creates a Siebel message and 
passes it back to Set Update Status, which passes the Siebel message back up to External 
Update. External Update transfers the Siebel message to System B.

■ Opportunity Sharing Siebel Update. System B receives the Siebel message and runs 
Opportunity Sharing Siebel Update, which checks to see if it needs to insert the opportunity's 
account again by calling PRM ANI Inbound Create Account. It then updates the Opportunity's 
information. If successful, this workflow updates the Transfer Status on system B to Update 
Successful, and then adds the current transfer status to the Siebel message, which it sends back 
to System A.

■ Opportunity Sharing Receive Update Response. After System A receives the response, it 
calls the Opportunity Sharing Receive Update Response workflow, which updates the status of 
the transfer based on the response.

Workflows to Receive an Opportunity Update
After an opportunity has been transferred, the brand owner or partner can click the Receive Update 
button to query the other company’s system for new information that has been entered about the 
opportunity, and to update the opportunity in its own system with this new information. When the 
brand owner or partner does this, the following workflows are invoked in this order: 
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■ Opportunity Sharing External Query. When the brand owner calls the Receive Update button 
on the Transfer Opportunity Child form, this workflow calls the Opportunity Sharing External 
Query workflow. External Query first uses the Opportunity Sharing Inbound or Outbound 
workflow to determine whether this was originally an inbound or an outbound opportunity, as 
described in “Workflows to Update an Opportunity” on page 60. Then, Opportunity Sharing 
External Query takes that information and creates a Siebel message with System A's and System 
B's keys. It then transfers this Siebel message to System B.

■ Opportunity Sharing Siebel Query. When System B receives the Siebel message, it runs the 
Opportunity Sharing Siebel Query workflow. Opportunity Sharing Siebel Query makes sure the 
opportunity exists and then calls Opportunity Sharing Set Update Status. 

■ Opportunity Sharing Set Update Status. This workflow first calls the Opportunity Inbound or 
Outbound workflow, which does the following:

■ Determines whether this was originally an outbound opportunity or an inbound opportunity, 
as described in “Workflows to Update an Opportunity” on page 60.

■ Retrieves System A's key and the partner ID of the employee to whom the opportunity was 
sent, and passes this information back to Opportunity Sharing Set Update Status.

Opportunity Sharing Set Update Status then updates the Transfer Status to Update Pending and 
calls the Opportunity Sharing Opportunity Build Siebel Message workflow to create a message 
containing the opportunity ID, System B and System A's keys, and the partner ID. After the 
Siebel message is passed back to Opportunity Sharing Set Update Status, this workflow passes 
the Siebel message back up to Opportunity Sharing External Update. Opportunity Sharing 
External Update transfers the Siebel message to System A.

■ Opportunity Sharing Siebel Update. After System A receives the response, it calls 
Opportunity Sharing Siebel Update. This workflow returns a Siebel message, which Opportunity 
Sharing External Query transfers back to System B. 

■ Opportunity Sharing Receive Update Response. System B receives the Siebel message and 
calls Receive Update Response, which will update the status of the transfer based on the 
response.

Update of the Status Field by These Workflows
The final step in these opportunity transfer processes updates the status field to tell the user whether 
the transfer, send update, or receive update process was successful. The Transfer Status field can 
have the following values: 

■ Blank. The opportunity has never been transferred to a partner. In this case, only the Transfer 
button is active. You cannot send or receive an update until after the opportunity has been 
transferred.

■ Transfer Pending. The opportunity has been transferred to a partner, but the acknowledgement 
from the partner has not yet been received. In this case, none of the transfer buttons is active.

■ Transfer Successful. The opportunity has been transferred to a partner, and the 
acknowledgement indicates that the transfer went through. In this case, only Send Update and 
Receive Update are active. Once an opportunity has been transferred successfully, it cannot be 
transferred again.
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■ Transfer Unsuccessful. The opportunity has been transferred to a partner, but the 
acknowledgement indicates that the transfer did not go through for one of these possible 
reasons:

■ The connection timed out

■ The opportunity already exists on the other system

■ The source organization is not listed as a partner in the other system

■ There was an exception with the insert step

In this case, the Transfer button is the only active one. The user can try again to transfer the 
opportunity to the same partner or a different one.

■ Update Pending. The send update or receive update process is underway, but no response has 
yet been received. In this case, none of the buttons is active.

■ Update Successful. The send update or receive update process completed successfully. In this 
case, the Send Update and Receive Update buttons are active.

■ Update Unsuccessful. The send update or receive updated process failed, based on the return 
message from the partner’s system, for one of these possible reasons:

■ The connection timed out

■ The opportunity does not exist on the other system

■ There was an exception with the update step

In this case, the Send Update and Receive Update buttons are active.
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Opportunity Sharing Build Siebel Message
The Opportunity Sharing Build Siebel Message workflow process is shown in Figure 3.

When this workflow is called, the following events happen:

■ Create Message Header. This event creates an empty message header that will be added to 
the Siebel message. This header will eventually contain the transfer information.

■ Store Message Header/Append Message. This event creates an empty Siebel message using 
the ANI Opportunity Message (PRM ANI) format and appends the message header to it.

■ Query Oppty. This event queries the database for the opportunity matching the object ID and 
returns the account ID for the account of this opportunity.

■ Store Oppty & Append Oppty. This event adds the opportunity to the Siebel message.

■ Oppty Has An Account. This event checks to see if the account ID is null. If it is, the workflow 
does not need to query for an account.

Figure 3. Opportunity Sharing Build Siebel Message Process
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■ Create Account Message. If there is no account for this opportunity, this event creates an 
empty account property set to follow the ANI Opportunity Message (PRM ANI) format for the 
Siebel message.

■ Query Account. If there is an account for this opportunity, this event returns the account 
information.

■ Store Oppty Account/Append Account. This event adds the account information to the Siebel 
message.

■ Query Partner/Store Partner/Append Partner. This event queries for the partner to whom 
the opportunity is being sent and appends that information to the Siebel message.

■ Query Source Org/Store Source Org/Append Source Org. This event queries for the source 
organization and appends that information to the Siebel message.

■ Get Organization DUNS/Set Organization DUNS. This event retrieves the source 
organization's D-U-N-S number and adds it to the Siebel message.

■ Add Internal Key. This event sdds the internal key to the Siebel message.

■ Add Internal Key Description. This event adds the internal key description to the Siebel 
message.

■ Add External Key. This event adds the external key to the Siebel message.

■ Add External Key Description. This event adds the external key description to the Siebel 
message.

■ Add Sent Time to Message. This event adds the current timestamp to the Siebel message.
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Opportunity Sharing External Create
This Opportunity Sharing External Create workflow process is shown in Figure 4.

When this workflow is called, the following events happen:

■ Create Source Key. This event generates an internal key from the process property internal key 
description. Currently, internal key description has a default value. This value can be changed 
manually or passed in from any workflow that calls this as a subprocess.

■ Query ANI Keymap. This event searches for a transfer record for this opportunity in ANI 
Keymap, the buscomp that stores all the transfer information. 

■ ANI Keymap Record Exist. This event checks to see if the number of transfer records for this 
opportunity is greater than zero—that is, whether a transfer record already exists for this 
opportunity.

■ Insert Value into Keymap. If a transfer record for this opportunity does not already exist, this 
event creates a new transfer record for this opportunity.

■ Update Value in Keymap. If a transfer record for this opportunity already exists, this event 
updates the transfer status to Transfer In Progress.

■ Create Siebel Message. This event calls the Opportunity Sharing Build Siebel message, passing 
in the internal key, internal key description, partner ID, and object ID, and returns a Siebel 
message.

Figure 4. Opportunity Sharing External Create Process
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

65



Setting Up Application Services Interfaces ■  ASI Workflows
■ Get Rid of Extra Message Layer. This event removes the extra layer that is added to a Siebel 
message when it is passed up from a subprocess.

■ Output Siebel Message. This event checks to see if the value of the process property Write Orig 
File is Y or N.

■ Find Port. This event finds the Web service port for the partner to whom the opportunity is being 
sent.

■ Transfer. This event sends the opportunity to the other system.

■ Update Status to Failed. If the transfer step returns an exception, this event updates the 
transfer status of the opportunity to Transfer Unsuccessful.

■ Write Response. This event checks to see if the value of the process property Write Response 
to File is Y or N.

■ Write Siebel Message. If Write Orig File is Y, this event writes the pretransfer Siebel message 
to an XML file. If Write Response to File is Y, this event writes the post-transfer Siebel message 
to an XML file.

■ Receive Create Response. This event calls the subprocess Oppty Sharing Receive Create 
Response, passing it the Siebel message received from the transfer.
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Opportunity Sharing External Query
The Opportunity Sharing External Query workflow process is shown in Figure 5.

When this workflow is called, the following events happen:

■ Get Dest Org Id. This event calls Opportunity Sharing Inbound or Outbound. This workflow 
returns the partner ID of the partner requesting an update, the external key, and external key 
description.

■ Set Status. This event updates the transfer status to Update Pending.

■ Create Message/Store Message/Append Message. This event creates an empty Siebel 
message.

■ Generate Key. This event creates the internal key.

■ Add Internal Key. This event adds the internal key to the Siebel message. 

■ Add Internal Key Description. This event adds the internal key description to the Siebel 
message.

■ Add External Key. This event adds the external key to the Siebel message. 

Figure 5. Opportunity Sharing External Query Process
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■ Add External Key Description. This event adds the external key description to the Siebel 
message.

■ Find Port. This event finds the Web service port for the partner.

■ Send Oppty Update Request. This event sends this Siebel message to the other system and 
returns the response from the other system.

■ Get Request Update Status. This event gets the transfer status from the response Siebel 
message.

■ Request Update Ok. This event checks that the transfer status is successful.

■ Update Opportunity. This event calls Opportunity Sharing Siebel Update as a subprocess, 
passing it the Siebel message, and returns the response Siebel message.

■ Remove Extra Message Layer. This event removes the extra layer that is added when a Siebel 
message is passed up from a subprocess.

■ Get Update Oppty Status. This event retrieves the status of the update from the Siebel 
message that Opportunity Sharing Siebel Update inserts before returning the message. 

■ Status Ok. This event checks to see if the update status is Update Successful. 

■ Swap Addresses. This event swaps the source organization and channel partner information, 
the internal key and external key, and the internal key description and the external key 
description.

■ Remove Extra Layer from Message. When a Siebel message is passed up from a subprocess 
it adds an extra layer to the message. This event removes that layer.

■ Add Method Name. This event inserts the name of this method, Query, into the Siebel message. 
This will be used in a later workflow.

■ Find Response Port. This event finds the Web service port for sending an update response for 
this partner.

■ Transfer Response. This event transfers the Siebel message with the update status back to the 
partner. 

■ Update Status. If any of the transfer statuses from the Siebel message are Update Unsuccessful 
or any of the transfers returns an exception, this event updates the transfer status to Update 
Unsuccessful. 
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Opportunity Sharing External Update
The Opportunity Sharing External Update workflow process is shown in Figure 6.

When this workflow is called, the following events happen:

■ Build Message. This event calls the subprocess Opportunity Sharing Set Update Status, passing 
in the opportunity ID, and returns the partner ID and a Siebel message.

■ Get Rid of Extra Siebel Message Layer. This event removes the extra layer that is added to 
a Siebel message when it is passed up from a subprocess.

■ Write Siebel Message. This event checks to see if the value of the process property Write Orig 
File is Y or N. 

■ Find Port. This event finds the Web service port for the partner.

■ Transfer. This event sends the opportunity to the other system and returns a response Siebel 
message.

■ Write Response to File. This event checks to see if value of the process property Write 
Response is Y or N. 

■ Receive Update Response. This event calls the subprocess Opportunity Sharing Receive 
Update Response, passing it the response Siebel message.

■ Write to File. If Write Orig File is Y, this event writes the pretransfer Siebel message to an XML 
file. If Write Response to File is Y, this event writes the post-transfer Siebel message to an XML 
file.

Figure 6. Opportunity Sharing External Update Process
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■ Set Status to Failed. If transfer returns an exception, this event updates the transfer status for 
this opportunity to Update Unsuccessful.

Opportunity Sharing Inbound or Outbound
The Opportunity Sharing Build Siebel Message workflow process is shown in Figure 7.

When this workflow is called, the following event happens:

■ Get Inbound Partner Id. This event queries the ANI Keymap bus comp and retrieves the initial 
direction, the partner ID, the external key, and the external key description of this opportunity. 

Opportunity Sharing Pick Partner
The Opportunity Sharing Pick Partner workflow process is shown in Figure 8. 

When this workflow is called, the following events happen:

■ Catch Partner Id. This event retrieves the Partner ID of the partner to whom the opportunity 
is sent, and stores it in a process property.

■ Send Opportunity. This event calls Oppty Sharing External Create, passing it the partner ID.

Figure 7. Opportunity Sharing Inbound or Outbound Process

Figure 8. Opportunity Sharing Pick Partner Process
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Opportunity Sharing Receive Create Response
The Opportunity Sharing Receive Create Response workflow process is shown in Figure 9. 

When this workflow is called, the following events happen:

■ Get External Key. This event finds the value of the external key in the Siebel message and 
returns it.

■ Get External Key Desc. This event finds the external key description in the Siebel message and 
returns it.

■ Get Internal Key. This event finds the value of the internal key in the Siebel message and 
returns it.

■ Get Internal Key Description. This event finds the value of the internal key description in the 
Siebel message and returns it.

■ Get Status. This event returns the transfer status from the Siebel message.

■ Get Status Message. This event returns the transfer status message from the Siebel message.

■ Get Last Update Time. This event retrieves the time when the Siebel message was created, 
which was added to the Siebel message when it was created. 

■ Insert Values into Keymap Bus Comp. This event adds the external key, external key 
description, status, and the timestamp to the keymap record.

Figure 9. Opportunity Sharing Receive Create Response Process
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Opportunity Sharing Receive Update Response
The Opportunity Sharing Receive Update Response workflow process is shown in Figure 10. 

When this workflow is called, the following events happen:

■ Get Method. This event returns the method value from the Siebel message. Both update and 
query use Opportunity Sharing Receive Update Response, and this method value tells the 
workflow whether this is a send update or receive update.

■ Query Response. This event checks to see if this is a response from an update or if this is a 
response from a query.

■ Get Internal Key/Get Internal Key Description/Parse Key/Query Opportunity. If this is 
a response from a query, this workflow is started from the inbound Web services, so there is no 
active object ID. The workflow needs to find the opportunity and retrieve the object ID. This 
group of steps returns the external key and the external key description and creates a search 
specification from them. Query Opportunity uses this search specification to find the opportunity 
and return its object ID. If this is a response from an update, the workflow is activated from the 
Opportunity Sharing External Update workflow and an object ID is passed in as an argument, so 
these steps are skipped.

■ Get Status. This event returns the transfer status from the Siebel message. 

■ Get Status Message. This event returns the transfer status message from the Siebel message.

■ Get Last Update Time. This event retrieves the time when the Siebel message was created, 
which was added to the Siebel message when it was created. 

■ Update Status and Time. This event updates the status and the timestamp to the keymap 
record.

Figure 10. Opportunity Sharing Receive Update Response Process
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Opportunity Sharing Set Update Status
The Opportunity Sharing Set Update Status workflow process is shown in Figure 11. 

When this workflow is called, the following events happen:

■ Get Dest Key. This event calls Opportunity Sharing Inbound or Outbound and returns the 
partner ID, external key, and external key description.

■ Generate Key. This event generates an internal key from the process property internal key 
description. Currently, internal key description has a default value. This value can be changed 
manually or passed in from any workflow that calls this as a subprocess.

■ Update Status. This event updates the transfer status to Update Pending. 

■ Create Siebel Message. This event calls Opportunity Sharing Build Siebel Message, passing in 
an object ID, partner ID, external key, external key description, internal key, and internal key 
description. It returns a Siebel message.

■ Get Rid of Extra Message Layer. This event gets rid of the extra layer that is added to a Siebel 
message when it is passed up from a subprocess.

Figure 11. Opportunity Sharing Set Update Status Process
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Opportunity Sharing Siebel Create
The Opportunity Sharing Siebel Create workflow process is shown in Figure 12. 

When this workflow is called, the following events happen:

■ Get Opportunity. This event retrieves the opportunity property set from the Siebel message.

■ Query Opportunity. Using the opportunity property set, this event searches for the opportunity 
in this database and returns the number of opportunities that match the search specification.

■ Oppty Exists. This event checks to see if the number of opportunities found by the query is 
greater than zero, to determine whether the opportunity already exists. 

■ Set Opportunity Error Status. If the opportunity already exists, this event sets the status 
process property to an error status and sets the status message process property to the 
appropriate error message.

■ Get External DUNS Number. If the opportunity does not exist, this event retrieves the source 
organization’s D-U-N-S number.

Figure 12. Opportunity Sharing Siebel Create Process
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■ DUNS Num Exists. This event checks to see if the previous step returns an empty D-U-N-S 
Number.

■ Set Partner DUNS Error Status. If the D-U-N-S number is empty, this event sets the status 
process property and sets the status message process property to the appropriate error 
message.

■ Retrieve Record Id. If the D-U-N-S Number has a value, this event uses that value to find the 
partner ID of the source organization.

■ Partner Exists. This event checks to see if the previous step returns an empty partner ID.

■ Set Partner Id Error Status. If the partner ID is empty, this event sets the status process 
property and set the status message process property to the appropriate error message.

■ Add Account. This event calls the PRM ANI Inbound Create Account Process, passing it the 
Siebel message, the name of the account integration object this process uses, and the account 
object hierarchy path. It returns an account status code and an account status message.

■ Account OK. This event checks to see if the account status code equals the general error code.

■ Set Account Error Status. If the account status code returned a general error, this event sets 
the status process property to an error status and sets the status message process property to 
the appropriate error message.

■ Upsert Opportunity. This event inserts the opportunity property set into the system.

■ Set Oppty Error Status. If the opportunity insert returns an exception, this event sets the 
status process property to an error status and sets the status message process property to the 
appropriate error message.

■ Get External Key. This event finds the value of the external key in the Siebel message and 
returns it.

■ Get External Desc. This event finds the external key description in the Siebel message and 
returns it.

■ Create Internal Key. This event generates an internal key from the process property internal 
key description. Currently, internal key description has a default value. This value can be changed 
manually or passed in from any workflow that calls this as a subprocess.

■ Swap Addresses. This event swaps the source organization and channel partner information, 
the internal key and external key, and the internal key description and the external key 
description.

■ Remove Extra Message Layer. When a Siebel message is passed up from a subprocess it adds 
an extra layer to the message. This event removes that layer.

■ Insert Values into Keymap Bus Comp. This event creates a new transfer record for this 
opportunity.

■ Set Status OK. This event sets the status process property to successful.

■ Add Status. This event adds the status to the Siebel message. This is done whether there has 
been a problem and the status is an error code or whether the status is okay.

■ Add Status Message. This event adds the status message to the Siebel message.
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

75



Setting Up Application Services Interfaces ■  ASI Workflows
Opportunity Sharing Siebel Query
The Opportunity Sharing Siebel Query workflow process is shown in Figure 13. 

When this workflow is called, the following events happen:

■ Get Internal Key. This event finds the value of the internal key in the Siebel message and 
returns it.

■ Get Internal Desc. This event finds the internal key description in the Siebel message and 
returns it.

■ Parse Key. This event takes in internal key and internal key description and creates a search 
specification.

■ Get Opportunity. This event searches for the opportunity using the search specification.

■ Opportunity Exists. This event checks to see if the number of opportunities found by the query 
is greater than zero to determine if the opportunity already exists.

■ Add Error Status. If the opportunity does not exist, this event sets the transfer status in the 
Siebel message to an error status.

■ Add Error Message. If the opportunity does not exist, this event sets the transfer status 
message in the Siebel message to an error status message.

■ Set Update Status and Create Siebel Message. This event calls Opportunity Sharing Set 
Update Status, passing it the opportunity ID.

■ Get Rid of Extra Message Layer. This event removes the extra layer that is added to a Siebel 
message when it is passed up from a subprocess.

Figure 13. Opportunity Sharing Siebel Query Process
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Opportunity Sharing Siebel Update
The Opportunity Sharing Siebel Update workflow process is shown in Figure 14. 

When this workflow is called, the following events happen:

■ Get Internal Key. This event finds the value of the internal key in the Siebel message and 
returns it.

■ Get Internal Key Description. This event finds the internal key description in the Siebel 
message and returns it.

■ Parse Key. This event takes in the internal key and internal key description and creates a search 
specification.

■ Find Opportunity. This event searches for the opportunity using the search specification.

■ Opportunity Exists. This event checks to see if the number of opportunities found by the query 
is greater than zero to determine if the opportunity already exists.

■ Set Opportunity Error Status. If the opportunity does not exist, this event sets the status 
process property to an error status and set the status message process property to the 
appropriate error message.

■ Get Opportunity. If the opportunity does exist, this event retrieves the opportunity property 
set from the Siebel message.

Figure 14. Opportunity Sharing Siebel Update Process
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■ Insert Account. This event calls PRM ANI Inbound Create Account Process, passing it the Siebel 
message, the name of the account integration object this process uses, and the Account Object 
Hierarchy Path. It returns an account status code and an account status message.

■ Account OK. This event checks to see if the account status code equals the general error code.

■ Set Account Error Status. If the account status code returned a general error, this event sets 
the status process property to an error status and sets the status message process property to 
the appropriate error message.

■ Upsert Opportunity. This event updates the opportunity.

■ Get External Key. This event retrieves the external key from the Siebel message.

■ Get External Key Description. This event retrieves the external key description from the Siebel 
message.

■ Swap Addresses. This event swaps the source organization and channel partner information, 
the internal key and external key, and the internal key description and the external key 
description.

■ Remove Extra Message Layer. When a Siebel message is passed up from a subprocess it adds 
an extra layer to the message. This event removes that layer.

■ Set Oppty Error Status. If the opportunity update returns an exception, this event sets the 
status process property to an error status and sets the status message process property to the 
appropriate error message.

■ Update Status. This event updates the transfer status and the timestamp for this transfer 
record.

■ Set OK Status. This event sets the status process property to successful.

■ Add Status. This event adds the status to the Siebel message. This is done whether there has 
been a problem and the status is an error code or whether the status is okay.

■ Add Status Message. This event adds the status message to the Siebel message.

PRM ANI Inbound Create Account Process
The PRM ANI Inbound Create Account workflow process is used by both opportunity transfer and 
shopping cart transfer. This process is described in “PRM ANI Inbound Create Account Process” on 
page 87. 

PRM ANI Inbound Addressing Change Process
The PRM ANI Inbound Addressing Change workflow process is used by both opportunity transfer and 
shopping cart transfer. This process is described in “PRM ANI Inbound Addressing Change Process” on 
page 90. 

Shopping Cart Transfer Workflows
The workflow processes described in this section are associated with shopping cart transfers. 
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These processes are used for the following functions:

■ Outbound transfer

■ Inbound transfer

They transfer as much data as is needed for the receiving system to be able to process the shopping 
cart. This includes sending information on the account and contact that serve as customers to the 
shopping cart, as well as the quote, any of the extended attributes of products in the shopping cart, 
and information about the source and destination organizations. 

Workflows for Outbound Shopping Cart Transfer
Outbound shopping cart transfer uses the following processes: 

■ Transfer Cart Outbound Initial. This process manages the general process flow, from the 
selection of the destination organization to the acknowledgment processing. 

■ Transfer Cart Outbound Request. This process controls the creation of the shopping cart data 
structure. Most of the work is done in the subprocesses; everything is pieced together here.

■ Transfer Cart Outbound Create Header Process. This process gathers and sets data needed 
for the message header and creates the message header. 

■ Transfer Cart Outbound Create and Append Process. This process is used in many places 
as a utility workflow process that creates the child hierarchy and appends the child instance to 
the parent object. 

■ Transfer Cart Outbound Receive Acknowledgment Process. This process handles the 
response generated by the external system.

Many of these workflows have steps with names similar to Rename Child Object and Remove 
Message Layer. These steps deal with formatting the data structures correctly as they are passed up 
from subprocesses, and they are not associated with any business logic. 

Workflows for Inbound Shopping Cart Transfer
Inbound shopping cart transfer uses the following processes: 

■ Transfer Cart Inbound Receive. This process handles the initial processing of the data. 

■ Transfer Cart Inbound Create Cart. This process handles the task of coordinating calls to the 
other subprocesses. If an error occurs with either the customer contact or an account, it uses 
user-configurable business logic to determine what happens next.

■ PRM ANI Inbound Create Account. This process inserts an account record if the data is 
present and viable. It returns an error if the data is not viable and skips the insert steps if the 
data is not present, assuming that the customer has only contact information and no account.

■ Transfer Cart Inbound Create Contact. This process creates the customer contact information 
if the data is present and viable. It returns an error if the data is not viable and assumes the 
contact is anonymous if the data is not present. 

■ Transfer Cart Inbound Create Quote. This process creates the quote (persistent shopping 
cart) after checking the data for integrity.
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■ PRM ANI Inbound Addressing Change. This process swaps the source organization and 
destination channel partner information.

Error handling is used to catch problems and report them to the external (requesting) system. 
Generally, if an error is found, the process will stop and pass the error messages up to the calling 
process. The calling process then passes the error back to its calling process.When it reaches the top 
process, it returns an error saying that the transfer was unsuccessful. 

Transfer Cart Outbound Initial Process
The Transfer Cart Outbound Initial Process workflow process is shown in Figure 15. 

When this workflow is called, the following events happen:

■ The first event checks for the availability of the items the customer wants to purchase.

■ The next event finds the communication information associated with the partner and runs the 
Transfer Cart Outbound Request Process subprocess to create the shopping cart data structure.

■ The next event checks to see if the brand owner is in debug mode (controlled by the Debug Flag 
in the Process Properties). If so, the brand owner needs to dump the data into a file and read in 
a suitable response from a file.

■ Most of the time the Debug Flag is set to false, and allows use of the Web Services instead. In 
this case, the RPC call is made and a response is received when Web services is complete.

■ The Response is processed by Transfer Cart Outbound Receive Acknowledgement Process (either 
success or failure) as the final event in this process.

Figure 15. Transfer Cart Outbound Initial Process 
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Transfer Cart Outbound Request Process
The Transfer Cart Outbound Request Process workflow process is shown in Figure 16.

When this workflow is called, the following events happen:

■ The first event creates the message header with information about the message itself including 
timestamps, and so on.

■ The next event adds the shopping cart data (Quote, Quote Item, and so on) to the shopping cart 
data structure.

■ The process then includes information about the source organization sending the data.

■ Then, the process appends information about the destination partner to this message.

■ Finally, the process adds the customer information, including account and customer data.

Figure 16. Transfer Cart Outbound Request Process
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Transfer Cart Outbound Create Header Process
The Transfer Cart Outbound Create Header Process workflow process is shown in Figure 17.

When this workflow is called, the following events happen:

■ The early events gather and set data used in the message header as follows:

■ They set all of the key information first, including the internal key and key description. The 
external system uses this to reference a record in the Siebel database.

■ They also set the timestamps and status messages.

■ The later events instantiate the header instance by creating an empty data structure based on 
the metadata provided by the integration object definition in Siebel Tools. They append all the 
data to the empty data structure.

Figure 17. Transfer Cart Outbound Create Header Process
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Transfer Cart Outbound Create and Append Process
The Transfer Cart Outbound Create and Append Process workflow process is shown in Figure 18. 

When this workflow is called, the following events happen in this order:

■ The workflow creates the child hierarchy. If no business component reference is provided (empty 
Customer Account Data, for instance), it instantiates an empty instance of the child.

■ The workflow appends the child instance to the parent object (usually this is the shopping cart 
object). If a flag is set, it can create an empty parent and append this child to it.

Figure 18. Transfer Cart Outbound Create and Append Process
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Transfer Cart Outbound Receive Acknowledgment Process
The Transfer Cart Outbound Receive Acknowledgment Process workflow process is shown in 
Figure 19. 

When this workflow is called, the following events happen in this order:

■ The workflow gets the status of the message that has been received and looks for the partner it 
was received from.

■ The workflow looks for an existing Keymap record that indicates whether to update it or create 
a new record. The Keymap data includes a record of the transferred information, including the 
time of the last transfer and the key used to reference the shopping cart's counterpart in the 
external system.

■ If there is no error, the workflow creates or updates the keymap record and retrieves the URL 
information. Then, it renders the redirection view with the URL it has retrieved, using Virtual 
Fields.

■ If there is an error, the workflow presents the customer with an option view that allows him or 
her to decide whether to choose another partner or cancel the transaction.

Figure 19. Transfer Cart Outbound Receive Acknowledgement Process
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Transfer Cart Inbound Receive Process
The Transfer Cart Inbound Receive Process workflow process is shown in Figure 20. 

When this workflow is called, the following events happen in this order:

■ The workflow makes sure that the sender is someone that is authorized to send requests.

■ The workflow checks that the external system's key is present, and that the brand owner is the 
intended recipient.

■ The workflow gets the key description and runs the Transfer Cart Inbound Create Cart Process.

■ If an error is generated, the workflow reports it to the calling system and finishes the process. 
No Keymap record is created because the quote may not have been created.

Figure 20. Transfer Cart Inbound Receive Process
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■ If no error is generated (OK status), the workflow does the following: 

■ Updates the keys’ statuses in the shopping cart message. 

■ Creates the Keymap record.

■ Generates the URL needed to send to the calling system, so it can redirect the user to this 
system, with this shopping cart.

■ Sets the timestamps and sends the message back to the caller. 

Transfer Cart Inbound Create Cart Process
The Transfer Cart Inbound Create Cart Process workflow process is shown in Figure 21. 

When this workflow is called, it performs the following events in this order:

■ Checks for the quote 

■ Inserts the customer account information

■ Inserts the customer contact information

■ Inserts the quote information and links it to the customer information 

Figure 21. Transfer Cart Inbound Create Cart Process
Siebel Partner Relationship Management Administration Guide Version 7.8, 
Rev. A

86 



Setting Up Application Services Interfaces ■  ASI Workflows
PRM ANI Inbound Create Account Process
The PRM ANI Inbound Create Account Process is shown in Figure 22. 

When this workflow is called, it performs the following events in this order:

■ Checks to see if the Account Name and D-U-N-S number are viable

■ Looks in the database for an account with the same D-U-N-S number. This number is the Siebel 
method of uniquely identifying an account or partner.

■ If the account is found, reports the record’s ID 

■ If the account is not found, creates a new account

Figure 22. PRM ANI Inbound Create Account Process
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Transfer Cart Inbound Create Contact Process
The Transfer Cart Inbound Create Contact Process workflow process is shown in Figure 23. 

When this workflow is called, it performs the following events in this order:

■ Checks for the presence and viability of data

■ If data is not present, it assumes that the contact is anonymous

■ If the data is not viable, it returns an error

■ Creates a user key for the contact similar to the user key acceptable for most credit card 
transactions, which is the combination of first name, last name, street address, city, state, and 
postal code 

■ Extracts customer information from the data structure, and then uses the key to query for the 
contact

■ If a duplicate is found, it is reported 

■ If a duplicate is not found, it attempts to insert the contact into the contact table

Figure 23. Transfer Cart Inbound Create Contact Process
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Transfer Cart Inbound Create Quote Process
The Transfer Cart Inbound Create Quote Process workflow process is shown in Figure 24. 

When this workflow is called, the following events happen:

■ The unique identifier for the quote is the Destination Key. The key is provided by the source 
system to reference objects on the external system. If this is the first request for a transfer of 
this cart, the value of the key should be empty. Then, the workflow creates the cart and 
generates a new key for the Quote record.

■ If this cart has been transferred before, then the key contains data that is used to locate the 
existing cart on the destination system. The workflow updates this cart data. 

■ Finally, the quote is attached to the correct Contact and Account Records (the customer data).

Figure 24. Transfer Cart Inbound Create Quote Process
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PRM ANI Inbound Addressing Change Process 
The PRM ANI Inbound Addressing Change Process is shown in Figure 25. 

When this workflow is called, the following events happen:

■ The first events take the information about the system keys, internal and external, and use it to 
judge whether to swap the source organization and destination channel partner information in 
the message.

■ If the key manipulation is handled elsewhere, the remaining steps are ignored. 

■ If the key manipulation is not handled elsewhere, the next events swap the source organization 
and destination channel partner data as follows: 

■ Because the fields (including the addresses) are the same, the names of the components are 
altered—for example, Channel Partner Address becomes Organization Address. No data is 
actually moved.

■ The hierarchy component names are kept in process properties to allow for greater flexibility. 
If an integration component is renamed, a small change in the process properties is all that 
is needed.

Business Services Used by ASIs
A set of business services named PRM ANI Utility Services have been created to support both 
opportunity transfers and shopping cart transfers. 

Figure 25. PRM ANI Inbound Addressing Change Process
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Most of these service methods deal with the manipulation of integration objects, and rely on the 
Siebel Adapter Service on the internal side. Whenever possible, follow usage examples from the 
workflows provided.

You can use the PRM ANI Utility Services in situations where there is only one instance of a 
component type in the hierarchy path. So if there are multiple instances of a contact under the 
opportunity, you cannot get the Contact element from the integration object because each hierarchy 
path provided (Account.Contact in this case) must be unique. If this constraint must be violated, then 
refer to each instance with a separate Integration Component Name. For example, if Person had the 
same type of data as Contact, then use a reference to Account.Person to store another contact.

Conventions for Hierarchy Paths
The following convention is used for hierarchy paths in a number of service methods:

Hierarchy paths are inputs of the form IC1.IC2.IC3…, where IC1, IC2, IC3, and so on, are Integration 
Component Names that tell the method how to traverse the object definition to find the right place 
to put the child. For example, when placing a business address under the account under the 
opportunity object, the path would read Opportunity.Account.

For the Set Child Type method, a slightly different methodology in the hierarchy path is used, as 
follows:

In the case of Set Child Type, refer to IC1, IC2, IC3, and so on as the actual structure of the Siebel 
hierarchy. The examples listed come from the ANI Shopping Cart Message (PRM ANI) Integration 
object.

The first three substrings will appear as follows: 
ChildObject.ListOfMessageType.RootComponentName. An example is:

SiebelMessage.ListOfANI Shopping Cart Message (PRM ANI).Message Details

The following substrings will alternate between ListOf Component Names and the Component Names 
themselves. An example is:

ListOfChannel Partner.Channel Partner.ListOfChannel Partner Business Address.Channel 
Partner Business Address

Append Hierarchy
This method appends a child integration object to a parent integration object. The parent object must 
contain the child object’s full definition.

See the notesabout calls to the Load Child Hierarchy method. There is a dependency in calls to 
Append Hierarchy on calls to Load Child Hierarchy, so the Load Child Hierarchy method must be called 
before calling this method.

The following are inputs for Append Hierarchy:

■ Hierarchy Path - String. This is used to denote where to append the child to the parent.

■ SiebelMessage - Hierarchy. This is used to store the parent hierarchy’s integration object data.

Append Hierarchy has only one output:
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■ SiebelMessage - Hierarchy. This is the resulting object instance with the child attached to the 
parent in the correct place on the data structure.

Example: Transfer Cart Outbound Create Header Process, Append Header to Message

Create Empty Hierarchy
This method creates an empty integration object instance with the same structure as a normal 
integration object but with two notes. All data fields are present and empty (initialized to empty 
string). 

Each component in the definition of the integration object is instantiated once only in the exact 
structure that is prescribed by the definition.

The following are inputs for Create Empty Hierarchy:

■ Hierarchy Name - String. This provides the name of the integration object to instantiate.

■ Message Id - String. (Optional) This provides the Message ID that is used to identify this 
specific integration object instance. If this is not provided, a new one will be calculated.

Create Empty Hierarchy has only one output:

■ SiebelMessage - Hierarchy. This returns the integration object instance with the empty 
Component fields.

Example: Transfer Cart Outbound Create Header Process, Create Header Instance

Generate Key
This method returns a string that you can use to uniquely identify a record in the service's business 
component. In the case of Workflow Processes, this refers to the primary business component of the 
processes’ business object.

Generate Key has only one input:

■ Key Description - String. This is used to describe the form of the string to be generated. 

This input is in the form [A].[B].[C]… where A, B, C… are names of fields that should correspond 
to a unique key in your database.

For instance, when using Contact, [Last Name].[First Name] would generate an insufficient 
value. However, [Id].[Last Name] would work because [Id] itself is guaranteed unique in this 
system.

Generate Key has only one output:

■ Source Key - String. This is used to identify the record in the service's business component.

Example: Transfer Cart Inbound Create Cart Process, Create New Quote Key

Get Child Type
This method reports the child type of a property set. For integration objects, this is generally of type 
SiebelMessage.
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Get Child Type has only one input:

■ SiebelMessage - Hierarchy. These are hierarchy children that should be examined. 

Get Child Type has only one output:

■ Child XX - String. (Optional) The outputs will have names numbering from 0 to n-1 where n is 
the number of children in the input Siebel Message.

For example, if there are two children, the output property names will be Child 0 and Child 1. 
The output values are the names of the Child Types.

Get Hierarchy Value
This method returns a string field value in the integration object structure.

The following are inputs for Get Hierarchy Value:

■ Hierarchy Path - String. This is the path to the IC parent of the field. Note that this path does 
not include the field name.

■ Property Name - String. This is the name of the field to read.

■ Siebel Message - Hierarchy. This is the integration object you are looking into.

■ ReturnBlankIfNull - String. (Optional) This allows the returned value to be blank, instead of 
returning an error if the field is not found in the hierarchy.

Get Hierarchy Value has only one output:

■ Property Value - String. This is the value of the field the brand owner is examining.

Example: Transfer Cart Inbound Create Contact Process, Get Contact Street Address

Get System Preference
This method looks up values in the system preferences.

Get System Preference has only one input:

■ System Preference Name - String. The name of the system preference to look for.

Get System Preference has only one output:

■ System Preference Value - String. The value of the system preference.

Example: Transfer Cart Outbound Request Process, Get Organization DUNS

Isolate Integration ID
This method strips an integration object instance of everything except for the Integration ID, 
including child components.

This method is not called by PRM ASIs, but is referenced by other ASIs. It is used to direct Siebel 
Adapter Operations to consider only the Integration ID to look for a record in some cases.

Isolate Integration ID has only one input:
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■ Siebel Message - Hierarchy. This contains the object to be stripped through.

Isolate Integration ID has only one output:

■ Siebel Message - Hierarchy. This is the object that will be returned. The only field that will 
contain any data is the Integration Id.

Load Child Hierarchy
This method places a child hierarchy in memory to be used at a later time. It is used for operations 
that require two hierarchy type operands, such as Append Property Set.

Load Child Hierarchy has only one input:

■ Siebel Message - Hierarchy. This is the message you want to load that will be operated upon 
later.

There are no outputs.

Example: Transfer Cart Outbound Create and Append Process, Set the Child Hierarchy

Parse Key
This method generates a search specification from a given key and key description. The search 
specification can be fed into a query step (Siebel operation or otherwise) to look for the record that 
the key has specified.

The following are inputs for Parse Key:

■ Key Description - String. This is a description of the key following the format described in 
“Generate Key” on page 92.

■ Source Key - String. Along with the description, this defines the record you want to view. 

Parse Key has only one output:

■ Search Spec - String. This is the search specification used to execute the primary business 
component. Only one record should be in this record set because it is unique.

Example: Transfer Cart Inbound Create Quote Process, Parse Quote Key

Query Business Component
This method provides a way to query any business component in the business object. This gives you 
a bit more flexibility than the standard Siebel operation query, because you can search the entire 
business component without regard to the links to the primary business component.

If both Search Spec and Query fields are provided, the Search Spec is chosen over the Query field 
arguments to execute the business component with. If neither is provided, then an error is returned.

The following are inputs for Query Business Component:

■ Business Component - String. This is the name of the business component in the business 
object to query through.
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■ Keep Context - String. (Optional, defaults to Yes) This is a string defining whether to query 
with regard to the current state of the business object or if to instantiate a new business object 
to query with (outside of context). 

■ Output Field - String. (Optional) These are the values you want to have returned from the 
record. A number can be appended to the name so that more than one field can be retrieved. 

For instance, if you wanted a Name and Location, there would be the arguments Output Field 1 
and Output Field 2 with Name and Location as their values. If there is more than one record with 
the search specification, you obtain values from the first record in the executed business 
component.

■ Query Field - String. (Optional) These are the input values determining the search specification 
that is used on the business component.

To use this argument correctly, you must append the name of the field to the argument name. 
The value of the field can be any Workflow Process-evaluated string. For instance, if you are 
looking for a record where [Account Id] = Process Property [Siebel Operation Object Id], you 
would have: 

■ Argument Name: Query Field Account Id

■ Type: Process Property

■ Process Property: Siebel Operation Object Id

■ Search Spec - String. (Optional) If the search specification is more easily formulated as a 
string, then you can choose to provide it here. The string can have the same format as any other 
search specification in Siebel Tools; also, you can also choose to have a Workflow Process-
evaluated string as a possible input.

The following are outputs for Query Business Component:

■ Record Count - String. This returns a string representation of the number of records found in 
the query, up to 100. If there are more than 100 records, it returns the value -1, indicating that 
there are too many records in the query.

■ Output Fields - String. These are fields that are returned in the query with the property name 
equal to the field name.

In the example above, the two output arguments are named Name and Location. Their values 
would be those of the first record returned by the query.

Example: PRM ANI Inbound Create Account Process, Find Account

Detach Hierarchy
This method is a complementary function to Append Hierarchy. It takes the specified integration 
object and extracts it from the parent object.

The following are inputs for Detach Hierarchy:

■ Child Hierarchy Name - String. This is the name of the child hierarchy to instantiate from the 
parent data.

■ Hierarchy Path - String. This specifies the path to trace to find the child root integration 
component. 
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■ Siebel Message - Hierarchy. This specifies the parent from which the child object will be 
extracted.

Detach Hierarchy has only one output:

■ SiebelMessage - Hierarchy. The Child Object Instance defined by The Child Hierarchy Name, 
with data contributed from the input Siebel Message.

Example: PRM ANI Inbound Create Account Process, Get Account Object

Set Child Type
This method is a complementary function to Get Child Type. It sets the hierarchy type if you need to 
change something to the type Siebel Message.

The following inputs are for Set Child Type: 

■ Siebel Message - Hierarchy. This is the object whose children are changing type.

■ Child Type - String. (Optional) This lists the current child types, their values, and the values to 
which you want to change them. For instance, if a user wanted to change a child of type Account 
to a child of type Partner, the user would need to specify the following:

■ Argument Name: Child Type: Account

■ Argument Value: Partner

■ Hierarchy Path - String. (Optional). This tells the method where to do its work. For more 
information about the structure of this string, see “Conventions for Hierarchy Paths” on page 91.

Set Child Type has only one output:

■ Siebel Message - Hierarchy. This is the existing object with the child type changed.

Example: Transfer Cart Outbound Request Process, Rename Root Object 1

Set Hierarchy Value
This method is a complementary function to Get Hierarchy Value. It sets the value of a property in 
an object.

The following are inputs for Set Hierarchy Value:

■ Hierarchy Path - String. This specifies the integration component path to the field.

■ Property Name - String. This is the name of the property you want to set. 

■ Property Value - String. This is the value for which you want to set the property.

■ Siebel Message - Hierarchy. This is the object that you want to have this new field.

If there is a problem with the path (a component in the path cannot be found), an error is 
returned.

Set Hierarchy Value has only one output: 

■ Siebel Message - Hierarchy. This is the object with the hierarchy value set correctly.

Example: Transfer Cart Outbound Create Header Process, Set Message Time Stamp
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5 Working with New Partners
This chapter contains the following topics:

■ “About Partner Registration and Enrollment” on page 99

■ “The Siebel PRM Portal Home Page” on page 100

■ “Providing Information for Public Users” on page 100

■ “Applying for User IDs” on page 101

■ “Enrolling New Partner Companies” on page 106

■ “Delegated Administration” on page 122

About Partner Registration and 
Enrollment
Siebel PRM enables new partner recruitment by allowing public users to view the Siebel PRM Portal 
Web site and to register as either individuals or companies. If a prospective partner registers as a 
company, the brand owner can decide whether to form a partnership with that company. 

There are three levels of access to the Siebel PRM Portal:

■ Public Users (also called Anonymous Users). Any user can view the Siebel PRM Portal home 
page without registering or providing any information. Public users can read company news and 
find out about the partner programs that are available. They can also view product offers that 
are available to the general public (not just to partners), and view literature in the Info Center. 
The public user home page also includes a login area for registered partners and a link to the 
registration page for visitors who want to register as partners. 

■ Individual Partners (also called Self-Registered Users). Users who register as individual 
partners may be consultants who want to get detailed information about your products to 
recommend them to clients. After providing information about themselves, users are 
automatically enrolled as individual partners. They can then use the Siebel PRM Portal to 
purchase products for themselves, participate in auctions, browse and sign up for training 
courses, view literature, view special offers, and view partner alerts. They cannot share 
opportunities, service requests, activities, or any other transactional or service data through the 
Siebel PRM Portal. 

■ Company Partners (also called Registered Users). Companies that want to work in an active 
partnership with your company register in your company's partner program. They use the Siebel 
PRM Portal to provide detailed information about their companies. Your partner manager 
evaluates this information, decides how your company can work with their company, and decides 
whether to approve them as partners. Before they are approved as partners, they can view the 
same information as individual partners. After they are approved as partners, they can view and 
share opportunities, service requests, and other transactional data with your company. 
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You can also add companies as partners that you have recruited in other ways, in addition to those 
that have applied through the Web site. 

The Siebel PRM Portal Home Page
Siebel PRM uses one home page for public, individual and registered users. Views on the home page 
are hidden or displayed based on the user’s login to personalize the home page for each different 
type of user. 

When you create your home page, you must control which views and content are displayed to 
different types of users.

Personalization rules control whether views are hidden or displayed. Personalization is based either 
on global variables or on profile attributes, depending on whether the user is anonymous, self-
registered or registered. For example, personalization uses a global variable to determine whether 
the user is anonymous. 

Other personalization rules use profile attributes to determine whether the user has a position or 
not. For example, the Partner Alerts Center view on the home page will only appear if the user is not 
anonymous—that is, if the user has registered as an individual or company. The Program Information 
view appears if the user is anonymous. 

Other personalization rules used in the salutation can be based on many other profile attributes, such 
as the user’s organization or geography.

For more information about personalization, see Siebel Personalization Administration Guide.

Providing Information for Public Users
When public users come to the Siebel PRM Web site, they see the home page as personalized for 
public users. In addition to letting registered users log in, this page includes links to information 
about your partner programs that prospective partners can read without logging in. 

You can customize and personalize this home page and the linked pages.

You can give public users visibility to master data, such as literature, FAQs, and product offers. You 
cannot give them visibility to transactional data, such as opportunities, service requests, or 
activities. 

In the seed data distributed with Siebel PRM, public users have the Unregistered Partner Agent 
responsibility, and you can control what views they can see by adding or subtracting views to this 
responsibility. 

You can set up catalogs for public users in the same way you would for partners. Catalogs that are 
visible to public users will also be visible to self-registered users. Only Partner Catalogs appear on 
the Siebel PRM Portal; these are catalogs with the value Partner in the Type field. 

For more information about responsibilities, see Security Guide for Siebel Business Applications. 

For more information about setting up catalogs, see the section “Assigning Master Data to the Partner 
Company” on page 112. 
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For more information about customizing Siebel PRM, see Using Siebel Tools and Siebel 
Personalization Administration Guide. 

Applying for User IDs
Any user who wants to register for a user ID must be a company or an employee of a partner 
company only; individual users cannot apply for a user ID.

Eligible users can apply for partnership by clicking on one of these links:

■ “Registering for a User ID (Employee)” on page 102

■ “Applying for Partnership (Company)” on page 102

Partner Company Identifier
The final step in enrolling a new partner company is to set up a partner company identifier. A 
company identifier should be a unique, alphanumeric code such as the Row #of the partner record. 

When a user clicks the Register for a User Id (for employees of existing partner companies only) link 
on the Siebel PRM Portal, the user is immediately prompted for the company identifier. The user 
cannot proceed without entering the company identifier.

The user’s application appears in the Partner User Applications screen in Siebel PRM Manager.  On 
that screen, the brand owner can view that application and click the Qualify button, which adds the 
partner to the User Assignments list view on the Administration - Partner screen > Registered 
Partners view. 

Use the following procedure to set up a company identifier.

To set up a company identifier (brand owner)

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view.

2 Drill down on the company record and then click the More Info tab.

3 In the Company Identifier field, enter a unique alphanumeric code, such as Row #, if necessary.

■ To get the Row #, on the menu bar, click Help > About Record.

NOTE: When a new partner record is created, the company identifier defaults to the number 
converted from the <row id>, which you can overwrite. This unique identifier is validated across 
all partners behindand you can turn off this check by changing the user property Check Company 
Identifier Duplicates on BC Channel Partner to N.

On the PRM Portal, a registered user for that partner can find the company identifier and share it 
with other users who want to apply from that company.

Use the following procedure to find a company identifier.
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To find the company identifier (partner)

1 Navigate to the Site Map > User Profile screen > Company Profile view.

2 View the alphanumeric code in the Company Identifier field.

After the application has been submitted, the brand owner can qualify it in the Partner User 
Application view.

Use the following procedure to qualify a user.

To qualify a user’s application (brand owner)

1 Navigate to the Site Map > Administration - Partner screen > Partner User Application view and 
select a partner user application record.

New records will have Pending Qualification in the Status field.

2 Click Qualify.

The user record appears in the Registered Partner screen > User Assignments tab.

You should now add responsibilities and a position to the user as described in “Adding User 
Assignments at the Partner Company” on page 114.

Registering for a User ID (Employee)
Use the following procedure to register for a user ID as an employee of an existing partner company.

To register as an employee of an existing partner company (partner)

1 On the Siebel PRM Portal home page, click the Register for a User ID (for employees of existing 
partner companies only) link.

2 Type in the your company identifier code in the Company Identifier field.

If you do not know the company identifier, you can look it up. For more information, see “Partner 
Company Identifier.”

3 Type in your personal information in the fields in the Personal Information form, and type in your 
contact information in the fields in the Contact Information form.

4 Read the Terms and Conditions page and click I Agree.

A Thank You message appears and you are registered.

Applying for Partnership (Company)
A company that wants to be a partner must register online on the Siebel PRM Portal.

Use the following procedure to apply for a partnership for your company.
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To apply for partnership for your company (partner)

1 On the Siebel PRM Portal home page, click on the Apply for Partnership (for your company) link.

2 Complete the Partnership Application form.

Click Next at the bottom of each page to continue.

3 Read the Terms and Conditions page and click I Agree, and then click Finish to complete the 
registration process.

A Thank You message appears and you are registered.

Configuring the Individual Partner Homepage
When people who are registered as individual partners log into Siebel PRM, they view the individual 
partner home page. 

This page uses Siebel Personalization to greet individual partners by name, and it includes links to 
information such as products available to individual partners. You can customize this home page.

Controlling Individual Partners’ Access to Data
Three factors determine what individual partners see when they use Siebel PRM: 

■ Access Group. You give your partners visibility to master data by associating this data with 
access groups. 

■ Responsibility. In Siebel applications, the screens and views that users can see are determined 
by their responsibility. Siebel PRM has one responsibility for individual partners, which is called 
Self-Registered Partner Agent. Individual partners can see screens and views assigned to this 
responsibility.

■ Personalization. In Siebel applications, the views that users see and the data they see can be 
controlled using personalization, which determines what is visible to users based on global 
variables (such as the global variable that determines whether the user is anonymous) and based 
on many profile attributes, such as the user’s organization, age, or geography. 

To control individual partners’ access to data, you should go through the following process:

■ Assign other master data to individual partners.

■ Optionally, control the screens and views individual partners can see. 

NOTE: Organization is not used to limit data that individual partners can see, because organizations 
are used primarily for transactional data, and individual partners do not have access to transactional 
data. Individual partners are entered as contacts in the brand owner company’s default organization. 

Assigning Master Data to Individual Partners
Siebel applications work with two types of data:
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■ Master (or Referential) Data. This is data that users can only read, such as sales literature 
and service solutions. It is usually assigned to groups of users through access groups.

■ Transactional Data. This is data that users can create, read, edit, and delete, such as 
opportunities, accounts, contacts, and service requests. It can be assigned to individuals, to 
groups of individuals (such as a sales team), or to organizations. You cannot share transactional 
data with individual partners, only with partner companies.

Individual partners cannot view transactional data, but you can allow them to view master data. It 
may be useful for individual partners to view master data such as price lists and literature they use 
when working with your products, data sheets and information on best practices for system 
integrators, product offers that you sell to partners and to the general public, and other types of 
master data, such as FAQs and solutions. 

Public catalogs are visible to self-registered partners out of the box, if the catalog’s Type field has 
the value Partner. 

To use access control to make other master data visible to individual partners, add the individual 
partners to user lists, add these user lists to access groups, and associate the access groups with 
the appropriate categories. These can be categories that are also associated with partner companies, 
or they can be categories you create specifically for individual partners. 

For more information about assigning data to organizations and categories, see Security Guide for 
Siebel Business Applications. 

For more information on creating and assigning product offers, see Siebel Marketing User Guide.

For more information on creating and assigning literature and other master data, see Applications 
Administration Guide.

NOTE: The following procedure shows how to assign literature to individual partners. Assign other 
types of master data in the same way, but use the other view tabs under the category, instead of the 
literature view tab. 

To associate literature with a category (brandowner)

1 Navigate to the Administration - Catalog screen and click the appropriate catalog.

A Categories list appears that shows the categories in that catalog. 

2 Select the appropriate Category. 

3 Click the Literature view tab, click the menu button, and then click New Record.

The Add Literature dialog box appears. 

4 If necessary, use a query to find the literature you are looking for. 

5 Select literature that you want to associate with the category, and click OK. 

The literature is associated with the category and is visible to individual partners. 

Controlling the Screens Visible to Individual Partners
By default, individual partners can see selected views in these screens: 
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■ Home 

■ User Profile 

■ Infocenter

■ Offers 

■ Partner Locator 

■ Partner Alerts

■ Search 

■ Self-Service 

■ Auctions Lister Area 

■ Sales Catalog, Shopping Cart, Orders, and Saved Quotes 

■ Training 

In the seed data, the responsibility for individual partners is Self-Registered Partner Agent. You can 
see the views available to individual partners by showing the views that are associated with this 
responsibility. You can also make views in other screens visible to individual partners by associating 
them with this responsibility. 

If you want to add a new responsibility or add new views to an existing responsibility, talk to your 
system administrator. 

For more information about responsibilities, see Security Guide for Siebel Business Applications. 

NOTE: Do not give the Self-Registered Partner Agent responsibility visibility to views in screens such 
as Opportunities, Service Requests, Activities, or other screens that let you share transactional data 
with partners. Only partner companies should be able to view these screens. 

Thanking Individual Partners for Registering
The sample data distributed with Siebel PRM uses workflows to automatically send email when new 
individual partners register to thank them for registering. This email works like a mail-merge letter; 
it is based on a form-letter template, and it is personalized using information that the partners filled 
out when they registered.

You should modify the form letter template included in the sample data to use your own company 
name. You may also want to modify it in other ways. 

To modify the email template you must modify the workflow process. Ask your system administrator 
for details.

The name of the workflow is Prospect Registration eChannel. 
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Enrolling New Partner Companies
Siebel PRM lets you share more sensitive information with partners with whom you have a formal 
business relationship. For example, if you have entered into a partnership with a company that will 
resell your product, it is important to share information about accounts, opportunities, and activities 
with that partner. Siebel PRM lets you share this information with the partner’s employees in the 
same way that you would your own employees. To provide access to this data, you give the partner 
employees login access to the Siebel PRM Portal. 

To do this, you must follow a series of steps that will set up this partner company in your system. 
Typically, this process begins when the partner uses the Siebel PRM online registration to apply to 
be a part of your partner program. There are other ways that a partnership can be initiated, which 
are discussed in the section “Other Ways of Adding Partner Records” on page 119. 

The process of adding partners depends on the following data and structures that are put in place 
by your system administrator or channel operations manager when Siebel PRM is initially set up: 

■ The organization structure must be established so that you can place this new partner 
organization into the existing organization hierarchy. 

■ Partner responsibilities must exist in order to assign these responsibilities to the partner 
organization. 

■ Access groups must also have been created so that the new partner can be placed in the 
appropriate access groups and be given access to master data. 

These steps are described in Chapter 3, “Setting Up Siebel PRM.”

Enrollment Process
To enroll a new partner company, you typically use the following process:

■ View the new applications. View the applications submitted on the Siebel PRM Portal by 
prospective partners. 

■ Prospective Partners. If a company applies to be a partner through your Siebel PRM Web 
site, it has entered the information you need for the partner record. After this application is 
submitted, it is visible in Prospective Partners List view. To view the applications of 
prospective partners, navigate to the Site Map > Administration - Partner screen > 
Prospective Partners view. 

To qualify the partner, click Qualify. This moves the application from the Prospective Partners 
list to the Qualified Partners List. The prospective partner is now a qualified partner. 

■ Qualified Partners. To view the applications of qualified partners, navigate to the Site Map 
> Administration - Partner screen > Qualified Partners view. 

■ Registered Partners. After qualifying a prospective partner, add it to the Registered Partner 
list by clicking Register. The partner is now a registered Partner. To view the registered 
partners, navigate to the Site Map > Administration - Partner screen > Registered Partners 
view. For more information about registering partners, see “Registering the Partner Company.”
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■ Assign responsibilities to the partner company. Responsibilities control the views partners 
can see. 

■ Assign positions to the partner company. You can define the positions for the partner 
company, or you can let a delegated administrator at the partner company define these positions. 

■ Assign master data to the partner company. You assign most master data by adding the 
partner company to one or more access groups. You also assign a price list to the partner 
company. 

■ Add user assignments at the partner company. You can enter the users at the partner 
company yourself, or you can enter one user at the partner company as a delegated 
administrator, who can add other users and delegated administrators at the partner company. As 
part of adding user assignments, you can also create a User ID and password for each employee 
and associate the user with a position and responsibilities.

■ Assign roles to the partner company. Roles enhance usability by limiting the screen tabs 
displayed and providing hyperlinked task lists to employees. 

■ Contact the new delegated administrator. You can set up a workflow to send email to the 
new delegated administrator after the partner company has been added.

■ Add locations for the partner locator. If you want the partner company to be visible in the 
Partner Locator, you must add locations or have the partner add its own locations, and you must 
publish locations. 

■ Complete the partner profile. Optionally, you can complete the partner profile to make sure 
that it has the information you need and that it is accessible to the right people in your company. 

NOTE: In some cases, you can add a partner company and skip the registration and the following 
steps. Do this only if the partner company is not using the Siebel PRM Portal. You can still work with 
the partner company record using the Siebel PRM Manager: the channel manager can view the 
company’s records in the Partner screen and can also use the Siebel PRM Manager to request market 
development funds (MDFs) for the company. You display partners who are approved but not 
registered by navigating to the Administration - Partner screen and choosing the Approved Partners 
link. You display registered partners by navigating to the Administration - Partner screen and 
choosing the Registered Partners link. 

Displaying and Assessing Prospective Partner 
Companies
When a company applies to be a partner, you need to assess how well it can work with your company 
before deciding whether to enroll it as a partner.

There are many things you can do when you assess a potential partner company. You begin by 
assessing the profile data entered when the company applied to be a part of the partner program. 
You may also want to read a Company Briefing, do a credit check, talk to key people in the company, 
and do many other offline activities. 
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When a company applies at your Siebel PRM Portal to be a partner, the company fills out a partner 
profile, including detailed information about the potential partner company’s business. You begin the 
enrollment process by examining this information to understand this company’s business model and 
seeing how it may fit in with your business goals. 

You use the Prospective Partners list to view the companies that have applied to become your 
partners, along with their profiles. This list includes companies and individuals that have registered 
as partners online.

To view prospective partners and their profiles (brandowner)

1 Navigate to the Site Map > Administration - Partner screen > Prospective Partner view. 

The Prospective Partners list appears with a list of companies that have applied to be partners.

2 Select a partner company in the Prospective Partners list.

Profile information about that company is displayed in the More Info form.

Adding a Partner Record by Qualifying a Partner 
Company
If a partner company registered at your Web site wants to apply to be a partner, the first step is to 
qualify the partner company. Qualifying a partner company moves it from the Prospective Partners 
list to the Qualified Partners list. 

Use the following procedure to qualify a partner company.

To qualify a partner company

1 Navigate to the Site Map > Administration - Partner screen > Prospective Partners view. 

2 Select the prospective partner record that you want to qualify and click Qualify. 

The Prospective Partner record is converted to a Qualified Partner record, and appears in the 
Qualified Partners list. 

NOTE: In some cases, you can just qualify a partner company and skip the registration tasks. Do 
this only if the partner company is not using the Siebel PRM Portal, and you are using Siebel PRM 
only to keep track of the partner company, not to share information with it. You can still work with 
the partner company record using the Siebel PRM Manager; the channel manager can view the 
company’s records in the Partner screen and can also use the Siebel PRM Manager to request market 
development funds (MDFs) for the company. 

Registering the Partner Company
For any method you choose to use to add a partner company record, you must register the partner 
company.
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Use the following procedure to register a partner company.

To register the partner company

1 Navigate to the Site Map > Administration - Partner screen > Qualified Partners view. 

2 In the Partners view, select the company you want to register and click Register.

3 In the Register Partner view, click on the Organization check box.

a In the Parent Organization field, select a parent organization.

b In the Partner Manager field, select a manager.

About Placing the Partner Company in the Organization Hierarchy
Siebel applications let you divide your business into organizations, which control visibility to data. 
For example, when users choose All Contacts, they display the contacts in their own organization. 

While setting up Siebel PRM, your company’s partner operations manager may have created a 
hierarchical organizational structure to organize your partner companies. For example, there may be 
a hierarchy that organizes partner companies based on the product they specialize in or the industry 
in which they work. 

When you register a new company, you must place it in the organization hierarchy by choosing its 
parent organization. For example, if your hierarchy is based on industry, you must place the new 
partner organization under the organization for the appropriate industry. 

You can also create a hierarchical structure with multiple organizations for the partner company 
itself. For example, if you assign opportunities to different regional divisions of a partner company, 
you can create an organization that represents the entire partner company and organizations under 
it in the hierarchy that represent its regional divisions. Then, you can assign opportunities to 
organizations representing the regional divisions, and only the division you assigned the opportunity 
to will be able to see it. 

For more information about setting up the organization hierarchy in Siebel PRM, see Chapter 3, 
“Setting Up Siebel PRM.”

For more information about using organizations to control visibility to data, see Security Guide for 
Siebel Business Applications.

About Specifying the Partner Manager for a Partner Company
If you are using market development funds (MDFs), you need to specify an employee in the partner 
manager field, so that fund requests are routed properly for approval. The employee selected in the 
partner manager field is the first to approve an MDF request. 

If you are not using MDFs, you do not need to use the Partner Manager field. You can enter a sales 
team instead. You may want to use the Partner Manager field as well as the Sales Team field to 
indicate that one person has primary responsibility for the partner. 
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In any event, the employee selected in the Partner Manager field must also be on the sales team to 
have visibility to the record in My Partners view. The partner’s record is displayed in My Partners view 
for members of the account team. 

NOTE: The employee selected in the Partner Manager field does not automatically have visibility to 
the Partner Record in the My Partners view. The Sales Team field determines who has visibility to the 
partner record in the My Partners view. You can display the record in the Approved Partner list and, 
in the More Info form, add employees responsible for the partner to the sales team. 

Registering the Partner Company
Select the Partner record and click Register to place the partner in the organization hierarchy and 
specify the Partner Manager field. 

NOTE: After you register the partner company, you cannot delete the partner organization. Be sure 
you want to create a new organization before clicking Register. 

To register the partner company

1 Add a Partner record for the new partner company, using the method described in the section 
“Adding a Partner Record by Qualifying a Partner Company” on page 108 or one of the methods 
described in the section “Other Ways of Adding Partner Records” on page 119. 

2 In the Approved Partners view, with the new Partner record selected, click Register at the top of 
the Partners list. 

The Register Partner form appears. 

3 Check the Organization box. 

Registering this partner company will make it an organization, so you can put it in your 
organization hierarchy. 

4 Click the select button for the Parent Division field. 

The Organization dialog box appears. 

5 Choose the division that will be above this partner organization in the organization hierarchy, and 
click OK. If you leave the field blank, the current user’s organization will be the parent 
organization by default.

6 To specify the Partner Manager field: 

a Click the select button for the Partner Manager field. 

The Pick Position dialog box appears, listing the positions and names of your employees. 

b In the Pick Position dialog box, choose the position and person who will be the partner manager 
for this partner organization, and click OK. 

The login name of the person you selected is entered as the Partner Manager in the Register 
Partner form. 

c If you do not select an employee for this field, the current user is entered by default. 
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7 Click the Save button at the top of the Register Partner form. 

The partner company has been registered. 

After enrolling and registering the new partner, add the company identifier to start processing user 
applications from the Administration - Partner screen > Partner User Applications view.

Assigning Responsibilities to the Partner Company
Responsibilities specify which views users of Siebel applications can access. 

For example, you can create the responsibility Salesperson, which includes the My Opportunities 
view, the responsibility Sales Manager, which includes both My Opportunities and My Team’s 
Opportunities views, and the responsibility Sales Director, which includes the My Opportunities, My 
Team’s Opportunities views, and All Opportunities views. 

If you are using delegated administration, assign one partner employee the Partner Operations 
Manager responsibility, which includes the views for delegated administration in the Siebel PRM 
Portal. The partner operations manager uses the delegated administration views to add other 
employees and assigns them responsibilities. 

Partners cannot create their own responsibilities. They can choose only from the set of 
responsibilities that you give them access to. You must associate at least one responsibility with the 
partner organization, so the partner users have access to some views when they log in to the PRM 
Portal. Typically, you assign multiple responsibilities to the partner organization so that the delegated 
administrator can give different types of users different responsibilities, just as you would with your 
own employees.

For more information about positions and responsibilities, see the section on defining positions and 
on defining responsibilities in Applications Administration Guide.

NOTE: Before you can assign responsibilities to a partner company, your partner operations 
administrator must have created the appropriate responsibilities while setting up Siebel PRM, as 
described in Chapter 3, “Setting Up Siebel PRM.”

To assign responsibilities to a partner company

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view. 

2 In the Partners list, select the record for the partner company to which you are assigning the 
responsibilities.

3 Click the Responsibilities view tab.

The Responsibilities view appears. 

4 In the Responsibilities list, click the menu button, and then click New Record. 

The Add Responsibilities dialog box appears. 

5 Select the Responsibility record that you want to add, and click OK. 

The responsibility is added to the Responsibilities list. 
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Assigning Positions to the Partner Company
Positions specify which data Siebel applications users can see when they display one of the “My” 
views. For example, if a user displays the My Opportunities view, the user sees the opportunities that 
have that user’s position on the sales team. 

For this reason, most Siebel implementations give a different position to each employee. For 
example, Siebel implementations would generally use positions such as Salesperson-042233 and 
Salesperson-042234 to give each of their salespeople a unique position. Then, when salespeople 
display My Opportunities view, for example, they see only their opportunities, not the opportunities 
of other salespeople. 

Because positions are used this way, you can assign data to new employees who replace other 
employees simply by giving them the positions of the employees they are replacing (such as 
Salesperson-042233) to give them visibility to the data they need. 

If you are using delegated administration, which lets administrators at partner companies add 
employees at their company, you must create at least one position for the delegated administrator. 
You will generally want the delegated administrators to create positions in addition to adding 
employees, since they generally must create a new position whenever they add a new employee. 

If you are not using delegated administration, you will have to add positions for all partner 
employees.

For more information about positions and responsibilities, see Security Guide for Siebel Business 
Applications.

To assign positions to a partner company

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view. 

2 In the Partners list, select the record for the partner company to which you are assigning the 
positions.

3 Click the Positions view tab.

The Positions view appears. 

4 In the Positions list, click the menu button, and then click New Record.

5 Enter information in the Position form to create a new position.

Assigning Master Data to the Partner Company
Siebel applications include two different types of data, which you work with in different ways: 

■ Transactional Data. This is data that users can create, read, edit, and delete, such as 
opportunities, accounts, contacts, and service requests. It can be assigned to individuals, to 
groups of individuals (such as a sales team), or to organizations. 

■ Master (or Referential) Data. This is data that users can only read, such as sales literature 
and service solutions. It is usually assigned to groups of users through access groups.

The next step in adding a new partner company is to assign it the appropriate master data. 
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To assign most master data to partners, you use access groups. Before you can do this, your channel 
operations manager must set up the appropriate access groups and categories of master data, as 
described in Chapter 3, “Setting Up Siebel PRM.” Then, any partner company that you add to the 
access group will have access to the master data visible to that access group. 

Price lists are the only type of master data that is not assigned using access groups, because price 
lists are usually assigned to smaller groups of partner companies than other forms of master data. 
For example, you may assign master data to an access group called resellers, but you may have a 
different price list for each reseller, or you may have a standard price list for most resellers but 
special price lists for five of your resellers. Assigning price lists to access groups would limit the utility 
of the access groups, because price lists often do not follow the same rules as other master data.

You may also want to assign some types of transactional data, such as customer accounts and 
contacts, to the new partner company. You will assign other types of transactional data, such as 
opportunities and service requests, to the partner company after you start working with it. 

Most often, the type of access groups that partners are assigned to Partner Communities, but they 
can be assigned to access groups of any type.

For information about assigning transactional data to partner companies, see Chapter 8, “Sharing 
Data with Partners.”

To add a channel partner company to an access group

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners. 

2 In the Partners list, select the record for the partner company which you are adding to the access 
group.

3 Click the Access Groups view tab. 

4 In the Access Groups list, click the menu button, and then click New Record. 

The Add Access Groups dialog box appears. 

5 Select the Access Groups to which you want to add the partner, and click Add.

To assign a price list to a partner company

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view. 

2 In the Partners list, select the record for the partner company to which you are assigning the 
price list.

3 Click the Price Lists view tab.

The Price Lists view appears. 

4 In the Price Lists list, click the menu button, and then click New Record. 

The Add Price List dialog box appears. 

5 Click the select button for the Price List record that you want to add. 

The price list is added to the Price Lists list. 
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Adding User Assignments at the Partner Company
As the next step in adding a new partner company, use the User Assignments view to add partner 
employees as Siebel PRM users. You can also use this screen to update positions, responsibilities, 
and logins for existing users. 

NOTE: Partner users must be added as employees to be able to log into the Siebel PRM Portal. The 
Employee check box must be selected in the User Assignments view tab. This check box is selected 
by default when a new user is added. 

Siebel PRM lets you add two types of partner employees:

■ End Users. You can add the employees in your partner company as end users. 

■ Delegated Administrators. You can designate one or more employees at the partner company 
as delegated administrators, who can then add new users at the partner company and assign 
them responsibilities you have created for this partner company. The delegated administrator can 
also perform routine maintenance tasks, such as modifying user records. A delegated 
administrator must have a responsibility that includes the views used for delegated 
administration. In the seed data, this responsibility is Partner Operations Manager.

Delegated administrators can also give employees at their company the responsibility of delegated 
administrators. Therefore, you can add the person who submitted the application for a partner 
company as a delegated administrator, and then that delegated administrator can add other 
employees at the partner company as delegated administrators, who will actually enter the users.

After the delegated administrator has added partner employees, you can see them using the Siebel 
PRM Manager. 

For more information on adding users and delegated administrators, see Chapter 3, “Setting Up Siebel 
PRM.”

NOTE: If you are using delegated administration, you must make at least one partner employee a 
delegated administrator. In the User Assignments view, edit the user's record and enter a position 
and responsibility for the user.

To display partner employees who are Siebel PRM users

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view. 

2 Select the record for the partner company whose employees you want to see. 

3 Click the User Assignments view tab.

The User Assignments view appears. The information in the following table will be entered for 
the person who applied to be a partner and for any other partner employees who have been 
added.

Field Comments

Name fields The first and last name and title (such as Mr. or Ms.).

Job Title The user’s job title.

Positions The user’s position or positions. 
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Assigning Roles to the Partner Company
Roles increase the usability of Siebel PRM for both brand owner and partner employees. When you 
create roles and assign users to these roles:

■ Users only see the screen tabs and view tabs for their roles. Roles do not restrict the screens and 
views that users can display, as responsibilities do. They merely reduce the number of screen 
tabs and view tabs, so only the ones that the user commonly needs are displayed. 

■ Users have a task list for their role on their home page, with hyperlinks that take them directly 
to the views they use most frequently. 

For more information about roles, see the section about administering roles in Chapter 3, “Setting Up 
Siebel PRM.”

If you are using a delegated administrator at the partner company to add partner users, you should 
assign roles to the partner company. This makes the roles available to the delegated administrator 
at that company, who associates them with employees.

You assign roles to the partner company by adding them to the User Roles list of the Administration 
- Partner screen. 

For detailed information about assigning roles to a partner company, see “Making Roles Available to 
Partner-Delegated Administrators” on page 35. 

Contacting the New Delegated Administrator
Contact the delegated administrator at the new partner company to provide more details about next 
steps. 

You should tell the delegated administrator to use the Siebel PRM Portal to add new users, including 
new delegated administrators, and to add user assignments for the employees at the company who 
will be using the Siebel PRM Portal.

You can contact the new delegated administrator personally, or you can set up Siebel Business 
Process Designer to send the administrator email automatically when the company is added as a 
partner. 

Responsibilities The user’s responsibility. 

User ID and Password The login name and password with which the user logs into the 
Siebel PRM Portal. Password is only accessible if LDAP has been set 
up.

Time Zone The user’s time zone.

Role Select the user’s role. For more information about roles, see 
“Administering Roles” on page 34.

Field Comments
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The sample data included with Siebel PRM includes a sample of this email and a sample of a workflow 
that sends it automatically after the new partner company is added. You can use this as the basis of 
your email and workflow. 

The name of the workflow is Send Prospect Partner Application Status eMail (Siebel PRM). 

For more information about Siebel Business Process Designer, see Siebel Business Process Designer 
Administration Guide.

Adding Locations for the Partner Locator
If you want partners to be visible to other partners in the Partner Locator, you should add their 
locations and publish them to the Partner Locator. Alternatively, partners can add their own locations 
through the Siebel PRM Portal, and you can publish them. 

The Partner Locator allows customers, partners, and brand owner employees to find partners who 
are near to their location and who have special expertise. For example, if customers want a specific 
service, they can go to your Web site and use the Partner Locator to find a list of partners near them 
who have expertise in that service. If one partner company wants to find other partners to work with 
it on an opportunity, it can find other partners with the expertise it needs. 

The Partner Locator allows users to search for partner name, partner type, partner expertise, and 
satisfaction index. It also allows users to enter their own location and choose the distance from their 
location that they want to search. For example, they can search for partners within 50 miles of their 
location. 

Because one partner company can have many locations, you or the partner company must enter all 
the locations that will appear in the Partner Locator. 

Partners can add locations under their Company Profile, available through the Profile hyperlink on 
the PRM Portal.

You must also select the Publish check box for a partner to publish all of that partner’s locations to 
the Partner Locator. You can deselect this check box to remove all the partner’s locations from the 
Partner Locator. For example, you may want to do this if you charge partners a fee to be listed in the 
Partner Locator and one partner company does not pay. 

If this check box is not selected, the partner company is still visible to the brand owner in the Partner 
Locator of the Siebel PRM Manager, but it is not visible to other partner companies in the Partner 
Locator of the Siebel PRM Portal. 

NOTE: When you publish a partner to the partner locator, you can only select an existing address. 
If you want to add a new address for the partner in the partner locator, you must add the new address 
in the Partners form in the Partners screen above the location list before you add the location.

To publish a partner to the Partner Locator and add locations

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner that you want to publish to the Partner Locator.

3 In the More Info form, select the Publish check box.
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4 Click the Locations view tab. 

5 If the address of this location has not been entered, click the Select button of the address field 
in the Partners form above the Locations list, and use the dialog box to add the address. 

6 In the Locations list, add a record for each of the partner’s locations and enter the information 
in the following table. 

Completing the Partner Profile 
Optionally, after completing the administrative tasks of adding a partner company, you can make 
additional entries in the partner profile to make sure that it has the information your company needs 
and that it is accessible to the right people in your company. 

You can:

■ Enter the partner’s competitors and existing partnerships.

■ Enter the partnership profile. 

■ Give your employees access to the partner in the My Partners view. 

Entering the Partner's Competitors and Existing Partnerships 
Because it could be a security breach to expose the lists of a partner’s competitors and existing 
partnerships during registration, these fields have been left as text fields during the registration 
process, so they are not automatically entered in the database. To update these fields, you can select 
companies that match what your partner entered in the Partner Profile view during registration. 

To enter the partner’s competitors and existing partnerships

1 Navigate to the Partners screen, select the record of the new partner company, and then click 
the Profile tab in the lower part of the screen. 

Field Comments

Location Name Enter a business name for this location. 

Address Click the Select button and select the address of this location. 

City Entered when you select the address. 

Zip Code Entered when you select the address. 

State Entered when you select the address. 

Country Entered when you select the address. 

Longitude Calculated and entered by the system when the record is saved. 

Latitude Calculated and entered by the system when the record is saved. 

Business Hours Enter the business hours for this location. 
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2 Click the Partnership Application link. 

The information that the partner filled out in the profile appears. 

3 If necessary, click the show more button. 

4 Note the existing partners and competitors entered by your partner.

5 In the Profile form’s Show drop-down list, choose Partner Profile. 

The Partner Profile appears. 

6 On the Profile form, in the field Other Program Memberships, enter the companies that the 
partner specified as its existing partners. If the specified company does not exist on the account 
list, you may want to add an account to your account list for this company.

7 In the Partner's Competitors field, enter the companies the partner specified as its competitors. 
If the specified company does not exist on the account list, you may want to add an account to 
your account list for this company.

Entering the Partnership Profile 
Siebel PRM includes two types of profiles: 

■ Partner profile. This profile describes the partner company. 

■ Partnership profile. This profile describes how your company will work with the partner 
company. 

The partner profile should have been entered when a company applied to be a partner or when you 
were evaluating the potential partner. 

After you register a partner, you should enter the partnership profile. 

For more information about the partnership profile, see Chapter 15, “Managing Your Partners.”

Giving Your Employees Access to the Partner in My Partners View
You can give access to this partner record to specific employees in your company, so this partner is 
included in the Partners list when they display My Partners view. 

You make the partner company visible in an employee’s My Partners view by adding that employee 
to the sales team for the partner company. 

To add an employee to the partner’s sales team

1 Navigate to the Partners screen. 

2 In the Partners list, select the record of the new partner company. 

3 In the More Info form, click the show more button. 

The More Info form is expanded.

4 In the More Info form, click the select button of the Sales Team field. 

The Sales Team Members dialog box appears. 
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5 Select an employee you want to add to the Sales Team and click OK. If necessary, click the New 
button to add employees to the Sales Team Members dialog box. 

Other Ways of Adding Partner Records
Because it is most common for partners to apply through your Web site, only this method was 
described earlier in this chapter. However, you can add a partner record in three ways:

■ Qualify and register a partner company. If a company applied to be a partner through your 
Siebel PRM Web site, it has entered the information you need for the partner record. To add a 
partner record, click Qualify and then in the Partner List, click Register. 

■ Enter a partner company manually. If a company became a partner without applying through 
your Siebel PRM Web site, you can enter it in the Partners list manually. When you first set up 
Siebel PRM, you enter records for your existing partners manually. 

■ Convert a customer account to a partner. If one of your customers also becomes a partner, 
you can add it to the Partners list by converting its Account record to a Partner record. 

The following section describes the other two other methods of adding a partner record, which are 
less common but also are useful. 

After adding a new partner in either of these two ways, you must go through the rest of the process 
of enrolling a new partner, as described previously. The process using the three methods of adding 
a new partner is shown in Figure 26. 

Adding a New Partner Record Manually
If a company did not apply to be a partner at your Web site, add the new partner record manually. 
You can enter a partner manually in two ways:

■ Add a qualified partner manually. If you have already qualified the partner company, you can 
enter it manually as a Qualified partner. 

Figure 26. Process for Adding a New Partner
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■ Add a prospective partner manually and promote it. If you have not already qualified the 
partner company, you can enter it manually as a prospective partner. After it is qualified, you can 
promote it. 

Adding a Qualified Partner Manually
If the partner has been qualified, enter the qualified partner record manually. Then, register the 
partner and enter the partner profile. 

To add a qualified partner manually

1 Navigate to the Site Map > Administration - Partner screen > Qualified Partners view. 

2 In the Partners list, click the menu button, and then click New Record to add a new record to that 
list.

3 Fill in the blank record and the More Info view about the new partner with the information in the 
following table.

Field Comments 

Name Enter the name of the partner company.

Site Enter a description of the physical location of the partner, such as 
“Headquarters” or “San Francisco.”

Address, and so on Enter the partner company’s street address, city, state, ZIP code, and 
country.

Main Phone # Enter the partner company’s main phone number. 

Main Fax # Enter the partner company’s main fax number. 

Email Enter the partner company’s main email address.

URL Enter the address of the partner’s Web site.

Currency Enter the currency the partner uses. 

Partner Type Optionally, click the select button and use the dialog box to choose 
the type of partner you are adding—for example, aggregator, reseller, 
or service provider. 

Partner Tier Enter the partner tier. Companies might use tiers such as gold, silver, 
and bronze, or strategic, premier, and alliance. 

Industries Optionally, click the select button, and in the dialog box, choose the 
industries to which this partner sells.

Territories Optionally, click the select button, and in the dialog box, choose the 
territories to which this partner sells.

Ranking Optionally, enter information about how this partner is ranked against 
other partners in your partner program, which can help you keep 
track of your top performing partners. 
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4 Click Register, and complete the process of adding the partner company, as described earlier in 
this chapter in “Enrolling New Partner Companies” on page 106. 

Adding a Prospective Partner Manually
If the partner has not yet been qualified, manually enter both the Prospective Partner record and 
partner profile. At some later time after the partner has been approved, click Qualify to move it to 
the Approved Partner list, and then complete the registration. 

Before you add Prospective Partner records manually, you must make sure that the partner managers 
at your company who add Prospective Partner records have the value Self-Registered Partner Agent 
in their New Responsibility field. When these managers create new users, the new users will inherit 
the responsibility in their New Responsibility field. When the prospective partners inherit the 
responsibility Self-Registered Partner Agent, the partners will be able to log into the Siebel PRM 
Portal as self-registered users in the interim, until they are qualified. 

To enter the partner manager’s new responsibility

1 Navigate to the Site Map > Administration - User screen. 

2 Use a query to find the employee whose new responsibility you want to enter.

3 In the More Info view, click the More/Less button to expand the More Info form. 

4 In the New Responsibility field, choose Self-Registered Partner Agent. 

Stage Use the picklist to choose the stage of the partner’s application. 
Options are Active, Application Pending, Candidate, and Contract 
Pending.

Organization Use this field to enter the partner’s organization, as described in the 
next section. 

Sales Team Select the sales team for the partner company. These are your 
employees who will see this partner company’s record in the My 
Partners view. 

Price List Select one or more price lists that this partner company will use. 

Alias Optionally, enter aliases for this partner company, names that the 
partner company might use in addition to its company name. 

Currency Select one or more currencies that this partner company uses. 

Account Type Select Partner as the account type. 

Status Select the account status: Active, Contract Pending, Marked for 
Deletion, or Inactive. 

Parent Account Optionally, enter the parent company of the partner company.

Parent Account Site Optionally, enter the site of parent company.

Field Comments 
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To add a prospective partner manually

1 Navigate to the Site Map > Administration - Partner screen > Prospective Partners view.

2 In the Prospective Partners list, click the menu button, and then click New Record to add a new 
record to that list.

3 Fill in the blank record and the More Info view with the information about the new partner.

4 Click the Profile view tab and enter the partner profile. 

5 At some later time after the partner has been qualified, click Qualified to move it to the Qualified 
list and complete the registration process as described earlier in this chapter in “Enrolling New 
Partner Companies” on page 106.

Converting a Customer Account to a Partner 
You may find that one of your customers wants to become a partner. You can convert the customer’s 
Account record to a Partner record. 

To convert a customer account to a partner

1 Navigate to the Accounts screen. 

2 In the Accounts list, select the customer account that you want to convert to a partner.

3 In the More Info view, select Partner from the Account Type drop-down list.

4 Click the Partner check box to select it. 

The account is converted to a partner and will appear in the Partners screen, Approved Partners 
view, as well as in the Accounts screen.

5 Navigate to the Site Map - Administration - Partner screen > Approved Partners link. 

6 Click the Register button to complete the process of adding the partner company, as described 
in “Enrolling New Partner Companies” on page 106. 

Delegated Administration
Delegated administration allows partners to enter and maintain information about users and about 
their organizations, positions, responsibilities, and communication profiles, to reduce the 
administrative work that the brand owner must do.

Delegated administration also gives partners more flexibility to associate users with the appropriate 
organization, responsibility, and position, and to create or modify product catalogs and literature 
catalogs.

Partners have the ability to do the following:

■ Administer users

■ Administer product and literature catalogs

■ Administer communication profiles
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Delegated User Administration
When you register a new partner company, you create an organization for that partner company. You 
can also use the Administration - Group screen to create suborganizations under that partner 
organization. For more information, see “Setting Up the Organization Structure” on page 30. 

When you create a partner company, you add at least one user and you add positions and 
responsibilities used by that company. For more information, see “Enrolling New Partner Companies” 
on page 106. 

Delegated administrators can reduce your administrative burden by adding and maintaining users at 
the partner company. To add a user, they must associate the user with one or more positions and 
one or more responsibilities. 

Because responsibilities control which views a user can view, delegated administrators are not 
allowed to create new responsibilities. The delegated administrator can associate users with 
responsibilities that you created. 

Delegated administrators can create new positions, as described “Adding Positions” on page 123. In 
most implementations of Siebel applications, each employee has a different position, so it is also 
necessary to create new positions when you add new employees. 

For more information about adding users, see “Adding User Assignments at the Partner Company” on 
page 114. For more information about responsibilities, see “Assigning Responsibilities to the Partner 
Company” on page 111. For more information about positions, see “Assigning Positions to the Partner 
Company” on page 112. 

A delegated administrator at a partner company can:

■ Add and maintain users

■ Add and maintain positions

■ Associate users with organizations or suborganizations

NOTE: For the partner to use suborganizations, the brand owner must create the suborganizations 
under that partner organization. 

Adding Positions 
Positions control which data users see in the My and My Teams views: 

■ In My views, users see the data for their own position. For example, in the My Opportunities view, 
users see all the opportunities where their position is on the sales team. 

■ In My Team views, managers see the data for their own position and for all of their reports. For 
example, in the My Team’s Opportunities view, managers see all the opportunities where their 
position or their reports’ positions are on the sales team. 

When delegated administrators create new positions, they specify a name and a parent position for 
each position. The parent position is the position of the manager whose team this employee is on. 
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In most implementations of Siebel applications, each employee has a different position. For example, 
rather than one position named Sales Representatives, there would be positions named Sales 
Representative 100, Sales Representative 101, and so on. Then in the My Opportunities view, sales 
representatives would only see opportunities where they are on the sales team; they would not see 
all opportunities where any sales representative is on the sales team.

Therefore, delegated administrators generally must add new positions for new users. The position 
should be added before the user is added. 

To add a new position at the partner company

1 The partner delegated administrator navigates to the Administration screen. 

2 In the Organization Explorer, the partner clicks the + icon next to the organization to which the 
position will be added. 

Hyperlinks for Organizations, Positions, and Users appear under this organization. 

3 The partner clicks the Positions hyperlink under the organization. 

4 In the Positions list, the partner clicks New.

5 In the Positions form, the partner enters information about the new position and clicks Save. 

Adding Users 
In most implementations of Siebel applications, each employee has a different position, as described 
in the previous section. After you have added the position for the new user, you can add the record 
for the new user. 

To add a new user at the partner company

1 The partner delegated administrator navigates to the Administration screen. 

2 In the Organization explore, the partner clicks the + icon next to the organization to which the 
user will be added. 

Hyperlinks for Organizations, Positions, and Users appear under this organization. 

3 The partner clicks the Users hyperlink under the organization. 

The Users list appears.

4 In the Users list, the partner clicks New.

5 In the Users form, the partner enters information about the new user (including position) and 
clicks Save. 

Giving Users Visibility to Different Organizations
When new users are added, the delegated administrator adds them to an organization, as described 
in the previous section. The delegated administrator can also associate existing users with different 
organizations and suborganizations than the ones which with they were initially associated, thus 
changing the data that is visible to them. 
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Suborganizations can be used to control data visibility within the partner company. They are also 
important to partner collaboration. Partner collaboration allows partners to share information with 
organizations and suborganizations in other partner companies, and partners can associate 
employees with the appropriate suborganization so they can view the data they need. 

The brand owner must set up this structure of suborganizations under the partner organization. For 
more information about organizations, see “Setting Up the Organization Structure” on page 30. 

A user can be associated with more than one organization. If a user is already associated with an 
organization and the partner wants the user to be associated with a different organization, the 
partner must delete the user’s existing position as well as add the position in the new organization. 
If the existing position is not deleted, the partner will still be associated with the first organization 
as well as with the second. 

NOTE: The delegated administrator associates the user with the organization by giving the user a 
position in that organization. If the position does not already exist, then before performing the 
following procedure, the delegated administrator must create it, as described in “Adding Positions” on 
page 123.

NOTE: Though the user has visibility to the data in the organization with which the position is 
associated, the delegated administrator still sees this user’s name listed under the user’s original 
organization. 

To associate a user’s position with an organization or suborganization

1 The partner delegated administrator navigates to the Administration screen. 

2 The partner clicks the + icon next to the organization or suborganization that the user is currently 
in. 

3 The partner clicks the User hyperlink under that organization. 

4 In the User list, the partner clicks the name of the user to be associated with an organization. 

The Users form appears, with information about that user. 

5 The partner clicks the Select button for the Position field. 

The Positions Occupied dialog box appears. 

6 If the partner does not want the user to be associated with the earlier organization, only with 
the new one, then in the Positions Occupied dialog box, the partner selects the user’s existing 
position and clicks Delete. 

7 In the Positions occupied dialog box, the partner clicks New. 

8 In the Add Positions dialog box, the partner clicks a position associated with the organization 
with which this partner will be associated and clicks OK. 

9 In the Positions occupied dialog box, the partner clicks OK. 

The user can see the data visible to the organization with which this position is associated. 
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Delegated Catalog Administration
The partner-delegated administrator can add products or literature to catalogs. 

Partners may do this for a number of reasons. For example, if a partner sells products that are 
complementary to the brand owner’s products, the partner can add these to the product catalog and 
add literature about them to the literature catalog. Then, their product and literature catalog will 
support the complete solution that they provide to customers. 

Partners may also want to create their own catalogs and use them for selling products and managing 
literature. 

The brand owner must create the catalog, even if it has no items in it. The partner can then add 
items to it. 

The partner can see all the master data that the brand owner has associated with the catalog, but 
the partner can only add products and literature. 

For more information about creating catalogs, see “Assigning Master Data to the Partner Company” on 
page 112. 

For more information about pricing, see Pricing Administration Guide.

Adding Items to Catalogs
Delegated administrators can use the following procedure to add items to catalogs.

To add items to catalogs

1 The partner-delegated administrator navigates to the Catalog Administration screen. 

2 In the Catalogs list, the partner selects the catalog to which items will be added.

3 In the Categories list, the partner does either of these actions:

a Selects an existing category to which the item will be added 

b Clicks New and enters information about a new category to which the item will be added 

4 The partner clicks either the Products or the Literature view tab. 

5 To add an existing product: 

a The partner clicks the Products view tab. 

b In the Products list, the partner selects New Record from the drop-down menu. 

c In the Add Internal Products dialog box, the partner queries to find an existing product, and 
clicks Go. 

d The partner selects the existing product to be added and clicks OK. 

e The partner associates the product with a price list, as described in Step 7. 

6 To add a new product: 

a The partner clicks the Products view tab. 
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b In the Products list, the partner selects New Record from the drop-down menu. 

c In the Add Internal Products dialog box, the partner clicks Go to runs an empty query. 

d In the Add Internal Products dialog box, the partner clicks New. 

e In the Products form, the partner enters information about the product and clicks Save. 

f The partner associates the product with a price list, as described in Step 7. 

7 To associate a product with a price list: 

a After adding the product, the Partner clicks its name in the Product list. 

The Product form appears, with the Price Lists list below it. 

b In the Price Lists list, the partner clicks New.

c In the Add Price Lists dialog box, the partner selects a price list and clicks OK.

d In the Price Lists list, the partner enters a price for the product in the List Price field. 

8 To add a new literature item: 

a The partner clicks the Literature view tab. 

b In the Literature list, the partner clicks New. 

c In the name field of the new record, the partner clicks the select button. 

d The partner uses the dialog box to select the file that contains the literature. 

Delegated Communication Administration
Delegated communication administration uses two screens, the Communication Administration 
screen and the Communication Profile view of the User Profile screen. 

The Siebel PRM Portal’s Communication Administration screen allows the delegated administrator to 
view communications drivers, such as the drivers used for email. Each driver has parameters that 
specify how it behaves. For example, the parameters for an email driver may allow the administrator 
to choose whether the message will be in plain text, whether the From address is required, whether 
messages are deleted after being processed, and other parameters. 

The drivers and parameters in Siebel PRM Portal. 

After these drivers have been set up, the Siebel PRM Portal’s User Profile screen allows the delegated 
administrator to associate drivers with partner employees, to specify which drivers each employee 
uses. 

In the User Profile screen, the delegated administrator can also override the default parameters for 
individual users. For example, for an email driver, the parameter set in the Communication 
Administration screen may specify that all messages are plain text. In the User Profile screen, the 
administrator may override this for specific users to allow them to view HTML messages. 

For more information about communication administration, see Siebel Communications Server 
Administration Guide. 
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Setting Up Drivers and Parameters
Delegated administrators can use the following procedure to add or set up drivers and parameters.

To set up drivers and parameters

1 The partner-delegated administrator navigates to the Site Map > Administration - 
Communication screen > Communications Drivers and Profiles view. 

2 In the Communications Drivers list, the partner selects a driver. 

3 In the Driver Parameters list, the partner modifies the parameters for that driver by specifying 
whether parameters are required and specifying the default value of parameters.

Associating a Driver with Partner Employees
Delegated administrators can use the following procedure to associate a driver with a partner 
employee.

To associate a driver with partner employees

1 The partner delegated administrator navigates to the Site Map > User Profile screen. 

2 In the Show drop-down list, the partner chooses Communication Profile. 

3 In the Profiles list, the partner clicks New.

4 In the Name field of the new record, the partner enters a user’s name. 

5 In the Driver field of the new record, the partner clicks the select button and selects a driver. 

6 Optionally, to override default parameters for that driver, in the Profile Parameter Overrides list, 
the partner selects names of parameters and enters new values for the parameters. 
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6 Partner Programs 
Administration
This chapter discusses how to set up and administer partner programs.

This chapter contains the following topics:

■ “About Partner Programs” on page 129

■ “Setting Up Partner Programs” on page 130

■ “Applying to Partner Programs” on page 134

■ “About Eligibility Administration” on page 135

■ “About Application Approval” on page 143

■ “Administering Partner Program Memberships” on page 147

■ “Partner Programs Workflows” on page 148

About Partner Programs 
A partner program is a set of requirements, entitlements, and processes associated with a particular 
type of partnership. The brand owner sets up each partner program to enable partners to apply for 
membership. A partner program is a multi-organization enabled object that supports access control 
visibility. 

Partner programs administration allows channel partners to apply for partner program membership 
on the PRM Portal.  After the prospective partner has completed the application, a channel operations 
manager (brand owner) must review and approve or reject the application.  If the application is 
approved, the channel operations manager will then grant the new partner access to the program 
through the PRM Partner Portal. In Siebel PRM 7.8, these tasks have been streamlined to require less 
manual input by the brand owner.

Partner programs administration and management involves these five steps: 

■ Setting Up Partner Programs. The brand owner sets up a catalogue of partner programs so a 
partner can select the program or programs from the PRM Portal.

■ Applying to the Partner Program. The partner goes to the PRM Portal to apply for partner 
membership.

■ Administering and Approving Partner Eligibility. The brand owner defines the criteria that 
determines who can apply to a partner program. The brand owner also defines the criteria that 
determines who can be automatically approved.

■ Approving Partner Applications. The brand owner reviews the submitted application to verify 
the information and then approves or rejects it.

■ Administering Partner Program Memberships. The brand owner reviews and tracks 
membership data for all partners who are enrolled in a partner program. 
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Setting Up Partner Programs
The first step to partner program administration is to set up the partner program. There are four 
partner programs types: Authorization, Accreditation, Specialization and Program.

Process for Setting Up Partner Programs
Setting up a partner program requires that a brand owner do the following tasks:

■ “Setting Up a Partner Program Catalog” on page 130

■ “Setting Up a Partner Program Application” on page 131

■ “Setting Up and Associating Program Tier Groups” on page 132s

■ “Setting Up Related Programs” on page 133

■ “Adding Literature to a Partner Program” on page 133

■ “Setting Up Catalog Translations” on page 134

Setting Up a Partner Program Catalog
The first step in setting up a partner program is to set up a program catalog. For more information 
on working with catalogs, see Siebel Order Management Guide.

This task is a step in “Setting Up Partner Programs.” 

To set up a partner program catalog (brand owner)

1 Navigate to Site Map > Administration - Catalog screen.

2 In the Catalogs list applet, create a catalog.

■ In the Catalog Type field, select Partner Program.

■ If this catalog is to be private, click the Private check box.

■ Click Access Tab to add Access groups. 

This action determines who can view the partner program in the catalog.

3 Drill down on the new catalog and in the Category applet, create a category.

4 On the Category applet, click on the Partner Program link and in the Partner Program view.

If the link is not in view, click the arrow at the right end of the links to see more options.

5 Click New to add Partner Programs to Categories.
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Setting Up a Partner Program
The brand owner needs to set up the partner program that will appear on the PRM Portal.

This task is a step in “Setting Up Partner Programs.”

To set up a partner program (brand owner)

1 Log in to PRM Manager and navigate to Site Map > Partner Programs screen > Program Design 
view.

2 Create a new program.

■ In the Type field, select Program.

■ To make this program public (no eligibility rules), click the Available To All check box.

■ To give a partner the capability to apply on behalf of a branch organization, click the 
Delegated Application check box.

■ To give branch organizations the capability to be automatically approved when the parent 
organization is approved, click the Auto Cascade check box.

❏ For example, if the Headquarters of a company is approved, the Western Branch, Eastern 
Branch and MidWest Branch will also be approved.

3 Drill down on the program name and on the More Info tab, and complete the fields.

■ In the Approval Method field, select a method.

❏ If this is a partner program that will approve all applicants automatically, select Approve 
All.

❏ If this is a partner program in which applicants listed on a Approval Eligible list 
automatically, select Approval List. 

❏ If this is a partner program in which approvals will be done manually in the Application 
Inbox, select Manual.

❏ If you change the status of a partner program to Active, the record becomes Read-Only.

NOTE: After you save the Partner program record, Siebel Partner Manager automatically creates 
an access group with a name that is the combination of the partner program name and the 
organization name. Siebel Partner Manager automatically maintains this Access Group by adding 
or removing Access Group members based on the partners’ membership status within that 
partner program. For more information on partner program membership, see “Administering 
Partner Program Memberships.”

Setting Up a Partner Program Application
A partner program application is a form that the partner completes on the PRM Portal when applying 
to join a partner program.
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The brand owner’s internal users can attach SmartScripts to a partner program application. Each 
program can have one SmartScript initial application and one Smartscript renewal application. The 
actual design and administration of SmartScripts are performed in the SmartScript Administration 
screen. For more information on SmartScripts, see Siebel SmartScript Administration Guide.

Alternatively, the brand owner can attach URLs for the .asp or .jsp pages that will render the initial 
and renewal applications.

NOTE: For any given partner program application, you can specify either SmartScript applications 
or external applications, but not both.

This task is a step in “Setting Up Partner Programs.”

To set up a partner program application (brand owner)

1 Navigate to Site Map > Partner Program screen > Application Design view.

The name of the program you set up is filled in the Name field.

2 In the Initial Application field, select the SmartScript script you want to include in the application.

3 In the Renewal Application field, select the Smartscript you want to use to renew this application.

4 In the External Application field, enter the initial URL for any external applications attached to 
this application in the Initial URL field. Enter the renewal URL in the Renewal URL field.

Setting Up and Associating Program Tier Groups
A program tier group is a group of programs that are related, usually in a tier structure. An example 
of a tier group is a program that has three status groups, a Silver group, a Gold group and a Platinum 
group. 

A partner who is currently in the Silver group, for example, can upgrade to the Gold group. Note that 
PRM enforces that the partner can only be a member of one group at a time. For example, once a 
partner upgrades to Gold, that partner cannot still be in the Silver group.

NOTE: Partner tier groups are not related to the Partner Tier multi-value field on the Partner Profile 
view.

This task is a step in “Setting Up Partner Programs.”

To set up program tier group (brand owner)

1 Navigate to Site Map > Partner Programs screen > Program Tier Group view.

2 Create a new program tier group.

To associate a program tier group to a partner program (brand owner)

1 Navigate to the Partner Program screen > More Info view.

2 Select the partner program you to which you want to associate the program tier group.
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3 In the Program Tier Group field, select the program tier you want associated to this program.

Setting Up Related Programs
Related programs are programs that have a relationships with a base program. There are two types 
of related programs:

■ Addenda. This is a program that is not in the original agreement. For example, a base program 
that authorizes partners to be resellers might have an addenda program for each product the 
partners can sell.

NOTE: Partners cannot apply for an addenda program unless they are members of the base 
program.

■ Prerequisite. This relationship is informational only.

This task is a step in “Setting Up Partner Programs.”

To set up an addenda program

1 Navigate to Site Map > Partner Programs screen > Program Design view, and create a new 
program.

2 In the Partner’s Program applet, select the base program to which you want to relate the addenda 
program.

3 Click on the Related Programs tab and in the Name field, and query for and select the Addenda 
program you created.

Adding Literature to a Partner Program
Adding literature allows partners to download collateral, terms and conditions and so on that detail 
the partner program. The partner can access this literature by drilling down on the partner program 
in the catalog on the PRM Portal.

This task is a step in “Setting Up Partner Programs.”

To add literature to a partner program (brand owner)

1 Navigate to Partner Programs screen > Program Design and create a program, or select an 
existing partner program to which you want to add literature.

2 Click the Literature tab and query for the literature you want to add, or click Add and select the 
literature.
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Setting Up Catalog Translations
Setting up catalog translations provides the ability to translate fields from the partner program so 
that partners can view them in their language.

This task is a step in “Setting Up Partner Programs.”

Use the following procedure to set up catalog translations.

To set up catalog translations (brand owner)

1 Navigate to the Partner Program screen > Program Detail view and select the program for which 
you need translation.

2 Click the Translations tab and then click New.

3 In the Language Code field, select the language you want.

4 Complete the Program, Description and Long Description fields.

Applying to Partner Programs 
After the partner program has been set up, and the partner user application has been created, the 
partner can launch the PRM Portal to apply for membership to the program. 

Only partner programs with the status Active are visible to partners on the PRM Portal. If the catalog/
category is marked as Private, the partner must be added into the access group. If the program is 
not checked as Available to All, the partner has to be added to the Eligible Partners list to be able to 
see the program on the PRM portal. 

About Applying to Partner Programs
Partners who are not registered for partner programs can apply to partner programs on the PRM 
Portal as well as those who have already registered (registered meaning the partners have some 
visibility to the program). 

The following procedure allows partners to apply to a partner program.

To apply as a partner (partner)

1 Log in to the PRM Portal and navigate to Site Map > Partner Programs screen.

2 Select and drill down on the program you want.

3 Check for literature attachments, check for any existing applications, and check the membership 
data.

NOTE: Make sure you are not currently a member of this partner program. If you are already a 
member, you will not be allowed to apply again.

4 Click Apply, complete the fields in the application, and then click Submit.
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5 To check the status of your application, click the Program Applications tab and query for the 
application.

NOTE: SmartScript enables you to click Save if you need to stop before the application is 
completed, and then click Resume when you return to it without losing the data you have already 
entered.

About Eligibility Administration
A partner program has lists of eligibility attributes that determine what partners can apply to it or 
renew a membership. The brand owner can use automated rules, lists of partner companies, or 
manually enter data to determine partner eligibility. 

An eligibility list for a partner program can be created by entering data manually or using Siebel 
Analytics.

Creating an Eligibility List Manually
To create an eligibility list manually, you enter information about each partner program to generate 
a picklist. Note that this method might not be practical for a long list of partner programs. If you 
have a lot of partner programs, see “Creating an Eligibility List Using Analytics Data Load.”

Use the following procedure to create an eligibility list manually.

To create an eligibility list manually (brand owner)

1 Navigate to Partner Programs screen > Membership Administration link and drill down on the 
program for which you want to create an eligibility list.

2 On the Eligibility Administration tab, click on one of the following links for the type of list you are 
creating. 

■ Eligible Partners. An Eligible Partner list defines who can apply for a program. It determines 
whether a partner meets the criteria to apply for the partner program. On the PRM Portal, 
partners will see the Apply button only on programs for which they are eligible.

NOTE: Clicking on the Available to All check box will override this list. Make sure that 
Available to All is not selected if you want to use an Eligible Partners list.

■ Renewal Eligible. A Renewal eligibility list determines which partners can renew their 
membership to a partner program. Renewal eligibility determines whether the Renew button 
is active on the PRM Portal.

■ Approval Eligible. An Approval Eligible list determines which partners are automatically 
approved for a program. The approval eligibility is associated to the approval method you 
chose on the Program Design view. 

3 Click Add and select the partners from the picklist. 

4 Optionally, you can use the Add List button to import a list of partners that must be defined in a 
list on the List Management > Partner List.
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Creating an Eligibility List Using Analytics Data Load 
It is recommended that you use an Analytics Data Load when importing many partner records based 
on many criteria. This report generates the list of partners and provides a link to that report. For 
procedures for setting this process, see “Using Analytics Data Load.”

Use the following procedure to create an eligibility list from a report in Siebel Analytics.

To create an eligibility list from a report in Siebel Analytics

1 Navigate to Partner Programs screen > Membership Administration link and drill down on the 
program for which you want to create an eligibility list.

2 Query for and then drill down on the program for which you want to create an eligibility list.

3 Click on the <row_id> record you need to create a list:

■ To create an Eligible Partners list, select a record with the Load Name value that begins with 
Eligible. 

■ To create a Renewal Eligible list, select a record with the Load Name value that begins with 
Renewal. 

■ To create an Approval Eligible list, select a record with the Load Name value that begins with 
Approval. 

4 Click on the Location field, and then select a location from the picklist applet.

The Location list is available only if the user IDs and user passwords in Siebel PRM and Siebel 
Analytics are identical. For more information on configuring integration between Siebel 
application and the Siebel Analytics application see “Siebel Analytics Setup Workflow.”

5 Click Activate and scroll down to the Load History applet.

A record with the status of Pending appears.

6 As the Analytics Data Load runs, click Refresh to change the status to In Progress.

The status changes to Completed.

7 Scroll down to the Task Log applet and check all log details. 

8 Click the Eligibility Administration link and click Deactivate.

9 To view information for the records that fail:

a Navigate to Partner Programs screen > Membership Administration view. 

b Select the partner program and drill down. 

c In the Eligibility Administration view, scroll down to see the Load History applet. 

d Select the appropriate record in the Load History applet and Task Log applet to view information 
about the status of the data load and any errors encountered during data load. 
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Creating a Refresh Schedule
A refresh schedule determines how often the Analytics Data Load is run for each eligibility list. 

Use the following procedure to create a refresh schedule.

To create a refresh schedule (brand owner)

1 Navigate to Partner Programs screen > Membership Administration view.

2 Select the Data Load record for which you want to add a refresh schedule.

3 If the Active flag is checked, click Deactivate to enable updates to the schedule.

4 Set up the schedule.

a In the Start Date field, select the first date you want the data load to run.

b In the Next Schedule Date field, select the next scheduled date you want the data load to run.

c In the Repeat Every field, select the amount of time you want the data load to run. 

For example, if you want it to run every five days, you would select 5.

d In the Unit field, select the unit of measure you want the data load to run.

For example, if you want it to run every five days, you would select days.

e In the Until field, select the last date the analytics segment will run.

For example:

Start Time: Current date and time

Next Schedule Date: Current time + 10 minutes

Repeat Every: 4

Unit: Days

Until: Current date + one month.

This means the data load is configured to be activated after 10 minutes and to run every four 
days until the following month.

5 Click Activate, then scroll down to the Load History applet, and then click Refresh until the status 
is Completed.

The imported records will appear in the Eligibility Partners applet after the data load has run.

6 Click Deactivate.

Using Analytics Data Load 
Eligibility lists for partner programs can be created using Siebel Analytics Data Load and then 
imported into Siebel OLTP. 
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Figure 27 shows the partner program load data flowchart.

In the Partner Program Data Load workflow, there is a step called Analytics Data Load. It has an input 
property called MaxErrors. Default value for this parameter is 1. If there is an error during data load, 
the job is terminated. It is possible to change this input property on the workflow. If the value is 
increased to 100, then 100 data load errors are ignored.

A Refresh of the eligibility list can be scheduled at particular intervals, for example, hour/day/month. 
For information on creating a refresh schedule, see “Creating a Refresh Schedule.”

Siebel Analytics Setup Workflow
The following is the workflow for using the Analytics Report.

1 Activate related workflows.

a Navigate to Site Map > Administration- Business Process screen > Workflow Deployment view > 
Repository Workflow Processes applet.

b Activate version ZERO of the following list of workflows and restart the Workflow Process 
Manager Component.

❏ Workflow Name: Partner Program Data Load Group: Marketing

❏ Workflow Name: Import Marketing Contact Group: Marketing

2 Make sure Workflow Process Manager is running.

Figure 27. Partner Program Load Data Flow
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a Navigate to Site Map > Administration - Server Management screen > Components view and 
query for Workflow Process Manager.

One record is returned with Component Status = Online

3 Update the location of Marketing File System.

a Navigate to Site Map > Administration - Server Configuration screen > Servers view > 
Components view.

b Query for Workflow Process Manager and then select it.

c Go to the Parameters tab in the next applet.

d Query for Marketing File System and change the value to the file system location of the machine 
where the Analytics Server is installed.

4 If necessary, update the User Id and Password for the Default Analytics Web Server.

a Navigate to Site Map > Administration - Partner screen > Servers view.

b Query for Default Analytics Web Server.

c Update the User Id and Password.

5 Update the Web services setup.

a Navigate to Site Map > Administration - Web Services screen > Outbound Web Services view 
and then query for Name = “*Service”.

b In Service Ports list, change the first part of the address (the default value is CHANGEME) to 
match the server name and domain of your Siebel Analytics Web Server.

This address should be the full path name. For example, if the server name is MyServer1, the 
full address for the JobManagementService is:

❏ http://MyServer1/analytics/saw.dll?Soaplmpl=jobManagementService.

c Repeat Step a and Step b for the records in the Service Ports applet for the 
SAWSessionServiceSoap and WebCatalogServiceSoap Web Services.

❏ SAWSessionServiceSoap: http://MyServer1/analytics/
saw.dll?Soaplmpl=nQSessionService

❏ WebCatalogServiceSoap: http://MyServer1/analytics/
saw.dll?Soaplmpl=webCatalogService

6 In the Outbound Web Services applet, click Clear Cache.

You do not need to restart the Siebel Server for this change to be effective.

Setting Up a Siebel Analytics Report
It is important that the Analytics Report setup is completed and configured properly before you use 
it to create an eligibility list. 

Use the following procedure to create an Analytics Report.
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To create an Analytics Report

1 Connect to the marketing analytics URL (http://My Server1/analytics) and log in.

2 Click Marketing on the Dashboard and then click Create a List Format to enter the start page of 
List formats.

3 In the List Subject area, select Marketing Account List.

The Marketing Account List catalog displays in the left panel.

4 Select the Accounts (Transaction Database) folder in the catalog panel on the left.

5 Select the ROW_ID column.

■ Update the Table Heading Account (Transaction Database) to Channel Partner.

■ Update the Column Heading ROW_ID to Id.

NOTE: Channel Partner is the name of the integration component and Id is one of the Channel 
Partner integration component keys. You can use other Channel Partner integration component 
keys or create a new one. Make sure the key uniquely identifies the record before using it.

6 Select the Partner Flag column.

a Apply a filter (Partner Flag = 'Y') on this column.

b Remove the Partner Flag column.

7 Select columns where certain query criteria are required. Apply the filters and then remove the 
columns.

8 Select any two columns from any folder and apply formatting to these two columns with 
parameterized values which are used for the PPR Partner Program Partner Integration business 
component and the Partner Program Data Load workflow.

a Format the first column as:

❏ Table Heading: PPR Partner Program Partner Integration

❏ Column Heading: Prog Id

❏ Column Formula: '@{partnerProgramID}{0}

b Format the second column as:

❏ Table Heading: PPR Partner Program Partner Integration

❏ Column Heading: Type

❏ Column Formula: '@{eligiblePartnerListType}{0}'

9 Navigate to the Options tab and select:

Purpose = Analytics Data Load

10 Navigate to the Header and Footer tab and enter the header text as the following:

# Channel Partner

#

11 Navigate to Options tab and set these attributes:
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■ Purpose = Analytics Data Load

■ Delimited (checked)

■ End of Field Delimiter = Comma

■ Text Qualifier = " "

12 Save this report in a chosen folder.

13 To preview the list, click the Preview tab. To set up this preview functionality:

a Log in to the machine where Analytics Web (SAW) is installed

b Modify the MarketingPreviewPath in instanceconfig.xml which is located at D:\<Analytics Server 
directory>\Web\config 

c Modify the MarketingPreviewPath in instanceconfig.xml which is located at 
[Install_Drive]:\<Analytics Data directory>\Web\config

d Restart the SAW service 

Below is a sample list you will see: 

# Channel Partner

#Channel Partner.Name,Channel Partner.Location,PPR Partner Program Partner 
Integration.Prog Id,PPR Partner Program Partner Integration.Type

Active Systems,HQ,0,0

Active Systems - Americas,HQ,0,0

Asyrex Technologies,HQ,0,0

Avaya Communications,HQ,0,0

CKS Software,HQ,0,0

Dun & Bradstreet,HQ,0,0

Illuminent Technologies,HQ,0,0

Impatica,HQ,0,0

International Software Solutions,HQ,0,0

Lawson Utility,HQ,0,0

Lexis Nexis,HQ,0,0

Outtask,HQ,0,0

PCVista,HQ,0,0

Puma Technology, Inc.,HQ,0,0

SKF,HQ,0,0

Vertica Partners,HQ,0,0
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About Mass Updates
Brand owners need the ability to add or remove lists of partners to or from partner programs. The 
Mass Update functionality is a means to create a partner list for ad-hoc adds or removal of program 
members. This task can be performed manually or can be set up in Analytics. 

There is a user property called MassUpdateLimit on the PPR Partner Program Partner business 
component (buscomp).The default value of this parameter is 500. The value in this user property 
determines the maximum number of records that can be processed at one time. For more 
information about buscomps and user properties, see Siebel Developer’s Reference.

Creating a Mass Update List
You can create a mass update list for a partner program by entering data manually or using Siebel 
Analytics. It is recommended that you use the Analytics Data Load process when you need to import 
many partner record based on many criteria. For information on setting up Analytics Data Load 
process, see “Using Analytics Data Load.”

Use the following procedure to create a mass update list manually. 

To create a mass update list manually (brand owner)

1 Navigate to Partner Programs screen > Membership Administration link and drill down on the 
program.

2 Click on the Mass Update tab and in the Mass Update applet:

■ Click Add and select the records you want to add.

■ Click Delete to delete the partner from the Mass Update list.

3 Optionally, you can use the Add List button to import a list of partners that must be defined in a 
list on the List Management > Partner List.

Use the following procedure to set up a mass update using Analytics Data Load.

To create a mass update list using a Siebel Analytics report (brand owner)

1 Navigate to Partner Program screen > Membership Administration link and drill down on the 
program.

2 Select the Mass Update Data Load record that appears in the Eligibility Administration applet, 
then click on the Location field, and then select an Analytics report from the picklist.

3 Click Activate and scroll down to the Load History applet.

4 As the Analytics Data Load task runs, click Refresh to update the status value and select an 
Analytics report from the picklist.

For the procedure for scheduling a Mass Update data load, see “Creating a Refresh Schedule.”

Use the following procedure to execute a Mass Update list.
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To execute a mass update list

1 Navigate to Partner Programs screen > Membership Administration > Mass Update.

2 Select a partner record or multiple records.

NOTE: The following processes are background processes; you can continue to use the PRM 
application while the mass update is executing.

■ To add this partner as a member to the program, click Add as Members.

■ To remove this partner from the program, click Remove from Program.

The record will not physically delete, but will have a Membership Status field is changed to 
Terminated.

NOTE: When you add a partner as a member to the program, the partner is also added to 
the access group that was automatically created when the program was created.

3 Click the Membership tab to view the status of each partner.

About Application Approval
After a partner applies for a partner program using the PRM Portal, the application is available for 
the brand owner to view and evaluate. In Siebel PRM 7.8, brand owners can designate individuals or 
teams to review and approve applications for each partner program.  

The Application Inbox views provides a centralized view of all program applications. These views are:

■ Application Detail. This screen shows each question and answer on the application.

■ Attachments. This screen shows any attachments submitted by the partner.

■ Activities. This screen shows activities associated with application approvals.  These activities 
may be prepopulated based on an activity template defined for the program.

You can create an Activity Template (of type PRR Partner Prog Application) by navigating to the 
Site Map > Administration - Data screen > Activity Templates view.

■ Audit Trail. This screen logs any updates made to key fields.

Process for Approving an Application
The brand owner approves a submitted application by performing the following tasks:

■ “Reviewing Application Detail Inbox Information” on page 144

■ “Reviewing Application Attachments” on page 144

■ “Reviewing Application Activities” on page 145 

■ “Reviewing the Application Audit Trail” on page 145

■ “Reviewing Application MDF Programs” on page 145 

■ “Accepting a Program Application” on page 146
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■ “Approving an Application” on page 146

■ “Rejecting an Application” on page 147

■ “Notifying Partner of Application Approval by Email” on page 147

■ “Administering Partner Program Memberships” on page 147

Reviewing Application Detail Inbox Information
Application Inbox views show all program applications submitted by registered partners. Prospective 
and qualified partners can apply for partner programs but their applications will not appear in these 
views until they are registered. For information on registering a partner, see “Enrollment Process.”

This task is a step in the “Process for Approving an Application.”

Use the following procedure to view application detail information.

To view application detail information (brand owner)

1 Navigate to Partner Programs screen > Application Inbox link and select an application.

2 Drill down on the application. 

The detail information appears in the More Info tab.

Reviewing Application Detail
The Application Detail view shows the program applications with the corresponding responses from 
the partner. These question/answer pairs can be in one of these two formats:

Smartscript Session: For questions where the Save Answer Table is checked. For more information 
on Smartscript, see Siebel SmartScript Administration Guide.

External Application: If membership applications are delivered using .jsp or .asp pages, the PPR 
Partner Program Application Detail Integration Component within the PPR Partner Program 
Integration Object must be used for mapping and integration.

This task is a step in the “Process for Approving an Application.”

Use the following procedure to view application information.

To view the application detail information (brand owner)

1 Navigate to Partner Programs screen > Application Inbox link > Application Detail tab.

2 Select each question in the Question field and review the applicant’s answers in the Answer field. 

Reviewing Application Attachments
The Attachments view is where that attachments that the partner has uploaded appear.

This task is a step in “Process for Approving an Application.”
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Use the following procedure to review attachments associated with the application.

To view the application attachments (brand owner)

1 Navigate to Partner Programs screen > Application Inbox link.

2 Select and drill down on the application you want, and click the Attachments tab.

The attachment(s) display on the Attachments applet.

3 Review all attachments.

Reviewing Application Activities
Brand owner and partner users can monitor the activities associated with approving an application. 
These activities fields can be populated based on an activity plan associated to the partner program. 

This task is a step in the “Process for Approving an Application.”

Use the following procedure to review activities associated with the application.

To view the application activities

1 Navigate to Partner Programs screen > Application Inbox link.

2 Select and drill down on the application you want, and click the Activities tab.

Reviewing the Application Audit Trail
Updates to fields such as Status and Partner Names can be tracked in the Audit Trail. 

This step is a task in the “Process for Approving an Application.”

Use the following procedure to view the audit trail.

To view the application audit trail (brand owner)

1 Navigate to Partner Programs screen > Application Inbox link.

2 Select and drill down on the application you want and click on the Audit Trail tab.

3 In the Date field, select a date and view the information.

Reviewing Application MDF Programs
When the partner’s application status is Approved, all MDF programs that are associated to the 
partner program appear in the MDF Program view. The brand owner can also generate new MDF 
program accounts for the partner from this view as needed.

This task is a step in the “Process for Approving an Application.”

NOTE: The following procedure applies to the Advanced MFD option only. For more information, see 
“Managing the Advanced MDF Option.”
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To view MDF programs associated with the application (brand owner)

1 Navigate to Partner Programs screen > Application Inbox link.

2 Select and drill down on the application you want and click on the MDF Programs tab.

3 Review the MDF programs.

4 Click Generate to generate an MFD program account for that partner.

Accepting a Program Application
After reviewing all the application information, the next step in the approval process is to accept an 
application. This means that the you now own the application and will review it and be responsible 
for approving or rejecting it. 

This task is a step in the “Process for Approving an Application.”

Use the following procedure to accept a program application.

To accept a program application

1 Navigate to > Application Inbox link.

2 Select the program to accept and click Accept.

■ The Current Owner field is filled in with your login.

■ The Status field is Pending.

■ The Accept button in the More Info applet is grayed out.

Approving an Application
After researching and reviewing all the application data, the application owner approves the 
application by clicking Approve on the Application Inbox view.

NOTE: The workflow used in the following procedure is the PPR Auto Approval Workflow.

Approving or rejecting an application is a task in the “Process for Approving an Application.”

Use the following procedure to approve an application.

To approve an application (brand owner)

1 Navigate to Partner Programs screen > Application Inbox link.

2 Select the application and click Approve.

The message, You are approving an application. This will create a membership record for this 
partner. Do you wish to continue?, appears. Click Yes.

The Status field is Approved, and the application becomes read-only.
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Rejecting an Application
If the application should not be approved, you can reject it by clicking the Reject button on the 
Application Inbox. 

Use the following procedure to reject an application.

To reject an application (brand owner)

1 Navigate to Partner Programs screen > Application Inbox link.

2 Select the application and click Reject.

The message, Are you sure you would like to reject this application?, appears. Click Yes.

The Status field is Rejected.

Notifying Partner of Application Approval by Email
When approved to join a partner program, Siebel PRM will alert the partner with an email from the 
brand owner.

Email notification is a workflow or business service that automatically sends a partner an email when 
their application is approved. The brand owner can copy this workflow and modify it for other 
purposes, for example, notifying partners that they were rejected or notifying partners that their 
memberships are about to expire.

Administering Partner Program 
Memberships
When a partner is approved for the partner program, a membership record is automatically created. 
This record is populated with the following data:

■ Start Date. The day the membership begins.

■ End Date. The day the membership expires. After this date the Membership Status will 
automatically change to In Grace Period.

■ Renewal Begin Date. The date after which the partner can apply for renewal. 

■ Renewal End Date. The date after which the partner cannot apply for renewal. When this date 
passes, the Membership Status changes to Expired and the partner must reapply.

■ Renewal Ineligible. A checkbox that, when checked, makes the partner ineligible to renew. 
This field is unchecked by default. 

■ Membership Status. Values are Current Member, In Grace Period, Expired, and Terminated. 
This field is read-only. 

■ Active Flag. This read-only flag indicates whether the partner is an active member in this 
program.
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

147



Partner Programs Administration ■  Partner Programs Workflows
When any of these fields requires an update, you can type over the existing data to change it.

Use the following procedure to review or change the partner membership information. 

To view or change partner membership information (brand owner)

1 Navigate to Partner Program screen > Membership Administration view.

2 Select and drill down on the partner program and then click on the Membership tab.

Program membership data such as membership status and program begin and end dates 
appears.

3 To change existing data, click on each field you want to change and type in the new data.

Associating MDF Programs
Brand owners can associate one or more MDF programs to a partner program.

NOTE: The following procedure applies to the Advanced MDF option only. For more information, see 
“Managing the Advanced MDF Option.”

To add MDF programs to a partner program

1 Navigate to the Partner Program screen > Membership Administration view.

2 Select and drill down on the partner program and then click on the MDF Program tab.

3 Click Add and select one or more MDF Program records.

4 Check the Auto Create Account flag if you want an MDF Program account to be created 
automatically for the selected MDF Program when the partner is approved for membership.

Partner Programs Workflows
The following workflows are related to partner programs maintenance.

■ PPR Auto Approval Workflow. This workflow automatically approves or rejects an initial (or 
renewal) partner program application submitted by a partner user on the PRM Portal. It is 
initiated when the Approval Method field on the Partner Program screen > More Info tab is set 
to Approval List or Approve All.

■ PPR Expire Membership. This workflow automatically sets a partner program member’s 
Membership Status to Expired when both the membership Ends Date and the Renewal End Date 
have passed. This means the partner is no longer an active member of the program. Both fields 
are on the Partner Program > Membership Administration screen > Membership view.

■ PPR Send Approval Email. This workflow sends a notification email to the partner when the 
partner’s application to a partner program has been approved.
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■ PPR Set Partner Program Inactive. This workflow sets the Program Status value to Inactive 
for a partner program when the Program End Date has passed. These fields are on the Partner 
Programs screen > Program Design view.

For more information on working with workflows, see Siebel Business Process Designer 
Administration Guide.
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7 CHAMP Planning
This chapter describes how Siebel PRM is used to support the Channel and Alliance Management 
Process (CHAMP) methodology to develop plans that allow you to work collaboratively with partners. 

This chapter contains the following topics:

■ “About CHAMP Planning” on page 151

■ “Creating CHAMP Metrics” on page 155

■ “Creating Initiatives” on page 157

■ “Using Partner Plans” on page 159

■ “Executing the Plan and Evaluating Performance” on page 167

About CHAMP Planning
The Siebel PRM planning module incorporates the business planning component of the industry-
standard Channel and Alliance Management Process (CHAMP) methodology. CHAMP is an established 
and replicable process that lets brand owners and their business partners work collaboratively to 
develop and execute effective partnerships. 

There are two phases to the CHAMP methodology:

■ CHAMP Partner Planning. Partner planning is a facilitated session designed for an internal 
audience of channel or alliance managers at the brand owner company. The Siebel professional 
helps the channel managers analyze the partner’s business and their own business to find the 
best opportunities for the two companies to work together. This phase produces a business plan 
for the partner relationship. 

■ CHAMP Joint Planning. Joint planning is a facilitated session designed for the brand owner and 
partner. Using the plan that resulted from the CHAMP Partner Planning session as a foundation, 
the two organizations meet face-to-face to define their partnership strategy and business plan. 

The Siebel PRM CHAMP Planning module lets the user create, capture, and track partnership 
initiatives and partner plans. Partner plans include clearly defined objectives, action plans that detail 
how each partner company will achieve its objectives, and metrics for measuring the success of each 
partner in achieving its objectives.

The CHAMP Planning module is included in the Siebel PRM product. Customers purchase the CHAMP 
methodology separately.

Business Scenario
Here is an example of a typical business scenario showing how you might use CHAMP planning:
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■ Your company sells computers and Internet services to consumers and to small and medium 
businesses, depending to a large extent on resellers to go to market. Your company has recently 
outlined a corporate strategy to identify and penetrate new markets for growth and profitability.

■ As part of this corporate strategy, your company has developed an initiative to enter into the 
North American financial services market for small and medium businesses. It has named this 
initiative “Foray into Financial Services,” and has set the revenue goal of $200M for the fiscal 
year 2005 as part of the initiative.

■ To execute the initiative, your company plans to use existing reseller partners who focus on the 
financial services industry. In addition, your company has already run a marketing campaign to 
recruit new reseller partners who focus on this industry and has selected six new partners. 

■ Your company recognizes the importance of carefully mapping out how you will work with each 
partner. Therefore, your company uses the CHAMP Partner Planning methodology to develop a 
strategy for each partner. Then, you invite their key partners to a CHAMP Joint Planning session 
to discuss and agree on the partnership strategy, and to develop detailed goals for the 
partnership. The CHAMP process provides:

■ A clear definition of each company’s reasons for partnering, success metrics, and 
expectations for the partnership. 

■ A better understanding of each company’s business including their growth strategy, products 
and services, and their sales model. 

■ The ability to identify, evaluate, and select the business initiatives that will help the 
partnership succeed. 

■ The ability to assess and track the revenue potential of the partnership. 

■ A business plan for developing and executing the partner relationship. 

■ You use the CHAMP Planning Module in Siebel PRM to create your business plan for the 
partnership. Your partners use the Siebel PRM Portal to:

■ Look up their objectives. 

■ Design detailed action plans to achieve these objectives. 

■ Assign its employees as resources to each of the action plans. 

■ Associate various opportunities with each of its revenue objectives, so it knows how its 
revenue objectives can be achieved.

■ During the plan period and at the end of the plan period, your company uses the Siebel PRM 
Manager to track the performance of each of its partners, compare the performance of its 
partners, and to design incentives for partners based on their performance. At the same time, 
your partners use the Siebel PRM Portal to compare their actual performance with their 
objectives.

Using the Siebel PRM CHAMP Planning Module
To use the CHAMP Planning Module in Siebel PRM, you perform the following high-level steps:
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■ Plan and create a set of appropriate metrics that allow you to measure your partners’ 
performance. You create these metrics before creating any initiatives—they will let you define 
specific objectives for your partners. 

■ Create a new partnership initiative.

■ Create a specific partner plan for each partner company that participates in the initiative. 

■ Execute the plan and evaluate partner performance.

A detailed diagram of the steps the brand owner performs in the CHAMP Planning Module of Siebel 
PRM is shown in Figure 28 on page 154. 

A detailed diagram of the steps the partner performs in the CHAMP Planning Module of Siebel PRM 
is shown in Figure 29 on page 155. 
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You may have other ways of working with your partners. CHAMP planning is not required, but it does 
have a track record of improving the execution, effectiveness, and overall success of partner 
relationships.

Figure 28. Using the CHAMP Planning Module of Siebel PRM (Brand Owner’s Viewpoint)
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Creating CHAMP Metrics
You should create CHAMP metrics before you create any CHAMP plans. 

CHAMP metrics let you categorize CHAMP objectives in ways that let you measure them. For example, 
if you are going to develop a series of CHAMP plans with different partners to increase sales of a 
product, you could create a metric named Sales Revenue. Then, when you evaluate partner 
performance, you can search on the metric field to list the objectives with Sales Revenue as the 
metric, so you can compare the target and actual performance of your partners.

Figure 29. Using the CHAMP Planning Module of Siebel PRM (Partner’s Viewpoint)
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In CHAMP planning, performance is measured using the Target and Actual value fields of each 
objective. The metric defines and categorizes objectives, so you can measure and compare the 
performance of different partners.

NOTE: You should create all the appropriate metrics before creating any CHAMP plans. Analyze your 
CHAMP planning program and decide how you want to use metrics to measure and categorize 
objectives. When you create a specific CHAMP plan, the metrics that you have created are available 
in the picklist of the Metrics field of the plan’s objectives.

Viewing CHAMP Metrics
If you have an ongoing CHAMP planning program, you should view existing CHAMP metrics before 
adding any new metrics. 

To view CHAMP metrics

1 Navigate to the Site Map > Administration screen > List of Values and then click Query. 

The Find List of Values form appears. 

2 In the Type field, enter CHAMP_METRIC_CD and click Go.

A list of Metrics of the type CHAMP_METRIC_CD appears.

Adding New CHAMP Metrics
Before you add new metrics, analyze your CHAMP planning program and decide what metrics you 
will need to measure the performance of your CHAMP participating partners.

To add a new CHAMP metric

1 Navigate to the Administration - Application screen > List of Values. 

2 In the List of Values list, click the menu button, and then click New Record.

The Find List of Values form appears. 

3 In the Type field, enter CHAMP_METRIC_CD. 

4 In the Order field, enter the order in which this metric will appear on the list of values in the 
picklist for the Metric field of Objective records. 

5 In the Display Value field, enter the name for this metric that will appear in the drop-down list 
for the Metric field of Objective records. 

6 Click Language Name, and select the language for this record. 

7 Other fields are optional and are not generally used in CHAMP planning. Complete the other fields 
only if you have a special reason to do so. 

This metric is added to the Metrics drop-down list. 
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Creating Initiatives 
After you have created the appropriate CHAMP metrics, you can begin the CHAMP planning.

The first step in CHAMP planning is to create initiatives to outline your high-level partnership 
strategies.

A partnership initiative is a large-scale or general business strategy that involves working with 
partners. For example, if a computer manufacturer wants to work with its partners to penetrate the 
untapped market segment of financial services, it might create an initiative named Foray into 
Financial Services. It might use existing partners, such as value-added resellers, to work on this 
initiative or form new partnerships with partner companies that have experience in this industry. 

As part of creating an initiative, you should specify which partners will participate in it. 

To create an initiative, you go through the following process:

■ Add an initiative

■ Add partners as participants in the initiative

Adding an Initiative
To create initiatives, you must first add an initiative. 

Use the following procedure to add an initiative.

To add an initiative

1 Navigate to the CHAMP Planning screen. 

From the Show drop-down list, accept the default initiatives. 

2 In the Partnership Initiatives list, click the menu button, and then click New Record. 

3 Enter the information in the following table in the fields of the new record and the fields of the 
More Info form.

Field Comment

Name Enter a name for the initiative.

Description Enter a description of the initiative for your own use. 

Period Select the period for which this initiative is valid.

Start Date The start date of the selected period is entered automatically, based 
on your selection in the Period field. This is a read-only field.

End Date The end date of the selected period is entered automatically, based 
on your selection in the Period field. This is a read-only field.

Target Market Select the market segments toward which this initiative is targeted.
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Adding Partners as Participants in an Initiative
Participants in an initiative are partner companies that are best positioned to work on the initiative. 
You might also form new partnerships with companies that are especially qualified to work on the 
initiative. 

You must add these partners as participants in the initiative.

To add a partner company as a participant in an initiative

1 Navigate to the CHAMP Planning screen. 

From the Show drop-down list, accept the default initiatives. 

2 In the Partnership Initiatives list, select the initiative to which you want to add partners.

3 Click the Initiative Participants view tab.

The Initiative Participants list appears. 

4 In the Initiative Participants list, click the menu button, and then click New Record to add a record 
to the list.

The Add Partner dialog box appears. 

5 Choose one or more partners and click OK. 

The partners are added to the Participating Partners list. 

Target Amount Enter the target amount of money you expect this initiative to 
generate.

Target Quantity Enter the target quantity you expect the initiative to achieve. For 
example, if the goal of the initiative is to get new customer accounts, 
enter the number of new accounts you hope to get.

Actual Amount After the period of the initiative has ended, you will enter the actual 
amount of money this initiative generated.

Actual Quantity After the period of the initiative has ended, you will enter the actual 
quantity this initiative achieved.

Active This read-only field indicates whether the initiative is still active. It is 
automatically set to True on the start date and set to False after the 
end date.

Field Comment
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Using Partner Plans
Partner plans allow brand owner companies to work with their partners to set up joint business plans 
that contribute to initiatives. A partner plan is specific to one partner company. For example, a 
partner plan could have a specific partner company generate $1M in revenues by selling a 300GHz 
server to the financial services customers in the northeastern United States. This plan goal could 
eventually contribute to a larger initiative to generate $500M from the sales of the new 300GHz 
server. These plans include specific objectives for each partner, so that you can measure each 
partner’s performance on this initiative. 

Initiatives are general company strategies, so they are visible only to your company. Plans are 
strategies for working with specific partner companies, and so they are visible to your company and 
to the partner companies that are involved. 

To create and use a partner plan, you go through the following process: 

■ Create a new plan, which involves the following steps: 

■ Add a plan and its highlights.

■ Add objectives for the plan.

■ Associate opportunities with each revenue objective. 

■ Add an Action Plan for each objective with resources for each Action Plan item. 

■ Approve the plan internally and publish it to the partner. 

■ Approve the plan jointly with the partner. 

■ Optionally, add notes to the plan.

Adding a Plan and Its Highlights
The first step to create a new plan is to add a new Plan record, with which you will associate the 
information about the plan.

When you add a plan record, you should also enter the highlights for the plan, which are an overall 
view of the goal, value propositions, and critical success factors for the plan. 

To add a new plan and its highlights from the CHAMP Planning screen

1 Navigate to the Site Map > CHAMP Planning screen > All Plans Across Partners view. 

2 In the Partner Plans list, click the menu button, and then click New Record to add a new record 
to the list.
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3 Enter the information in the following table in the fields of the new record and of the More Info 
form.

4 Click the plan name to drill down to the Plan Objectives view of the CHAMP Planning screen, which 
is used for adding objectives to the plan. 

5 To add other key information about the plan, click the Plan Highlights view tab. 

Field Comment

Name Enter a name for the partner plan.

Partner From the list of partner companies, select the name of the partner for 
which this plan is being created. 

Period Select the period for which the plan is valid. For example, the picklist 
might contain 2005 or Q2 2006.

Period Type This read-only field displays whether the period you selected is a 
quarter, month, year, and so on. 

Start Date This read-only field displays the start date of the period you selected.

End Date This read-only field displays the end date of the period you selected.

Status Select the status of the plan. When you are working on creating the 
plan, select In Progress. When you submit the plan for internal review, 
select Pending Review. Later, as the plan is approved by the internal 
audience, select Internally Approved and when the plan is approved 
both by the internal and the partner audience, select Jointly Approved.

Publish to Partner This field indicates whether the plan is visible to the partner through 
the Siebel PRM Web site. When you are creating the plan, select False. 
Later, after the plan has been internally approved and is ready to be 
approved by the partner, select True.

Active This read-only field indicates whether the plan is still active. It is 
automatically set to True on the start date and set to False after the 
end date.

Created Date The date when the plan record was created is entered automatically. 

Created By 
(Created by Name)

The Login ID of the person who created the plan is entered 
automatically. 

Last Updated
(Updated Date)

The date when the plan record was last modified is entered 
automatically. 

Last Updated By
(Updated By Name)

The Login ID of the person who last modified the plan is entered 
automatically. 
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6 In the Plan Highlights form, enter the information in the following table. 

Adding Objectives to the Plan
Objectives establish specific goals for the partner plan, which are used later to measure the partner's 
success in implementing the plan.

When you create an objective, you enter a target for that objective. After the plan has been 
completed, the actual performance data can be entered manually or automatically.

An objective is defined using metrics. Metrics allow objectives to be measurable and categorized. 
Objectives can be revenue or nonrevenue. For example, “Generate $3M in revenues” is a revenue 
objective while “Train three employees from the partner company” is a nonrevenue objective. To 
allow measurement of both these types of objectives, Siebel PRM allows you to define quantity and 
amount metrics as follows:

■ Quantity. If the objective is a quantity, enter the target quantity when you create the objective 
and enter the actual quantity after the objective is completed. For example, if your company is 
trying to sell a new line of printers, the measure could be the number of printers the partner has 
sold.

■ Amount. If the objective is an amount, enter the target amount when you create the objective 
and enter the actual amount after the objective is completed. For example, if your company is 
trying to achieve $3M in sales by selling a new line of printers, you could measure your partner 
on the amount of sales revenue generated by selling the new line of printers.

Field Comment

Goal Enter the plan’s goal, describing the overall purpose of 
the plan. For example, a plan goal could be Increase 
market share for the new servers by 20% before the end 
of fiscal year 2005.

Value Proposition to My Company Enter a description of the plan’s value proposition to your 
company. For example, the value proposition could be 
Increased market share for my new servers.

Value Proposition to Partner Enter a description of the plan’s value proposition to this 
partner company. For example, the value proposition 
could be New line of business.

Value Proposition to Market Enter a description of the plan’s value to the market. For 
example, the value proposition could be Availability of 
better and high-performance server products.

Critical Success Factors Enter a description of the critical success factors of the 
plan. For example, some of the critical success factors 
could be Timely training and certification of the partner 
in the new server products and Timely execution of 
focused marketing campaigns.
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To enter plan objectives

1 Navigate to the CHAMP Planning screen. 

2 From the Show drop-down list, choose All Plans Across Partners. 

The Partner Plans list appears.

3 In the Partner Plans list, select the plan to which you want to add objectives.

4 Click the Plan Objectives view tab. 

The Plan Objectives list appears. 

5 In the Plan Objectives list, click the menu button, and then click New Record to add a new record 
to the list.

6 Enter information in the following table about the objective in the new record and in the More 
Info form.

Field Comment

Name Enter a name for the objective.

Strategy Enter a general summary of your strategy for how this objective will be 
achieved.

Metric Select the metric that will be used to measure the objective.

Initiative Select the initiative to which this objective is linked.

Internally 
Accountable

Select this flag if your company is accountable for meeting this objective. 
(If both your company and the partner company are accountable, select 
both the Internally Accountable and the Partner Accountable flags.)

Partner 
Accountable

Select this flag if the partner company is accountable for meeting this 
objective. (If both your company and the partner company are 
accountable, select both the Internally Accountable and the Partner 
Accountable flags.)

Target Quantity Enter the target value for the metric associated with this objective. 

Target Amount Enter the target value for the metric associated with this objective. 

Condition Clause Enter a brief description of the condition that must be satisfied.

Training Course Optionally, select the training course that must be completed as part of 
the objective. 

Product Optionally, select the product that the partner must sell, be trained on, or 
work with, as a part of the objective.

Target Industry Optionally, select industries that are targeted as a part of the objective.

Target Market Optionally, select the market that is targeted as a part of this objective.

Fund Optionally, select the market development funds that will be used for the 
objective.
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7 Continue to add new records to the Objectives list until you have entered the objectives for this 
plan. 

Associating Opportunities with Each Revenue Objective
If an objective is a revenue objective—that is, if it has a metric such as sales revenue or some other 
form of direct revenue—you can associate it with an opportunity or opportunities. This feature lets 
you develop a road map of how the revenue target will be achieved in terms of the available 
opportunities.

You can associate one or more opportunities with each revenue objective.

To associate an opportunity plan with a revenue objective

1 Navigate to the CHAMP Planning screen. 

2 From the Show drop-down list, choose Objectives. 

3 In the Plan Objectives list, select the objective with which you want to associate an opportunity. 

4 Click the Opportunity Plan view tab.

The Opportunity Plan list appears.

5 In the Opportunity Plan list, click the menu button, and then click New Record. 

The Add Opportunities dialog box appears. 

6 Choose one or more opportunities and click OK. 

The Opportunity Plans are added to the Opportunity Plan list. 

Actual Quantity At the end of the plan period, enter the actual value for the metric. You 
can do this manually, or if the product has been configured with the 
appropriate workflows or business services, it can be done automatically.

Actual Amount At the end of the plan period, enter the actual value for the metric. You 
can do this manually, or if the product has been configured with the 
appropriate workflows or business services, it can be done automatically. 

Condition Met When the plan has been completed, if the metric has a condition, select 
this flag if the condition clause was satisfied, or leave it unselected if the 
condition clause was not satisfied. 

Shared This flag defaults to True to indicate that this objective is shared with the 
partner and is a CHAMP objective. If you deselect this flag so the 
objective is not visible to the partner, then you should select the 
Internally Accountable flag and deselect the Partner Accountable flag, to 
indicate that your company is solely accountable for this objective. 

Field Comment
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

163



CHAMP Planning ■  Using Partner Plans
Adding an Action Plan and Resources for Each Objective
You should develop a specific action plan for every objective. An action plan is a list of activities that 
your company and the partner company will perform to achieve the objective. 

When you create the action plan, you give each of its activities a planned start date and completion 
date. As you execute the plan, you enter the actual start and completion dates for each activity. If 
an activity is created by a partner or assigned to a partner, your partner should record its progress 
by using the Siebel PRM Portal to enter the begin and completion dates, and you can check its 
progress using the Siebel PRM Manager.

You should also specify the resources that you will have available for each activity in the action plan.

To add an action plan and resources for an objective

1 Navigate to the CHAMP Planning screen. 

2 From the Show drop-down list, choose Objectives. 

The Plan Objectives list appears.

3 Click the Action Plan view tab. 

The Action Plan list appears. 

4 In the Action Plan list, click the menu button, and then click New Record to add a new record to 
the list. Enter information from the following table about the first activity of the action plan in 
the new record’s fields.

Field Comment

Name Enter a name for the activity.

Description Enter a description of the activity. 

Type Enter the type of activity, such as customer visit.

Assigned To The person who created this activity is automatically entered in this 
field.

Status Choose a value to indicate the progress of the activity.

Due Enter the date on which this activity is due. 

Priority Select a value that indicates the importance or urgency of this activity. 

Planned Start Enter the planned start date of the activity. 

Planned Completion Enter the planned completion date of the activity. 

Actual Start When a user begins working on this activity, the user enters the date in 
this field. 

Actual Completion When a user completes this activity, the user enters the date in this 
field. 

% Complete When users work on the plan, they can indicate how close this activity 
is to being completed. 
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5 In the Resources list, enter the resources from the following table that you will have available for 
this activity in the Resources form. 

Approving the Plan Internally and Publishing It to the 
Partner
After a partner plan is created, discuss and approve it internally. You can then publish the plan to 
the partner company, and the partner can view it through the Siebel PRM Portal.

To publish a plan to a partner company

1 Navigate to the CHAMP Planning screen > All Plans Across Partners view. 

2 In the record for the partner plan that you want to publish, click the Publish to Partner field. 

A check mark appears in the field. The partner can now see the plan on the Siebel PRM Portal. 

Account Select the account that is related to this activity.

Programs/
Other Comments

Optionally, enter materials, equipment, any program participation 
information, or other miscellaneous comments.

Last Name Optionally, enter the last name of the contact related to this activity. 

First Name Optionally, enter the first name of the contact related to this activity. 

Associated Cost Optionally, enter the amount of money needed for this activity.

Campaign Optionally, select a campaign that is associated with this activity.

Fund Request Optionally, select a fund request associated with this activity.

Site The location of the selected account. 

Field Comment

Last Name Enter the last name of the person who works on this activity.

First Name Enter the first name of the person who works on this activity.

Job Title Enter the job title of the person who works on this activity.

External 
Organization

Enter the organization of the person who works on this activity, if it is not 
in your own organization.

Email Enter the email address of the person who works on this activity.

Work Phone # Enter the work phone number of the person who works on this activity.

Home Phone # Enter the home phone number of the person who works on this activity.

Alias Optionally, enter an alias for the person who works on this activity.

Field Comment
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Approving the Plan Jointly with the Partner
After the plan is published, the partner company can access the plan through the Siebel PRM Portal 
and can change the action plan by adding new activities, deleting activities, changing the start dates 
of activities, and so on. 

If the partner company has no objections to the plan, it can immediately approve the plan by using 
the Siebel PRM Portal to select Jointly Approved in the Status field. 

If the partner company has made changes to the plan, your company and the partner company 
should review the plan jointly, to make changes that are necessary to make it acceptable to both. 
Once both companies have approved the plan, you can change its status to Jointly Approved. 

To change a plan’s status to Jointly Approved using the Siebel PRM Manager

1 Navigate to the CHAMP Planning screen > All Plans Across Partners view. 

2 In the Status field of the plan, select Jointly Approved.

To change a plan’s status to Jointly Approved using the Siebel PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the CHAMP Planning screen. 

2 In the Partner Plans list, in the Status field of the appropriate plan, the partner selects Jointly 
Approved.

Adding Notes to the Plan
You can add notes when you are creating a plan or when working on the plan after it has been 
approved. Notes let you enter free text comments about the plan. There are two types of notes:

■ Private Notes. These are notes that can be seen only by the person who created the note. These 
notes are used to record miscellaneous information about the plan for your own use. 

■ Shared Notes. These are notes that can be seen by everyone in your company who has access 
to that view and record. These notes are used to share miscellaneous information about the plan. 

To add notes to a plan

1 Navigate to the CHAMP Planning screen > All Plans Across Partners view. 

2 In the Partner Plans list, select the plan to which you want to add a note. 

3 Click the Plan Notes view tab. 

4 Add a new record to either the Shared Notes or the Private Notes list. 
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5 From the following table, enter the note in the new record’s fields.

Executing the Plan and Evaluating 
Performance
After the plan has been jointly approved, your company and the partner company can execute the 
plan.

You should analyze and evaluate the performance of your partner companies while the plan is being 
executed and after the plan is completed.

Evaluating Partner Performance
One of the powerful aspects of CHAMP planning is that it allows you to analyze and measure partner 
performance against the targets set in the partner plans.

While the plan is being executed, you can view the plan periodically to review the partner company’s 
performance. The partner company can also check its performance during the plan period. If the 
actual values are not on track to reach the target values, the problem can be corrected. 

After the plan is completed, you should review the partner’s performance thoroughly, taking action 
to correct problems and rewarding good performance. 

You evaluate the partner’s performance by comparing the values in the Actual Quantity and the 
Actual Amount fields with the target values that you entered when you created the objective as part 
of the partner plan.

After the end date for the plan, you can manually enter the actual values. You can also automate the 
entry of actual values using workflow rules or business services. For example, a workflow could be 
written to populate to the actual values based on transactional data such as opportunities, service 
requests, orders, and so on.

For example, if a partner has a revenue objective of $20 million during the plan period of fiscal year 
2005, then Siebel Business Process Designer can be configured so that, at the end of the plan period, 
it adds the revenues associated with all the opportunities this partner closed during the year and 
enters this computed revenue in the Actual Value field for this objective.

You can also evaluate performance by comparing the performance of different partners.

For more information about Siebel Business Process Designer, see Siebel Business Process Designer 
Administration Guide.

Field Comment

Created The date when the note was created is entered automatically.

Note Type Enter the type of the note. For example, it might be “Directions” or “Reference.”

Note Enter the text of the note.
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To evaluate partner performance across multiple partners

1 Navigate to the CHAMP Planning screen > Performance Across Partners view. 

The Plan Objectives list and Performance Over Time chart appear. 

2 From the following table, choose values in the fields of the Objectives list to view the performance 
of your partners. When a combination of criteria is selected, you will see objectives that meet 
these criteria.

3 Use the Show drop-down list in the chart to toggle between the following charts: 

■ Performance Over Time, which displays the performance of your partners across different 
plan periods for both quantity and amount metrics.

■ Performance On a Metric, which displays the performance of your partners over different 
metrics for both quantity and amount metrics. 

To evaluate partner performance for an individual partner

1 Navigate to the Partners screen > All Partners Across Organizations. 

2 In the Partners list, select the record of the partner you want to evaluate.

3 Click the Partner Performance view tab.

Field Comment

Metric Allows you to choose objectives for a particular metric or the metrics for which 
there are associated objectives. 

NOTE: The Performance On a Metric chart and the Performance Over Time 
chart are valid only if you choose a metric here.

Partner Allows you to choose objectives for a particular partner or the partners in your 
portfolio for which you have a partner plan. 

Plan Allows you to choose objectives for a particular partner plan or all partner 
plans. 

Plan Period Allows you to choose objectives for a particular plan period or all plan periods. 
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4 From the following table, choose values in the fields of the Objectives list to view your partner’s 
performance. When a combination of criteria is selected, you will see objectives that meet these 
criteria.

5 Use the Show drop-down list in the chart to toggle between the following charts: 

■ Performance Over Time, which displays the performance of your partners across different 
plan periods for both quantity and amount metrics.

■ Performance On a Metric, which displays the performance of your partners over different 
metrics for both quantity and amount metrics. 

To display charts evaluating Partner Performance

1 Navigate to the Partners screen. 

2 In the Partners list, choose the partner whose performance you want to evaluate. 

3 Click the Partner Performance view tab. 

By default, Performance Over Time is selected in the Show drop-down list of the Partner 
Performance list. 

4 In the Performance Over Time (Amount) or the Performance Over Time (Quantity) views, use the 
drop-down lists to choose the time periods for which you want to display a chart and the type of 
chart you want to display. 

Charts are displayed showing the partner’s performance during the time period as measured by 
an amount metric or by a quantity metric.

5 Navigate to the Performance On a Metric chart, and in the Plan Objectives list, click the drop-
down lists to choose the metric, the partner, the plan, and the plan period for which you want to 
measure performance. 

6 In the Performance On a Metric (Amount) or the Performance On a Metric (Quantity) views, use 
the drop-down lists to choose the chart you want to display. 

Charts are displayed showing the partner’s performance against this metric for an amount metric 
or for a quantity metric.

Field Comment

Metric Allows you to choose objectives for a particular metric or the metrics for which 
there are associated objectives.

NOTE: The Performance On aMetric and the Performance Over Time charts are 
valid only if you choose a metric here.

Partner Allows you to choose objectives for a particular partner or the partners in your 
portfolio for which you have a partner plan. 

Plan Allows you to choose objectives for a particular partner plan or all partner plans. 

Plan Period Allows you to choose objectives for a particular plan period or all plan periods. 
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Reviewing Partner Performance
After the plan has been completed, you should conduct a thorough review of the partner company’s 
performance. You can see how it performed by comparing the actual values with the target values. 
You may also want to compare that partner with other partners on similar metrics, to see which 
partners are performing the best. 

You should take the following actions based on your evaluation: 

■ For nonperforming partners, you can make changes in future action plan items to make them 
more feasible, you can recommend corrective actions to the partner, or you can take some other 
corrective action, such as giving the partner more training. 

■ Performing partners should be rewarded. For example, you could increase their market 
development funds (MDFs), give them more opportunities, give them awards or recognize them 
for a job well done, or reward them in some other way. 

After you have finished working on an initiative and you have evaluated its success, you can start a 
new planning cycle by creating new initiatives. Your reviews of the partners’ performance and of the 
initiative’s performance will help you plan the next initiative more successfully. 
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8 Sharing Data with Partners
This chapter describes how to share different types of data with partners using Siebel PRM. It covers 
both transactional data and master data. 

This chapter contains the following topics:

■ “About Transactional and Master Data” on page 171

■ “Sharing Transactional Data with Partners” on page 171

■ “Sharing Master Data with Partners” on page 185

About Transactional and Master Data
Siebel applications include two different types of data, which you work with in different ways: 

■ Transactional Data. This is data that users can create, read, edit, and delete, such as 
opportunities, accounts, contacts, and service requests. It can be assigned to individuals, groups 
of individuals (such as a sales team), or to organizations. 

■ Master (or Referential) Data. This is data that users can only read, such as sales literature 
and service solutions. It is usually assigned to groups of users through access groups.

This chapter has a separate section on how to work with each of these two types of data, because 
they are assigned differently.

For more information on making transactional and master data visible to users, see Security Guide 
for Siebel Business Applications.

Sharing Transactional Data with 
Partners
In Siebel PRM, you can assign opportunities, accounts, contacts, service requests, activities, and 
other forms of transactional data either to partner organizations or to individual partner employees. 

How the data is assigned determines its visibility. For example: 

■ If you assign an opportunity to the partner organization, it is visible in the All Opportunities view 
for that organization, but it is not visible in the My Opportunities view for any individual. 

■ If you assign an opportunity to an individual partner employee, it is visible to that person in the 
My Opportunities view. 

Because it is difficult to keep track of individual partner employees, many brand owner companies 
prefer to assign transactional data to partner organizations. If you do this, the partner company must 
give one of its employees the responsibility of looking for new data in the All Opportunities view and 
the other “All” views, and assigning this new data to the appropriate employee. 
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Many of the tasks in this section require you to use the All Across Organizations views. Channel 
managers have these views in the standard configuration of Siebel PRM. If you do not have these 
views, you do not have the appropriate responsibilities in Siebel PRM. Ask your system administrator 
to assign you the appropriate responsibilities. 

This section provides general information about sharing transactional data with partners. 
Subsequent chapters provide specific information about sharing data to manage sales, manage 
service, manage marketing, and manage market development funds (MDFs). 

NOTE: The tasks in this section assume that you have set up the organization structure so each 
partner company is in an organization of its own. If you have set up multiple partner companies as 
subdivisions of a single organization, you generally should assign transactional data to an individual 
and not to an organization. If you assigned these items to an organization rather than an individual, 
they would become visible to all partner companies because they are visible to all divisions that are 
members of that organization. In general, to avoid conflict, you do not want to have the same 
opportunity, account, contact, or service request available to more than one partner company. 

Assigning Opportunities to a Partner
You can assign opportunities to partner employees just as you assign opportunities to your own 
salespeople—manually or using the Siebel Assignment Manager to create rules that automatically 
assign opportunities to partner employees. You can use Assignment Manager to set up rules for 
assigning opportunities based on territory potential revenue, industry segment, and other criteria. 

For example, a software company may get many inquiries from people who want to buy its 
midmarket products through its Web site. If that company does not sell midmarket products directly, 
it can use Assignment Manager to distribute these opportunities to reseller partners based on 
geography. 

Partner employees can also enter opportunities themselves, which are visible to your company as 
well as the partner.

The opportunity you assign to a company as a whole will appear in the All Opportunities view when 
the partner accesses Siebel PRM through the Web, but will not appear in the My Opportunities view 
for any individual. An employee at the partner company who has access to the All Opportunities view 
must assign the information to an individual.

The employee who enters the opportunity is automatically added to the sales team and defaulted as 
the primary on the sales team. The primary on the sales team can only be changed by the primary's 
manager.

For more information about assigning opportunities to partners, see Chapter 9, “Managing Sales.”

For more information about working with opportunities, see the section on opportunities in 
Applications Administration Guide.

For more information about the Assignment Manager, see Siebel Assignment Manager Administration 
Guide.

NOTE: If you want to view the opportunity in the Partner Operations screen, you must assign the 
opportunity to the partner organization. You can also assign it to an individual. 
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To assign opportunities to a partner employee manually

1 Navigate to the Opportunities screen > All Opportunities Across Organizations view.

2 In the Opportunities list, select the opportunity you want to assign to the partner. 

3 In the More Info form, click the select button for the Sales Team Field.

The Sales Team Members dialog box appears. 

4 Click New to add a new record to the list. 

5 In the Add Employees Members dialog box, click New to add a new record to the list. 

6 Select the partner employee you want to assign the opportunity, and click OK. 

7 In the Sales Team Members dialog box, click OK. 

The partner employee is added to the Sales Team list. This partner employee can now view this 
opportunity in the My Opportunities view.

To assign opportunities to a partner company manually

1 Navigate to the Opportunities screen > All Opportunities Across Organizations view.

2 In the Opportunities list, select the opportunity you want to assign to the partner. 

3 In the More Info form, click the select button for the Organization field.

The Organizations dialog box appears. 

4 In the Organizations dialog box, click New to add a new record to the list. 

5 In the Add Organizations dialog box, select the organization you want to assign the opportunity, 
and click OK. 

This partner organization can now view this opportunity in the All Opportunities view.

To work with the opportunities of a partner
■ Modify an opportunity record by selecting a field and changing the information. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete Record.

Viewing a Partner’s Opportunities 
In some industries, partners develop opportunities, and the brand owner company views these leads, 
either to follow up on the leads or to review how well they are progressing. Even if your company 
develops opportunities and assigns them to partners, you can view the opportunities to see how they 
are progressing—for example, by looking at the partner activities for each opportunity.

When you view opportunities, you can use the audit trail to track changes in the opportunity. By 
default, whenevera change is entered in the Sales Stage, Opportunity Status, or Expected Revenue 
field, the audit trail creates a record of how the value was change stamped with the login of the 
employee who made the change and the time the change was performed.
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The record is stamped with the employee login and the time when the change was performed. 

You can view partner opportunities two ways: 

■ The Partner Operations screen. All partner companies are listed on the Partner Operations 
screen. Anyone at the brand owner company with access to this screen can select a partner 
company record and display all its opportunities. This screen displays only opportunities that 
have the partner organization on their organization team; it does not display opportunities that 
have been assigned to individual partner employees but not to the partner organization. 

■ The Opportunities screen. The Opportunities screen displays different sets of opportunities 
records in different views. In My Opportunities view, it displays opportunities only if you are in 
the sales team. In the All Opportunities view, it displays opportunities if your organization is in 
the organization team. In the All Opportunities Across Organizations view, it displays all 
opportunities for all partner companies. 

In either case, you can drill down on an opportunity to view more information about it, if you have 
access to the opportunity detail view. 

It is usually easiest to use the Partner Operations screen to display the opportunities of a partner 
company. 

To view all the opportunities of a partner company

1 Navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose opportunities you want to view.

3 Click the Opportunities view tab. 

The partner’s opportunities appear. 

Assigning Service Requests to a Partner
Customers often have service requests that one of your partners is most qualified to handle. You may 
receive the service request through your call center, and then find that a partner should handle it. 

You can assign service requests to partner employees manually, or you can use Siebel Assignment 
Manager to create rules that automatically assign service requests to the appropriate partner 
employee. 

You can use Assignment Manager to decide which of your employees or your partner’s employees is 
best able to handle a service request by scoring them on the basis of product expertise, territory, 
and many other criteria. Assignment Manager sums the scores for all the criteria and assigns the 
service request to the employee with the highest score.

For example, a large air conditioning manufacturer may rely on third-party technicians to service its 
products. Service requests come in through the manufacturer’s call center, and the manufacturer can 
use Siebel Assignment Manager to assign the service requests to partner technicians based on the 
partner’s locationand expertise. 

If you have set up a partner company as the only division in its organization, you can assign a service 
request to the organization instead of to a specific employee. 
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The service request assigned in this way appears in the All Service Requests view when partners 
access Siebel PRM through the Web, but it does not appear in the My Service Requests view for any 
individual. A person at the partner company who has access to the All Service Requests view must 
assign the service request to an employee.

Employees of partner companies can also enter service requests themselves on behalf of customers, 
and these are visible to your company as well as to the partner company.

For more information about working with service requests, see the chapter on service requests in 
Applications Administration Guide.

For more information on the Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide.

NOTE: Because a service request has only one owner, it is automatically visible in the Partner 
Operations screen under the owner’s company. You do not have to explicitly assign the service 
request to the partner organization to make it visible in the Partner Operations screen. 

To assign service requests to a partner employee manually

1 Navigate to the Service screen > All Service Requests Across Organizations view.

2 In the Service Requests list, select the service request you want to assign to the partner. 

3 In the More Info form for the service request, click the select button of the Owner field. 

The Pick Service Request Owner dialog box appears.

4 Select the record for the partner employee you want to assign the service request, and click OK. 

This partner employee can now view this service request in the My Service Requests view.

To assign a service request to a partner company

1 Navigate to the Service screen > All Service Requests Across Organizations view.

2 In the Service Requests list, select the service request you want to assign to the partner. 

3 In the More Info form for the service request, click the show more button to display the 
Organization field, if necessary. 

4 In the More Info form for the service request, click the select button in the Organization field. 

The Pick Organization dialog box appears.

5 Select the record for the organization you want to assign the service request, and click OK. 

This partner organization can now view this service request in the All Service Requests view.

To work with the service requests you have assigned to a partner
■ Modify a record by selecting a field and changing the information. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete Record.
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Viewing Partner Service Requests
In some business models, the partners receive and log service requests, which you can view for 
tracking purposes. For example, if a partner is a value-added reseller, customers who need service 
will go directly to the partner, with whom they already have a business relationship. 

You can view partner service requests in two ways: 

■ The Partner Operations screen. All partner companies are listed on the Partner Operations 
screen. Anyone at the brand owner company with access to this screen can select a partner 
company record and display all its service requests.

■ The Service screen. The Service screen displays different sets of service request records in 
different views. In the My Service Requests view, it displays service requests only if you are the 
owner. In the All Service Requests view, it displays service requests if your organization is in the 
organization field. In the All Service Requests Across Organizations view, it displays all service 
requests for all partner companies. 

To view the service requests of a partner company

1 Navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose service requests you want to see.

3 Click the Service Requests view tab. 

The partner’s service requests appear. 

Assigning Customer Accounts to a Partner
Your partners must have information about your customers to sell or provide service to them. You 
assign customer accounts to partners in order to give them this information. Employees of a partner 
company can also add new accounts themselves, and these added accounts are visible to you as well 
as to the partner company.

If you assign a customer company to a partner organization rather than to an individual partner 
employee, the assigned account appears in the All Accounts view when partners access Siebel PRM 
through the Web, but does not appear in the My Accounts view for any individual. An employee at 
the partner company who has access to the All Accounts view must get the information and assign 
it to an employee.

For more information about working with accounts, see the section on accounts in .

NOTE: If you want to view the account in the Partner Operations screen, you must assign the 
account to the partner organization. You can also assign it to an individual. 

To assign a customer account to a partner employee

1 Navigate to the Accounts screen > All Accounts Across Organizations view.

2 In the Accounts list, select the account you want to assign to the partner. 
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3 In the More Info form, click the show more button to display the Organization field, if necessary. 

4 In the More Info view, click the select button for the Account Team field. 

The Account Team Members dialog box appears.

5 Click New to add a new record to the list. 

The Add Employees dialog box appears. 

6 Select the record for the partner employee to whom you want to assign the account, and click OK. 

The Account Team Members dialog box appears, with the partner employee added to the list. 

7 In the Account Team Members dialog box, click OK.

This partner employee can now see this account in the My Accounts view.

To assign a customer account to a partner company

1 Navigate to the Accounts screen > All Accounts Across Organizations view.

2 In the Accounts list, select the account you want to assign to the partner. 

3 In the More Info view, click the select button for the Organization field. 

The Organizations dialog box appears.

4 Click New to add a new record to the list. 

5 The Add Organizations dialog box appears. 

6 Select the organization of the partner company for which you want to assign the account, and 
click OK. 

The Organizations dialog box appears, with the partner organization added to the list. 

7 In the Organizations dialog box, click OK.

This partner can now see this account in the All Accounts view.

To view all the accounts of a partner company

1 Navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose accounts you want to see.

3 Click the Accounts view tab. 

A list of the partner’s accounts appears. This list includes accounts that have been assigned to 
the partner organization; it does not include accounts that have been assigned to partner 
employees but not to the partner organization.

To work with the customer accounts of a partner
■ Modify a record by selecting a field and changing the information. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete Record.
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Assigning Contacts to a Partner
Your partners need information about your contacts at your customers in order to sell or provide 
service to them. You can provide this information by assigning contacts at your customer accounts 
to partners. Employees of partner companies can also add new contacts, and these added contacts 
are visible to you.

If you assign a contact to a partner organization rather than to an individual partner employee, this 
contact appears in the All Contacts view when partner employees access Siebel PRM through the 
Web, but does not appear in the My Contacts view for any employee. Someone at the partner 
company who has access to the All Contacts view must assign the contact to an employee.

For more information about working with contacts, see the chapter on contacts in Applications 
Administration Guide.

NOTE: You cannot use the Contacts view of the Partners screen to assign contacts to a partner. Use 
this screen to enter your own business contacts at the partner company.

To assign a contact to a partner employee

1 Navigate to the Contacts screen > All Contacts Across Organizations view.

2 In the Contacts list, select the contact you want to assign to the partner. 

3 In the More Info form for the contact, click the select button for the Contact Team field. 

The Access List dialog box appears.

4 Click Add to add a new record. 

The Add Employees dialog box appears. 

5 Select the partner employee you want to assign to the contact and click OK. You can also select 
multiple employees and click OK to add them all to the access list.

6 In the Contact Team dialog box, click OK.

To assign a contact to a partner company

1 Navigate to the Contacts screen > All Contacts Across Organizations view.

2 In the Contacts list, select the contact you want to assign to the partner. 

3 Scroll right and click the drop-down arrow in the Organization field. 

The Pick Organization dialog box appears.

4 Choose the partner organization, and click OK.

To work with the contacts of a partner
■ Modify a record by selecting a field and changing the information. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete Record.
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Assigning Activities to a Partner
Managers can assign activities to employees and view their activities. A channel manager at the 
brand owner company can assign activities to partners in the same way that managers assign 
activities to employees of their own company. Partners can also add activities that are visible to their 
channel manager at the brand owner company. 

Depending on your company’s business model, you can assign activities to partner employees or just 
view the activities that they enter. 

For more information about working with activities, see the chapter on activities in Applications 
Administration Guide.

NOTE: Generally, you do not use the Activities view of the Partner screen to assign activities to 
partners. This view is generally used to enter your own activities for your work with the partner 
company.

To assign an activity to a partner employee

1 Navigate to the Activities screen > All Activities view.

2 If you want to create a new activity to assign to the partner employee, in the Activities list, click 
menu, click New Record to add a new record to the list, and then enter the details of the activity. 
If you want to assign an existing activity to the partner employee, in the Activities list, select the 
activity. 

3 In the More Info form for the activity, click the select button of the Employees field. 

The Employees dialog box appears.

4 Click New. 

5 In the Add Employees dialog box, select the partner employee to whom you want to assign the 
activity, and click OK. 

The employee is added to the list of employees.

6 In the Employees dialog box, click OK.

To work with the activities of a partner
■ Track a partner employee’s activities by doing a query on the Employees field to display that 

employee’s activities. Then, you can sort on the Due field to display the activities in chronological 
order. 

■ Modify a record by selecting a field and changing the information. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete Record.
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Viewing a Partner’s Quotes
Partner employees enter quotes in Siebel PRM through the Web. Partner relationship managers at 
the brand owner company can see quotes that partner employees have created in the same way they 
see quotes their own employees have created.

The Siebel PRM Manager’s Partner Operation screen lets you view all the quotes of a partner 
company. 

For more information about working with quotes, see Applications Administration Guide.

To view the quotes of a partner employee 

1 Navigate to the Quotes screen > All Quotes Across Organizations view. 

2 In the Quotes list, click the menu button, and then click New Query.

A query form appears.

3 In the Sales Rep field, type the login name of the partner employee whose quotes you want to 
see. 

4 In the Quotes list, click the menu button, and then click Run Query.

All the quotes for that partner employee appear.

To view the quotes of a partner company

1 Navigate to the Partner Operations screen.

2 In the Partners list, select the partner company whose quotes you want to see.

3 Click the Quotes view tab. 

A list of the partner’s quotes appears. Quotes are listed here if they are assigned to the partner 
organization; they are not listed here if they are assigned to a partner employee but not to the 
partner organization. 

Assigning an Order to a Partner Employee
In some industries, it is common for the brand owner company to get orders from customers and 
then assign them to a partner for fulfillment, outsourcing all or part of the order. For example, if a 
bank is providing a mortgage for a customer, it may outsource the appraisal request to a partner. 
You can assign an order to a partner employee or to a partner company. 

In other industries, partners get orders from customers. The partner relationship managers at the 
brand owner company can see all of the orders at a partner company. 

To assign an order to a partner employee

1 Navigate to the Orders screen > All Sales Orders Across Organizations view.

You can also choose the All Service Orders Across Organizations view. 
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2 In the Orders list, select the record for the order you want to assign.

3 In the More Info form for the record, click the select button for the Team field. 

The Order Team Members dialog box appears. 

4 Click New. 

The Add Employees Dialog box appears. 

5 Select the partner employee to whom you want to assign the order and click OK.

The employee is added to the Order Team Members dialog box. 

6 In the Order Team Members dialog box, click OK.

The order will be visible to this partner employee in the My Orders view.

To assign an order to a partner company

1 Navigate to the Orders screen > All Sales Orders Across Organizations.

You can also choose the All Service Orders Across Organizations view. 

2 In the Orders list, select the record for the order you want to assign.

3 In the More Info form for the record, click the select button for the Organization field. 

The Organizations dialog box appears. 

4 Click New. 

The Add Organizations Dialog box appears. 

5 Select the organization of the partner company to which you want to assign the order and click 
OK.

The organization is added to the Organizations dialog box. 

6 In the Organizations dialog box, click OK.

The order will be visible to this partner organization in the All Orders view.

To view the orders of a partner company

1 Navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose orders you want to view.

3 Click the Orders view tab. 

A list of the partner’s orders appears. This list includes orders that have the partner organization 
assigned to the order; it does not include orders that have partner employees assigned to them 
but do not have partner organizations assigned to them. 
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Assigning Assets to Partners
Field service businesses use the Assets screen for tracking and managing assets, which can be 
installed at customers’ locations or can be stored at their own warehouses and inventory locations. 

Users can select an asset in the Assets screen and click the view tabs to view the service requests, 
entitlements, warranty, components, uptime data, repairs, preventive maintenance, and other 
information for this asset, providing the field service business with information used for preventive 
maintenance, repairs, billing, and marketing.

You can enter this information about assets using either the Siebel PRM Manager or Siebel Field 
Service. Your partners can view it using the Siebel PRM Portal. 

Because only one partner company provides field service for a given asset, you can assign an asset 
to only one organization. Employees of that organization can then see the asset in the All Assets 
view. 

If a partner employee owns a service request, that partner employee can view the asset associated 
with the service request only if the employee has access to the All Assets view. 

For more information about working with assets, see Siebel Field Service Guide. 

For a business scenario illustrating how brand owners and partners can work together using assets, 
see “The Partner Responds to Service Requests for Assets” on page 233. 

NOTE: For the asset to be visible to the partner, the asset’s organization must match the partner’s 
organization. When you are upgrading to a new version, assets may be assigned to the default 
organization, while partner contacts remain part of the partner organization. If so, the partner 
contacts will not be able to see the assets.

To assign an asset to a partner company

1 Navigate to the Assets screen.

2 In the Assets list, select the asset that you want to assign to the partner company.

3 In the More Info form, click the show more button to expand the form. 

4 In the More Info form, in the Organization field, click the select button.

5 In the Pick Organization dialog box, select the organization of the partner company and click OK.

The asset and the information associated with it are visible to users in this partner company in 
the All Assets view. 

Assigning Inventory to Partners
Field service businesses use the Inventory screen to manage parts through their life cycles and to 
monitor parts consumption during order fulfillment and field. Mobile field service engineers also use 
the Inventory screen to manage their trunk inventories using a disconnected client.
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The Inventory screen lists locations where inventory is stored. Users can select a location and click 
the view tabs to display the product inventory for the location, pending orders, vendors, and other 
information, and can also use one view to generate orders. 

You can enter this information about inventory and generate orders using either the Siebel PRM 
Manager or Siebel Field Service. Your partners can view this information and generate orders using 
the Siebel PRM Portal. 

You can use the Position field of the Inventory Location record to assign the record to one person, 
who would see it in the My Inventory Locations view. In general, you assign the record to a manager 
at the brand owner company in this way. 

To share inventory with partners, assign an inventory location to a partner organization. Employees 
of that partner company can then see it in the All Inventory Locations view. 

For more information about working with inventory, see Siebel Field Service Guide. 

For a business scenario illustrating how brand owners and partners can work together using assets, 
see “The Brand Owner and Partner Manage Inventory” on page 231. 

To assign an inventory location to a partner company

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, select the location that you want to assign to the partner 
company.

3 In the More Info form, in the Organization field, click the select button.

4 In the Organizations dialog box, click the New button.

5 In the Add Organizations dialog box, select the organization of the partner company and click OK.

6 In the Organizations dialog box, click OK.

The Inventory location and the information associated with it are visible to users in this partner 
company in the All Inventory view. 

Sharing Files with Partners
You can share files with your partners. For example, you can give them a copy of a report you have 
written about an opportunity or get a copy of a report they have written. 

Both the brand owner and partner company can share files by attaching the files to opportunities, 
service requests, or fund requests. Both can also view or delete an attachment to an opportunity, 
service request, or fund request. 

NOTE: Do not add an attachment to the partner’s record in the Partner screen to share a file with 
the partner. Attachments to partner records are purely for your own use in managing these partners. 
To share attachments with a partner, you must add the attachments to opportunities, service 
requests, or fund requests that the partner can access. 
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To add an attachment to an opportunity assigned to a partner employee

1 Navigate to the Opportunities screen > All Opportunities Across Organizations view. 

2 In the Opportunities list, select an opportunity you have assigned to the partner employee. 

3 To make sure you have assigned that opportunity to a partner, you can click the Sales Team view 
tab. 

The Sales Team view appears, and it must include the partner employee’s name. If it does not, 
find an opportunity that does include the partner on the team, and add the attachment to that 
opportunity. 

4 Click the Attachments view tab to view attachments for that opportunity. 

5 In the Attachments list, click the menu button, and then click New Record to add a record to that 
list. 

6 In the new record, click the select button in the Attachment Name field. 

7 In the Add Attachment dialog box, click Browse next to the File Name text box. 

8 Browse to select the file you want, and click Open. 

9 In the Add Attachment dialog box, click Add. 

To add an attachment to a service request assigned to a partner employee

1 Navigate to the Service screen > All Service Requests Across Organizations. 

2 In the Service Requests list, select a service request you have assigned to the partner employee. 

3 To make sure you have assigned that service request to a partner, look at the Owner field, which 
must display the partner employee’s name.

4 Click the Attachments view tab to display attachments for that service request. 

5 In the Attachments list, click the menu button, and then click New Record to add a new record 
to that list. 

6 In the new record, click the select button in the Attachment Name field. 

7 In the Add Attachment dialog box, click Browse next to the File Name text box. 

8 Browse to select the file you want, and click Open. 

9 In the Add Attachment dialog box, click Add. 

To add an attachment to a Market Development Fund request

1 Navigate to the Market Development Fund Requests screen > All Fund Requests view. 

2 In the Fund Requests list, select a fund request of the partner company. The company’s name 
must appear in the Partner field. 

3 Click the Fund Request Attachments view tab to display attachments for that fund request. 

4 In the Attachments list, click the menu button, and then click New Record to add a new record 
to that list. 
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5 In the new record, click the select button in the Attachment Name field. 

6 In the Add Attachment dialog box, click Browse next to the File Name text box. 

7 Browse to select the file you want, and click Open. 

8 In the Add Attachment dialog box, click Add. 

Sharing Master Data with Partners
Master data is assigned to groups of employees rather than to individual employees. It is most 
common to assign the following types of master data to your partners:

■ Literature. These are documents used to sell or understand your products, such as sales 
brochures and technical background information. 

■ Solutions. These are answers to common service requests. 

■ Training Courses. These are courses administered through the the Site Map > Siebel 
Administration - Training screen. 

■ Products. These are the goods or services that you sell. 

■ Price Lists. These are the prices you charge this partner for the goods or services that you sell. 

In addition, auction items, competitors, decision issues, events, resolution items, and response 
templates can also be assigned to categories. 

For most master data, visibility is controlled by using catalog visibility. This mechanism lets you 
categorize master data into catalogs. The value in the catalog’s Type field must be Partner for the 
catalog to be visible in the Siebel PRM Portal. 

You control visibility to these catalogs using access groups, which are groups of different parties in 
your Siebel environment. Partner communities are a type of access group that you use to group 
partners, so you can give groups of partners access to the same catalogs of master data. For 
example, you might have a catalog specifically for Partner Literature, and you might give all partner 
communities visibility to this catalog. You might have a catalog for a specific product line, such as a 
catalog of all literature, solutions, products, and training courses related to your line of server 
products. You might put all resellers who sell your line of server products into one partner 
community, so you can give this group of partners visibility to this server catalog.

You can also create public catalogs, which have no visibility restrictions, to provide master data 
visibility to unregistered users and individual partners.

To assign most types of master data to partners, you add the partner company to the appropriate 
access group. Make sure your channel operations manager has set up the appropriate access groups 
and categories of master data. Then, any partner company that you add to the access group will have 
access to all the master data in the categories visible to that access group. 

The exception is price lists, which are usually assigned to smaller groups of partner companies than 
other types of master data. For example, you may assign master data to an access group called 
Resellers, but you may have a different price list for each reseller, or you may have a standard price 
list for most resellers but special price lists for five of your resellers. Assigning price lists to access 
groups would limit the utility of the access groups, because price lists often do not follow the same 
rules as other master data.
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For more information about master data, categories, and user groups, see Security Guide for Siebel 
Business Applications. 

To assign master data to partners, you must go through the following process:

■ Create categories and access groups

■ Add partner companies to access groups

■ Assign price lists to partner companies

In addition, when you produce new master data, such as new sales brochures, you must add them 
to the appropriate category to make them visible to your partners.

Creating Categories and Access Groups 
Before partner managers assign any master data to partner companies, the channel operations 
manager or system administrator must analyze the way you need to share master data with your 
partners and create the appropriate categories and access groups. 

Though most of the work of setting up catalogs and access groups is done when you first set up 
Siebel PRM, you can add catalogs and access groups to the application at any time. Some examples 
of when you would add them are as follows: 

■ If you launch a new product line, you would probably want to add a new catalog or to add new 
categories to an existing catalog for information about that product line.

■ If you restructure your partner program, you might have to rework your system of access groups 
completely.

You would also want to continuously add information to catalogs as more data is created and made 
available. For example, you would need frequent updates to catalogs as you create new FAQs and 
new product data sheets or brochures. 

For more information on creating categories and access groups, see Chapter 3, “Setting Up Siebel 
PRM.”

Adding Partner Companies to Access Groups
After categories and access groups have been set up properly, you assign a partner company to the 
appropriate access group to give it visibility to all the master data associated with that access group. 

For example, you may have access groups for resellers, value added resellers, service providers, and 
system integrators. If you form a new partnership with another service provider, you associate it with 
the appropriate access group to give it visibility to your sales literature, training courses, and other 
master data that service providers need. You do this when you first enroll the new partner in your 
partner program and create a Partner record. 

Partner communities are the type of access group used specifically to group partner companies. It is 
useful to have partner communities, because you can identify which access groups are used to 
manage partners and which are used for other purposes. When Siebel PRM users add access groups, 
they should use partner communities.
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If you add a new partner program—for example, if you launch a new product to a select group of 
resellers—you would create new partner communities so you can give these partners access to the 
information they need about the product. These partners would probably still belong to the same 
partner communities as before, but they would also belong to this new one in order to get access to 
specific information about this new product they are reselling. 

You might create several new groups for resellers of this product line, named Authorized, Silver, 
Gold, and Platinum. Each group would have access to different data sets. You could also use the 
inheritance rules to set up these groups hierarchically. For example, if you are in the Platinum group 
you see everything that Gold sees plus the information specific to your group; if you are in the Gold 
group, you see everything Silver sees plus the information specific to your group; if you are in the 
Silver group, you see everything authorized resellers see plus the information specific to your group. 
Inheritance rules give you flexibility in modeling relationships among groups.

If you do not know which access group to use, ask the partner operations manager who set up access 
groups in your company. 

To add a partner company to an access group

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view. 

2 In the Partners list, select the record for the partner company that you want to add to a 
community and click the Access Groups view tab. 

3 In the Access Groups list, click the menu button, and then click New Record. 

4 In the Add Access Groups dialog box, select the group or groups to which you want to add the 
partner. If necessary, use queries to find these groups, and click Add. 

Adding Master Data to Categories
Using access groups makes it easy to assign new master data to partner companies. For example, 
when you create a new sales brochure, you just have to associate it with the appropriate category. 
If categories and access groups have been set up correctly, the brochure is visible to all your partners 
who are in access groups associated with that category. 

For example, when you come out with a new datasheet for a new version of an existing product, or 
when you launch a new product line and build a new catalog about that product line, you would 
perform the following process tasks:

■ If you are creating a new catalog for the new data, ask your channel operations manager to help 
you set up the new catalog structure and to associate it with the appropriate access groups. To 
add master data, you must understand the structure of access groups and categories that the 
partner operations manager has set up. 

■ Create the new master data content, such as new literature or new solutions. 

■ After the content is finished, add it to the database by navigating to the appropriate screen (for 
example, the Literature or Solutions screen) and adding a new record for the content file. If you 
are adding a whole catalog, you would add multiple items on each screen and categorize the 
items as you add them.
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■ Add each item to the correct category, by either navigating to the Category view in the screen 
where you added the item or by navigating to the Administration - Catalog screen, displaying the 
correct category, and adding the item. (If you are associating existing master data with 
categories, it is generally easier to use the Administration - Catalog screen. If you are creating 
new master data content, it is generally easier to use the Administration - Catalog screen > 
Category view where you added the data.) All of the partners in partner groups associated with 
these categories will have visibility to the data.

NOTE: The following two procedures show how to associate literature with a category. You associate 
other types of master data in exactly the same way, using the other view tabs instead of the 
Literature view tab or using other screens instead of the Literature Administration screen. 

To associate literature with a category using the Catalog Administration screen

1 Navigate to the Administration - Catalog screen. 

2 In the Catalogs list, click the name of the catalog that contains the category with which you want 
to associate the literature to drill down into that catalog. 

A Categories list appears that contains that category. 

3 Select the Category with which you want to associate literature. 

4 Click the Literature view tab.

The Literature view appears.

5 In the Literature list, click the menu button, and then click New Record.

The Add Literature dialog box appears. 

6 If necessary, enter criteria for a search and click Go. 

7 Select the literature item that you want to associate with the category, and click OK. 

The literature is associated with the category. 

To associate literature with a category using the Literature Administration screen

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, add a new literature item, or select the record for the literature you want 
to associate with a category. 

3 Click the Category view tab.

4 In the Category list, click the menu button, and then click New Record.

The Add Subcategories dialog box appears. 

5 Select the category with which you want to associate the literature, and click OK. 

The literature is associated with the category. 
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Assigning Price Lists to Partner Companies
In order for a partner to access your company’s products, you must assign it a price list as well as a 
buying catalog. 

Buying catalogs are catalogs that contain products you sell. They are set up in the same way as other 
catalogs, which were discussed earlier in this section. For example, you can give different internal 
divisions and partners access to different buying catalogs in the same way that you give them access 
to different literature catalogs. A buying catalog must have the value “Buying” in the Catalog Type 
field. 

CAUTION: If you do not set the Catalog Type to Buying, users will be able to see products in the 
InfoCenter and All Product Lists view, but the Catalog screen will be empty. 

Buying catalogs do not contain prices. Price lists are stored separately from buying catalogs to give 
you greater flexibility. You could use this flexibility in several ways—for example: 

■ All resellers of a certain product line might have access to the same catalog; you put them all in 
the same access group, and you give the group access to the catalog. However, you might give 
resellers a discount that is determined by sales volume, so each reseller needs a different price 
list. 

■ All resellers of a certain product line might have access to the same catalog and to the same price 
list. In this case, there are no volume discounts and no special deals. Regardless of what product 
lines you sell, you pay the same price. 

Price lists should contain prices for every product; products are visible only if they are included in 
the price list as well as in the catalog. Each partner should be assigned a price list; you can assign 
the same price list to multiple partners, or assign a unique price to each partner if necessary. 

For more information about creating pricing models and price lists, see Pricing Administration Guide. 

To assign a price list to a partner organization

1 Make sure the price list to be assigned has already been created in the Siebel PRM Manager or 
some other Siebel Business application.

2 Navigate to the Site Map > Administration - Partner screen > Registered Partners view. 

3 Select the record for the partner company for which you want to assign a price list.

4 Click the Price Lists view tab. 

The Price Lists list appears. 

5 In the Price Lists list, click the menu button, and then click New Record. 

The Add Price Lists dialog box appears.

6 Select the price list you want to assign to the company, and click OK.

The Price Lists list appears with the price list that you selected added to it. 
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9 Managing Sales
This chapter describes scenarios that illustrate different ways that you can use Siebel PRM to manage 
sales. It also describes tools that Siebel PRM provides to help you manage sales. 

This chapter contains the following topics:

■ “About Managing Sales” on page 191

■ “Scenarios for Partner-Led Sales” on page 192

■ “Scenarios for Collaborative Selling” on page 199

■ “Opportunity Management Workflows” on page 207

■ “Scenarios for Forecasting Partner Sales” on page 207

■ “Using Presentations and Proposals” on page 216

■ “Using Incentive Compensation” on page 218

About Managing Sales
This chapter describes sales scenarios that are examples of how you might use Siebel PRM to manage 
sales. It is not comprehensive; it simply gives you an idea of the many ways that Siebel PRM can be 
used. The sales scenarios fall into the following categories:

■ Partner-led sales. Partner sales agents work on opportunities generated by either the partner 
or brand owner company. 

■ Collaborative sales. Partners and the brand owner work on opportunities together.

This chapter includes scenarios illustrating how the brand owner and partner can work together. For 
information about how partners can work with other partners, see Chapter 13, “Partner-to-Partner 
Collaboration.”

In addition to these sales scenarios, this chapter describes these tools that are useful in managing 
sales:

■ Forecasting. You have several ways of forecasting partners’ sales, and this chapter provides 
forecasting scenarios.

■ Presentations and Proposals. You can create templates for presentations and proposals, 
which your partners can use to generate specific sales presentations and proposals. 

■ Incentive Compensation. You can set up incentive plans that give partners added 
compensation for selling specific products. 
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Scenarios for Partner-Led Sales
The partner works on the opportunities in the following scenarios:

■ The brand owner creates opportunities and assigns them to partners. 

■ The brand owner creates opportunities and transfers them to partners. 

■ Partners create and work on opportunities.

Brand Owner Creates Opportunities and Assigns Them 
to Partners
In this scenario, opportunities are created by the brand owner company and assigned to specific 
partners. 

This scenario applies to you if you generate opportunities through your marketing campaigns and 
you can clearly determine which partner should follow up on each opportunity—for example, because 
each partner specializes in a different geographical territory or in a different product line. 

This scenario consists of the following steps:

■ Step 1. The brand owner enters the opportunities 

■ Step 2. The brand owner assigns the opportunities to partners 

■ Step 3. Partners view, work on, and update the opportunities 

■ Step 4. The brand owner tracks the opportunities 

Step 1: The brand owner enters opportunities
You may gather opportunities in a number of different ways—for example, at trade shows, through 
marketing campaigns, or through your Web site. The first step in working with an opportunity is to 
enter it into your Siebel application. When you enter an opportunity, you are automatically added to 
the sales team as the primary.

If opportunities have already been entered in another application, you can import them into your 
Siebel application using Siebel Enterprise Integration Manager (EIM) or Siebel Business Application 
Integration (EAI). For example, you may get opportunities through a Web site that stores them in 
another format, and then import them into the Siebel PRM Manager. 

For more information about EIM, see Siebel Enterprise Integration Manager Administration Guide. 

For more information about EAI, see Overview: Siebel Enterprise Application Integration. 

For more information about working with opportunities, see the section on opportunities in Siebel 
Sales User Guide  and Applications Administration Guide.

To enter a new opportunity

1 Navigate to the Opportunities screen. 
Siebel Partner Relationship Management Administration Guide Version 7.8, 
Rev. A

192 



Managing Sales ■  Scenarios for Partner-Led Sales
2 In the Opportunities list, click New to add a new record to that list.

3 Enter information about the opportunity in the new record. 

Step 2: The brand owner assigns opportunities to partners
Next, assign the opportunities to the appropriate partner. You can do this manually, but it is generally 
better to use Siebel Assignment Manager to assign the opportunity by creating rules based on 
partners’ skills, expertise in a specific product, language ability, territory, workload and availability, 
or other criteria. 

For example, you might assign all opportunities in Illinois for one of your product lines to a partner 
who is located there and has expertise in that product line. 

You can assign opportunities to partners in two ways:

■ Assign opportunities to the partner company. To assign an opportunity to a partner 
company, enter that company’s organization in the Organization field of the Opportunity record. 
The opportunity will be visible in the All Opportunities view for that organization, but it will not 
be visible in the My Opportunities view for any employee of the organization. The partner 
company must designate a person who has visibility to the All Opportunities view to find these 
new opportunities and assign them to the appropriate employee. 

■ Assign opportunities to partner employees. To assign an opportunity to a partner employee, 
you enter the employee’s name in the Sales Team field of the Opportunity record. The 
opportunity will be visible in the My Opportunities view for that employee. 

You can either assign the opportunities manually, or you can set up Assignment Manager to assign 
them automatically. Assignment Manager can add partner organizations to the opportunity’s 
Organization field or add partner employees to the opportunity’s Sales Team field. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 

Step 3: Partners view and work on the opportunity
After the opportunity has been assigned, partner employees work on it using the Siebel PRM Portal: 

■ If the opportunity was assigned to a partner employee, that employee will be on the sales team 
and can see the opportunity in the My Opportunities view. 

■ If the opportunity was assigned to a partner organization, it will appear in the All Opportunities 
view, but it will not appear in the My Opportunities view of any employees until partner 
employees are added to the sales team.

As partner employees work on an opportunity, they update information about that opportunity. For 
example, they may update activities related to the opportunity, create proposals and presentations 
for the opportunity, create quotes for the opportunity, and update contacts for that opportunity.

As partner sales agents learn more about the opportunity and get a clearer sense of the deal size, 
they can update the revenue items associated with the opportunity. The expected revenue, sales 
stage, and probability fields of the revenue record will give you crucial information about the 
opportunity.
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For more information about opportunities and revenue, see Siebel Sales User Guide and Applications 
Administration Guide. 

To add a revenue item to an opportunity using the Opportunities screen of the Siebel 
PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the Opportunities screen. 

2 In the Opportunities list, the partner selects the opportunity to which revenue line items will be 
added. 

3 The partner clicks the Revenues view tab. 

4 In the Revenues list, the partner clicks the menu button, and then clicks New Record. 

A new record is added to the revenues list. 

5 In the new record, the partner enters information about product, quantity, price, type, and 
probability. 

The revenue field is calculated automatically based on values in the price and quantity fields.

6 In the Revenues list, the partner clicks the menu button, and then clicks Update Opportunity. 

The Revenue and Expected Revenue fields of the opportunity are updated.

To add a revenue item to an opportunity using customer quotes in the Siebel PRM 
Portal 

1 In the Siebel PRM Portal, the partner navigates to the Opportunities screen > My Opportunities 
view.

2 The partner selects the Opportunity record upon which the quote will be based. 

3 The partner clicks the Quotes tab, and in the Quotes list, the partner clicks the menu button, and 
then clicks New Record. 

4 The partner enters information about the new quote including the name of the quote, the price 
list that will be used for the quote, order terms, shipping terms, billing details, and shipping 
details. The prices from the price list that is selected will be entered automatically for the items 
that are selected. 

The partner can see the new quote in the Quotes list.

5 The partner drills down on the quote record that was just created.

6 In the Line Items list, the partner clicks the menu button, and then clicks New Record.

7 In the new Line Item record, the partner enters the product, quantity, and other information.

8 The partner continues to add new line items, until the line items for the quote are added. 

9 In the Quotes list, the partner clicks Update Opportunity. 

The opportunity is updated with information from the line items of the quote. The revenues 
associated with the quote and the opportunity reflect prices from the selected price list.
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Step 4: The brand owner tracks the opportunity
You can track a partner’s progress on opportunities by displaying the opportunities, looking at the 
activities attached to them, and looking at the status field of each opportunity to see if the sale has 
been closed. 

Because you created the lead in this scenario, you are automatically the primary on the sales team. 
You can drill down on the opportunity record to view detail information about the lead. If you were 
not on the opportunity sales team, you could view this record in the Partner Operations screen, but 
you could not drill down into the opportunity record and view details. 

NOTE: The Partner Operations screen displays opportunities if the partner company is listed in the 
Organization field. 

To track a partner company’s opportunities

1 Navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose opportunities you want to see.

3 Click the Opportunities view tab. 

The partner’s opportunities appear. 

4 Click the name of an opportunity. 

The Opportunity form appears. 

5 Click the view tabs to display information associated with that opportunity, such as revenues and 
activities.

Brand Owner Creates Opportunities and Transfers Them 
to Partners 
All the other scenarios in this chapter assume that you are working with partners who use the Siebel 
PRM Portal. However, you can also share opportunities with partners who do not use the Siebel PRM 
Portal by using opportunity transfer to move opportunity data to the partner’s customer relation 
management (CRM) system. 

The brand owner can initiate the opportunity transfer. After the opportunity has been transferred, 
the brand owner may send updates to the partner that update the opportunity in the partner’s 
system, and the brand owner may query the partner’s system to receive updated information about 
the opportunity. 

If the partner uses Siebel PRM or some other CRM system that supports opportunity transfer, the 
partner can also initiate an opportunity transfer, and then send updates to the brand owner’s system, 
or query the brand owner’s system to receive updates. 

This business scenario for using opportunity transfer is similar to “Brand Owner Creates Opportunities 
and Assigns Them to Partners” on page 192. It also applies to you if you generate opportunities 
through your marketing campaigns and you can clearly determine which partner should follow up on 
each opportunity. However, it is appropriate when you are working with large partners who have their 
own CRM systems and do not use the Siebel PRM Portal. 
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This scenario shows how to transfer opportunities and send and receive updates manually. In 
practice, a brand owner can use Siebel Business Process Designer to automate the processes of 
transferring opportunities to partners and of sending and receiving updates. 

This scenario consists of the following steps:

■ Step 1. The brand owner sets up the ASIs for opportunity transfer 

■ Step 2. The brand owner enters an opportunity and transfers it to a partner 

■ Step 3. The partner views, works on, and updates the opportunity 

■ Step 4. The brand owner tracks the opportunity 

Step 1: The brand owner sets up the ASIs for opportunity transfer
Opportunity transfer uses Siebel’s Application Services Interfaces (ASIs) to synchronize your Siebel 
database with the partner’s CRM system. 

Before you can transfer opportunities, you must set up the appropriate ASIs. There are three ASIs 
used for opportunity transfer—one to initiate the opportunity transfer data, one to send updates to 
the partner’s system, and one to query the partner’s CRM system to receive updates. 

For more information on setting up ASIs, see Chapter 4, “Setting Up Application Services Interfaces.”

Step 2: The brand owner enters an opportunity and transfers it to a partner
The brand owner gathers and enters information about the opportunity in the same way described 
in the previous scenario, “Brand Owner Creates Opportunities and Assigns Them to Partners” on 
page 192. However, after entering the data, the brand owner clicks the Transfer Opportunity button, 
rather than assigning ownership of the opportunity to a partner company or partner employee. 

To enter a new opportunity

1 Navigate to the Opportunities screen. 

2 In the Opportunities list, click New to add a new record to that list.

3 Enter information about the opportunity in the new record. 

4 In the Organization field for the new record, select the partner organization. 

5 Click the Transfer Opportunity view tab. 

6 In the Transfer Opportunity form, click Transfer Opportunity. 

A list of partners appears, including all partners who are set up for opportunity transfer. 

7 Select the partner to whom you want to transfer the opportunity, and click OK.

The opportunity is transferred, and the Transfer Status field is updated with a value that specifies 
whether the transfer was successful. 
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Step 3: Partners view and work on the opportunity
After the opportunity has been transferred, partner employees work on it in the same way they would 
work on any opportunity in their CRM system. 

When the opportunity is transferred, all the contacts, revenues, notes, and activities associated with 
it are also transferred to your partner’s CRM system, and converted to the data used in that system. 
For example, if your partner’s system uses the word “lead” instead of “opportunity,” the opportunity 
will appear to the partner as a Lead record. 

Step 4: The brand owner tracks the opportunity
You can track a partner’s progress on opportunities by using opportunity transfer to query the 
partner’s CRM system and to update the opportunity record and related information back in the 
Siebel PRM Manager. 

For example, if the partner’s CRM system supports equivalent data, you can look at the Activity 
records attached to the opportunity, and look at the status field of each opportunity to see if the sale 
has been closed. If the partner has updated the revenue associated with the opportunity, you can 
use the Revenue record in your forecasting. 

NOTE: You can receive an update from a partner only if you already transferred the opportunity to 
the partner or if the partner transferred the opportunity to you. 

To query the partner’s database to update an opportunity

1 Navigate to the Opportunities screen. 

2 In the Opportunities list, select an opportunity that has been transferred to a partner.

3 Click the Click the Transfer Opportunity view tab. 

4 In the Transfer Opportunity form, click Receive Update, and click OK to confirm the action. 

Siebel PRM Manager queries the partner’s system for an update of the opportunity. 

Partners Create and Work on Opportunities
In this scenario, opportunities are created by the partner company and logged by the partner 
company for tracking purposes. Using the Siebel PRM Portal, sales agents at the partner company 
can enter opportunities they develop, share these opportunities with other agents at the partner 
company, and track the opportunities as they work on them. Using the Siebel PRM Manager, the 
channel manager at your company can also track the opportunities’ progress at partner companies. 

This scenario consists of the following steps:

■ Step 1. Partner sales agents enter opportunities 

■ Step 2. Optionally, partner sales agents share opportunities with other partner sales 
agents 

■ Step 3. Partner company managers track their reports’ opportunities 
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■ Step 4. The brand owner’s channel manager tracks the opportunities at the partner 
company 

Step 1: Partners enter opportunities
In this scenario, your partners develop new opportunities and enter them into the Siebel system 
using the Siebel PRM Portal. When a partner enters an opportunity, the partner is automatically 
added to the Sales Team field as primary and the partner organization is automatically added to the 
Organization field. 

To enter a new opportunity through the Siebel PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the Opportunities screen. 

2 In the Opportunities list, the partner clicks the menu button, and then clicks New Record to add 
a new record to that list.

3 The partner enters information about the opportunity in the new record. 

Step 2: Partners share opportunities 
Optionally, if the partner sales agent who entered the opportunity thinks that other sales agents at 
the partner company can help work the opportunity, then the agent can share the opportunity with 
the other agents by adding them to the Sales Team field. By default, the partner sales agent who 
added the record is the primary on the sales team. 

The partner sales agents on the sales team will see the opportunity whenever they display the My 
Opportunities view, and they can modify the opportunity record as they work on the opportunity. 

For more information about an end user’s work with opportunities, see Siebel Sales User Guide. 

To share an opportunity with other partner sales agents

1 In the Siebel PRM Portal, the partner navigates to the Opportunities screen. 

2 In the Opportunities list, the partner selects the opportunity to be shared. 

3 In the More Info view tab, the partner clicks the select button of the Sales Team field. 

The Sales Team Members dialog box appears. 

4 In the Sales Team Members dialog box, the partner uses the query function to find other partner 
employees to be added to the sales team, clicks the check box next to an employee’s name to 
select that employee, and clicks OK to add all selected employees to the sales team. 

5 In the Sales Team Members dialog box, the partner reviews the list to make sure that the 
individuals who should be on the sales team are listed. Then, the partner clicks OK.

Step 3: Partner company managers track opportunities
Just as sales managers at your own company use Siebel Sales to track their direct reports’ progress 
on opportunities, managers at the partner company can use the Siebel PRM Portal to display the 
opportunities their direct reports have entered and track their progress on them. 
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To display your report’s opportunities

1 In the Siebel PRM Portal, the partner navigates to the Opportunities screen > My Team’s 
Opportunities. 

Opportunities that have the manager on the sales team or one of the manager’s reports as the 
primary on the sales team appear. 

Step 4: The brand owner channel manager tracks opportunities 
Although your company does not develop or work opportunities in this scenario, your channel 
managers can display the opportunities for the partner companies that they manage, in order to 
track each partner company’s progress in selling your products. 

In this scenario, the channel manager does not see detail information about the opportunity. To see 
detail information, the channel manager must be on the sales team for the opportunity. To make 
detail information visible, you can set up Siebel Assignment Manager to automatically add the 
channel manager to the sales team when a partner creates an opportunity, as described in the next 
scenario. 

To view the opportunities of a partner company

1 In the Siebel PRM Manager, navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose opportunities you want to see.

3 Click the Opportunities view tab. 

The partner’s opportunities appear. 

Scenarios for Collaborative Selling
This section looks at three different scenarios that let the partner work on sales opportunities in 
collaboration with the brand owner: 

■ The brand owner creates an opportunity and the brand owner and partner work together on it. 

■ The partner creates an opportunity and the brand owner and partner work together on it. 

■ The partner creates an opportunity and assigns it to the brand owner. 

■ A customer transfers a shopping cart from the brand owner’s Web site to a partner.

Brand Owner Creates Opportunities and Brand Owner 
and Partner Work Together on Them
In this scenario, opportunities are created by the brand owner company and assigned to specific 
partner sales agents who will work collaboratively on the opportunity with your sales agents. 
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This scenario is appropriate for you if you generate opportunities and you use partners’ help in 
following up on opportunities. For example, you may generate opportunities through a national 
marketing campaign, and when you follow up on these opportunities, you may need help from 
partners who specialize in training or in systems integration.

This scenario consists of the following steps:

■ Step 1. The brand owner enters the opportunities

■ Step 2. The brand owner assigns the opportunities to your sales agents

■ Step 3. The brand owner assigns the opportunities to partners 

■ Step 4. The brand owner and partner work together on opportunities 

Step 1: The brand owner enters the opportunities
You may gather opportunities in a number of different ways—for example, at trade shows, through 
marketing campaigns, or through your Web site. The first step in working with an opportunity is to 
enter it into your Siebel application. 

When you enter an opportunity through the Siebel PRM Manager, you are automatically added as 
the primary on the sales team.

For more information about opportunities, see the section on opportunities in Applications 
Administration Guide. 

To enter a new opportunity

1 Navigate to the Opportunities screen. 

2 In the Opportunities list, click the menu button, and then click New Record to add a new record 
to that list.

3 Enter information about the opportunity in the new record. 

Step 2: The brand owner assigns opportunities to brand owner sales agents
After you enter the opportunity, it must be assigned to the appropriate sales agent at your company. 
To assign an opportunity to a sales agent, you enter the employee’s name in the Sales Team field of 
the Opportunity record. The opportunity is then visible in the My Opportunities view for that 
employee.

You can assign the opportunity manually, but it is best to use Siebel Assignment Manager to assign 
the opportunity by creating rules based on geography, partners’ skills, expertise in a specific product, 
language ability, territory, workload and availability, or other criteria. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide.
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Step 3: The brand owner assigns opportunities to partners
Next, opportunities are assigned to the appropriate partner. You can do this manually or use Siebel 
Assignment Manager to assign the opportunity by creating rules based on partners’ skills, expertise 
in a specific product, language ability, territory, workload and availability, or other criteria. 

You can assign opportunities to partners in two ways:

■ Assign opportunities to the partner company. To assign an opportunity to a partner 
company, you enter that company’s organization in the Organization field of the Opportunity 
record. The opportunity will be visible in the All Opportunities view for that organization, but it 
will not be visible in the My Opportunities view for any employee of the organization. The partner 
company must designate an employee to find new opportunities in the All Opportunities view and 
assign them to the appropriate employee. 

■ Assign opportunities to partner employees. To assign an opportunity to a partner employee, 
you enter the employee’s name in the Sales Team field of the Opportunity record. If you do this, 
the opportunity will be visible in the My Opportunities view for that employee. 

You can either assign the opportunities manually, or you can set up Assignment Manager to assign 
them automatically. Assignment Manager can add partner organizations to the opportunity’s 
Organization field or add partner employees to the opportunity’s Sales Team field. 

It is usually difficult for you to keep track of the special skills of individual employees in partner 
companies, so it is more common to assign the opportunity to the partner company and have 
someone there assign it to the appropriate employee. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 

Step 4: The brand owner and partners work together on opportunities
It is easier for you and the partner to work together on the lead, because both are on the sales team. 

Whenever you display the My Opportunities view in the Siebel PRM Manager or the partner displays 
the My Opportunities view in the Siebel PRM Portal, the shared opportunity is included in the list. You 
can select the Opportunity record and do the following: 

■ Share files. You and the partner can share files (such as Microsoft Word documents) that are 
useful for this opportunity by clicking the Attachments view tab and adding records to the Shared 
Attachments list.

■ Share activities. You and the partner can log your activities as you work on this opportunity by 
clicking the Activities view plan and adding records to the Activities list. You will always be 
current about each other’s activities. You can also add future activities to the Activities view tab 
or add activity plans to the Activity Plans view tab for this opportunity, in order to invite other 
members of the sales team to work on these activities. 

■ Share notes. You and your partner can share notes by adding activities to the opportunity and 
choosing the Note activity type.

■ Share revenue line items. As the partner sales agents learn more about the opportunity, they 
can add to it revenue line items, which indicate the potential revenue, chance of success, and 
sales stage. These will be visible to both partner companies. 
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■ Create customized sales tools. You can use the brand owner's prebuilt proposal, presentation, 
and correspondence templates to create proposals, presentations, and letters based on this 
opportunity, giving you selling tools that are automatically customized for this opportunity and 
account.

Partner Creates Opportunities and Brand Owner and 
Partner Work Together on Them 
In this scenario, opportunities are created by the partner companies, and the partners then invoke 
help from sales agents at the brand owner company, so they can work in a joint selling effort. 

This scenario is appropriate for you if your partners generate opportunities and need help working 
on the opportunity. For example, your partners may generate opportunities by attending trade 
shows, and when they follow up on these opportunities, they may need help from your sales agents 
who have special product knowledge. 

This scenario consists of the following steps:

■ Step 1. The brand owner uses Assignment Manager to add its employees to the sales 
team

■ Step 2. Partners enter opportunities

■ Step 3. The brand owner and partner work together on opportunities 

Step 1: The brand owner uses Assignment Manager to add its employees to the sales team
To make it easier to work with your partner, set up Siebel Assignment Manager so it automatically 
adds the appropriate employees from your company whenever partners enter new opportunities. You 
would probably want to add the following employees from your company:

■ Channel manager. Add the channel managers who are responsible for the partner companies 
that entered each opportunity, so they can track the opportunities. Because the channel 
managers are on the sales team of the opportunities generated by the partner companies they 
work with, they can track these opportunities by displaying the My Opportunities view. 

■ Sales agents. Add the appropriate sales agents to work with the partner sales agent who 
entered the opportunity. Assignment Manager can choose which of your sales agents to add to 
each opportunity based on your agents’ location, product expertise, workload and availability, 
and other criteria. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 

Step 2: Partners enter opportunities
Partners develop new opportunities and enter them into the Siebel PRM Portal. When a partner enters 
the opportunity, that partner is automatically added to the sales team as primary. 

You can set up Siebel Assignment Manager so the channel manager and appropriate sales agents at 
the brand owner company are also added to the sales team automatically when the partner enters 
the record. Alternatively, the partner can assign the opportunity to these people manually. 
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To enter a new opportunity through the PRM Portal

1 Navigate to the Opportunities screen. 

2 In the Opportunities list, the partner clicks New to add a new record to that list.

3 The partner enters information about the opportunity in the new record. 

4 The opportunity can be assigned to appropriate sales agents manually or automatically as 
follows: 

a The partner can assign the opportunity to appropriate sales agents at the partner company and 
to the channel manager at the brand owner company by adding these people to the Sales Team 
field manually. Then, the channel manager would add sales agents at the brand owner company 
to the sales team. 

b You can set up Siebel Assignment Manager to add these people to the Sales Team field 
automatically. 

Step 3: The brand owner and partners work together on opportunities
Having both your sales agents and partner sales agents on the sales team makes it easier to work 
together on the opportunity. 

Whenever your sales agent displays the My Opportunities view in the Siebel application or the 
partner displays the My Opportunities view in the Siebel PRM Portal, this opportunity is included in 
the list. Both your agents and your partner can select the Opportunity record and do the following: 

■ Share files. You and the partner can share files (such as Microsoft Word documents) that are 
useful for this opportunity by clicking the Attachments view tab and adding records to the Shared 
Attachments list.

■ Share activities. You and the partner can log the activities you have done to work on this 
opportunities by clicking the Activities view plan and adding records to the Activities list. You and 
the partner will always be up to date about each other’s activities. You can also add future 
activities to the Activities view tab or add activity plans to the Activity Plans view tab for this 
opportunity, in order to invite other members of the sales team to work on these activities. 

■ Share notes. You and your partner can share notes by adding activities to the opportunity and 
choosing the Note activity type.

■ Share revenue line items. As the partner sales agents learn more about the opportunity, they 
can add to it revenue line items, which indicate the potential revenue, chance of success, and 
sales stage. These will be visible to both partner companies. 

■ Create customized sales tools. You can use the brand owner’s prebuilt proposal, presentation, 
and correspondence templates to create proposals, presentations, and letters based on this 
opportunity, giving you selling tools that are automatically customized for this opportunity and 
account.
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Partner Creates Opportunities and Assigns Them to 
Brand Owner
In this scenario, opportunities are created by the partner companies and assigned to employees of 
the brand owner company. 

This scenario is appropriate for your company if your partners generate opportunities for you and 
you follow up on each opportunity. For example, your partners may generate opportunities by 
attending trade shows, and your company may follow up on these opportunities through your 
national sales force. 

This scenario consists of the following steps:

■ Step 1. Partners enter the opportunities 

■ Step 2. The brand owner assigns the opportunities to brand owner employees 

■ Step 3. Optionally, the brand owner notifies the employees 

■ Step 4. Brand owner employees view and work on the opportunities 

■ Step 5. The brand owner tracks the opportunities 

Step 1: Partners enter the opportunities
In this scenario, your partners develop new opportunities and enter them using the Siebel PRM 
Portal. 

When partner sales agents enter the opportunity, they are automatically added to the sales team as 
primary. Though the partner sales agents remain on the sales team, they will not work on this 
opportunity. 

To enter a new opportunity through the Siebel PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the Opportunities screen. 

2 In the Opportunities list, the partner clicks the menu button, and then clicks New Record to add 
a new record to that list.

3 The partner enters information about the opportunity in the new record. 

4 The partner assigns the opportunity to the brand owner company by adding a brand owner 
organization in the Organization field. 

The opportunity will be visible to everyone in that brand owner organization who can display the 
All Opportunities view. 

Step 2: The brand owner assigns opportunities to its sales agents
Next, you assign opportunities to the appropriate sales agent in the brand owner company. Use 
Siebel Assignment Manager to assign each opportunity by creating rules based on the employee’s 
special skill, product lines, geography, or other criteria. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 
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Step 3: The brand owner notifies sales agents
Optionally, you can notify the sales agent by email when an opportunity is assigned. You set up rules 
in Siebel Business Process Designer so it sends the email using the communication server when the 
rules are satisfied. 

As with partners, you can notify the employee only when important opportunities are assigned. For 
example, you can create a workflow rule saying that email should be sent when an opportunity is 
assigned that involves sales of over $200,000. 

Step 4: Brand owner sales agents view and work on the opportunities
Once the opportunity has been assigned to a sales agent at the brand owner company, the employee 
can view it in Siebel Sales or another Siebel application by displaying the My Opportunities view. 
Because Siebel products use the same database, you do not have to export this record from Siebel 
PRM to Siebel Sales. 

To view a new opportunity

1 Navigate to the Opportunities screen. 

2 Select the new opportunity in the Opportunities list and click the appropriate view tabs to view 
more details about the opportunity. 

Step 5: The brand owner tracks opportunities
As your employees work on these opportunities, you can track their progress using the Siebel PRM 
Manager. 

To track an employee’s opportunities

1 Navigate to the Opportunities screen > My Team’s Opportunities view. 

2 Click Query, and use the Query form to search for the employee.

3 Select an opportunity you want to track, and click the Revenues and Activities view tab.

The revenue items and activities attached to that opportunity appear. 

A Customer Transfers a Shopping Cart From the Brand 
Owner’s Web Site to a Partner 
Shopping cart transfer is used by companies that want to make sales through their own Web site but 
that want distributors, authorized resellers, or other partners to fulfill the orders. The customer can 
use Siebel Sales on your Web site to create a shopping cart. Then, the customer can transfer the 
shopping cart to a partner’s site for fulfillment. 

This scenario consists of the following steps:

■ Step 1. The brand owner sets up a Web site to sell to customers 

■ Step 2. A customer makes a purchase at the brand owner’s Web site
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■ Step 3. A partner fulfills the order 

Step 1. The Brand Owner Sets Up a Web Site to Sell to Customers 
Before customers can use shopping cart transfer, the brand owner must:

■ Set up a Web site to sell products or services to customers. 

■ Set up the Application Services Interface (ASI) for shopping cart transfer. 

In this scenario, the brand owner creates the Web site where customers make purchases. Partners 
who fulfill orders do not need to use Web sites to sell to customers. 

The brand owner may set up this Web site using Siebel Sales. For more information, see Siebel eSales 
Administration Guide. 

Shopping cart transfer uses Siebel’s ASI to integrate the brand owner’s and the partner’s order 
systems. The partner does not need to use the Siebel PRM Portal to track and fulfill orders. 

For information about setting up the ASI for shopping cart transfer, see Chapter 4, “Setting Up 
Application Services Interfaces.”

Step 2. A Customer Makes a Purchase at the Brand Owner’s Web Site 
Customers make purchases at this Web site as they would at any Web site, by browsing the catalog 
and adding items to the shopping cart. The Web site displays an approximate price for the products 
or services they are ordering. 

When they are ready to buy, customers click the Transfer Cart button and choose the partner who 
will fulfill the order. Then they see the exact price that partner will charge for their order. 

To make a purchase using shopping cart transfer

1 The customer browses the catalog at the brand owner’s Web site and adds products or services 
to the shopping cart. 

2 The customer clicks Transfer Cart.

A list of partners who can fulfill the order appears. 

3 The customer selects a partner to fulfill the order. 

A screen appears to allow the customer to confirm the order, with the exact price that the 
selected partner will charge. 

4 The customer confirms the order. 

Step 3. A Partner Fulfills the Order 
After the shopping cart is transferred, it appears as an order in the partner’s order management 
system. The partner company fulfills this order as it would any other order. 
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Opportunity Management Workflows
With any of the scenarios above that involve the brand owner and partner sharing opportunities, you 
can use the Siebel PRM opportunity management workflows to send email notification to the brand 
owner or partner employee who is assigned the opportunity and to that employee’s manager when 
certain conditions are met. 

The following opportunity management workflows are available:

■ Opportunity Assigned Notification Process 

■ Opportunity Pending Notification Process 

■ Opportunity Inactive Notification Process 

■ Opportunity Pending Notification Process 

■ Opportunity Lost Notification Process 

■ Opportunity Won Notification Process 

For more information about these workflows, see the section about opportunity workflows in 
Applications Administration Guide.

Before you can use them, you must activate these workflows, as described in “Activating Workflows” 
on page 24. 

Scenarios for Forecasting Partner Sales
Forecasting lets you monitor the sales pipeline to predict future sales. When salespeople enter 
opportunities, they specify the total possible revenue and probability of success for that opportunity, 
which is the basis of forecasting. 

By using the forecasting module, analysts at the brand owner company can define a forecast series 
covering virtually any scenario. They can specify the partners, accounts, products, opportunities, and 
other data to be included in the forecast series. Then, both brand owners and partners can use the 
predefined forecasting series to create forecasts of future revenues.

For more information about forecasting, see Siebel Forecasting Guide. 

NOTE: Partner Forecasting lets you give forecasting credit to partners in multiple ways. You can give 
credit to a partner if that partner is the primary organization in the Organization field using the 
[Opportunity Primary Organization] search specification. You can also give credit to a partner if a 
partner employee is the primary on the opportunity sales team by using the [Sales Rep Organization] 
search specification. If you want to give credit to all partner organizations, you can give credit to 
partners who are the primary organization in the Organization field by using the [Opportunity 
Primary Organization Partner Flag] search specification. Alternatively, you can give credit to the 
partner organizations in which the primary sales representative works for a partner organization by 
using the [Partner] search specification. To support the last alternative, the Partner field must be 
completed on revenue line items to be included in the forecast.
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

207



Managing Sales ■  Scenarios for Forecasting Partner Sales
This section provides scenarios that are specific to partner forecasting. Brand owners can forecast 
partner revenue and partners can forecast their own revenue. Administrators at the brand owner 
company can set up forecast series in different ways to automate forecasts, limit visibility, and allow 
modifications of forecasts at each level of the forecast. The scenarios fall under the following 
categories: 

■ The brand owner forecasts partner revenue.

■ Partner managers at the brand owner forecast revenue for the partners they manage.

■ Partners forecast their own revenue without the brand owner viewing forecasts.

Brand Owner Forecasts Partner Revenue
The brand owner can forecast partner revenue in a number of different ways. This section provides 
the following scenarios: 

■ The brand owner creates a direct quarterly forecast of all partner revenue.

■ The brand owner creates a direct annual forecast of revenue for one partner organization.

■ The brand owner creates a rollup forecast of annual revenue for one partner organization.

The Brand Owner Creates a Direct Quarterly Forecast of All Partner 
Revenue
In this scenario, only one person at the brand owner company, typically the channel manager, creates 
a forecast.

The forecast series in this scenario covers quarterly revenues that have been committed where a 
partner employee is the primary on the sales team or the partner organization is the primary in the 
Organization field. Forecasts would be run once every month.

This scenario consists of the following steps:

■ Step 1. Create a forecast series 

■ Step 2. Create forecasts 

Step 1: Creating the forecast series
Before running a forecast, you must create the forecast series. The forecast series defines forecasts 
covering all committed, quarterly partner revenue. 

To create the forecast series

1 Navigate to the Site Map > Administration - Forecast screen. 

2 In the Forecast Series list, click the menu button, and then click New Record. 
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3 Enter the values in the following table in the fields of the new record.

4 Click the Forecasts Series Dates tab. 

5 In the Forecast Series Dates list, click the menu button, and then click New Record. 

6 Enter the values in the following table in the fields of the new record.

7 To create additional forecast dates, you can select the record you just created, click the menu 
button, and then click Copy Record. By default, the new forecast date is one month later and the 
rest of the fields are the same as in the original record. Repeat this step as many times as you 
want; as you repeatedly copy records, the Forecast Date continues to change to later dates. 
Therefore, you may want to change the Start Date and End Date periods to reflect the time 
frames of the forecasts you want to generate.

8 Click the Forecast Series Participants view tab, and in the Forecast Series Participants list, click 
the menu button, and then click New Record. 

The Add Participants dialog box appears.

9 In the Add Participants dialog box, use a query to find the channel manager, select the channel 
manager’s record, and click OK. 

Field Comment

Name A name for the forecast, such as Channel Manager’s Quarterly 
Partner Forecast.

Auto Forecast Search Spec ([Partner] is not NULL or [Opportunity Primary Organization 
Partner Flag] = 'Y') and [Committed] = 'Y' and 
[Calculated Primary Flag] = 'Y'

Active checked

Description A description of the forecast, such as Channel Manager’s 
Quarterly Partner Forecast - Committed.

Detail Depth Summary Only

View Mode All Across Organizations

Interval Period Type Month

Interval 1

Base Period Type Quarter

Field Comment

Forecast Date The date when you want to begin running forecasts. This may be today’s date. 

Description A description, such as Q1 Partner Forecast. 

Start Date The start date for the forecast period, such as 1/1/05.

End Date The end date for the forecast period, such as 3/31/05.
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Step 2: Creating the forecast
Once the forecast series has been set up, you can run the forecast. 

To create the forecast

1 Navigate to the Forecasts screen. 

2 In the Forecast list, click the menu button, and then click New Record. 

3 In the Forecast Series field of the new record, select the forecast series you want to use, such 
as Channel Manager’s Quarterly Partner Forecast. 

4 In the Forecast Date field, click the select button. 

5 In the Pick Forecast Series Date dialog box, select the record with the forecast date you want 
and click OK. 

The forecast runs. 

The Brand Owner Creates a Direct Annual Forecast of Revenue for One 
Partner Organization
In this scenario, only one person at the brand owner company, typically the channel manager, creates 
a forecast. 

For this forecast, the forecast series defines forecasts that would cover annual revenue of one 
specific partner (Partner X) and be run once every quarter. The forecast results would provide a 
running total of forecasted revenues for the year. 

You create this forecast series and forecast in the same way that you do in the scenario “The Brand 
Owner Creates a Direct Quarterly Forecast of All Partner Revenue” on page 208, with these exceptions:

■ Because this is an annual forecast that will be run on a quarterly basis, you need to set up the 
Forecast Series Dates accordingly.

■ You enter the values in the following table in the fields of the Forecast Series record. 

Field Comment

Name A name for the forecast, such as Channel Manager’s Annual 
Partner X Forecast.

Auto Forecast Search Spec ([Sales Rep Organization] = ‘Partner X’ or [Opportunity Primary 
Organization] = 'Partner X') and [Committed] = 'Y' and 
[Calculated Primary Flag] = 'Y'

Description A description of the forecast, such as Channel Manager’s Annual 
Partner X Forecast - Committed.

Active checked

Detail Depth Summary Only

View Mode All Across Organizations

Interval Period Type Quarter
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The Brand Owner Creates a Rollup Forecast of Annual Revenue for a 
Partner Organization
In this scenario, partner employees whose revenues are included in the forecast can run the forecast. 
In the previous scenarios, only the channel manager could run the forecasts. 

This scenario consists of the following steps:

■ Step 1. Set up the reporting hierarchy 

■ Step 2. Create the forecast series

■ Step 3. Create the forecast 

Step 1: Setting up the reporting hierarchy
In this scenario, forecasts are rolled up through the position hierarchy to the channel manager at the 
brand owner company. You must set up the position hierarchy so all partner employees whose 
revenue will be included in the forecast report directly or indirectly to the channel manager at the 
brand owner company. 

The position at the top of the partner company reporting hierarchy, the partner relationship manager, 
should report to the channel manager at the brand owner company. Partner sales agents whose 
revenue will be included in the forecast should report directly or indirectly to the partner relationship 
manager. 

You can set up the positions hierarchy using Siebel PRM Manager’s Administration - Partner Screen 
> Positions view. For more information about setting up the positions hierarchy, see Applications 
Administration Guide.

Step 2: Creating the forecast series
The channel manager creates a forecast series that defines forecasts that will cover annual revenue 
of one specific partner (Partner X) and be run once every month. If you have set up the reporting 
hierarchy correctly, you can create this forecast series to do a rollup forecast. 

To create the forecast series

1 Navigate to the Site Map > Administration - Forecast screen. 

2 In the Forecast Series list, click the menu button, and then click New Record. 

Interval 1

Base Period Type Year

Field Comment
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3 Enter the values in the following table in the fields of the new record.

4 Click the Forecasts Series Dates tab. 

5 In the Forecast Series Dates list, click the menu button, and then click New Record. 

6 Enter the values in the following table in the fields of the new record.

7 If you want create additional forecast dates, you can select the record you just created, click the 
menu button, and then click Copy Record. By default, the new forecast date is one month later, 
and the rest of the fields are the same as in the original record.

8 Click the Forecast Series Participants view tab, and in the Forecast Series Participants list, click 
the menu button, and then click New Record. 

The Add Participants dialog box appears.

9 In the Add Participants dialog box, query for the people in the brand owner and partner 
organization who would run the forecast, select these people, and then click OK.

The positions of these people would include Channel Manager, Partner Sales Representative, 
Partner Sales Manager, and Partner Relationship Manager. 

Field Comment

Name A name for the forecast, such as Rollup Forecast of Annual 
Partner X Revenue.

Auto Forecast Search Spec [Sales Rep Organization] = 'Partner X' and [Committed] = 'Y' 
and [Calculated Primary Flag] = 'Y'

Description A description of the forecast, such as Rollup Forecast of Annual 
Partner X Revenue - Committed.

Active checked

Detail Depth Summary Only

View Mode My Revenues

Interval Period Type Month

Interval 1

Base Period Type Year

Field Comment

Forecast Date The date when you want to begin running forecasts. This may be today’s 
date. 

Description A description, such as June Rollup Forecast of Annual Partner X Revenue.

Start Date The start date for the forecast period, such as 1/1/05.

End Date The end date for the forecast period, such as 12/31/05.
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Step 3: Creating the forecast
Either the channel manager at the brand owner company, or any employee in the partner company 
who is below the channel manager in the reporting hierarchy, can run the forecast. 

In order for the rollup forecast to run logically and to give employees the ability to adjust their 
forecasts, employees run and roll up forecasts in an order that is inversely related to their rank. The 
sales representative runs the forecast first, then the sales manager, then the partner relationship 
manager, and finally, the channel manager.

However, when managers run forecasts, Siebel PRM automatically runs their reports’ forecasts, if the 
report has not already run the forecast. 

To create the forecast

1 In the Siebel PRM Portal, partner sales representatives (employees with no reports) navigate to 
the My Forecasts view.

2 The partner sales representative clicks New to create a new forecast.

3 The partner sales representative selects Rollup Forecast of Annual Partner X Revenue as the 
forecast series name.

4 The partner sales representative selects June Rollup Forecast of Annual Partner X Revenue as the 
forecast series date.

5 If the partner sales representative wants to adjust any of the revenue amounts that comprise 
the forecast, the partner sales representative clicks the Details view tab and modifies the 
revenue amounts. 

6 When the partner sales representative is satisfied with the forecast details, the partner sales 
representative clicks the rollup button. 

The forecast is rolled up to the partner sales representative's manager, the sales manager.

7 In the Siebel PRM Portal, the sales manager repeats Step 1 on page 213 through Step 6, rolling 
up the forecast to the partner relationship manager.

8 In the Siebel PRM Portal, the partner relationship manager repeats Step 1 on page 213 through 
Step 6, rolling up the forecast to the channel manager at the brand owner company.

9 In the Siebel PRM Manager, the channel manager at the brand owner company repeats Step 1 
on page 213 through Step 5. 

The channel manager’s final rollup forecast includes information from all of the employees whose 
revenues contributed to the forecast.

Partner Managers at the Brand Owner Forecast Revenue 
for Multiple Partners 
In this scenario, a channel manager forecasts revenue for multiple partner companies. The brand 
owner forecasts revenue for all partners that a partner manager oversees.
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The Brand Owner Forecasts Revenue for All Partners that a Partner 
Manager Oversees
In this scenario, there are multiple channel managers at the brand owner organization. Each channel 
manager oversees partnerships with a distinct group of partner organizations. 

A channel manager at a brand owner organization wants to track the revenues associated with his 
or her own partners, but does not want other channel managers to be able to view these forecasts. 
In this scenario, only the channel manager can see the forecast.

This scenario consists of the following steps:

■ Step 1. Create the forecast series 

■ Step 2. Create the forecast 

Step 1: Creating the forecast series
The channel manager creates a forecast series that defines forecasts that would cover the annual 
revenue of three specific partners (Partner X, Partner Y, and Partner Z) and be run once every 
quarter. 

To create the forecast series

1 Navigate to the Site Map > Administration - Forecast screen. 

2 In the Forecast Series list, click the menu button, and then click New Record. 

3 Enter the values in the following table in the fields of the new record.

4 Click the Forecasts Series Dates tab. 

Field Comment

Name A name for the forecast, such as Channel Manager’s Annual 
Forecast of Partners X, Y, and Z.

Auto Forecast Search Spec ([Sales Rep Organization] = 'Partner X' or [Sales Rep 
Organization] = 'Partner Y' or [Sales Rep Organization] = 
'Partner Z') and [Committed] = 'Y' and 
[Calculated Primary Flag] = 'Y'

Description A description of the forecast, such as Channel Manager’s Annual 
Forecast of Partners X, Y, and Z - Committed.

Active checked

Detail Depth Summary Only

View Mode All Across Organizations

Interval Period Type Quarter

Interval 1

Base Period Type Year
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5 In the Forecast Series Dates list, click the menu button, and then click New Record. 

6 Enter the values in the following table in the fields of the new record.

7 If you want to create additional forecast dates, you can select the record you just created, click 
the menu button, and then click Copy Record. By default, the new forecast date is one quarter 
later, and the rest of the fields are the same as in the original record. You then edit the record—
for example, to change the description so it refers to the new quarter.

8 Click the Forecast Series Participants view tab, and in the Forecast Series Participants list, click 
the menu button, and then click New Record. 

The Add Participants dialog box appears.

9 In the Add Participants dialog box, use a query to find the brand owner’s channel manager, select 
this record, and click OK. In the Forecast Series form, click Save.

Only the channel manager who was selected will be able to run a forecast based on this forecast 
series.

Step 2: Creating the forecast
Only the channel manager at the brand owner organization can run the forecasts based on this 
forecast series.

After the forecast series has been set up, the channel manager can run the forecast. 

To create the forecast

1 The channel manager navigates to the Forecasts screen. 

2 In the Forecast list, click New. 

3 In the Forecast Series field of the new record, the channel manager selects the forecast series 
to be used, such as Channel Manager’s Annual Forecast of Partners X, Y, and Z. 

4 In the Forecast Date field, select the forecast date. 

Field Comment

Forecast Date The date when you want to begin running forecasts. This may be today’s 
date. 

Description A description, such as Q1 Partner X, Partner Y, and Partner Z Forecast.

Start Date The start date for the forecast period, such as 1/1/05.

End Date The end date for the forecast period, such as 12/31/05.
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Partners Forecast Their Revenue Without the Brand 
Owner Viewing Forecasts
Previous scenarios focused on producing forecasts for the brand owner company, though the partner 
company could sometimes share the forecasts. In the following scenarios, forecasts are produced 
exclusively for the use of the partner company:

■ The channel manager creates a direct partner forecast series that only the partner relationship 
manager can run.

■ Multiple partner employees create rollup forecasts.

The Channel Manager Creates a Direct Partner Forecast Series
In this scenario, the channel manager creates a forecast series that allows only the partner 
relationship manager to run a forecast of the partner’s own revenue. The partner relationship 
manager does not share this information with the brand owner. 

The steps are identical to the steps in “The Brand Owner Creates a Direct Annual Forecast of Revenue 
for One Partner Organization” on page 210. The only difference is that instead of adding the channel 
manager to the Forecast Participants, you add the partner relationship manager at the partner 
company. Then, only the partner company can run these forecasts of its annual revenue.

Multiple Partner Employees Create Rollup Forecasts
In this scenario, multiple partner employees run a forecast of the partner company's revenue. The 
partner does not share this information with the brand owner. 

The steps required for this scenario are identical to the steps in “The Brand Owner Creates a Rollup 
Forecast of Annual Revenue for a Partner Organization” on page 211. The only difference is that the 
channel manager at the brand owner company is not included in the Forecast Series Participants list, 
so the brand owner does not automatically have visibility into the forecast.

Using Presentations and Proposals
Using the Siebel PRM presentation and proposal generation functionality, brand owners can 
standardize partners’ proposals and presentations, make sure that partners are positioning brand 
owner products appropriately, and reduce the amount of time and money that partners spend 
generating new proposals or presentations. Using the proposal and presentation generation 
capabilities, partners can generate customized, professional proposals and presentations that reflect 
the most current and accurate information available, without having to write any original content 
themselves.

To do this, you use the Siebel PRM Manager to create templates for sales presentations and sales 
proposals. When your partners generate an actual presentation, proposal, or correspondence, these 
templates incorporate information about a specific opportunity or account. 
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Siebel Presentations generates Microsoft PowerPoint or Lotus Freelance Graphics slide shows. You 
create the templates for slide shows about your products. When your partner generates a slide show, 
it is personalized with the customer’s name or with other information that you specified when you 
created the template. The partner can further customize the slide show by changing the order of the 
slides or adding slides from the presentation library. 

Siebel Proposals generates Microsoft Word or Lotus WordPro documents. You create templates for 
typical sales proposals. When your partner generates a specific proposal, it is personalized with 
information from the Opportunity or Account record, and also with a quote, if it was included in the 
template. Your partner can customize it by changing the order of sections or adding sections from 
the proposal library. 

Your partners do not need to have Microsoft PowerPoint, Lotus Freelance Graphics, Microsoft Word, 
or Lotus WordPro installed locally to use Siebel Presentations and Proposals. Partners need these 
applications only if they want to edit presentations and proposals. 

Your employees can use the same presentation and proposal templates as your partners. 

The following scenario illustrates how you would typically create a proposal or presentation. 

A sales executive at the brand owner company develops a conceptual plan for a generic template for 
a presentation or proposal that should be standardized. The plan includes modularized sections that 
can be added or subtracted, depending on the nature of a specific opportunity. The proposal or 
presentation includes markers where fields, such as the account name, quote, product name, sales 
representative, contact, and so on, should be inserted. 

The sales executive’s staff uses Siebel PRM Manager to create the presentation or proposal template, 
including bookmarks where fields will be inserted. The staff also maps these bookmarks to fields from 
opportunity or account records in the Siebel database. These bookmarks will be replaced by data 
from the account or opportunity on which the proposal is based. Finally, the staff saves the template 
in the presentation or proposal library. Then, partner sales agents can use the Siebel PRM Portal to 
generate the presentation or proposal. 

For more information about presentations and proposals, see Applications Administration Guide.

To generate a presentation or proposal

1 In the Siebel PRM Portal, the partner navigates to the Opportunities screen or the Accounts 
screen. 

2 The partner selects the opportunity or account record on which the presentation or proposal will 
be based. 

3 The partner clicks the Presentation or Proposal view tab. 

4 The partner clicks Auto Presentation or Auto Proposal. 

The system automatically selects the most appropriate presentation or proposal template for the 
account or opportunity and creates a new record. 

5 The partner clicks Generate Draft to generate and display the presentation or proposal in 
Microsoft PowerPoint, Lotus Freelance Graphics, Microsoft Word, or Lotus WordPro. 

6 If the partner has the appropriate application installed locally, then the partner can drill down on 
the record to display the presentation or proposal in that application.
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Using Incentive Compensation
Siebel Incentive Compensation lets you implement incentive compensation plans for both your 
partners and your employees to help meet your corporate sales goals. 

The brand owner wants to give individual partner agents an incentive to generate more revenue from 
a specific high margin product, Product X. The following is an example of how the brand owner can 
use incentive compensation to help generate sales of Product X:

■ In the User Administration screen, the brand owner makes sure that all partner employees who 
will be included in the plan have the Compensable field checked. 

■ In the Compensation Administration screen, the brand owner creates a filter in the Filters view 
called Product Filter, which includes these values for the following fields:

■ Type = Product

■ Inclusion = Include All

■ The brand owner drills down on the filter and adds Product X to the Products list.

■ The brand owner creates an incentive compensation rule in the Compensation Administration 
screen that includes these values for the following fields: 

■ Type = Commission

■ Performance Measure = % Revenue 

■ Participant Level = individual

■ Table = Simple

■ Transaction Level = Transaction

■ Earned = Booked

■ Payment Type = Recurring

■ Measure Period = Quarter

■ Filter = Product Filter

■ The brand owner creates a plan and associates the plan with the rule that was just created, 
including these values for the following fields: 

■ Estimable = checked

■ Period = Year

■ Display = checked

■ Status = Modifiable

■ Active = checked

■ The brand owner drills down on the rule and adds a simple table to the plan rules. This table 
indicates how much a partner agent will be compensated for generating different amounts of 
revenue from selling Product X. 

■ The brand owner makes sure the plan is active.
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■ In the Compensation Tracking screen, the brand owner defines a period for which order data will 
be imported into the transaction workbook, imports compensable events to the transaction 
workbook, and then exports data from the transaction workbook into the calculation workbook.

■ In the Calculation Runs view, the brand owner defines a name and period for the calculation run 
and then selects Calculate from the menu to calculate the commissions for the period.

■ After verifying the calculation results, the brand owner selects Release from the menu to publish 
the compensation results to the Compensation screen. This makes the results available to 
partners who are part of the plan.

■ The brand owner can view the Employee Calculations screen to see the compensation paid to 
each partner employee and can view the Plan Rule Payouts screen to see the total compensation 
the plan paid out. 

■ Partner sales agents use the Compensation screen in the Siebel PRM Portal to work with the plan, 
as follows: 

■ The Compensation view shows how much incentive compensation they have received. 

■ The Plans view shows the plans for which they can be compensated. 

■ The Quota view shows quotas that apply to them. 

■ The Quota Achievement view shows the degree to which they have met their quotas.

■ The Compensation Analysis provides a chart representing the data in the Compensation view.

For more information about incentive compensation, see Siebel Incentive Compensation 
Administration Guide.
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10 Managing Service Requests
This chapter describes scenarios that illustrate different ways that you can use Siebel PRM to manage 
service requests. 

This chapter contains the following topics:

■ “About Managing Service Requests” on page 221

■ “Managing Customer Service Requests” on page 221

■ “Managing Partners’ Service Requests” on page 235

■ “Using Solutions and SmartScripts to Help Partners Solve Problems” on page 236

About Managing Service Requests
This chapter describes scenarios that are examples of how you might use Siebel PRM to manage 
service requests. 

You can use Siebel PRM to manage two types of service requests:

■ Customer Service Requests. Customers will sometimes log service requests that your partners 
are responsible for. You can refer customer service requests to partners, work on them 
collaboratively with partners, or track service requests that partners have logged on behalf of 
your customers. 

■ Partner Service Requests. Partners will sometimes log service requests that you must respond 
to. For example, partners may have questions about your products or about the partnership, or 
they may need other forms of service. 

These scenarios cover a number of methods to manage each type of service request. 

To reduce the number of service requests you receive, you can create a repository of FAQs, solutions, 
and SmartScripts to help partners solve customers’ problems and their own problems without logging 
service requests. 

Managing Customer Service Requests
This section provides two groups of scenarios for managing customer service requests:

■ Partner-led customer service. In these scenarios, the partner is responsible for responding to 
the service request.

■ Collaborative customer service. In these scenarios, the brand owner and partner work 
together to respond to the service request.
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Scenarios for Partner-Led Customer Service
There are two common scenarios where the partner responds to customer service requests:

■ The partner company receives service requests and logs them in the Siebel PRM Portal for its own 
tracking purposes. 

■ The brand owner receives service requests and uses  to assign them to a partner for fulfillment. 

Partner Receives Service Requests and Logs Them for Tracking 
Purposes 
Partners may receive customer service requests directly and log them in the Siebel PRM Portal for 
tracking purposes. Then, partners can use the Siebel PRM Portal to manage service requests within 
their own organization, and at the same time, give you visibility to these service requests so you can 
track how well your partners are serving customers. 

In this scenario, the partner acts as service provider on behalf of the brand owner, with no 
intervention from the brand owner. When customers have a problem with the product, they contact 
the partner with which they have a relationship. 

For example, if a partner is a dealer or a value-added reseller, customers who have made purchases 
from the partner would call the partner directly with service requests. 

Using the Siebel PRM Portal, the partner company can enter customer service requests, assign these 
service requests to the appropriate service agents, and track the service requests as the service 
agents work on them. Using the Siebel PRM Manager, the channel manager at your company can 
also track the progress of the service requests at partner companies. 

Partners have access to a subset of the service management functionality that you have in the Siebel 
PRM Manager. Partners can log service requests, add activities and attachments to service requests, 
and associate solutions from the knowledge base with service requests.

Partners can get help in researching service requests by using the Siebel PRM Portal Solutions screen 
to display frequently asked questions (FAQs) and their solutions and to display troubleshooting 
instructions, as discussed later in this chapter.

For more information about working with service requests, see the section on service requests in 
Siebel Call Center User Guide and Applications Administration Guide.

This scenario consists of the following steps:

■ Step 1. The partner logs service requests 

■ Step 2. The partner assigns service requests to the appropriate partner service agents 

■ Step 3. The partner service agents fulfill service requests 

■ Step 4. Partner company managers track service requests

■ Step 5. Optionally, the brand owner’s channel manager tracks the service requests 
logged by the partner company 
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Step 1: Partners log service requests
In this scenario, your partners enter service requests using the Siebel PRM Portal. The partner might 
get these service requests through its call center or through other customer contacts. 

To enter a new service request through the Siebel PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the Site Map > Service screen > My Customer’s 
Service Requests view. 

2 In the Service Requests list, the partner selects New Record from the menu to add a new record 
to that list.

3 The partner enters information about the service request in the new record. 

4 Optionally, the partner entering the service request can assign it immediately by selecting a 
service agent in the Owner field, so the service request appears in the owner’s My Service 
Requests view. 

If the service request is not assigned immediately, it will be visible only in the All Service 
Requests view. The employee responsible for managing the service request queue would have to 
assign it later, as described in the following section. 

Step 2: Partner assigns service requests
If service requests are not assigned by the employee logging the service request, a partner employee 
would have the responsibility of managing the service request queue. This employee would regularly 
look at new service requests in the Siebel PRM Portal’s All Customer Service Requests view, and 
would use the Owner field to assign each service request to the partner employee who is qualified 
to respond to it. The appropriate employee could be a service agent who contacts the customer by 
telephone or a field service agent who goes to the customer site.

The employee who manages the service request queue should have a responsibility that includes 
visibility to the All Service Requests view. For more information about using responsibilities to control 
visibility to views and about the responsibilities available in the seed data, see the section about 
defining partner responsibilities in Chapter 3, “Setting Up Siebel PRM.”

To assign a service request to a partner service agent

1 In the Siebel PRM Portal, the partner navigates to the Site Map > Service screen > All Customer’s 
Service Requests view. 

2 In the Service Requests list, the partner selects the service request to be assigned. 

3 In the More Info view tab, the partner clicks the select button of the Owner field. 

The Pick Service Request Owner dialog box appears. 

4 In the Pick Service Request Owner dialog box, the partner selects a partner employee to be 
added as the owner of the service request and clicks OK. 
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Step 3: Partners fulfill service requests
Partner service agents and field technicians who fulfill service requests would regularly navigate to 
the Siebel PRM Portal’s Service screen > My Customers’ Service Requests view. They would research 
and respond to new customer service requests. 

Alternatively, they could be notified automatically by email whenever a new service request is 
assigned to them. The brand owner would set up Siebel Business Process Designer to send this email. 
For more information about Siebel Business Process Designer, see Siebel Business Process Designer 
Administration Guide. 

When they finish working on a service request, they change the status to closed. 

Step 4: Partner company managers track service requests
Managers at the partner company can use the Siebel PRM Portal to view the service requests that 
their direct reports own and track progress on them. 

To view your report’s service requests
■ In the Siebel PRM Portal, the partner navigates to the Site Map > Service screen > My Team’s 

Customer’s Service Requests view. 

The service requests owned by this partner company manager’s reports appear. 

Step 5: The brand owner channel manager tracks service requests 
Although your company does not develop or work on service requests in this scenario, your channel 
managers can view the service requests for the partner companies that they manage. This lets them 
track each partner company’s progress in fulfilling service requests. 

Optionally, you can also produce the Partner Operations report, which lists the service requests a 
partner is working on, as well as that partner’s opportunities, accounts, and so on. 

To view the service requests of a partner company

1 In the Siebel PRM Manager, navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose service requests you want to see.

3 Click the Service Requests view tab. 

The partner’s service requests appear. 

Brand Owner Receives Service Requests and Assigns Them to the 
Partner
In this scenario, service requests are received and entered by the brand owner company and 
assigned to specific partners. 
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This scenario would be appropriate, for example, if the brand owner runs a call center where 
customers call to report problems with products they purchased directly from the brand owner or 
through a reseller. The call center agents log the service requests, which then are assigned either 
automatically or manually to a partner with the appropriate skills to solve the customer's problem. 
The partner to whom the service request was assigned retrieves the service request through the 
Siebel PRM Portal. This partner then assigns it either to a partner employee who is a service agent 
responsible for telephoning the customer, or to a partner employee who is a field service technician 
responsible for visiting the customer’s house. After solving the problem, the service agent changes 
the service request’s status to closed using the Siebel PRM Portal. A service manager at the brand 
owner company can track the status of service requests to monitor customer satisfaction.

For more information about working with service requests, see the section on service requests in 
Siebel Call Center User Guide and Applications Administration Guide.

This scenario consists of the following steps:

■ Step 1. The brand owner enters the service requests 

■ Step 2. The brand owner assigns the service requests to partners 

■ Step 3. Partners view and work on the service requests 

■ Step 4. The brand owner tracks the service requests 

Step 1: The brand owner enters service requests
Your call center agents, field service representatives, or other employees who work with your 
customers receive service requests and enter the service requests in the Siebel application that they 
use, which may be Siebel PRM Manager, Siebel Call Center, Siebel Service, or Siebel Field Service. 
Because Siebel applications use the same database, these service requests will be visible to you in 
Siebel PRM Manager even if they are entered in Siebel Call Center, Siebel Service, or Siebel Field 
Service. 

To enter a new service request

1 Navigate to the Service screen.

2 In the Service Requests list, click the menu button, and then click New Record to add a new 
record to that list.

3 Enter information about the service request in the new record. 

4 Assign the service request to a partner service agent, as described in the next step. 

Step 2: The brand owner assigns service requests to partners
Next, service requests are assigned to the appropriate partner. You can do this manually, but it is 
generally better to use Siebel Assignment Manager to assign the service request by creating rules 
based on geography, partners’ skills, expertise in a specific product, language ability, territory, 
workload and availability, or other criteria. 

For example, you might assign service requests from Spanish-speaking customers for one of your 
product lines to a partner company that has expertise in that product line and employees who speak 
Spanish. 
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You can set up Assignment Manager either to assign service requests to partner companies or to 
assign service requests to individuals who may be service agents at the partner company or at your 
own company, depending on which agent is most qualified to deal with each service request. 

You can assign service requests to partners in two ways:

■ Assign service requests to the partner company. To assign a service request to a partner 
company, you enter that company’s organization in the Organization field of the Service Request 
record. The service request will be visible in the All Service Requests view for that organization, 
but it will not be visible in the My Service Requests view for any employee of the organization. 
The partner will have to designate an employee to find new service requests in the All Service 
Requests view and assign them to the appropriate employee by entering the employee’s name 
in the Owner field of the service request, which is visible after you click the More/Less button of 
the More Info form. 

■ Assign service requests to partner employees. To assign a service request to a partner 
employee, you enter the employee’s name in the Owner field of the Service Request record. The 
service request will be visible in the My Service Requests view for that employee.

It is usually difficult for you to keep track of the special skills of individual employees in partner 
companies, so it is more common to assign the service request to the partner company and have an 
employee there assign it to the service agent. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 

Step 3: Partners view and work on service requests
After the service request is assigned, the partner employees work on it using the Siebel PRM Portal, 
as follows: 

■ If the service request is assigned to a partner employee, that person will be the owner of the 
service request and can see it in the My Service Requests view. 

■ If the service request is assigned to a partner organization, employees in that organization can 
see that service request in the All Service Requests view, but the service request will not appear 
in any employee’s My Service Requests view until a partner employee is added in the Owner field.

When service agents resolve a service request, they change its status to Closed.

To view a service request and change its status to Closed

1 In the Siebel PRM Portal, the partner navigates to the Service screen. 

2 In the Service Requests list, the partner selects the service request. 

3 When the service request has been resolved, the partner selects Closed in the Status field.

Step 4: The brand owner tracks service requests
You can track your partner’s progress on its service requests by displaying the service requests and 
viewing the status fields to see which service requests have been closed. 
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To track a partner’s service requests

1 In the Siebel PRM Manager, navigate to the Partner Operations screen. 

2 In the Partners list, select the partner company whose service requests you want to see.

3 Click the Service Requests view tab. 

The partner’s service requests appear. 

4 If you want to see more details about a service request, click its number in the Service Request 
list.

Scenarios for Collaborative Customer Service 
This section describes two scenarios that let the partner work on service requests in collaboration 
with the brand owner: 

■ The partner logs the service request and gets help by working on it jointly with the brand owner. 

■ The partner logs the service request and transfers it to the brand owner. 

Partner Logs Service Requests and Works on Them with the Brand 
Owner 
In this scenario, the partner acts as the primary service provider but collaborates with the brand 
owner to get service issues resolved when the partner receives service requests that require 
expertise from the brand owner.

For example, you might use this scenario if your partner is a value-added reseller of your company’s 
complex manufacturing equipment. Your partner’s field service technicians are on site installing new 
equipment, and have a problem with the machine’s software that require a software patch. The field 
service technician would log a service request in the Siebel PRM Portal’s Self-Service screen to get 
help from the brand owner and to request the patch.

This scenario consists of the following steps:

■ Step 1. Partners log service requests

■ Step 2. Partner uses self-service to get help from the brand owner

■ Step 3. The brand owner responds to the partner’s self-service request

Step 1: Partners log service requests
In this scenario, your partners enter service requests using the Siebel PRM Portal. The partner might 
get these service requests through its call center or through other customer contacts. 

To enter a new service request through the Siebel PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the Service screen.

2 In the Service Requests list, the partner clicks New to add a new record to that list.
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3 The partner enters information about the service request in the new record. 

Step 2: Partners use self-service to get help
To get help in solving the problem that they logged, partners can enter a service request in the Self-
Service screen of the Siebel PRM Portal. 

To enter a new self-service request through the Siebel PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the Self-Service screen.

2 In the Service Requests list, the partner clicks New to add a new record to that list.

3 The partner enters information about the service request in the new record. 

Step 3: The brand owner responds to the partner’s self-service request
The partner’s self-service request will be in the same queue as the other service requests that come 
to your company, and is assigned to a service agent in your company in the same way as other 
service requests are assigned. For example, you can configure Assignment Manager to assign the 
service request to a service agent based on your service agents’ expertise, availability, or other 
factors.

Because your Siebel applications share a single database, this service request will appear in the 
Siebel PRM Manager, in Siebel Service, or in any other Siebel application that your service agents 
use to track service requests. 

After your service agent responds to the self-service request, your service agent and the partner can 
continue to work together on the service request, if necessary, by logging updates to the service 
request. 

To respond to a service request

1 Navigate to the Service screen.

The Service Request list appears, with the service requests that list you as owner. 

2 After researching the service request, you as service agent can enter an activity, which will 
appear as an update on the Siebel PRM Portal. Further updates logged by the partner through 
the Self-Service screen will be visible to you in the Activities list in the Service screen of the 
Siebel PRM Manager. 

3 You as a service agent can also add Attachments and Solutions to the Service Request record. 
The partner can view these through the Siebel PRM Portal as attachments to the service request 
in the Self-Service screen. 

Partner Logs Service Requests and Transfers Them to the Brand 
Owner
In this scenario, service requests are created by the partner companies and assigned to employees 
of the brand owner company. This scenario is appropriate for you if your partners receive customer 
service requests, and your company is responsible for fulfilling the service requests. 
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You might use this scenario in many different businesses. To give just one example, you could use it 
if your partners are resellers of satellite TV services, who take the orders for the service in the store, 
while the brand owner handles the actual installation of the satellite dish and the decoder. Whenever 
the reseller receives an order, the reseller logs a service request and assigns it to the brand owner 
so the brand owner can dispatch a field service technician to perform the installation. 

This scenario consists of the following steps:

■ Step 1. Partners enter the service requests and Assignment Manager assigns them to 
the brand owner company

■ Step 2. The brand owner assigns the service requests to its employees 

■ Step 3. Brand owner employees view and work on the service requests 

■ Step 4. The brand owner tracks the service requests 

Step 1: Partners enter service requests
In this scenario, your partners receive new service requests and enter them into the Siebel 
application using the Siebel PRM Portal. 

You must set up Siebel Assignment Manager to assign service requests to the appropriate employee 
or organization in your company when partners enter service requests. Assignment Manager can 
assign service request based on employees’ skills, product expertise, geography, or other criteria. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 

To enter a new service request through the Siebel PRM Portal

1 In the Siebel PRM Portal, the partner navigates to the Service screen. 

2 In the Service Requests list, the partner clicks New to add a new record to that list.

3 The partner enters information about the service request in the new record. 

Assignment Manager has been set up to assign the service request to the appropriate 
organization or employee in your company. 

Step 2: The brand owner assigns service requests to its employees
If Assignment Manager has assigned the service request to an organization in your company, you 
must assign service requests to the appropriate service agent or field service technician in your 
company. 

You can assign service requests manually. An employee at your company with access to the All 
Service Requests view can assign the service request to the appropriate employee, by choosing the 
employee name in the service request’s Owner field. 

Alternatively, you may have set up Assignment Manager to assign service requests to the appropriate 
employee automatically when they were entered by the partner. 

In either case, the service agent responsible for the request will see it in the My Service Requests 
view.
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For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 

Step 3: Brand owner employees view and work on service request
When the service request has been assigned to your service agent, the agent can view it in Siebel 
PRM Manager, Siebel Service, Siebel Call Center, or another Siebel application by displaying the My 
Service Requests view of the Service screen. Because Siebel applications use the same database, 
you do not have to export this record from Siebel PRM to other Siebel applications. 

To view a new service request

1 Navigate to the Service screen.

2 In the Service Requests list, select the new service request. 

3 Click the appropriate view tabs to see more details about the service request. 

4 After researching the service request and solving the customer’s problem, the service agent 
chooses Closed in the Status field of the service request. 

Step 4: The brand owner tracks the service request
As your employees work on these service requests, you can track their progress using the Siebel PRM 
Manager, or their managers can track their progress using Siebel Service. Again, because Siebel 
applications use the same database, you do not have to worry about exchanging data among 
different Siebel applications. 

You can track your employees’ progress as they work on their service requests by displaying the 
service requests, viewing the activities attached to it, and checking the status field to see if the 
service request has been closed. 

Your service agents’ managers can track their reports’ service requests by displaying the My Team’s 
Service Requests view. 

To track employee’s service requests

1 Navigate to the Service screen. 

2 From the Show drop-down list, choose My Team’s Service Requests.

3 In the My Teams Service Requests list, select a service request you want to track. 

4 Click the Activities view tab.

The activities attached to that service request appear.

Scenarios for Field Service
Many brand owners use partners to provide field service and other types of service that require use 
of parts to service assets that customers have purchased. Siebel PRM provides the Inventory screen 
and the Assets screen to support this sort of service. 
Siebel Partner Relationship Management Administration Guide Version 7.8, 
Rev. A

230 



Managing Service Requests ■  Managing Customer Service Requests
This section provides two typical scenarios for this sort of service:

■ The brand owner and partner manage inventory. 

■ The partner responds to service requests for assets. 

The Brand Owner and Partner Manage Inventory
Siebel PRM allows the brand owner and partners to work together to manage inventory, such as the 
spare parts that the partner needs to do repairs. 

The brand owner can share inventory with the partner. The partner can locate inventory and use it 
to service customers. The brand owner can automatically warn the partner if the inventory of a given 
part is too low. 

For more information about working with inventory, see Siebel Field Service Guide. 

This scenario consists of the following steps: 

■ Step 1: The brand owner sets up an inventory location for the partner

■ Step 2: The brand owner transfers products to the inventory location

■ Step 3: The partner transfers inventory to inventory sublocations

■ Step 4: The partner service agent finds and uses needed parts 

■ Step 5: The brand owner monitors partner inventory level 

Step 1: The brand owner sets up an inventory location for the partner
First, the brand owner sets up one primary inventory location for each partner who will use inventory. 
The organization for this inventory location should be the partner’s organization, so other partners 
cannot see this inventory. 

To set up an inventory location for a partner

1 Navigate to the Inventory screen. 

2 In the Inventory Locations list, click New to create a new record. 

3 Fill in the fields of the new record as follows: 

a In the More Info form, click the show more button to expand the form. 

b In the Organization field, select the partner organization. 

c In the Owner field, select a partner position in the specified partner organization. 

Step 2: The brand owner transfers products to the inventory location
Next, the brand owner associates products with the partner’s inventory location. These may be 
transferred from the brand owner’s inventory location, or they may be transferred from a virtual 
location that the brand owner created to hold products that will be transferred to partners. 
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To transfer a product to the partner’s inventory location

1 Navigate to the Inventory Transaction screen. 

2 In the Inventory Transactions list, click New to create a new record. 

3 Fill in the fields of the new record as follows:

a In the Source Location field, choose either your own inventory location or the virtual location 
used to hold products for partners. 

b In the Destination Location field, choose the inventory location you created for the partner. 

c In the Commit field, click the field to add a check mark, completing the transaction. 

Step 3: The partner transfers inventory to inventory sublocations
The partner service administrator logs into the Siebel PRM Portal and sees that this inventory location 
has been assigned to him or her. 

A small partner company with only one physical location for inventory could use this inventory 
location to represent its physical inventory location. 

A larger partner company with several physical locations for inventory would create a subinventory 
location under this inventory location to represent each of its physical inventory locations. Then it 
would transfer the inventory from the inventory location that the brand owner created to these 
inventory locations.

To transfer inventory to product inventory locations

1 The partner service administrator navigates to the Inventory screen. 

2 In the Inventory Locations list, the partner adds a new record representing each of the partner 
company’s physical inventory locations. 

3 The partner navigates to the Inventory Transfer screen. 

4 In the Inventory Transactions list, the partner adds a new record and fills in its fields as follows: 

a In the Source Location field, the partner chooses the inventory location that the brand owner 
created. 

b In the Destination Location field, the partner chooses one of the inventory locations created to 
represent the partner’s physical inventory locations. 

5 The partner continues to create new Inventory Transaction records until all of the inventory is 
transferred to locations representing its partner’s physical inventory locations. 

Step 4: The partner service agent finds needed parts
Now, when a partner service agent needs a spare part, the agent can use the part browser to find 
where the part is located. The part browser limits the agent to the partner company’s inventory 
locations. 

Then, when the partner service agent creates a service order, the partner associates it with the 
inventory location where this part was found. 
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Siebel PRM automatically adjusts the quantity of that part in inventory to reflect the fact that parts 
were used in service orders. 

To find a needed part

1 The partner service agent navigates to the Part Browser screen. 

2 The partner searches for the part and finds its locations. 

Now, the partner can go to the nearest location that has the part in inventory to get it. 

Step 5: The brand owner monitors partner inventory level
The brand owner can monitor each partner’s inventory for each part by navigating to the Part 
Browser screen and to the All Parts Across Organizations view. 

The brand owner can monitor each partner’s inventory locations by navigating to the Inventory 
screen and to the All Inventory Locations Across Organizations view. Then, the brand owner can click 
the Product Inventory view tab and see if the partner is short of inventory by looking at the following 
fields in the Product Inventory Record: 

■ Safety. When inventory reaches the amount in this field, the partner should reorder. 

■ Min. This is the absolute minimum that should be in inventory. The inventory should not reach 
the amount in this field, because the partner should reorder parts when the inventory reaches 
the safety level. 

The brand owner can set up Siebel Business Process Designer to automatically send the partner a 
notification telling the partner to reorder a part when the inventory of that part reaches the level in 
the Safety field. If the inventory of a part reaches the level in the Min field, Siebel Business Process 
Designer can send a more urgent warning to the partner, or it can send email to one of the brand 
owner’s sales representatives who will contact the partner personally. 

The Partner Responds to Service Requests for Assets
In this scenario, the partner uses the Assets screen to work with service requests for assets that 
customers have purchased. The brand owner can monitor the service requests for each asset. 

This scenario consists of the following steps: 

■ Step 1: The brand owner assigns assets to a partner 

■ Step 2: The partner logs a service request against the asset 

■ Step 3: The partner looks at the history of the asset 

■ Step 4: The brand owner monitors a partner’s service of assets 

Step 1: The brand owner assigns assets to a partner
A partner who services assets must have a list of assets that have been sold to each customer. 

If the partner sells and services the product, the partner would create the asset record when it sells 
the product. 
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In this example, the brand owner sells products and the partner services them. When a brand owner 
sells a product, it assigns the asset to a partner company to be serviced. 

To assign an asset to a partner company manually

1 Navigate to the Site Map > Assets screen.

2 In the Assets list, select the asset that you want to assign to the partner company.

3 In the More Info form, click the show more button to expand the form. 

4 In the More Info form, in the Organization field, click the select button.

5 In the Pick Organization dialog box, select the organization of the partner company and click OK.

Step 2: The partner logs a service request against the asset
When a customer calls or comes in to request service on an asset, the partner service agent logs a 
service request against the asset. 

The partner creates the service request record in the usual way, and associates it with an asset. 

To log a service request against an asset

1 The partner navigates to the Service screen > My Customer’s Service Requests view. 

2 The partner creates a new Service Request record and fills out its fields as follows.

a In the More Info form, the partner clicks the show more button. 

b In the More Info form, in the Asset field, the partner clicks the select button and chooses the 
Asset. 

Step 3: The partner looks at the history of the asset
To help in responding to the service request, the partner service agent uses the Assets screen to 
view all past service requests associated with the asset, see when the asset was installed, and look 
at other features of the asset’s history. 

To look at the history of the asset

1 The partner navigates to the Assets screen. 

2 In the Asset list, the partner selects the record for this asset.

3 The partner views information about the history of the asset in the Asset record and in the 
Activities, Notes, Service Requests, and Change Requests view tabs. 

Step 4: The brand owner monitors a partner’s service of assets
At any time, the brand owner can use the Siebel PRM Manager to view all the assets of a partner and 
to view the service requests associated with these assets, to monitor the partner’s service of each 
asset. 
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To monitor a partner’s service of assets

1 Navigate to the Site Map > Assets screen > All Assets Across Organization view. 

2 If necessary, click the show more button of the More Info form to display the Organization field. 

3 Click Query, select the partner organization in the organization field of the query form, and click 
Go.

All assets for that partner company appear in the Assets list. 

4 In the Assets list, select an asset. 

5 Click the Service Request view tab. 

All service requests for that asset appear. 

Managing Partners’ Service Requests
Partners often encounter situations in which they need assistance from the brand owner because 
they have questions about the partnership, requests for marketing collateral, questions about 
commission payments, or other questions. 

Your partners can use the Self-Service screen in the Siebel PRM Portal to log service requests, or if 
they have questions about the partnership, questions about using Siebel PRM software, or any other 
questions or needs that require personal service. 

To reduce the number of service requests you receive, you can create a repository of FAQs, solutions, 
and SmartScripts to help partners solve their own problems without logging service requests. These 
will be covered in “Using Solutions and SmartScripts to Help Partners Solve Problems” on page 236. 

NOTE: Be sure to tell your partners to use the Self-Service screen of the Siebel PRM Portal to log 
their own service requests. The Service screen is used to log customer service requests.

Assigning Service Requests
Your company’s service requests are listed in the Siebel PRM Manager and other Siebel applications 
in the All Service Requests view of the Service screen. As they are received, each request should be 
assigned to the appropriate service agent. After the service agents resolve service requests, they 
change their status to Closed. 

You can assign service requests in two ways:

■ Assignment Manager. You can set up Siebel Assignment Manager to assign service requests to 
the appropriate service agent at your company using criteria such as expertise, availability, and 
workload. 

■ Manual assignment. Service requests logged by the partner are displayed in the All Service 
Requests view in the Siebel PRM Manager. An employee at the brand owner company with access 
to this view can assign the service requests manually to the appropriate service agent. 

For more information about Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. 
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For more information about working with service requests, see Siebel Call Center User Guide, Siebel 
eService Administration Guide, and Applications Administration Guide.

Business Example Using Partner Self-Service
The following example shows how a partner might use a service request to get marketing materials.

One of your partners wants to organize a marketing event such as an executive seminar about 
partner relationship management. It needs to get appropriate marketing material from you for this 
event, where it will display both your brand name and its own brand name. 

The partner logs a service request for the marketing materials through the Self-Service screen in the 
Siebel PRM Portal. 

The service request is routed to the appropriate person at the brand owner company by Assignment 
Manager, or it is assigned manually by the person responsible for assigning service requests at the 
brand owner company. 

The service agent fulfilling the service request follows up by finding the appropriate marketing 
material and routing it to the partner. 

Using Solutions and SmartScripts to 
Help Partners Solve Problems
You can help partners solve problems by creating solutions or Siebel Troubleshooting or Instruction 
SmartScripts. Solutions or SmartScripts can help partners solve:

■ Customer problems. Partners can use solutions or SmartScripts rather than getting help from 
the brand owner to solve customer service requests. 

■ Partnership problems. Partners can use solutions or SmartScripts to solve their own problems, 
rather than using the Self-Service screen to enter service requests. 

Business Example Using Solutions and SmartScripts
The following is an example of how a partner might use solutions and SmartScripts that you have 
set up.

One of your partners is planning to organize a seminar to educate executives about partner 
relationship management. The partner wants to know whether the brand owner will refund the cost 
of this marketing event. 

The partner navigates to the Solutions screen in the Siebel PRM Portal, browses the frequently asked 
questions (FAQs), and searches on keywords to find relevant solutions. 

The partner finds an FAQ that says there is a SmartScript with a series of questions and answers that 
let you identify whether marketing events qualify for reimbursement. 
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The partner navigates to the Solutions screen in the Siebel PRM Portal and runs this SmartScript. It 
asks a series of questions about the type of event being organized, the partner company’s 
partnership level, and other parameters that determine whether a marketing event qualifies for 
reimbursement. 

The partner finds that the seminar qualifies for reimbursement. However, the partner still needs 
some help from the brand owner, such as marketing material and permission to use its logos. To get 
this help, the partner navigates to the Self-Service screen and logs a service request, as described 
in “Managing Partners’ Service Requests” on page 235.

Making Solutions Available to Partners
Service solutions are answers to frequently asked questions (FAQs). You can create solutions that 
your customers, employees, or partners can use. You can associate a solution with related solutions 
and resolution documents, so users can navigate among these related documents. A service agent 
can associate a solution with a service request or a change request to make it available to the user 
who logged the request. 

Solution records may be published internally, externally, or both: 

■ Solutions published internally are accessible to your employees. 

■ Solutions published externally are accessible to customers.

You publish solutions internally to make them available to partners, because Siebel PRM treats 
partner employees as your employees. 

Use access control to make solutions accessible to a specific partner or partner community. Use the 
Catalog Administration screen to add the solution to a catalog that is associated with the partner 
community for which you want to make it visible. 

Your partners access these solutions through the Solutions view of the Solutions screen in the Siebel 
PRM Portal. Partners can browse through the solutions or use a keyword search to find the solution 
they need. The Solutions view shows a flat list of solutions, which is useful for a keyword search.

Alternatively, solutions can be added to catalogs and be made available to users through the 
InfoCenter screen. Navigation of the InfoCenter is more straightforward.

For information on creating and administering service solutions, FAQs, and resolution documents, 
see the section on solutions and service requests in Applications Administration Guide.

Making Troubleshooting or Instruction SmartScripts 
Available to Partners
A SmartScript is a set of branching questions and instructions. The answer to each question 
determines which question or instruction appears next. 
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Siebel SmartScripts are often used by call center agents who perform troubleshooting. The 
SmartScript tells them what question to ask the customer. Depending on the customer’s answer, the 
SmartScript tells them the next question to ask. The scripted series of questions and answers helps 
the agent identify and solve the problem. 

You can also create SmartScripts to help your customers, employees, or partners solve problems. 

After you have created and tested the SmartScript, you select the Active check box to make it 
available. 

For information about creating and administering SmartScripts, see Siebel SmartScript 
Administration Guide. 

To make a Troubleshooting or Instruction SmartScript available to partners

1 Navigate to the SmartScript Administration screen. 

2 Create a SmartScript as follows: 

a Select Troubleshooting or Instructions in the Type field.

b Click the Active check box.

3 Add the SmartScript to the Service Catalog in the desired category. 

4 Make sure the partner is in the Access group for that category.

The SmartScript is visible to the partner in the Solutions screen of the Siebel PRM Portal. The 
partner can filter to display only Troubleshooting or Instruction SmartScripts. 
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This chapter describes scenarios that illustrate different ways you can use Siebel PRM to manage 
marketing campaigns. 

This chapter contains the following topics:

■ “About Managing Marketing Campaigns” on page 239

■ “Collaborative Marketing with Partners” on page 239

■ “Marketing to Partners” on page 242

■ “Marketing by Your Partners” on page 243

About Managing Marketing Campaigns
Siebel PRM can be used for three types of marketing: 

■ Collaborative marketing with your partners. The brand owner can work collaboratively with 
partners to market your products to customers. 

■ Marketing to your partners. The brand owner can direct marketing campaigns to your partners 
to help convince them to resell a new product that you are introducing, to join a specific partner 
program, or for other reasons. 

■ Marketing by your partners. Partners can use the Siebel PRM Portal to create and execute their 
own marketing campaigns. 

This chapter describes some scenarios that are examples of ways that you might use Siebel PRM for 
marketing. Siebel applications include marketing functionality that lets you create marketing offers, 
campaigns, and programs, that executes campaigns automatically, and that helps you manage 
responses. 

For more information about marketing, see Siebel Marketing Guide.

Collaborative Marketing with Partners
You often want to work with your partners collaboratively to market your products to your customers. 
Use Siebel PRM to:

■ Plan the collaborative marketing.

■ Manage the collaborative marketing campaign.
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Planning Collaborative Marketing 
You can use the Siebel PRM CHAMP Planning screen to plan collaborative marketing projects. This 
screen lets you do the following: 

■ Set specific marketing objectives, such as launching a 20% discount offer on a server product 
line in order to generate a 10% increase in revenue, or jointly hosting a conference about 
complementary products. 

■ Associate a detailed action plan with each objective, scheduling actions that you and your partner 
must take to meet the objective. 

■ Link each objective to a market development fund (MDF) to indicate the source of funding for the 
marketing program. Partners will be able to link fund requests to the objectives so they can 
receive credit for money spent executing the marketing program. 

For example, the brand owner and partner may decide to host an event to promote their 
complementary products or services. They use the CHAMP Planning screen to specify an agreed-upon 
action plan. Following the action plan, the partner organizes the event. As the partner incurs 
expenses in organizing the event, it submits MDF requests to receive credit against the fund. 

For more information about CHAMP planning, see Chapter 7, “CHAMP Planning.”

For more information about market development funds, see Chapter 14, “Using Market Development 
Funds.”

Managing Collaborative Marketing Campaigns
Campaigns typically involve contacting current or potential customers to market your products. For 
instance, you might have a campaign to contact people and sign them up for a seminar, or a 
campaign to send out a promotional mailing requiring that the recipients call in if they are interested 
in your products or services.

Because campaigns are contact-intensive, they are often handled by a call center. Many Siebel 
campaign functions are designed to maximize a campaign’s effectiveness in a call center 
environment. Siebel applications let you create campaigns, specify lists and groups of people to call, 
specify quotas for the call center personnel, and track which employees have the skills needed for 
different campaigns. 

Partner employees have access to call center campaigns through the Siebel PRM Portal in the same 
way that your employees have access through the Siebel PRM Manager. Partners can use the Siebel 
PRM Portal to update call status and outcome, refresh the contacts list, launch SmartScripts, create 
campaign leads, and do the other things that your internal employees do when they work with 
campaigns. 

You can also share other kinds of campaigns with partners, such as email, Web, or direct mail 
campaigns. For example, the brand owner could set up an email campaign, allow the partner to edit 
the contact list, close the campaign for editing, and then launch the email campaign. In this case, 
the brand owner executes the email campaign, but the partner has input on where the emails are 
sent.
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You create collaborative campaigns and campaigns that your own company executes in the same 
way. The only difference is that, for collaborative campaigns, you add partner organizations to the 
campaign, as well as your own employees. Siebel PRM lets your partners use the same functionality 
that your own company uses to run campaigns. 

After associating partner organizations with the campaign, you can use the Execution Options view 
of the Campaign Administration screen to assign campaign contacts to partners manually or by using 
Siebel Assignment Manager. Partners see only contacts that have been assigned to them. You can 
also use this view to specify whether partners can add and edit contacts for the campaign. 

As an alternative method of assigning partners to campaigns, you can use the Administration - 
Administration screen > Campaign Groups view to create groups of employees. For example, you 
can define a team of people within a partner company who regularly execute campaigns as a 
campaign group. You can assign the groups to campaigns, by using the Campaign Management 
screen > Groups view. After you assign the campaign to the partner organization, the partner can 
also assign these groups to the campaign using the Siebel PRM Portal. 

In one typical way of executing a collaborative campaign, the brand owner sets up the campaign and 
provides a contact list to the partner company, and the partner executes the campaign in its call 
center. For example, a collaborative campaign might involve the following scenario: 

■ Your company and your partner have sponsored an event collaboratively. You want to follow up 
by giving the attendees a phone offer to buy one of your products at a discounted price. 

■ You create the campaign and the offer using the Siebel PRM Manager’s Campaign Management 
screen. 

■ You add the attendees at the trade show to the campaign’s Contacts/Prospects list using the 
Siebel PRM Manager’s Campaign Administration screen. Alternatively, you import a list of 
attendees using the Siebel list management functionality, which lets you import lists in many 
standard formats.

■ You add one or more partner organizations to the campaign using the Siebel PRM Manager’s 
Campaign Administration screen. All partner companies whose organizations have been added 
will have visibility into the Campaign header using the Campaign Planning screen on the Siebel 
PRM Portal. A marketing manager at the partner company can then add employees at the partner 
company to the campaign team.

■ Depending on the execution options, campaign contacts will be assigned to the partners 
associated with the campaign either through Assignment Manager or manually. Other options 
determine whether partner organizations can or cannot add, remove or edit campaign contacts.

■ The partner company’s call center executes the campaign. Partner employees who are on the 
campaign team can see this campaign in the My Campaigns view of the Siebel PRM Portal’s 
Campaigns screen. They can click the view tabs to display a summary of the campaign, the call 
guide, the offer, the list of prospects and contacts, and other information.

For more information about creating campaigns, see Application Administration Guide. 

To add partner organizations to the campaign team

1 Navigate to the Campaign Administration screen. 

2 In the Campaigns list, select the campaign that you want the partner to execute.
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3 In the Organization field of the campaign, click the select button and use the dialog box to select 
partner organizations. 

All partner organizations that were added can see information about the campaign through the 
Campaign Planning screen of the Siebel PRM Portal.

Marketing to Partners
You can market to your partners to recruit more partners into your partner program, recruit existing 
partners into a new program, inform your partners about a new promotion or a new product launch, 
invite partners to an event, ask partners to participate with you or sponsor an event, or for other 
reasons. 

Siebel PRM and Siebel Marketing allow your marketing managers to market to partners through a 
variety of channels, and to market to partners in conjunction with their other marketing activities. 

Creating and Executing Campaigns
Campaigns are the key method of marketing to partners or to customers. You create campaigns with 
specific goals, such as introducing a new product, and offers that are part of each campaign, such 
as an offer to sell the product at a discount price. 

You can use the Campaign Administration screen to create campaigns that are specifically targeted 
to your partners, create offers and associate them with the campaign, create a prospect list that 
consists of prospective or existing partners, and send the offers to the prospects through a variety 
of channels: direct mail, fax, email, Web, phone, or newsletter. 

For example, if you are launching a new product line and want existing resellers of other product 
lines to sign up as resellers of this new line, you might go through the following process: 

■ Create a new campaign. Navigate to the Campaign Administration screen, add a new record, 
and enter information describing the campaign. 

■ Add contacts to the campaign. Determine which partners you want to receive the campaign 
and add them to the campaign’s contact list, or use list management to import a list of 
prospective partners. 

■ Create an offer for the campaign. Determine how you want the partners to get the news about 
this product launch, and then navigate to the Offers screen to create an appropriate offer. For 
example, if you want to contact the partners by email, create an email offer and associate 
literature (such as a brochure and price list) with the offer. The email can also have a hyperlink 
to the Siebel PRM Portal, where they can find out more about the new product line and sign up 
as resellers. 

■ Execute the campaign. The email is sent, and partners will respond if they are interested.

■ Create a followup campaign. To follow up the email campaign, you might plan an event for 
partners to attend if they have signed up as resellers of this product. You could create and 
execute this followup campaign as you did the initial campaign, except that the contacts are only 
the partners who have signed up as resellers and the campaign is a phone campaign, so it is 
executed by your call center. Creating the followup campaign requires Siebel Marketing. 
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For more information about campaigns, see Siebel Marketing Guide. 

Making Campaign Offers to Partners
When you do collaborative marketing with partners, you generally create phone offers and have the 
partners execute the phone campaign. When you market to your partners, you can use a variety of 
offers, including: 

■ eNewsletters

■ eMail Offers

■ Direct Mail Offers

■ Web Offers

■ Fax Offers

■ Phone Offers

Offers can be used for marketing and for communicating with partners. 

For example, you can create eNewsletters that update partners on the latest information about your 
company, or create eNewsletters that are delivered on a regular schedule. The eNewsletters can have 
a variety of purposes: you can use them for regular newsletters, news releases, quarterly financial 
results, special promotions, or for other purposes. 

Offers have content that can be personalized for each recipient. The Offers screen lets you create 
sections for each type of offer and to specify rules that determine which sections the recipient sees. 

For information about working with offers, see Siebel Marketing Guide.

Marketing by Your Partners
The Campaign Planning screen of the Siebel PRM Portal allows partners to create their own 
campaigns and execute them independently of the brand owner. 

Partners create campaigns as the brand owner does. They use the Campaign Planning screen to 
create a new Campaign record, and to create the following records that are associated with the 
campaign:

■ Lists. This record allows the partner to add external lists of contacts or prospects to the 
campaign. 

■ Offers. This record allows the partner to specify offers that the campaign will make to 
customers, including phone, direct mail, email, fax, media, and other types of offers. 

■ Contacts/Prospects. This record allows the partner to add existing Siebel Contacts to the 
campaign. 

■ Owner Audit Trail. This record allows the partner to track ownership of campaign contacts. 

■ Quotas. This record allows the partner to set targets for the campaign, such as the number of 
calls per hour.
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■ Responses. This record allows the partner to track responses to the campaign, if it is a campaign 
with a response type of Response. 

■ Team. This record allows the partner to specify the employees working on the campaign.

■ Groups. This record allows the partner to add predefined lists of employees to the campaign 
team. 

Other partners cannot see a campaign created by a partner company. The brand owner can see all 
partners’ campaigns by navigating to the Campaign Administration screen, All Campaigns Across 
Organizations view. 

The Campaign Planning screen of the Siebel PRM Portal is similar to the Campaign Administration 
screen in Siebel PRM Manager, but without a number of views. For more information about how the 
Campaign Administration screen is used, see Siebel Marketing Guide. 

NOTE: Siebel Marketing Manager for Partners is an additional product that offers more extensive 
marketing functionality for partners than Siebel PRM. For more information about this product, see 
Siebel Marketing Guide. 
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This chapter describes how you can use Siebel PRM to manage partner commerce. It looks at ways 
that you can use partner commerce to sell to partners, and at ways that partners use partner 
commerce to sell to customers. 

This chapter contains the following topics:

■ “About Partner Commerce” on page 245

■ “Setting Up Partners for Standard, Power, and Personal Commerce” on page 245

■ “Scenarios for Partner Commerce” on page 247

■ “Disabling Partner Commerce Workflows” on page 251

■ “Removing the PRM Portal Shopping Cart Toolbar” on page 251

About Partner Commerce
Siebel PRM supports the following types of partner commerce:

■ Standard Partner Commerce. Allows partners to create quotes and orders using a shopping 
cart, as customers do using Siebel Sales. Standard partner commerce is straightforward and can 
be used by partners with little or no training. 

■ Power Partner Commerce. Allows partners to create quotes and orders using the Quotes and 
Orders screens, as your own employees do using Siebel Partner Manager, Siebel Sales or other 
Siebel employee applications. Power partner commerce may require more training and has more 
capabilities. 

■ Personal Partner Commerce. Allows partners to buy only on their own account, not on behalf 
of a customer.

Setting Up Partners for Standard, 
Power, and Personal Commerce
Whether partner employees use standard partner commerce, power partner commerce, or personal 
partner commerce views depends on their responsibilities and roles:

■ Responsibility. Controls which views the partner can use. You assign partners a responsibility 
that allows them to access the standard partner commerce views or a responsibility that allows 
them to access the power partner commerce views. 

■ Role. Controls which options the partner gets in the Quotes home page and the Orders home 
page. The task applets in these home pages are driven by roles. 
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To set up a partner employee as a standard partner commerce user

1 Navigate to the Site Map > Administration - User screen. 

2 In the Employees list, select the record for the partner. 

3 In the More Info form, click the show more button. 

4 In the More Info form, in the Responsibility field, click the select button. 

5 In the Responsibilities dialog box, click New. 

6 In the Add Responsibilities dialog box, select the responsibility named “Partner Commerce 
Standard User,” click OK to add it to the user’s responsibilities, and then click OK in the Add 
Responsibilities dialog box. 

7 In the More Info form, in the Roles field, click the select button. 

8 In the Roles dialog box, click New. 

9 In the Add Roles dialog box, select the role named “Partner Commerce Standard User,” click OK 
to add it to the user’s roles, and then click OK in the Add Roles dialog box. 

To set up a partner employee as a power partner commerce user

1 Navigate to the Site Map > Administration - User screen. 

2 In the Employees list, select the record for the partner. 

3 In the More Info form, click the show more button. 

4 In the More Info form, in the Responsibility field, click the select button. 

5 In the Responsibilities dialog box, click New. 

6 In the Add Responsibilities dialog box, select the responsibility named “Partner Commerce Power 
User,” click OK to add it to the user’s responsibilities, and then click OK in the Add Responsibilities 
dialog box. 

7 In the More Info form, in the Roles field, click the select button. 

8 In the Roles dialog box, click New. 

9 In the Add Roles dialog box, select the role named “Partner Commerce Power User,” click OK to 
add it to the user’s roles, and then click OK in the Add Role dialog box. 

To set up a partner employee as a personal partner commerce user

1 Navigate to the Site Map > Administration - User screen. 

2 In the Employees list, select the record for the partner. 

3 In the More Info form, click the show more button. 

4 In the More Info form, in the Responsibility field, click the select button. 

5 In the Responsibilities dialog box, click New. 
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6 In the Add Responsibilities dialog box, select the responsibility named “Partner Commerce 
Personal User,” click OK to add it to the user’s responsibilities, and then click OK in the Add 
Responsibilities dialog box. 

7 In the More Info form, in the Roles field, click the select button. 

8 In the Roles dialog box, click New. 

9 In the Add Roles dialog box, select the role named “Partner Commerce Personal User,” click OK 
to add it to the user’s roles, and then click OK in the Add Roles dialog box. 

Scenarios for Partner Commerce
Your partners may use standard partner commerce to shop in two ways: 

■ Partners shopping for themselves. The partner is your customer. 

■ Partners shopping for their customers. The partner is your sales agent, selling your products 
to customers. 

In both of these methods, partners use the Siebel Sales catalog to choose products. For more 
information about setting up and using Siebel Sales, see Siebel eSales Administration Guide. 

Partner commerce can also use Siebel Interactive Selling, which includes Advisor, Configurator, 
Pricer, and Auction. For more information about Siebel Interactive Selling, see Product Administration 
Guide, Siebel Interactive Designer Administration Guide, Pricing Administration Guide, and Siebel 
eSales Administration Guide. 

Partners Shopping for Themselves 
Partners can place orders for themselves to replenish their store inventory or to order new products 
that the brand owner has made available to them as product offers.

After shopping, partners use the My Quotes and My Orders views in the Quotes and Orders screens 
in the Siebel PRM Portal to track the quotes and orders that they created.

Partners shop for themselves in the same way whether they use standard partner commerce or 
power partner commerce. 

NOTE: If partners are using personal partner commerce, the system skips the step that asks the 
partners whether they are shopping for themselves or for customers, because they can only shop for 
themselves. 

To shop for themselves 

1 In the Siebel PRM Portal, the partner navigates to the Product Catalog screen.

2 The partner browses the catalog and adds an item to the Shopping Cart.

The New Cart form appears, with the question Who are you shopping for?
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3 The Partner clicks My Company.

The shopping cart appears. 

4 The partner continues to browse the catalog and add items. 

5 While browsing, the partner can click View Details at any time to display the shopping cart. 

6 In the shopping cart, the partner can click Check Out to complete the purchase, or the partner 
can click Save Cart to save the cart as a quote. 

7 If the partner has saved the cart as a quote, it can be viewed by navigating to the My Quotes 
view. 

Partners Shopping for Customers
Partners with Standard Partner Commerce have only the easiest to use method of shopping for 
customers. Partners with Power Partner Commerce have additional methods of shopping for 
customers. 

Shopping for Customers Using Standard Partner Commerce
Your partners’ sales agents may use the Siebel PRM Portal to shop, provide quotes, and place orders 
for their customers, for example, if the partners are resellers of your products. This is more 
complicated than shopping for themselves, because resellers could have different price lists for 
different customers, based on geography, account, or other factors. 

After shopping, partners use the My Customer Quotes and My Customer Orders views in the Quotes 
and Orders screens in the Siebel PRM Portal to track quotes and orders that they created.

To shop for customers using Standard Partner Commerce, the partner uses the shopping cart and 
product catalog. 

This method gives the partner a simple shopping process. It does not allow the partner to specify 
line item Ship To addresses. 

To shop for customers using Standard Partner Commerce

1 In the Siebel PRM Portal, the partner using Standard Partner Commerce navigates to the Product 
Catalog screen.

2 The partner browses the catalog and adds an item to the Shopping Cart.

The New Cart form appears, with the question Who are you shopping for?

3 The Partner clicks A Customer.

The Customer Information form appears. 

4 In the Customer Information form, the partner clicks the Select buttons to select the customer’s 
account, last name, price list, and to link the sale to an opportunity. After selecting the 
customer’s account, the partner can select a price list for that account. 
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5 In the Customer Information form, the Partner clicks Next. 

The Shopping Cart form appears, with the Customer Information form above it.

6 The partner continues to browse the catalog and add items for the customer. 

7 When the shopping cart is displayed, the partner can edit the information in the Customer 
Information form. 

8 In the shopping cart, the partner can click Check Out to complete the purchase, or the partner 
can click Save Cart to save the cart as a quote. 

9 If the partner has saved the cart as a quote, it can be viewed by navigating to the My Customer 
Quotes view in the Quotes Screen. 

Shopping for Customers Using Power Partner Commerce
Your partners’ sales agents may use the Siebel PRM Portal to shop, provide quotes, and place orders 
for their customers, for example, if the partners are resellers of your products. This is more 
complicated than shopping for themselves, because resellers could have different price lists for 
different customers, based on geography, account, or other factors. 

After shopping, partners use the My Customer Quotes and My Customer Orders views in the Quotes 
and Orders screens in the Siebel PRM Portal to track quotes and orders that they created.

To shop for customers using Power Partner Commerce, the partner can follow any of the following 
three processes:

■ Use the Shopping Cart and Product Catalog

■ Use the Quotes Screen and the Product Catalog

■ Use the Quotes Screen without the Product Catalog

Using the Shopping Cart and Product Catalog
This is the best option if the partner does not have to specify line item Ship To addresses and if you 
want a simple shopping process. 

When they use this method, partners with Power Partner Commerce shop for customers in the same 
way as partners with Standard Partner Commerce. For instructions on how this is done, see the 
section “Shopping for Customers Using Standard Partner Commerce” on page 248. 

Using the Quotes Screen and the Product Catalog
This is a good option if you have partners who are experienced users. The Quotes screen provides 
additional functionality, such as the ability to specify due date, effective date, through date, or 
different bill to and ship to addresses than the defaults for the account.

This option is only available to Power Partner Commerce users. 
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To shop using the Quotes screen and the Product Catalog 

1 In the Siebel PRM Portal, the partner using Power Partner Commerce navigates to the Quotes 
screen.

2 In the Quotes form, the partner clicks the My Customer Quotes hyperlink.

3 The partner creates a new quote and enters Quote Header information, such as the account, 
contact, price list, and so on.

4 In the Quote Header form, the partner clicks Browse Catalog.

5 The partner browses the catalog and adds items to the cart. 

6 In the catalog, the partner clicks View Details. 

The Quote Detail view appears. 

7 The partner reviews and, if necessary, edits line items in the quote. 

8 The partner clicks the Orders view tab. 

9 The partner clicks Sales Order or Service Order to turn the quote into an order. 

Using the Quotes Screen Without the Product Catalog
This is also a good option if you have partners who are experienced users. It provides the same 
functionality as the previous option. The difference is a matter of preference: some brand owners 
think the product catalog is easier for partners to understand and work with, so they use the previous 
method. Other brand owners think that it is faster for partners to make choices from a flat list of 
products, so they use this method. 

This option is only available to Power Partner Commerce users. 

To shop using the Quotes screen without the Product Catalog using Standard 
Partner Commerce

1 In the Siebel PRM Portal, the partner using Power Partner Commerce navigates to the Quotes 
screen.

2 In the Quotes form, the partner clicks the My Customer Quotes hyperlink.

3 In the Quotes list, the partner clicks New to create a new quote and enters Quote Header 
information, such as the account, contact, price list, and so on.

4 The partner clicks the Line Items view tab. 

5 In the Line Items list, the partner clicks Add Item to add a new line item to the quote. 

6 The partner selects a product for the new line item, enters the quantity, discount, and other 
information. 

7 The partner continues to create a new line item for each product being purchased. 

8 The partner clicks the Orders view tab. 

9 The partner clicks Sales Order or Service Order to turn the quote into an order. 
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Disabling Partner Commerce Workflows
When a partner adds an item to a new shopping cart, both standard partner commerce and power 
partner commerce invoke workflows that ask whether the partner is shopping on behalf of a 
customer or on their own behalf. 

You can turn off this functionality by deleting the following parameter: 

PostAddToCartLogic = eChannelShoppingScenarios

You must delete this parameter in both the Server Administration screen and the Siebel Server.

To disable the message that asks partners who they are shopping for

1 Use any text editor to open the configuration file for the Siebel PRM Portal, which is the file 
<installation directory>\siebsrvr\bin\<lang>\scw.cfg. 

2 In the [InfraShoppingService] section of the file, delete the following line: 

PostAddToCartLogic = eChannelShoppingScenarios

3 Change this parameter in the Server Administration screen: 

a From the application-level menu, choose View > Site Map > Server Administration > 
Components. 

b Click the Component Parameters view tab. 

c In the Components list, search for eChannel Object Manager in the Name field. 

d In the Component Parameters list, find the parameter PostAddToCartLogic and delete it. 

4 Restart your server.

Removing the PRM Portal Shopping Cart 
Toolbar
The standard method of removing toolbars is not used for removing the Shopping Cart toolbar from 
the Siebel PRM Portal.

This section gives high-level instructions for removing this toolbar. You should do this only if you are 
experienced at working with Siebel Tools. For more information, see Siebel Tools Reference.

To remove the PRM Portal shopping cart toolbar

1 In Siebel Tools, navigate to: 

Web Page = eChannel Container Page

Web Page Item = Shopping Cart

2 Set Inactive = TRUE. 
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13 Partner-to-Partner 
Collaboration
This chapter describes ways in which your partner companies can use Siebel PRM to collaborate with 
other partner companies. The brand owner can track the collaboration, but does not have to 
participate in it. 

This chapter contains the following topics:

■ “About Partner-to-Partner Collaboration” on page 253

■ “Partner Collaboration” on page 253

■ “Siebel Projects” on page 258

About Partner-to-Partner Collaboration
Other chapters of this book describe ways in which Siebel PRM allows the brand owner to work with 
partners. This chapter describes ways in which Siebel PRM allows partners to work directly with other 
partners, and it covers the following topics:

■ Partner Collaboration. This provides a powerful way for partners companies to share 
information with employees or organizations of other partner companies. 

■ Projects. They provide a simple way for partner employees to share information with employees 
of other partner companies. 

You can also configure visibility using Siebel Tools to allow partners to share information in other 
ways. For more information, see “Configuring Visibility” on page 38. 

Partner Collaboration
Partner collaboration allows partners to share information with either employees or organizations of 
other partner companies. It can be used to share information among two or more partner companies. 

It also provides partners with an automated process of requesting and accepting collaborations. After 
using the Partner Locator to find partners it wants to collaborate with, the partner clicks Request 
Collaboration to send a message to these partners. The invitee partners can see these collaboration 
requests in the Collaborations screen and can accept or reject them by changing the value of the 
Status field. 

When a request is accepted, a Collaboration record is created. Partners associate this collaboration 
with resources, employees, or organizations that will work on the collaboration. 

The partner does not need to create a new collaboration whenever it has to collaborate on a new 
opportunity. After the collaboration and resources have been established, the partner can use 
resources on any new opportunities (or on other data) for the duration of the collaboration. 
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After the collaboration is set up, the partner companies that are collaborating can share 
opportunities, service requests, quotes, orders, campaigns, accounts, contacts, projects, and other 
information. 

The following is a scenario that describes how a partner can work on opportunities in collaboration 
with other partner companies. This scenario consists of the following steps:

■ Step 1: A partner locates other partners and sends collaboration requests 

■ Step 2: An invitee partner accepts the collaboration request 

■ Step 3: The initiating partner creates a collaboration

■ Step 4: Both partners add resources to the collaboration 

■ Step 5: The partner companies share opportunities 

■ Step 6: Partners monitor their collaborations 

■ Step 7: The brand owner monitors all collaborations 

Step 1: A Partner Locates Other Partners and Sends Collaboration Requests
As the first step, the partner who is the initiator of the collaboration uses the Partner Locator and 
enters criteria to find other partners to collaborate on this project. For example, it might look for 
other partners in a specific location with a specific expertise. 

After the initiator has located other partners, it clicks Request Collaboration to send them a message 
asking them to collaborate. Because the initiator does not necessarily know individuals in the partner 
company they are inviting to collaborate, the message is sent to the organizations of the invitee. 

To locate partners and send collaboration requests

1 The initiating partner navigates to the Partner Locator screen. 

2 In the Partner Locator, the partner enters criteria to identify other partner companies for this 
collaboration and clicks Search. 

The Partner Locations list appears, listing all partners that match the criteria. 

3 In the leftmost column of the Partner Locations list, the initiating partner selects the check box 
for all the partner organizations in the list that will be invited to collaborate. 

The initiating partner checks the Available for Collaboration column of the Partner Locator to see 
whether a partner organization can be involved in a collaboration. 

4 The partner clicks Request Collaboration. 

The Outbound Request form appears. 
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5 The  partner fills out the Outbound Request form with the information in the following table, and 
clicks Send Request. 

Step 2: An Invitee Partner Accepts the Collaboration Request 
The collaboration request will be in the Inbound Request list of each invitee partner. The partner can 
accept or reject the request by changing the value in its Status field. The default status of a new 
request is Pending. The partner changes this value to Accepted or Rejected. 

The initiating partner checks the Status field of the request in the Outbound Requests view to see if 
the request was rejected or accepted. 

To accept or reject a collaboration request

1 The invitee partner navigates to the Partner Collaboration screen. 

2 From the Show drop-down list, the partner chooses Inbound Collaboration requests.

3 In the Inbound Request list, the partner selects a new request. 

4 The partner clicks the Request Status view tab. 

Field Comment

Initiating Organization Displays the organization that is initiating the collaboration. 

Recipient Organizations Displays the partner companies being invited to participate in the 
collaboration. This list includes the partner companies that were 
chosen in the Partner Locator. The partner can also click the 
select button and use the Collaboration Organizations dialog box 
to add or remove partners from the recipient list for the request. 

Description Enter a description of the collaboration, which should give other 
partners enough information to decide whether they want to join 
the collaboration. 

Type Select the type of collaboration. Types include Opportunity and 
Project.

Request Date Enter the date of the request. The default is the date created. 

Expiration Date Enter the date the request will be made inactive. If the recipients 
do not respond by this date the request is removed from the 
recipients' inbox.

Name Enter a name for the collaboration request. 

Created By Displays the login of the creator of the request.

Created Date Displays the date the request was created. 

Available to Recipients When you click Send, the Available to Recipients check box is 
automatically checked to indicate that the message has been 
sent. If you click Save without selecting Available to Recipients, 
then the message will not be available to the recipient partners. 
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5 In the Request Status form, in the Status field, the partner chooses Accepted or Rejected. 

Step 3: The Initiating Partner Creates a Collaboration
After invitee partners accept the collaboration, the initiating partner creates the collaboration. When 
the initiating partner clicks the Create button, the collaboration is created and all the invitees who 
have accepted the collaboration are copied as participants of the collaboration. 

To create a collaboration

1 The initiating partner navigates to the Partner Collaboration screen > Outbound Collaboration 
view. 

2 In the Outbound Request list, the partner selects the request that has been accepted and will 
become a collaboration. 

3 The partner clicks Create Collaboration. 

A Collaboration record is created based on the request, and all the invitee partners who accepted 
the request are copied as participants of the collaboration.

4 The partner fills out the other fields in the Collaboration form. 

Step 4: Both Partners Add Resources to the Collaboration 
When an invitee partner has accepted the collaboration request, a collaboration record is created. 
The next step is for both the initiating partner and the invitee partner to add resources to the 
collaboration. 

Resources may be the positions of employees in the partner’s company or organizations in the 
partner’s company. Each partner in the collaboration adds positions and organizations in its own 
company. 

To add resources to the collaboration

1 Both the initiating and the invitee partners navigate to the Partner Collaboration screen.

2 In the Collaborations list, the partner selects a collaboration. 

3 The partner clicks the Resources view tab. 

4 In the Resources list, the partner clicks New and selects resources, displaying the information in 
the following table in the fields of the new record. 

Field Comment

Primary Select a resource from this list. 

Resource Name The name of the resource, entered automatically when you select the 
resource using the Primary list. 

User ID If the resource is a position, the employee’s login ID is entered 
automatically when you select the resource using the Primary list. 
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Step 5: The Partner Companies Share Opportunities
After the collaboration is set up, the partner companies that are collaborating can share 
opportunities, service requests, quotes, orders, campaigns, accounts, contacts, projects, and other 
information. 

For example, when a partner company in the collaboration works on an opportunity, it can share the 
opportunity and associated information with the other partner company, assigning the opportunity 
to any employee or organization in the other partner company that is a resource in the collaboration. 

To share an opportunity with another partner company

1 The partner navigates to the Opportunities screen. 

2 The partner creates a new opportunity or selects an existing opportunity. 

3 In the More Info form, the partner clicks Collaboration Resources. 

The Grant Access to Collaboration dialog box appears, listing all positions and organizations in 
other partner companies with which this partner employee has a relationship. 

4 In the dialog box, the partner selects Resources and clicks OK.

Partner positions that were selected are added to the sales team for the opportunity and can see 
it in the My Opportunities view. Partner organizations that were selected are added to the 
organization team for the opportunity and can see it in the All Opportunities view. 

Step 6: Partners Monitor their Collaborations 
At any time, a partner company can get an overview of all its collaborations. 

To monitor its collaborations

1 The partner navigates to the Company Profile screen and does the following:

a The partner clicks the Profile link at the top of the screen. 

b In the Show drop-down list, the partner selects Company Profile. 

Organization If the resource is an organization, the organization is entered 
automatically when you select the resource using the Primary list. 

Type The type of the resource, position, or organization, entered automatically 
when you select the resource using the Primary list. 

Description The description of the resource, entered automatically when you select 
the resource using the Primary list. 

Start Date The date when the resource becomes available, entered automatically 
when you select the resource using the Primary list. 

End Date The date when the resource will no longer be available, if one exists, 
entered automatically when you select the resource using the Primary list. 

Field Comment
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2 The partner clicks the Collaborations view tab.

A list of all the partner company’s collaborations appears.

3 In the Collaboration list, the partner selects a collaboration. 

All of the resources for this collaboration are displayed in the Resources list, which is below the 
Collaboration list. 

Step 7: The Brand Owner Monitors All Collaborations
Throughout the process, the brand owner can view all collaborations that partners have created, to 
monitor partner collaborations. 

The brand owner can also view the opportunities, service requests, and other information being 
shared in the collaboration by using the appropriate view, such as the All Opportunities Across 
Organizations view. 

To monitor all partner collaborations

1 Navigate to the Partner screen. 

2 Select the record of a partner company whose collaborations you want to see.

3 Click the Collaborations view tab.

A list of all the partner company’s collaborations appears.

4 In the Collaboration list, select a collaboration. 

All of the resources for this collaboration are displayed in the Resources list, which is below the 
Collaboration list. 

Siebel Projects
Siebel Projects is a virtual work space that allows direct partner-to-partner collaboration among 
employees of different partner companies. Partners can use it to work together on software 
deployment, installation of equipment, sales opportunities that require involvement of multiple 
partners, and many other types of projects.

All partner employees who are part of the project can view information associated with the project, 
so employees of different partner companies can use the project to share information and work 
together. 

The brand owner also has visibility across all projects on which the partners are working. Brand 
owners can monitor the status of the project based on project time lines, project budget, and key 
risk areas.

For more information about Siebel Projects, see Siebel Professional Services Automation Guide. 

The following is a scenario that describes how a partner that specializes in deploying software 
applications uses Siebel Projects to work with a partner that specializes in hardware. Because these 
partners are part of the same project, they can share information and work collaboratively on the 
project.
Siebel Partner Relationship Management Administration Guide Version 7.8, 
Rev. A

258 



Partner-to-Partner Collaboration ■  Siebel Projects
This scenario has the following steps:

■ Step 1. The partner creates a new project 

■ Step 2. The partner locates other partners and adds them to this project 

■ Step 3. Partners who are part of the project add their employees the project team 

■ Step 4. The partner companies work together on the project 

■ Step 5. The brand owner tracks the partners’s work on the project 

Step 1. The Partner Creates a New Project 
In the example used in this scenario, a partner company that specializes in implementation has won 
a contract to deploy the brand owner’s software. This partner uses the Siebel PRM Portal to create a 
project, which it can use to work with the brand owners and with other partners. 

To create a project

1 In the Siebel PRM Portal, the partner navigates to the Projects screen. 

2 In the Projects list, the partner clicks New. 

3 The partner confirms that its own organization has been added to the project by making sure 
that it is listed in the Organization field of the new project record. 

4 In the new project record, the partner fills out the fields with information about the project, such 
as project description, time lines, budget, and key contacts. 

Step 2. The Partner Locates Other Partners and Adds Them to this Project
The partner company that created the project realizes that it will need the help of a partner that 
specializes in hardware to work on this project. 

The partner can locate appropriate partners and add them to the project in two different ways:

■ Use the Partner Locator to find partners with relevant skills, and create a collaboration with those 
partners, as described in “Partner Collaboration” on page 253. 

■ Use the Partner Locator to find partners with relevant skills, and have the brand owner add them 
to the project team.

When they use the Partner Locator, partners can find appropriate companies by searching based on 
expertise, location, and other criteria. In this case, the partner would enter a criterion such as 
Partner Type = Hardware. 

After the initiating partner has found the appropriate partner to work with, the two partners can 
initiate a collaboration. Assuming the hardware partner accepts the collaboration, the initiating 
partner can add the hardware partner to the project team. 

Alternatively, they can request the brand owner to add the hardware partner to the project team 
using the All Projects Across Organizations view in Siebel PRM Manager.
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To use the Partner Locator

1 In the Siebel PRM Portal, the partner navigates to the Partner Locator screen.

2 The partner enters the appropriate search criteria, and clicks Search.

A list of partners who match the criteria appears. 

Step 3. Partners Add Their Employees to the Project
Once the partner companies that need to be involved in a project have been added to the project, 
each partner company can add its own employees as users of the project. These users form the 
virtual project team. 

NOTE: All partner companies in the project must add their own employees to the project, to allow 
those employees to access information about the project.

To add partner employees to the project

1 In the Siebel PRM Portal, the partner navigates to the Projects screen. 

2 The partner selects the project. 

3 The partner clicks the Access view tab. 

4 In the Access list, the partner clicks to add a new records for each employee of that partner 
company who will work on the project. 

Step 4. The Partners Work Together on the Project
All of the partner employees who have been added to the project can use the Siebel PRM Portal to 
view information about the project, such as the project summary, and to add information to the 
project, such as activities, contacts, invoices, notes, risks, service requests, status reports, tasks, 
and other information. 

Any partner employee who is on the project can see the information that the other partners have 
added. 

To add or view information about the project

1 In the Siebel PRM Portal, the partner navigates to the Projects screen. 

2 The partner selects the project. 

3 The partner clicks the appropriate view tabs to add or view information about the project. 

Step 5. The Brand Owner Tracks the Partners’ Work 
The brand owner can view the project to track its progress, even though the project was set up by 
partners independent of the brand owner. 

The brand owner can view all projects, even if it has not explicitly been made a member. 
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To track the partners’ work on the project

1 In the Siebel PRM Manager, the brand owner navigates to the Projects screen. 

2 From the Show drop-down list, the brand owner selects All Projects Across Organizations. 

3 In the Projects list, the brand owner selects the project. 

4 The brand owner clicks the appropriate view tabs to view information about the project. 
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14 Using Market Development 
Funds
This chapter describes how to use Siebel PRM to manage market development funds. 

This chapter contains the following topics:

■ “About Market Development Funds” on page 263

■ “Creating and Using MDFs” on page 263

■ “Managing the Advanced MDF Option” on page 277

About Market Development Funds 
Brand owners administer market development funds (MDFs) using Siebel PRM Manager, and partners 
can apply for market development funds on the PRM Portal. The Advanced MDF option provides 
additional partner program features. For more information on Advanced MDFs, see “Managing the 
Advanced MDF Option.”

An MDF makes it possible to do joint marketing activities with one or more partners. For example, 
you might create an MDF to fund a joint advertising campaign with one of your large partners or to 
send several of your partners to a large trade show.

Working with an MDF requires the following steps:

■ Creating the fund. When you create a fund, you specify how much funding it has and which 
partners participate in it. 

■ Authorizing employees to approve fund requests. You must authorize your employees to 
approve fund requests. Employees have a fund request approval limit. If a request is greater than 
an employee’s limit, that employee routes it to other employees for further review. 

■ Requesting funding. After a fund has been created, people from the partner company or from 
the brand owner company can request funding on behalf of partners who participate in the fund. 

■ Approving funding requests. Your company must approve or reject funding requests. 
Optionally, you can use Siebel Business Process Designer to inform people by email when they 
must review a request or provide more information. 

■ Tracking the spending. The MDF checkbook lets you track the amount of credits, debits, and 
total funds available in the a fund.

Creating and Using MDFs
Market development funds (MDFs) are created for a variety of reasons. For example, an alliance 
partner may agree to a fixed MDF as part of its alliance agreement, or you can do joint marketing 
with a partner and create an accrual MDF to which you will contribute one percent of the partner’s 
sales. 
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When you create a new MDF, you must specify which partners are participants in the fund and you 
must specify the fund type. 

There are three types of MDFs:

■ Fixed Fund. A fund that has a specific amount of money allocated to it. 

■ Accrual Fund. A fund that has money allocated to it based on the partner’s performance. For 
example, partners can accrue funds based on the number of units sold of a specific product or 
product line, based on a percentage of their revenues, or based on other metrics you define.

■ Mixed Fund. A fund that has both a fixed and an accrual element. It begins with a specific 
amount of money, and it also accrues additional money depending on partner performance. 

When you create the Fund record, you must specify the type of fund. This determines where funds 
will be added. 

To create a new MDF, you perform the following steps:

■ Create a new fund record

■ Add participants to the market development fund

■ Add funding to the market development fund 

Creating a New Fund Record
The first step in creating a new MDF is to add a new Fund record. 

To create a new Fund record

1 Navigate to the Fund Design screen. 

2 In the Fund Administration list, click New to add a new record to this list. 

3 Enter information about the new fund in the new record and the More Info form, as shown in 
Table 5.

Table 5. Fund Administration Fields

Field Comment 

Name Enter a name for the fund (up to 50 characters) for your own use.

Type Choose Fixed, Accrual, or Mixed to indicate how funding is allocated.

Fund ID A unique identifier that is generated automatically.

Active Indicates whether the fund is currently active—that is, whether partners can 
make fund requests against this fund. Generated automatically based on the 
start date and end date.

Locked Lets you lock the fund record so no one can update it.
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Adding Partner Companies as Fund Participants
The second step in creating a new MDF is to add the partner companies that are fund participants to 
the fund. Partners must be added to the Fund Participation list because only fund participants (and 
employees at the brand owner company acting on their behalf) are authorized to spend against a 
fund. 

Sometimes, partners contribute to MDFs for joint marketing activities with the brand owner. In these 
cases, the partner is usually the only participant in the fund.

Similarly, because accruals are used as incentive programs for partners, you generally have only one 
partner per accrual fund. If you added multiple partners, one partner would accrue funds and the 
other partners could spend the funds accrued by the first partner.

NOTE: If you add a partner company as a fund participant, there must be a partner manager defined 
for that partner company, so the partner’s fund requests can be routed to the partner manager for 
approval. For more information, see “About Specifying the Partner Manager for a Partner Company.” 

To add a partner company to an MDF

1 Navigate to the Fund Design screen. 

2 In the Fund Administration list, select the fund to which you want to add the partner company.

Period Optionally, use the Pick Period dialog box to choose a predefined period from 
a picklist defined by the Siebel administrator, such as 2005 or Jan. 2005. If 
you do this, the Start Date and End Date fields are filled automatically.

Start The date when a partner can begin applying for money from this fund. 

End The last date when a partner can apply for money from this fund.

Target 
Amount

The amount of money targeted to be accrued to a fund. For a fixed fund, the 
amount of money agreed to in a fund.

Description A text description of the fund for your own use. Enter up to 150 characters.

Total Credits The total of all deposits into the fund. Read-only field calculated by the system. 

Total Debits The total of all the approved withdrawals from the fund (actual amounts 
granted to partners). Read-only field calculated by the system. 

Fund Balance The balance in the fund, calculated as Total Credits minus Total Debits. Read-
only field calculated by the system. 

Fixed Credits Credits from fixed deposits into the fund. 

Accrual 
Credits

Credits from accruals to the fund. 

Table 5. Fund Administration Fields

Field Comment 
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3 Click the Fund Participation view tab.

The Fund Participation view appears.

4 In the Fund Participation list, click the menu button, and then click New Record to add a new 
record to this list. 

5 Enter information in the following table in the new record’s fields about the partner company’s 
participation.

Adding Funding to the Market Development Fund
The third step in creating an MDF is to add funding to it. The type of funding you add depends on 
the choice you made in the Type field when you created the Fund record: 

■ Fixed. If the fund type is Fixed, add the funding amount in the Fixed Fund Administration view. 

■ Accrual. If the fund type is Accrual, add the funding amount in the Accrual Fund Administration 
view. 

■ Mixed. If the fund type is mixed, use both the Fixed Fund Administration view and the Accrual 
Fund Administration view to specify the amount of funding it has. The mixed fund contains the 
sum of the fixed and accrual funding that you specify.

To add fixed funding to an MDF

1 Navigate to the Fund Design screen. 

2 In the Fund Administration list, select a Fund that is Fixed or Mixed. 

3 Click the Fixed Fund Administration view tab.

The Fixed Fund Administration view appears.

Field Comment 

Partner In the Pick Channel Partner dialog box, choose the participating partner 
company. 

Target 
Amount

Enter the target amount for this partner to receive from all its fund requests 
to this fund. 

Period Optionally, use the Pick Period dialog box to choose a predefined period, such 
as 2005 or Jan. 2005. When you do this, the Start Date and End Date fields 
are filled automatically. 

Start Enter the date when this partner can begin applying for money from this fund. 
The default value is the start date of the fund. 

End Enter the last date when this partner can apply for money from this fund. The 
default value is the end date of the fund.

Description Optionally, enter a description (up to 150 characters) of this partner 
company’s participation in this fund for your own use.
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4 In the Fixed Fund Administration list, click the menu button, and then click New Record to add a 
new record to this list. 

5 Enter information in the following table about the fixed funding in the new record.

To add accrual funding to an MDF

1 Navigate to the Fund Design screen. 

2 In the Fund Administration list, select a fund that is either an Accrual or a Mixed type. 

3 Click the Accrual Fund Administration view tab.

4 In the Partners list, select the partner company that will accrue funding, or click New to add a 
new partner company to the list. 

5 In the Accrual Definition list, click the menu button, and then click New Record. 

Field Comment 

Name A name for this funding for your own use, such as Initial Funding or Q2 Added 
Funding.

Amount The amount of funding allocated to this fund for this transaction. 

Period Optionally, use the Pick Period dialog box to choose a predefined period, such 
as 2005 or Jan. 2005. When you do this, the Start Date and End Date fields 
are filled automatically. 

Start The date when partners can begin spending this funding. If this record is the 
initial allocation of money to this fund, then this date should be the same as 
the start date for the fund. If this record is a supplementary allocation, it could 
be a different date. For example, if you have a yearly fund and you allocate 
extra funding for the third quarter, the start date for the extra funding could 
be the first day of the third quarter. 

End The last date when partners can spend this funding.
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6 Enter information about the accrual definition in the new record, as shown in Table 6.

Table 6. Accrual Definition Fields

Field Comment

Type Select the type of component on which the accrual is based. The default options 
are as follows:

■ Orders (accrued funding based on all the orders of the partner)

■ Product Line (accrued funding based on the orders of the partner for a specific 
product line)

■ Product (accrued funding based on the orders of the partner for a specific 
product)

Other options may have been added. 

Product Line If you choose Product Line in the Type field, in this field’s dialog box, choose the 
product line on which accrued funding is based. If you do not choose Product Line 
as the type, this field is disabled.

Product If you choose Product in the Type field, in this field’s dialog box, choose the 
product on which accrued funding is based. If you do not choose Product as the 
type, this field is disabled.

Period Optionally, use the list to choose a predefined period, such as 2005 or Jan. 2005. 
When you do this, the Start Date and End Date fields are filled automatically. 

Start The date when funding begins to accrue to this fund. 

End The last date when funding accrues to this fund.

Base This field lets you tier funding by specifying the base amount at which the accrual 
begins. For example, if you want to give the partner accrual funding only after it 
sells $1,000,000, you can set the base at $1,000,000. Or, if you want to give the 
partner 1% of the first $1,000,000 it sells, and 2% of everything above that, you 
can create one fund record with a base of $0 and a rate of 1% and a second fund 
record with a base of $1,000,000 and a rate of 1%. The second fund record would 
give an additional 1% beyond the 1% in the first fund record. 

U/M Select the unit of measurement on which the funding is based. For example, if 
you choose Pallet, Bag, or Dollar, the partner accrues the amount in the accrual 
rate field for each pallet, bag, or dollar of your product ordered. The units 
available here can be determined in the LOV administration view under 
UNIT_OF_MEASURE. 

Accrual Rate Enter an amount of funding that accrues per unit sold. 

Estimated 
Volume

Enter your goal, the volume of sales targeted for this accrual. 

Actual Volume Enter the actual volume of sales for this accrual. 
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NOTE: When you add an Accrual Definition record, the options available in the Type field can be 
defined in the List of Values view of the Applications Administration screen by adding values of type 
ACCRUAL_SRC_TYPE, and the options available in the U/M field can be defined by adding values of 
type UNIT_OF_MEASURE. For more information about list of value administration, see Application 
Administration Guide. 

Setting Up Fund Approval Authorization
Before your company can work with any MDFs, you must authorize the appropriate employees to 
approve fund requests. 

Optionally, you can also change the Partner Manager field. The partner manager is the initial reviewer 
of the fund request, so specifying the Partner Manager field for a partner company determines how 
new fund requests from that company are routed. 

Authorizing Employees to Approve Fund Requests
To authorize employees to approve fund requests, you specify the maximum amount of a fund 
request that each employee may approve.

Employees may get fund requests to review that are greater than the amount that they can approve. 
After reviewing those fund requests, they can route them to other employees in your company for 
approval. 

For example, your channel manager for this company may be authorized to approve requests up to 
$10,000. If a partner submits a request for $5,000 and the channel manager approves it, then the 
approval process is finished. The request does not need any further approval.

However, if a partner submits a request for $50,000, it is still reviewed by the channel manager 
initially. The channel manager can either deny or route it to his or her manager for approval. 
Managers continue to have the option to deny the request or route it to their managers, until it 
reaches a manager who is authorized to approve the amount. 

To route the request to the next employee in the approval process, select that employee’s name in 
the Processed By field of the Fund Request record. The employee in this field is the only employee 
who can change the value of the record. 

When you select an employee’s name in the Processed By field, Siebel PRM automatically routes the 
Fund Request record to that employee, and it appears in that employee’s My Funds Request view.

To authorize your employees to approve fund requests

1 Navigate to the User Administration screen. 

2 From the Show drop-down list, choose Employees. 

3 Select the record of the employee you want to authorize to approve fund requests. 

4 In the More Info view, click the More/Less button to display the extended version of the form, 
and enter the approval amount for that employee in the Fund Approval Limit field. 
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Changing the Partner Manager Field
Optionally, you can change the Partner Manager field to change the routing of fund requests for 
approval. 

The initial reviewer for a fund request logged by a partner is the employee selected in the Partner 
Manager field for that partner organization. This employee’s name is automatically entered in the 
Processed By field of the fund request. This is the only use of the Partner Manager field, and you can 
change the initial reviewer of fund requests by selecting a different employee in this field.

To change the partner manager

1 Navigate to the Administration - Partner screen. 

2 From the Show drop-down list, choose Registered Partners. 

3 In the Partner list, select the partner company for which you want to set the Partner Manager 
field. 

4 In the More Info form, click the More/Less button to display the extended version of the form. 

5 Click the select button for the Partner Manager field. 

The Pick Position dialog box appears.

6 Select the person you want as the partner manager, and click OK.

Initiating a Fund Request
A fund request can be submitted either by a partner who enters it using the Siebel PRM Portal, or by 
an employee at your company who enters it using the Siebel PRM Manager. For example, it may be 
submitted by an employee in your company’s marketing department who plans a marketing 
campaign involving MDFs.

Siebel Business Process Designer can be set up so that, when the request is initiated, the first 
employee who must approve it receives an email notifying that employee that the fund request has 
been submitted for approval. 

For more information about Siebel Business Process Designer, see Siebel Business Process Designer 
Administration Guide.

To initiate a fund request

1 Navigate to the Fund Requests screen. 

2 In the Fund Requests list, click the menu button, and then click New Record to add a new record 
to this list. 
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3 Enter information in the new record’s fields shown in Table 7.

Table 7. New Record Fields

Field Comment 

Name Enter a name for the request (up to 50 characters) for your own use.

Partner In the Pick Channel Partner dialog box, choose the partner to which the 
request applies. 

Fund In the Pick Fund dialog box, choose the fund from which the money 
comes. 

Tracking # This field contains a unique number generated automatically, which you 
can use to track the request.

Campaign Optionally, use the Pick Campaign dialog box to choose your company’s 
marketing campaign for which this fund is being used. 

Region Optionally, choose a region (for example, Africa or North America) 
where the funding will be spent. 

Vertical Optionally, choose an industry (for example, Automotive or Insurance) 
on which this funding will be spent. 

Category Optionally, choose a category (for example, Advertising or Customer 
Event) on which this funding will be spent.

Processed By This field displays the name of the manager who is currently reviewing 
this request. When you enter a new request, the value in the field 
defaults to the Partner Manager for this partner organization, who is 
normally the first manager to review the request. To transmit the 
request to the next manager in the approval process, use the Pick 
Position dialog box to choose that manager’s name. Only the employee 
whose name appears in this field can change the record (for example, 
to change the status to Approved or to Need More Information, or to 
route the record to the next person for approval).

Due Enter the date when the funds are needed. 

Status In a new request, the status is New. During the approval process, the 
status of the fund request changes.

Owned By This field holds the name of the person who initiated the fund request.

Amount Requested Enter the amount of the request. 

Amount Approved During the approval process, approvers will enter the approved amount 
in this field. They may approve the requested funding or a smaller 
amount. This field cannot be edited in a new request.
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Adding Attachments to Fund Requests
While you are working with a fund request, you may find it useful to add attachments, activities, or 
activity plans to the request.

You can attach supporting documents to fund requests. For example, if you write a report that 
describes in detail how the partner plans to use the funding, you can attach it to the Fund Request 
record. Or, if the request is to fund a booth at a trade show, you can attach a brochure from the trade 
show using any convenient file format, such as Adobe Acrobat. Employees who review and approve 
the request can view these attached documents. Attach files to MDF Request records in the Fund 
Request Attachments view. 

NOTE: The partner to which an MDF request applies can view attachments to the request and can 
also add attachments to the request for the brand owner company to view.

To enter fund request attachments

1 Navigate to the Fund Requests screen. 

2 In the list of fund requests, select the request to which you want to add the Attachment. 

3 Click the Fund Request Attachments view tab. 

The Fund Request Attachments view appears.

4 In the Fund Request Attachments list, click the menu button, and then click New Record to add 
a new record to this list. 

5 In the Attachment Name field, click the select button. 

The Add Attachment dialog box appears.

6 In the Add Attachment dialog box, click Browse, navigate to the file you want to attach to the 
record, and click Open.

The name of the file appears in the File Name field of the Add Attachments dialog box. 

7 Click Add. 

Actual Amount This field displays the actual amount that has been debited to this fund 
request. This field cannot be edited in a new request.

Approval Log Keeps track of the modifications to the fund request. Every time a user 
changes the status of the request or changes the amount approved, 
another record is added to the approval log.

Table 7. New Record Fields

Field Comment 
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Adding Activities to Fund Requests
You can record a variety of activities that you should perform as part of a Fund request, such as a 
meeting you must schedule with a partner to discuss the fund request. You can do this by attaching 
activities to the fund request. 

To add an activity for a fund request

1 Navigate to the Fund Requests screen. 

2 In the list of fund requests, select the request to which you want to add the activity. 

3 Click the Fund Request Activities view tab. 

The Fund Request Activities view appears.

4 In the Fund Request Activities list, click the menu button, and then click New Record to add a 
new record to this list. 

5 Fill in the fields with the details of the new activity.

Adding Activity Plans to Fund Requests
If you have a regular series of activities that you perform when you submit a type of fund request, 
such as a request for funding for a trade show, you can save time by using an activity plan. Activity 
plan templates define lists of activities that are often performed in sequence. If your company’s 
Siebel applications administrator has created appropriate templates, you can use a template to 
attach an activity plan to a fund request. 

For information about creating activity plans, see the section on creating activity templates in 
Application Administration Guide.

To enter an MDF request activity plan

1 Navigate to the Fund Requests screen. 

2 In the list of marketing fund requests, select the request to which you want to add the activity 
plan. 

3 Click the Fund Request Activity Plans view tab. 

The Fund Request Activity Plans view appears.

4 In the Fund Request Activity Plans list, click the menu button, and then click New Record list to 
add a new record to this list. 

5 Use the Template field picklist to choose an existing template. 

The activities from that template are listed in the Activities list.
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Reviewing a Fund Request
After a fund request has been submitted, it must be routed in sequence to the employees who must 
review it. If the initial reviewer is authorized to approve the full amount in the request, only this 
approval is needed. However, if the request is larger than the initial reviewer can approve, the 
reviewer can either reject it or route it to another employee in the brand owner company for further 
review. If that employee is not authorized to review the entire amount, that employee can either 
reject it or route it to another reviewer. 

To route the request for further review and approval, an approver selects Pending Approval in the 
Status field of the fund request and then selects that person’s name in the Processed By field of the 
fund request. The fund request appears in the My Fund Requests view for that person. Only the 
reviewer whose name is in the Processed By field can modify the Fund Request record. 

Rather than routing the request for further approval, approvers can also use the picklist in the Status 
field of the request to choose from among the following options: 

■ Need More Information. The approver needs more information to make the decision.

■ Rejected. The approver rejects the fund request, and the request fails. 

■ Approved. The approver gives final approval to the fund request. This option is available only 
to an employee who is authorized to approve the full amount of the request. 

When the status of a fund request is new, rejected, or need more information, all fields are editable.

When you change the status to another status, all fields become read-only, except for the Status, 
Comment, and Processed By fields. 

After you change the status to approved, processed, fulfilled, or submitted for fulfillment, all fields 
become read-only, except for the Due Date, Amount Approved, and Actual Amount fields. 

The possible values for the status of a fund request are shown in Table 8.

Table 8. Fund Request Status Values

Value  Comment

New The request has been submitted but has not yet been viewed by the 
initial approver. 

Pending Approval The request has been viewed by the initial approver.

Pending Approval 2 The request has been routed to a subsequent approver.

Pending Review The request has been routed to the final approver. The final 
approver is called the reviewer.

Need More Information One of the approvers has requested more information.

Rejected The request has failed because an approver has rejected it. 

Approved The request has the required approvals.

Submitted for Fulfillment The request has been submitted to the payments administrator for 
fulfillment.
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Before you approve a fund request, you should look at the fund’s checkbook to see the balance in 
that fund. Make sure the request is not larger than the remaining balance in the fund.

NOTE: The balance in the checkbook is debited only after the Actual Amount field for a fund request 
is filled out. If you have approved a request and entered the approved amount, it will not necessarily 
be reflected in the checkbook. It is visible only after you enter the actual amount.

To view the balance in an MDF

1 Navigate to the Fund Design screen. 

2 In the Fund Administration list, select the fund whose balance you want to see. 

3 For an accrual or mixed fund, click the Accrual Fund Checkbook view tab. 

The Accrual Fund Checkbook view appears.

4 Click the Calculate Total button to update the total.

The accrual balance in the fund appears in the Fund Balance field. 

5 For a fixed or mixed fund, click the Fixed Fund Checkbook view tab. 

The Fixed Fund Checkbook view appears.

6 Click Calculate Total to update the total.

The fixed balance in the fund appears in the Balance field. 

To review a fund request

1 Navigate to the Fund Requests screen. 

2 To reject the request, give final approval to the request, or ask for more information, choose a 
value in the Status field picklist of the request you are reviewing. 

The picklist gives you the option of approving the request only if its amount is less than the 
amount in the Fund Approval Limit field of your Employee record.

3 To route the request to another employee for further review and approval, do the following:

a Change the status to Pending Approval. 

b Click the select button to the right of the Processed By field to display the Pick Position dialog 
box. 

c Select that employee’s record, and click OK. 

Processed The request has been processed by the payments administrator.

Fulfilled The request has been fulfilled by the payments administrator. 
Funding has been sent to the partner.

Table 8. Fund Request Status Values

Value  Comment
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Viewing Fund Requests for a Partner Company
You can review a partner’s performance periodically or view how many other fund requests from a 
partner are open before approving the current request. The Partner Fund view lets you look at a 
single list of the partner’s fund requests, regardless of which MDF is involved.

To view a partner’s fund requests

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner whose requests you want to display.

3 Click the MDF Requests view tab. 

The MDF Requests list appears with that partner’s fund requests from any MDF.

Viewing the Status of a Fund Request
You can use the Siebel PRM Manager to check the status of a fund request after it has been 
submitted, and your partners can use the Siebel PRM Portal to view this information. For example, 
a partner who submitted a fund request can make sure that the approval process has started at the 
brand owner company. Employees who need to start work when the funding is available will want to 
see if it is approved.

A fund request can have the status values shown in Table 8 on page 274.

To view the status of a fund request

1 Navigate to the Fund Requests screen. 

2 In the Fund Requests list, select the request whose status you want to check. 

The status appears in the Status field of the form at the bottom of the screen.

Viewing a Fund’s Checkbook
You can use an MDF’s Accrual Fund Checkbook view and Fixed Fund Checkbook view to display the 
balance remaining in the fund, as well as to display the details of how much of this balance comes 
from fixed funding, how much comes from accrued funding, and which funding requests have been 
debited against the fund.

The debits against the fund are shown in both the accrual fund checkbook and in the fixed fund 
checkbook. 

NOTE: The balance in the checkbook is debited only after the Actual Amount field for a fund request 
is filled out. If you have approved a request and entered the approved amount, it will not be reflected 
in the checkbook. It is visible only after you enter the actual amount.
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To view an MDF’s checkbook

1 Navigate to the Fund Design screen. 

2 In the Fund Administration list, select the fund whose balance you want to see.

3 If it is an accrual or mixed fund, click the Accrual Fund Checkbook view tab.

The Accrual Fund Checkbook view appears.

4 Click Calculate Total to view the balance.

5 In the MDF Accrual Credits list, review the credits that have accrued to this fund. In the MDF 
Debits list, review the debits for this fund.

6 If it is a fixed or mixed fund, click the Fixed Fund Checkbook view tab.

The Fixed Fund Checkbook view appears.

7 Click Calculate Total to view the balance. 

8 In the Fixed Credits list, review the credits for this fund. In the MDF Debits list, review the debits 
for this fund.

Managing the Advanced MDF Option
This section includes the following topics:

■ “Overview of Advanced MDF Option” on page 278

■ “Key Features of MDF Management” on page 278

■ “Scenario for MDF Management” on page 279

■ “Process of Setting Up MDF Programs” on page 280

■ “Creating MDF Snapshot Periods” on page 280

■ “Making Partners Eligible for MDF Participation” on page 280

■ “Enabling the HTIM MDF Period Ending Process Workflow” on page 281

■ “Setting Up MDF Approval Authority Limits” on page 281

■ “Creating an MDF Program and Program Account” on page 281

■ “Setting Up a Program Account’s First Snapshot” on page 283

■ “Adding a Credit to a Program Account” on page 283

■ “Adding a Credit to a Program Account” on page 283

■ “Creating a Preapproval” on page 284

■ “Reviewing a Preapproval” on page 286

■ “Creating a Claim” on page 286

■ “Reviewing a Claim” on page 288
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Overview of Advanced MDF Option
In this MDF or co-op management process, the marketing manager sets up one or several programs 
and selects partners who can participate in the associated funds. This automatically creates program 
accounts for these partner participants so that partners can accrue funds or receive discretionary 
MDF amounts under the associated programs. Partners can request funding for marketing activities 
out of the funds accrued or received in their different program accounts. Partners request funding 
through the Siebel PRM Portal by creating a preapproval with one or more associated line items, 
identifying the different cost items associated with the marketing activity. These preapprovals are 
routed to the channel marketing manager, who can review and either accept or reject cost items at 
the line item level. Once approved, the partner can execute the corresponding marketing activity.

Partners can create claims through the Siebel PRM Portal to redeem the money in their program 
accounts for marketing activities against the preapprovals. When a claim is approved, the claim 
debits the program account. The claim amount can then be sent to the accounting system for 
payment processing. This process includes flexibility for routing and escalating approval requests to 
multiple people within brand owner organizations.

Key Features of MDF Management
MDF management includes the following features:

■ Program Management. Programs give the brand owner the ability to make marketing funds 
available to partners automatically. The brand owner can define a program with specific 
characteristics, such as activation date, expiration date, eligible partners, target markets, target 
products, fund accrual rules and so on. After the participating partners are identified, the system 
automatically generates all the program accounts for the participating partners. A pool of money 
made available to partners for the organization of marketing activities—for example, campaigns 
or events.

There are two programs types:

■ Co-Op Program. A program under which the partner accrues credits based on performance. 
The co-op program is also known as an accrual fund. For example, resellers could accrue 2% 
of all product revenue into their account set up under this program.

■ MDF Program. A program under which the partner receives discretionary funding from the 
brand owner. This is a nonperformance-based program. It is also known as a fixed fund. For 
example, after approval, this money could be spent on marketing activities for a specific 
product promotion.

■ Program Participant. The account or organization participating in the program. For 
participating, the partner will receive a program account for accrual of funds according to the 
program rules. This is temporary data used in selecting the partners that can be used for a 
program account.

NOTE: Participants can be selected only from accounts with the Fund Eligible check box selected. 
This check box appears in the Administration - Partner screen > Registered Partners view.
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■ Program Account. The individual account associated with the partner. Program accounts are 
child funds of the program. The partner accrues funds in a program account according to the 
program rules, or the channel account manager deposits discretionary amounts of money into 
the program account. Each partner can have multiple program accounts, one for each program 
in which the partner participates. Each partner can participate in the same program only once. 

■ Credit. This is a child of the program account used to represent the crediting of money to a 
particular program account. Credits are created manually.

■ Preapproval. This is a request for funds. Partners request funding for marketing activities out 
of the funds accrued in their different program accounts. A preapproval can be associated with 
only one program account.

■ Claim. This is a request for payment against a preapproval after a marketing activity has been 
executed. Claims go through an approval process at the brand owner’s company. Claims are 
created against a specific preapproval. When the claim is approved, the claim debits the program 
account defined for the associated program account.

■ Debit. Debits are read-only and created automatically only after a claim line item is approved.

Scenario for MDF Management
This scenario gives one example of how MDFs may be used. You may use MDFs differently, depending 
on your business model.

A program manager at the brand owner company is responsible for collaborative marketing with 
partners. She realizes that partners often have better insight into local markets and are therefore 
more suited to organize targeted marketing activities. Recently, her company’s new product was 
launched and in order to give resellers an incentive to resell this product, she has decided to set up 
a targeted program. This program will last for six months, active immediately, and only specially 
certified dealers will be eligible for participation. Under the program, resellers will accrue 3% of their 
revenues for the server product line into their program account. All the funds accrued can then be 
used by the resellers to run marketing activities. However, her firm will refund only 50% of the total 
amount approved for every activity.

As part of the setup, the program manager selects the resellers eligible for participation and adds 
them to the program. By clicking the Generate button, individual program accounts are generated 
for each participating reseller.

The sales manager at one of the brand owner’s resellers has noticed the new program set up by the 
brand owner. He decides to set up a local event to promote their new product to his existing client 
base. His plan is to invite his top 20 customers to a seminar discussing the product. He creates and 
submits a preapproval to obtain approval from the brand owner to run his event.

After the event, the reseller collects invoices for the individual line items on his preapproval and 
submits a claim for payment. He submits the claim, aware that the brand owner will fund a maximum 
50% of the total amount.

The channel account manager at the brand owner company reviews the claim. He sees that all 
conditions for payment are met. He sets the status of the claim to Accepted. However, because he 
can only approve claims up to $1000, the claim status is not automatically set to Final Approved. 
Instead, the claim gets routed to his manager for review, who approves it. 
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Process of Setting Up MDF Programs
To set up MDF programs, perform the following tasks:

■ “Creating MDF Snapshot Periods” on page 280

■ “Making Partners Eligible for MDF Participation” on page 280

■ “Enabling the HTIM MDF Period Ending Process Workflow” on page 281

■ “Setting Up MDF Approval Authority Limits” on page 281

Creating MDF Snapshot Periods
Program account snapshots give an overview of all transactions for a given program account by 
period. They contain the amount of available and used funds in an MDF during each period. To use 
snapshots successfully, periods must first be set up in the Administration - Data screen > Periods 
view. For more information about creating periods, see the chapter that discusses ongoing 
applications administration tasks in Application Administration Guide.

Before creating MDF programs, you should create at least six snapshot periods of type HTIM MDF 
Snapshot to cover the current month and the five following months.

This task is a step in “Process of Setting Up MDF Programs” on page 280.

To create snapshot periods

1 Navigate to the Administration - Data screen > Periods view.

2 In the Period Definition list, create a new record.

3 Enter a name for the period in the Period field.

4 From the Type drop-down list, select HTIM MDF Snapshot Month.

5 Complete any other the necessary fields. For more information about these fields, see Application 
Administration Guide.

Repeat Step 2 to Step 5 for each subsequent period until you have created at least six HTIM MDF 
Snapshot Month periods. Each period you create should begin at the end of the preceding period.

NOTE: You can edit snapshots in the Monthly Snapshot (Admin) view in the MDF Program Accounts 
screen.

Making Partners Eligible for MDF Participation
Prior to creating an MDF program, you must make sure that each partner you want to include in an 
MDF program is eligible for funds.

This task is a step in “Process of Setting Up MDF Programs” on page 280.

To make partners eligible for MDF programs

1 Navigate to the Site Map > Administration - Partner screen > Registered Partners view.
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2 Drill down on the record of the partner you want to include in a MDF program and then click the 
More Info tab.

3 Locate the Fund Eligible field.

■ If the Fund Eligible field is checked, this partner is already eligible for funds and can 
participate in an MDF program and no action is required.

■ If the Fund Eligible field is not checked, select the checkbox. The partner is now eligible to 
participate in an MDF program.

Enabling the HTIM MDF Period Ending Process Workflow
The HTIM MDF Period Ending Process workflow should be run as a server task (workflow manager 
task). It can be either a manual task or a repeated task running at the end of the period.

This task is a step in “Process of Setting Up MDF Programs” on page 280.

To enable the HTIM MDF Period Ending Process workflow

1 Navigate to the Administration - Business Process screen > Workflow Processes view.

2 Locate the workflow HTIM MDF Period Ending Process.

3 Verify that the workflow is activated.

For more information about the HTIM MDF Period Ending Process workflow, see “HTIM MDF Period 
Ending Process Workflow.”. For more information about business process workflows, see Siebel 
Business Process Designer Administration Guide.

Setting Up MDF Approval Authority Limits
You need to set up an approval authority limit in the Administration - User screen for each employee 
responsible for approving MDF programs.

This task is a step in “Process of Setting Up MDF Programs” on page 280.

To set up approval authority limits

1 Navigate to the Administration - User screen > Employees view.

2 Drill down on the employee for whom you want to set up approval authority limits.

3 Click the More Info view tab.

4 In the Approval Authority section, in the Fund Approval Limit field, enter an approval amount.

Creating an MDF Program and Program Account
The program manager creates an MDF program and adds partners to it. A program account is then 
created automatically so the partner can take advantage of the MDF.
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To create an MDF program and a program account

1 Navigate to the MDF Programs screen > Programs view.

2 Create a new record and complete the necessary fields. Some fields are described in the following 
table.

NOTE: Click the Rollup Snapshot button to refresh the sum of all the credits and debits for all MDF 
Program Accounts associated with the selected MDF program.

3 Drill down on the new record, click the Program Participants view tab, and then click Add.

4 In the Pick Account dialog box, select the partners you want to include in this program and click 
OK.

5 In the Program Accounts subview, click Generate.

Program accounts are created automatically for each partner.

Field Comment 

Aging Period (Month) Number of days until new credits expire.

Start Date Date preapprovals can start to be created against the program.

End Date Date after which partners can no longer create preapprovals against 
the program. 

NOTE: After this date, partners can still claim fund accruals in their 
Program Accounts (until the claim receipt deadline).

Amount Total dollar amount committed to the program. Required if MDF is 
selected from the Type field.

Type MDF or Co-op program.

Market Market segment.

Program GL Code General ledger account under which the program is created.

Participation Rate % Indicates the percentage of activities organized under this program 
that the brand owner is willing to fund. This value transfers down to the 
preapprovals and claim line items.

Available Balance Total Balance = [Total Credit] - [Total Debit]

These values are rolled up from the credit and debit records through 
the snapshot, to the program account, and then to the program.

Credit Rolled up from program account.

Debit Rolled up from program account.
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Setting Up a Program Account’s First Snapshot
Before you can add credits to a program account, you must set up snapshot periods for the program 
account.

To set up the first snapshot

1 Navigate to the MDF Program Accounts screen.

2 Locate and drill down on the program account for which you want to set up snapshots.

3 Click the Monthly Snapshot (Admin) view tab and add a new record.

4 Click the Period select button.

5 In the Pick Period dialog box, query for Period Type of HTIM MDF Snapshot Month.

6 Select the period with the Start Date that is less than or equal to today’s date, and the End Date 
less than or equal to today’s date, and then click OK.

Adding a Credit to a Program Account
You must create credits manually for each program account. Credits make funds available to 
resellers.

NOTE: Co-op program credits are incentive-based while MDF program credits are discretionary.

To create a credit

1 Navigate to the MDF Program Accounts screen > Program Accounts view.

2 Drill down on the program account record for the partner to whom you want to provide a credit.

3 Click the Checkbook (RW) view tab and add a new record.

4 Complete the necessary fields. Some fields are described in the following table.

Repeat for each partner or program account for which you want to provide a credit.

Field Comment 

Type Indicates the nature of the credit. Values available are Accrual, 
Adjustment, and Re-instatement. 

Sub Type Further indicates the nature of the credit. Values available are Earned 
or Discretionary.

Market Market segments relevant to this partner.

Amount Amount of the credit.

Period Posted Period during which this credit is posted.

Expiration Date Date this credit is no longer available for the partner’s use.
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Creating a Preapproval
Using the Siebel PRM Portal, the reseller creates a preapproval so that it can request funds offered 
by the MDF.

The reseller creates a preapproval with several associated line items. Line items allow the partner to 
identify specific items required for the marketing activity and their estimated cost. 

To create a preapproval

1 In the Siebel PRM Portal, navigate to the MDF Pre-Approvals screen > My Pre-Approvals view.

2 Add a new record and complete the necessary fields. Some fields are described in the following 
table.

3 Drill down on the Preapproval record and click the Line Items view tab.

Field Comment 

Pre-Approval # Automatically generated number for the preapproval.

Pre-Approval Name Description of the preapproval.

Status Approval status of the preapproval.

Program Name Name of the program to which the program account associated with 
this preapproval belongs.

Program Account Program account against which the preapproval was created. 

Assigned To Name of person responsible for reviewing and approving this 
preapproval.

Partner Name of the partner account that is submitting the preapproval 
request.

Submitted By Name of person who submitted this preapproval.

Total Amount 
Proposed

Sum total of the values in each Amount Proposed field in the line items.

Total Participation 
Amount

This value is equal to the participation rate multiplied by the amount 
proposed as part of the preapproval request.

NOTE: The participation rate value comes from the MDF program.

Total Amount 
Approved

Calculated field. The amount is rolled up from the preapproval line 
items.
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4 Add a new record for each component of this preapproval and complete the necessary fields. 
Some fields are described in the following table.

5 Click the Activity or Activity Plans view tab to associate activities with this preapproval.

6 In the Status field of the preapproval form, select Submitted to submit the preapproval, and then 
save your changes.

Field Comment 

Category Indicates the kind of item this is. Values include Advertisement, 
Seminar, Conference, Trade Show, and Collateral.

Market Market segments relevant to this partner.

Vendor Name Name of the vendor supplying the good or service indicated in the line 
item.

Start Date Date the specified marketing activity starts.

End Date Date the specified marketing activity ends.

Participation Rate This value is inherited from the MDF Program Participation Rate..

Participation Amount Calculated field indicating the maximum amount the brand owner will 
contribute. The value comes from the participation rate multiplied by 
the proposed amount.

Amount Approved Calculated field indicating how much the brand owner approves for a 
given line item. This defaults to the participation amount multiplied by 
the approved percentage.

Category Indicates the kind of item this is. Values include Advertisement, 
Seminar, Conference, Trade Show, and Collateral.

Market Market segments relevant to this partner.

Vendor Name Name of the vendor supplying the good or service indicated in the line 
item.

Start Date Date the specified marketing activity starts.

End Date Date the specified marketing activity ends.

Participation Rate This value is inherited from the MDF Program Participation Rate..

Participation Amount Calculated field indicating the maximum amount the brand owner will 
contribute. The value comes from the participation rate multiplied by 
the proposed amount.

Amount Approved Calculated field indicating how much the brand owner approves for a 
given line item. This defaults to the participation amount multiplied by 
the approved percentage.
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Reviewing a Preapproval
After a preapproval has been submitted, the channel account manager reviews it. He or she can 
change amounts, reject line items, and approve as appropriate.

To review a preapproval

1 Navigate to the MDF Pre-Approvals screen > All Pre-Approvals view.

2 Locate and select the preapproval you want to review.

3 Drill down on the preapproval and click the Line Items view tab to review each line item.

4 In the Status field of each line item, select one of the following:

a If you approve the line item, select Accepted As Is.

b If you approve the line item but have made changes to it, select Accepted With Changes.

c If you do not approve the line item, select Denied.

d If you want the partner to make changes, select Returned.

5 In the preapproval form, the value in the Status field should be Submitted and can then be 
changed to one of the following:

■ Accepted

■ Rejected

■ Pending

■ Returned

■ On Hold

Creating a Claim
After the partner has completed the activity for which it submitted the preapproval, the partner can 
create a claim and submit it to obtain the funds. 

NOTE: One preapproval can have several claims associated with it, but a claim can be associated 
only with one preapproval.

To create a claim

1 In the Siebel PRM Portal, navigate to the MDF Claims screen.
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2 Add a new record and complete the necessary fields. Some fields are described in the following 
table.

3 Save the claim, drill down on it, and enter more information in the More Info form as needed. 
Some fields are described in the following table.

4 Click the Line Items view tab, add a new record for each completed activity or task outlined in 
the preapproval, and complete the necessary fields. 

Field Comment 

Status Status of the claim. Values vary depending on where the claim is in the 
review process.

Pre-Approval # Indicates the preapproval against which this claim is being made. All 
claims originate from a preapproval. 

Claim Name Name of the claim.

Program Name Name of the program from which this claim originates.

Has Enough Funds If this check box is selected, it indicates that the internal available 
balance field is greater than or equal to the total amount approved 
field.

Total Amount 
Claimed

Total sum of money requested by the reseller.

Total Amount 
Approved

Total sum of approved line items.

Total Participation 
Amount

This value is equal to the participation rate multiplied by the amount 
proposed.

NOTE: The participation rate value comes from the MDF program.

Field Comment 

Claim Category Choose from a variety of types of events to describe what this claim is 
for.

Pre-Approval 
Category

Type of preapproval event. This value comes from the preapproval 
record. 

Promotion Name Provide the name used to promote your event.

Field Comment 

Amount Claimed Indicates how money much is being requested for this line item.

Name Enter a name for this line item.
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5 In the claim form, in the Status field, select Submitted to submit the claim.

6 Save your changes.

Reviewing a Claim
After the reseller submits a claim, the brand owner reviews it and decides whether it should be 
approved.

To review a claim

1 Navigate to the MDF Claims screen.

2 In the Claims list, locate and drill down on the claim you want to review.

3 Click the Line Items view tab and review each of the claim’s line items.

4 For each line item, enter values in the Amount Approved and Final Amount Approved fields.

NOTE: Amount Approved could be different from Final Amount Approved if the final approver has 
to make changes. Final Amount Approved is the field used for back-office processing.

5 In the Status field of each line item, select one of the following:

■ If you approve the line item, select Accepted As Is.

■ If you approve the line item but have made changes to it, select Accepted With Changes.

■ If you do not approve the line item, select Denied.

■ If you want the partner to make changes, select Returned.

6 In the claim form, change the value from In Progress to one of the following:

■ If you approve the claim, select Accepted.

After you change the Status field to Accepted, the claim is processed. If there are sufficient 
funds and the employee has a sufficient approval limit, then the claim status is automatically 
set to Final Approval and the appropriate debits are created.

■ If you do not approve the claim, select Denied.

The claim cannot be edited any further.

■ If you want to make changes to the claim before approving, select Returned.

The reseller can change the status to Pending and continue to work on the claim.
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HTIM MDF Period Ending Process Workflow
This workflow runs at the end of a period. It transfers credits and debits to a new snapshot record 
for the next period. The workflow appears in Figure 30.

This workflow performs the following steps:

1 The workflow looks at the current period.

2 The workflow verifies that the period has ended and that a subsequent period is available.

■ If the period has not ended and/or there is no subsequent period available, the workflow 
ends. 

■ If the period has ended and the subsequent period is available, the workflow moves to the 
next step.

All credits which currently exist in this period are voided. A debit entry is created for the next 
snapshot period as needed, the next snapshot is created, and the workflow ends.

Figure 30. HTIM MDF Period Ending Process
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15 Managing Your Partners
The other chapters of this book focus on how to share information with your partner. This chapter 
focuses on tools you would use to track information about your partners, to train your partners, and 
to communicate with your partners. 

As part of your relationship with partners, you can use Siebel PRM to train partner employees, certify 
partner companies, plan partner management activities, measure partners’ performance, and keep 
other records about your partners.

This chapter contains the following topics:

■ “Tracking Partner Information” on page 291

■ “Managing Partner Training Courses” on page 302

■ “Certifying Your Partners” on page 304

■ “Communicating with Your Partners” on page 310

■ “Using Partner Alerts” on page 310

Tracking Partner Information
The partner profile and partnership profile are key ways of tracking partner information. 

The partner profile is a key way of tracking partner information. 

You can also use the Partner screen to keep track of partner management activities, partner 
agreements, partner company attachments, partnership contacts, and partner notes, and to create 
a partner company organization chart. 

Using the Partner and Partnership Profile 
Siebel PRM lets you work with two profiles: 

■ Partner Profile. A partner profile includes information about the partner or prospective partner 
company’s business. 

■ Partnership Profile. A partnership profile includes information about your company’s 
relationship with the partner company. 

Using the Partner Profile 
You can use the Partner Profile screen to enter information about the partner company for your own 
use, such as its annual revenues, its number of employees, its sales revenues, and so on. 
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If this company applied to be a partner through your Siebel PRM Portal, it filled out a partner profile 
form. You can use the Partner Profile screen to view the information that it entered.

To enter or view a partner company profile

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner whose profile you want to display.

3 Click the Profile view tab.

4 If the Partner Profile is not already displayed, select Partner Profile in the drop-down list in the 
Profile view.

5 Enter or view the information in the following table about the partner company in the Partner 
Profile form.

6 In the Products list, enter the partner’s products and services that are relevant to your company. 
Add new records to the list, and enter the information in the following table in their fields.

Field Comment

Description of Business A short description of the partner company’s business and 
background.

Annual Revenue The partner company’s annual revenues.

Markets The market segments in which the partner operates.

# of Employees The number of employees at the partner company.

# of Sales Employees The number of employees in the partner company’s sales 
organization.

# of Service Employees The number of employees in the partner company’s service 
organization.

Growth Strategies The partner’s growth strategy.

Routes to Market The partner’s routes to market.

Expertise A list of the partner company’s special skills. 

Other Program 
Membership 

Other companies with which the partner has a relationship. (This 
partner is a member of these companies’ partnership programs.)

Partner's Competitors A list of the partner company's competitors.

Field Comment

Name The name of the partner’s product or service.

Version The version of the partner's product or service.

Description A description of the partner’s product or service.

Service Product Select this flag if the product is a service.
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7 In the Related Products list, add the brand owner company’s products that are related to the 
partner’s products that you entered. Add new records to the list, and enter the information in the 
following table in their fields.

To work with a partner company profile
■ Modify a record by selecting a field and changing the information. 

Entering the Partnership Profile
The Partnership Profile screen holds information about your relationship with the partner company 
and the way you work together, and so it supplements the partner profile, which holds information 
about the partner company itself. 

When you are first planning how you can work together with a partner company, the Partnership 
Profile screen lets you clarify your future relationship by discussing the items on this screen with 
people at the partner company. 

To enter or view a partnership profile

1 Navigate to the Partners screen. 

Sales Product Select this flag if the product is a sales-related product.

Part # Enter the part number associated with the product or service.

Type Enter the type of product.

Field Comment

Product The name of the brand owner’s product or service.

Relation Indicates the relationship of the brand owner’s product to the 
partner’s product. Examples are Component, Bundled, and Cross-
Promoted.

Integration Status Indicates the status of integration between the brand owner's product 
and the partner's product. Examples are Integration In Progress and 
Integration Completed.

Description A description of the product.

Vendor Vendor name of the product.

Effective Start Date The start date of the validated relationship between the brand owner's 
product and the partner's product.

Effective End Date The end date of the validated relationship between the brand owner's 
product and the partner’s product.

Orderable Indicates whether the product is orderable.

Field Comment
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2 In the Partners list, select the partner whose partnership profile you want to display.

3 Click the Profile view tab.

4 Select Partnership Profile in the drop-down list in the Profile view, if the partnership profile is not 
already displayed.

The Partnership Profile view appears.

5 Enter or view information in the following table about this partnership in the Partnership Profile 
form.

6 In the Product Line list, enter your product lines that are relevant to this partnership, such as 
lines of products that you expect the partner to resell. Add new records to the list, and enter the 
information in the following table in their fields.

Field Comment

Description of Partnership Enter a general description of the partnership. 

Channel Sales Growth Rate Enter the annual growth rate of the partner’s sales of your 
products.

Yearly Channel Sales Enter the partner’s yearly sales of your products. 

Quarterly Channel Sales Enter the partner’s quarterly sales of your products.

Start Date Enter the date when the partnership was initiated.

End Date If the partnership is terminated, enter the termination date.

Renewal Date Enter the date when the partnership should be renewed.

Fees Paid Select this flag to indicate that the partner has paid membership 
fees.

Internal Benefit Enter the benefit of this partnership to your company. 

Partners Benefit Enter the benefit of this partnership to the partner company. 

Satisfaction Index (1 - 10) The channel manager can use this field to rate this partnership 
on a scale of 1 to 10.

Joint Markets Select the market segments in which you and this partner will 
jointly operate.

Joint Routes to Market Enter a description of your company’s and the partner's joint 
routes to market.

Joint Growth Strategy Enter a description of your growth strategy for this partnership.

Field Comment

Product Line Choose a product line from a list of your company’s product lines. 

Description A description of the product line is entered automatically. 
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Entering Partner Management Activities
You often want to record activities that you should perform to manage your partners, such as a 
telephone call you must make or a meeting you scheduled. You can list these activities on the 
Partners screen, Activities view. 

NOTE: Activities you add in the Partners screen are generally for your own use. However, you can 
also assign them to your own employees or to partner employees by selecting an employee’s name 
in the Assigned To field. 

To enter a partner management activity

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner to which the activity applies. 

3 Click the Activities view tab.

The Partner Activities view appears.

4 In the Activities list, click the menu button, and then click New Record to add a new record to 
the list. 

5 Fill in the fields with the details of the new activity.

To work with partner management activities
■ Modify a record by editing the information in its fields. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete Record. 

■ To display a list of your activities, including your partner management activities, from the 
application-level menu, navigate to the Activities screen.

Entering Partner Management Activity Plans
Siebel applications make it possible to create activity plans, which are templates that include lists of 
activities that are often performed in sequence. Using activity plan templates makes it easier to 
create complicated series of activities. If your company’s Siebel applications administrator has 
created these templates, you can use them through the Partner Activity Plans view. 

For example, you may often organize marketing events together with your partners. Organizing a 
marketing event requires a sequence of activities that are fairly standardized. You can create an 
event organization activity plan that includes these standard activities. 

Products A list of products in this product line is entered automatically.

Product Line Manager The name of the product line manager is entered automatically.

Field Comment
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When you want to organize an event, use this activity plan, and assign each activity in it to the 
person who is responsible for it. 

For more information about activity plan templates, see Applications Administration Guide.

NOTE: Generally, the activity plans that you add in the Partners screen are for your use. However, 
you can also assign these activities to your own employees or to partner employees by selecting an 
employee’s name in the Activity record’s Assigned To field. 

To enter a partner management activity plan

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner to which the activity plan applies. 

3 Click the Activity Plans view tab.

The Activity Plans list appears. 

4 In the Activity Plans list, click the menu button, and then click New Record to add a new record 
to this list. 

5 Fill in the fields with the details of the new activity. Use the Template field list to choose an 
existing template. 

The activities from that template are listed in the Activities list.

To work with partner management activity plans
■ Delete a record by selecting it, clicking the menu button, and then clicking Delete.

■ To display a list of your activities, including activities from your partner management activity 
plans, navigate to the Activities screen.

Entering Partner Agreements
It is often useful to have a list of the agreements that you have made with a partner company to 
refer to when you want to look up a specific agreement. Use the Partner Agreements view to record 
the agreements that you have made with your partners. 

For more information on agreements, see the chapter on agreements in Applications Administration 
Guide.

NOTE: The partner agreements that appear in the Partners screen should not be confused with 
service agreements with your customers. Partner agreements are agreements between the brand 
owner and partner company.

To enter partner agreements

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner with which you have made the agreement. 
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3 Click the Agreements view tab.

The Agreements view appears. 

4 In the Agreements list, click the menu button, click New Record to add a new record to this list, 
and then enter the details of the agreement.

To work with partner agreements
■ Modify a record by selecting a field and changing the information. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete.

Adding Partner Company Attachments
When you attach documents to a partner company’s record, you can access them when you are 
working with that partner company. For example, if you write a report about a partner company, you 
can attach it to that company’s record. Use the Partner Attachments view to attach files to partner 
records. 

NOTE: The attachments you add in the Partners screen are for your company’s use. Your partners 
cannot access them. To share files with a partner, you must add attachments to Account, Contact, 
or Market Development Fund records, which the partner can access. 

To enter partner company attachments

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner to which you want to add the attachment. 

3 Click the Attachments view tab.

The Partner Attachments view appears. 

4 In the Attachments list, click the menu button, and then click New Record. 

The Attachments Form appears. 

5 In the Attachments Name field, click the select button. 

The Add Attachment File dialog box appears.

6 Browse to locate the file you want to attach to the partner company record and click Open.

The name of the file is entered in the File Name field of the new Add Attachment dialog box.

7 Click Add. 

The name of the file appears in the Attachment Name field. 

8 Fill out the other fields in the Attachments record.

To work with partner attachments
■ Modify a record by selecting a field and changing the information. 
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■ Delete a record by selecting it, clicking the menu button, and then clicking Delete. 

■ Display the contents of the attached file by clicking its name in the Name field. 

Entering Partner Contacts
The Contacts list keeps track of your business contacts at the partner company. 

Partner employees must be in the Contacts list to be included in partner organization charts. You can 
also add contacts when you are creating an organization chart; these new contacts are added to the 
Contacts list. 

NOTE: Adding a contact in the Partner Contacts view will not give that contact access to the Siebel 
PRM Portal. If you want partner contacts to have access to Siebel PRM, you must also add them in 
the User Assignments list of the Administration - Partner screen, or they must be added by the 
delegated administrator at their own company. For more information, see Chapter 5, “Working with 
New Partners.” 

To enter partner company contacts

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company where the contact is an employee. 

3 Click the Contacts view tab.

The Contacts list appears. 

4 In the Partner Contacts list, click the menu button, and then click New Record to add a new record 
to this list. 

5 Enter information about the contact. 

Entering Partnership Contacts
The Partnership Contacts list keeps track of the key people who manage this partnership. It should 
include the following:

■ Key partner contacts. These employees of the partner company are responsible for managing 
the partner relationship. 

■ Internal owners. These employees of the brand owner company are responsible for managing 
the partner relationship. 

NOTE: Partner employees must be in the partner Contacts list, described in the previous section, for 
you to be able to select them to be added to the Partnership Contacts list. 
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To enter partnership contacts

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company where the contact is an employee. 

3 Click the Partnership Contacts view tab.

The Key Partner Contacts list appears. 

4 In the Key Partner Contacts list, click the menu button, and then click New Record to add a new 
record to this list. 

The Key Partner Contacts form appears. 

5 Click the select button for the Last Name field.

The Pick Contact dialog box appears, listing employees already added to the partner Contacts 
list. 

6 Select the record for the contact you want to add, and click OK.

The fields in the Key Partner Contacts form are filled out with information about this contact.

7 In the Internal Owners list, click the menu button, and then click New Record. 

8 In the Add Positions dialog box, select the person in your company who is the internal owner of 
this partnership contact. You can select more than one internal owner. 

Adding Notes About a Partner Company
Partner notes let you enter text information about partner companies. For example, if a partner gives 
you driving direction to its office, you can enter the information in a note added to that company’s 
record. 

This information can be exclusively for your use or can be shared with colleagues in your company:

■ Private Notes. These notes are visible only to the person who entered them.

■ Shared Notes. These notes are visible to anyone in the brand owner company who can see the 
partner’s records.

You and others in your company can use the Partner Notes view to enter notes about your partners. 

NOTE: Partner employees do not have access to shared notes. They are used for sharing information 
within the brand owner company.

To enter notes about a partner company

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner to which the note applies. 

3 Click the Notes view tab.

The Partner Notes view appears. 
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4 If the proper type of note is not already displayed, select Private Notes or Public Notes from the 
Show drop-down list. 

5 In the Notes list, click the menu button, and then click New Record to add a new record to this 
list. 

6 Enter the note as text in the Description field of the new record. 

To work with notes about a partner company
■ Modify a record by selecting a field and changing the information. 

■ Delete a record by selecting it, clicking the menu button, and then clicking Delete.

Creating a Partner Company Organization Chart
When you display a company organization chart of a large partner company, you can see every 
employee’s position at a glance. Siebel PRM lets you define the hierarchy shown in the organization 
chart by specifying the manager for every contact. Select the appropriate person in the Manager field 
of the Contact record. 

Everyone in the organization chart must be on your contact list for that partner company. You can 
add new contacts in the Partner Organization Analysis view while you are working on the organization 
chart, and they will also be visible in the Partner Contacts view. 

NOTE: The lower form in the Partners Organization Analysis view has a drop-down list next to its 
name. Use this list to toggle between a Contacts view, which has a list of your partner contacts, and 
an Organization Analysis view, which has an organization chart. If the chart appears when you first 
open it, you must use this drop-down list to display the Contacts list in order to select each contact’s 
manager. You can also use the Contacts list to add new contacts. 

To create a partner company organization chart

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company whose organization chart you want to create. 

3 Click the Organization Analysis view tab.

The Partner Organization Analysis view appears.

4 If the lower form is Contacts list, go on to Step 6. If the lower form is Organization Analysis, 
select Contacts from the drop-down list.

5 Select the partner employee whose manager you want to specify. 

6 Click the select button for the Manager Last Name field. 

The Pick Manager dialog box appears.

7 Select the person’s manager and click Pick. 

8 Repeat Step 6 and Step 7 to select a manager for each of the partner contacts.
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9 Select Organization Analysis from the drop-down list to display an organization chart for the 
partner company. 

To work with partner company organization charts
■ Maintain the chart whenever the company’s structure changes by using the Pick Manager dialog 

box to change Manager Last Name fields as needed. 

■ View the chart at any time by selecting the record of the partner company in the Partner screen 
and clicking the Organization Analysis view tab. 

Uploading Partner Logos
The Siebel PRM Portal allows a partner to upload its company logo. You can use the partner logo for 
collaborative presentations or proposals that you want to co-brand. 

The partner can upload multiple logos, because you may need its logo in different formats to use in 
different media. For example, you use .gif or .jpg format to display on the Web, and you may need 
a higher quality format for printed material. 

The partner uploads logos by clicking on the Profile hyperlink, displaying the Company profile, and 
then displaying the Logos list. The partner can add a record to this list and select the graphics file 
for the logo. 

After these logos are approved by the brand owner, the partner can specify which logo is displayed 
in the Partner Locator by selecting it in the Partner Profile Logo field of the Company Profile form. 
The brand owner can also specify which logo is displayed in the Partner Locator by selecting it in the 
Partner Profile Logo field in the Partner screen of the Siebel PRM Manager. Both partner and brand 
owner can access this field, and can use it to select a logo of the type jpg, bmp, gif, or another Web 
format to be displayed. 

You must approve logos that the partner has uploaded before they can be used. When a partner 
submits a logo, its status defaults to submitted. You approve it by changing the status to approved. 
The partner can view the status in the Siebel PRM Portal but cannot change it. 

You use the Siebel PRM Manager to approve, access and use all the partner’s logos. 

To approve or access a partner logo

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company whose logos you want to work with. 

3 Click the Logos view tab.

4 To approve a logo, in the Status field of its record in the Logos list, select Approved. 

5 To access a logo, in the Logos list, click the file name. 

When you drill down on the file name, the Logo Details view appears, where you can see the logo. 
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Managing Partner Training Courses
Siebel Training is fully integrated with Siebel PRM. Using the Siebel PRM Manager, brand owners can 
set up and manage Web-based video format courses, classroom-based courses with live instructors, 
courses on CD, and distance learning courses. In addition, brand owners can use the Siebel PRM 
Manager to host and deploy Web-based courses. 

Siebel Training allows channel managers to deploy video, online, and in-class courses and tests for 
partner employees. You use the Siebel PRM Manager to: 

■ Enter and administer information about courses, classes, curricula. 

■ Enroll partners in training courses.

■ Track enrollments for courses and classes as well as performance on tests and progress toward 
curriculum completion. 

■ Create certification tests, establish minimum passing requirements for tests, and track partner 
employees' performance on tests. 

■ Build and maintain libraries that contain training materials that enrollees can download. 

■ Develop, administer, and track the results of online tests. 

For more information on setting up training courses and managing registration, see Siebel Training 
Guide.

Training From the Partner’s Perspective
Employees of partner companies can use the Siebel PRM Portal to perform the following tasks:

■ Check the schedule of courses in which they are enrolled. Partner employees drill down on a class 
or course to view more detailed information about it, such as topics, objectives, tests, materials, 
and associated courses. Managers at the partner company can view their reports’ course 
enrollments by using the Training screen > Managers view.

■ Search for new training by browsing or searching lists of classes or courses, or by viewing 
training appropriate to their job role or training in a convenient location. 

■ Enroll in new courses or classes. The partner employee can select a Web-based course and drill 
down on the course and click Enroll. The system then takes the partner to the shopping cart 
where the partner can pay the fee for the course; if there is no fee, the partner’s shopping cart 
displays a fee of $0. If there is availability in the course or class, the user is automatically 
enrolled; if no space is available in the training course or class, the partner employee is put on 
a waiting list. 

■ After the partner has enrolled or wait-listed for a course or class, the partner can see the course 
record in the My Training view. The partner employee can download training materials to review 
before taking the course. (The partner does this using the Course Details view.)

■ After a partner employee is enrolled in a Web-based course, the partner employee can take the 
course by navigating to the My Training view, clicking the My Self-Paced Courses hyperlink, 
selecting and drilling down on the course, and launching the course by clicking on the Course 
Launch button or using the applet level menu. 
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■ After completing courses or classes, partner employees can take tests and receive their grades 
directly from the Siebel PRM Portal. (The partner does this by navigating to the My Training view, 
selecting and drilling down on the training record, navigating to the Tests applet, selecting the 
appropriate test, and clicking the icon to the right of the test record to launch the test.)

The Training screen provides one point of entry for end user activities related to training, including 
viewing training course schedules, searching for and enrolling in new courses, downloading course 
materials, and taking certification exams.

Administering Partner Training
You use Siebel PRM Manager to administer partner training. You can perform the following tasks:

■ Enter information about courses, classes, and curricula, including course type (Web-based video, 
instructor led, CD, or Distance Learning); job roles that would benefit from taking the course; 
times and locations of on-site classes; directions and hotels close to on-site classes. 

■ Associate courses with price lists, so users can be charged appropriately. 

■ Enroll partners in specific training courses. 

■ Track partner enrollments in Web-based courses and in classroom-based classes. (You enter this 
information in the Training Course Enrollments or Training Class Enrollments view.)

■ Track enrollees’ test scores. (You view this information in the Test Results view.)

■ Maintain an electronic library of training materials. (You enter this information in the Training 
Library view.)

■ Create online tests that are scored automatically when the test taker submits the tests. (You 
create the pool of questions in the Test Questions view. You create the tests in the Tests view.)

■ Administer distance learning for live Web-based courses. (You enter this information in the 
Distance Learning screen, by clicking the hyperlink View Available Sessions.) 

For more information about administering Siebel Training, see Siebel Training Guide.

Tracking Partner Training
You can track the courses a given partner has taken or the partners who have taken a given course. 

Displaying the Training Courses a Partner Has Taken
You can view the training courses a partner company has taken. For example, you can see if a new 
partner company has been taking the training needed to learn about your products. 

To display the training courses a partner has taken

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company whose training courses you want to see.
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3 Click the Course Enrollment view tab.

The Training Courses list appears. It includes partner employees who have enrolled in training 
courses and the titles of the training courses. 

Displaying the Partners Who Have Taken a Training Course
You may also want to see a list of partner employees who have taken a training course. For example, 
if you recently created a new course for your partners, you can see whether it is popular among 
partner employees. 

To display the partners who have taken a training course

1 Navigate to the Site Map > Administration - Training screen > Courses view.

2 In the Courses list, select the course whose enrolled partners you want to see.

3 Click the Partner Enrollments view tab.

The Partner Enrollments list includes partner employees who have taken the course. 

Certifying Your Partners
You can set up partner certification programs to give your partners an opportunity to improve their 
skills and let your customers know which partners are most skilled. 

For example, you might enroll new partner companies as silver partners. When a partner company’s 
employees have taken ten training courses, answered 20 customer service requests, and generated 
$20 million in revenue, you might make the company a Gold partner. Or, when employees have taken 
20 training courses, answered 40 customer service requests, and generated $50 million in revenue, 
you might make the company a Platinum partner. 

A partner company can work on several certification programs at the same time. For example, a 
partner may work on becoming a certified reseller and a certified service provider. 

To certify partners, you go through the following process: 

■ Plan and create appropriate metrics for all of your certification programs. 

■ Set up certification templates that specify the requirements for each level of certification in a 
certification program. 

■ Record the partners’ progress. You can enter the courses they have taken, or you can set up 
Siebel Business Process Designer to enter these values automatically. For example, when a 
partner uses the Siebel PRM Portal to take a training course, Siebel Business Process Designer 
can increment the value in the Actual# field for that partner’s training courses. 

■ Display a list of the certifications a partner company is working on, and check the progress on 
each certification. 
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Creating Certification Metrics
Before you can create any certification templates, you must create certification metrics. 

A certification metric lets you find partners who are taking similar certification programs. For 
example, if you plan to develop a series of certification programs that require partners to take 
training courses, you could create a metric named # of courses taken. Then, when you evaluate 
partner performance, you can search on the metric field to list the certification programs that require 
training courses, and compare the performance of partners working on these programs. 

A certification metric also lets you define the criteria for a particular certification. For example, you 
could define multiple criteria for a partner company to become a Certified Reseller. One of those 
criteria could be to generate $20 million in revenue. You would define this criterion by choosing a 
predefined metric named Sales Revenue and assigning a target amount value of $20 million.

A certification metric is not a mathematical formula that measures performance. Performance is 
measured using the Target and Actual fields of each certification definition. A metric lets you 
categorize criteria, so you can compare the performance of different partner companies measured 
using similar criteria. 

To add a new certification metric

1 Navigate to the Site Map > Administration - Training screen > List of Values view. 

2 In the List of Values, click the menu button, and then click New Record.

3 A new record is added to the list. 

4 Click the select button.

5 The Pick Value Type dialog box appears. 

6 Choose CHAMP_METRIC_CD, and click OK. 

7 In the Order field, enter the order in which this metric appears on the list of values in the list for 
the Metric field of Certification Criteria records. 

8 In the Display Value field, enter the name for the metric that will appear in the list for the Metric 
field of Certification Criteria records. 

9 Click Language Name, and select the language for this record. 

10 Other fields are optional and are not generally used in certification criteria. Fill them out only if 
you have a special reason to do so. 

This metric is added to the Metrics picklist in Certification Criteria records.

Creating Certification Templates
A certification template includes general information about a certification program, such as its name 
and description, and a list of the criteria required for that certification. 
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For example, you could create a template for companies that want to become Gold partners with two 
criteria: that a partner company’s employees must take ten training courses and answer twenty 
customer service requests. 

There are three fields that define criteria for certification: 

■ Target #. Enter the target number here when you create the certification template, and enter 
the actual number in the Actual # field as the certification program is being completed. For 
example, if you require a partner to resell one hundred of your computers to become a Gold 
partner, the measurement is the number of computers that a partner sells, so you would enter 
100 in the Target # field.

■ Target Amount. Enter the target amount here when you create the certification template and 
enter the actual amount in the Actual Amount field as the certification program is being 
completed. For example, if you require a partner to resell $100,000 of your computers to become 
a gold partner, the measurement is the amount of revenue for a partner’s sales, so you would 
enter 100,000 in the Target Amount field.

■ Condition Clause. If the criterion has a condition, enter a brief description of the condition that 
the partner company must satisfy when you create the certification template and select True or 
False in the Condition Met field as the certification program is being completed. For example, if 
the condition is to have the partner go to a trade show to display your computers, you would 
select True when the partner goes to the show. 

In addition, if you are using the Target # or Target Amount field, you can optionally specify what the 
target refers to in the Training Course or Product field. 

For example, in one certification definition, you might enter 100 as the target number and select 
Laptop computers as the product, showing that 100 refers to this product. In a second definition, 
you might enter 100 as the target number and select Printers as the product, showing that 100 refers 
to this product. Then, the partner would have to resell one hundred laptop computers and one 
hundred printers to receive this level of certification. 

To create a certification template

1 Navigate to the Site Map > Partner Certifications screen > Certification Templates.

2 In the All Certification Templates list, click the menu button, and then click New Record to add a 
new record to this list. 

3 Enter information in the following table about the certification template in the new record. 

Field Comment

Template Name Enter the name of the certification template.

Validity (months) Enter the number of months that a certification, once gained, is valid.

Created The system enters the date when this certification record was created. 

Created By The system enters the employee who created this template record.

Updated The system enters the date when this certification record was last 
updated.
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4 Click the Certification Criteria view tab. 

5 In the Certification Criteria list, click the menu button, and then click New Record to add a new 
record to this list. 

6 Enter the criteria from the following table in the new record’s fields.

Associating Certifications with a Partner Company
You can create a certification record for each of your partners and associate these records with 
certification templates.

You can also set up Siebel Business Process Designer to automatically enter the value Certified in 
the Status field of the Certification record when values are filled in the Certification Criteria list that 
satisfy all the requirements of the certification, making the partner company a certified partner. 

For more information about Siebel Business Process Designer, see Siebel Business Process Designer 
Administration Guide.

To create a certification record and associate it with a partner

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company for which you want to create a certification.

Updated By The system enters the employee who last updated the certification 
template.

Active Leave this field unchecked while you are working on the template. When 
the template is done, check the field to make the template active, so 
your partners can see it. 

Description A description of this certification for your own use.

Field Comment

Condition Clause If you are using a condition as the target, enter it here. 

Metric Select a metric, which you use to categorize and define your certification 
criteria. 

Target # If you are using a quantity as the target, enter the target number here. 

Target Amount If you are using an amount as the target, enter the target amount here. 

Training Course Optionally, choose the training course that must be completed as part of 
the criteria.

Product Optionally, choose the product that the partner must have sold or been 
trained on, as a part of the criteria. 

Field Comment
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3 Click the Certifications view tab.

Certifications view appears.

4 In the Certifications applet, click the menu button, and then click New Record. 

5 Enter information from the following table in the fields.

Recording Partners’ Progress
Partner employees can view certification programs in the Certification view of the Siebel PRM Portal. 
This view has Actual#, Actual Amount, and Condition Met fields in addition to the Target#, Target 
Amount, and Condition clause fields whose values you entered when you created the template. Your 
partners can view these fields to see a certification program’s requirements. 

You can configure Siebel Business Process Designer to fill out these fields automatically, based on 
actions that partner employees take when they register for training courses, or work with 
Opportunity records, or work with Service Request records, and so on. 

For more information about Siebel Business Process Designer, see Siebel Business Process Designer 
Administration Guide.

Checking a Partner’s Progress
At any time, you can look up each certification a partner company is working on and how much 
progress has been made on each one. 

Field Comment

Template Name Click the select button and select a predefined template. The criteria in 
the Certification Criteria applet are automatically filled based on the 
template chosen.

Certification Name Enter a name for the certification. 

Description Enter a description of the certification.

Partner Enter the name of the partner company.

Active This field is automatically set to true if the End Date is greater than 
today.

Status Indicates the status of the certification—In Progress, Not Started, 
Certified.

Certified Date The date on which the status is set to Certified is entered automatically 
when you select this status.

End Date The end date is entered automatically, set based on the certified date 
and the validity (in months) defined for the certification template. 
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To look up a partner company’s certifications

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company whose certifications you want to check.

3 Click the Certifications view tab.

Certification view appears.

4 Select any certification record in the Certifications list. 

The criteria for that certification are displayed in the Certification Criteria list. 

In the Certification Criteria list, compare the Target#, Target Amount, or Condition Clause field 
for each record with the Actual#, Actual Amount, or Condition Met field for each record.

Displaying Certified Partners
You can display the partner companies that have achieved each of your certification levels in the 
Partner Certification screen. 

To display certified partners

1 Navigate to the Site Map > Partner Certifications screen > Certification Templates view.

2 From the Show drop-down list, choose Certification Templates. 

3 In the All Certification Templates list, select a certification template.

4 Click the Certified Partners view tab. 

The Certified Partners list includes the partners with that certification. 

Displaying Certifications Across Partners
You can display the certifications all of your partners have completed or are working on in the Partner 
Certifications screen. The list includes the status of each certification. 

To view certifications across partners
■ Navigate to the Site Map > Partner Certifications screen > All Certifications Across Partners view.

The partner certifications appear.
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Configuring Autopopulation of Partner Certification 
Criteria
When the user adds a Certification child record to a Partner record in the Partner Certification - 
Certifications Detail view of the Partners screen, the criteria associated with the template selected 
are automatically populated in the Certification Criteria applet. 

This autopopulation depends on the following user properties in the Partner Certification business 
component:

■ Child Attribute BC

■ Template Definition BC

Autopopulation also requires that the following business components are configured in the Channel 
Partner business object using the appropriate links:

■ Partner Certification

■ Partner Certification Criteria

■ Partner Certification Template

■ Partner Certification Template Definition

The user properties and the business components must be consistent. 

Communicating with Your Partners
Aside from the methods of sharing data covered in earlier chapters, Siebel PRM gives you two special 
methods of communicating with your partners: 

■ Partner alerts. These are text messages that are targeted to specific partners and displayed on 
their Siebel PRM Portal home page. 

■ Siebel Briefings. These are news updates about your company that are targeted to specific 
partners and displayed on the Siebel PRM Portal home page and on the Briefings page of the 
Siebel PRM Portal, which the partner can also use to track information about other companies. 

Using Partner Alerts
Partner alerts are text messages that you send to your partners or to selected groups of recipients 
that are displayed on the partners’ home pages. 

You can create a new message in the Alert Administration screen. You can enter the message in plain 
text or in HTML format. You can use an HTML authoring tool to create the message and then paste 
the HTML code into the new message. 

Partner alerts support basic HTML tags. When a user is creating the body of a message in the Alert 
Administration screen, More Info form, the user can move the cursor to the icon that looks like the 
letter “i” to display a list of the tags that are supported: 

■ <b>...</b> bold
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■ <i>...</i> italic

■ <u>...</u> underline

■ <h4>...</h4> heading size 

■ <a href=”url”>...</a> hyperlink to url

Do not use HTML tags other than these. Do not use tags that define the HTML document, such as 
<HTML>, </HTML>, <body>,</body>, or <header>, </header>.

The partner employees to whom you have sent this message will see the abstract in the Partner 
Alerts applet of their Siebel PRM Portal home page between the activation date and the expiration 
date that you specified. This applet lists abstracts of their partner alerts in an order that depends on 
the priority you gave each alert. The abstract is a hyperlink, which partners click to see the entire 
message. 

You can also add literature or products as attachments, if desired. The recipients can view them 
through tabs that appear after they click on a hyperlinked abstract on the home page. 

There are three types of messages currently defined:

■ Partner alerts. These messages are visible to partners only. You determine whether to send 
them to all partners or selected recipients. 

■ Program information. These messages appear on the registered user home page only.

■ Public information. These messages appear on the unregistered user home page only.

Creating Partner Alert Keywords
Optionally, you can use Siebel Personalization to assign one or more keywords to each message to 
specify which partners see messages with specific keywords.

You can reuse keywords across multiple messages. Keywords are entered separately for each 
message. Because they are free-form, you must be very disciplined when you enter them if you plan 
to use them for personalization across messages. Personalization compares the keyword to attributes 
of the person logging into the Siebel PRM Portal and displays only those messages with a keyword 
corresponding to the profile.

For more information about personalization, see Siebel Personalization Administration Guide. 

Creating Partner Alerts
Use the following procedure to create a partner alert.

To create a partner alert

1 Navigate to the Site Map > Administration - Alert screen.

2 In the Partner Alerts list, click the menu button, and then click New Record.
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3 Enter information from the following table in the fields of the new record and the More Info form.

4 If you want to add literature as an attachment to the message, do the following:

a Click the Literature view tab. 

b In the Literature list, click the menu button, and then click New Record. 

The Add Literature dialog box appears. 

c In the dialog box, select the Literature records you want to add.

d In the dialog box, click OK.

5 If you want to add a product as an attachment to the message, do the following: 

a Click the Product view tab. 

b In the Products list, click the menu button, and then click New Record. 

The Add Internal Products dialog box appears. 

c In the dialog box, select the products you want to add.

Field Comment

Priority Choose the priority of the message. This determines where the message 
appears in the list of partner alerts on your partners’ Siebel PRM Portal home 
pages. Messages with the highest priority will be at the top of the list. 

Type Choose the type of the message. This determines the type of partner for 
which the message is displayed. Select Partner Alert to display the message 
for employees of registered partner companies, Program Information to 
display the message for self-registered individual partners, or Public 
Information to display the message for unregistered anonymous users. 

Partner You must select the Partner check box for the alert to be displayed to 
partners. 

Message Body Type in the text of the message, including HTML formatting code if desired. 

Abstract Enter a brief abstract that summarizes the message. This will appear as a 
hyperlink on your partners’ Siebel PRM Portal home pages. 

Keywords Enter keywords that the user can search on to find this message. You can 
also use keywords for personalization. 

All Users Select this check box if you want the message to appear to all partner users. 
Do not select this check box if you want to direct the message to specific 
partner companies or specific positions. 

Activation Enter the date when the message will first appear to your partners.

Expiration Enter the date when the message will no longer appear to your partners.

Created Automatically filled in with the date and time the message was created.

Created By Automatically filled in with your login name.
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d In the dialog box, click OK.

6 If you want to specify partner organizations to which you will send the message, do the following: 

a Click the Recipients view tab. 

b If it is not already selected, select Recipient Partners in the Show drop-down list. 

c In the Recipients list, click the menu button, and then click New Record. 

The Add Recipients by Partner dialog box appears. 

d In the dialog box, select the partner organizations that will receive the alerts. 

e In the dialog box, click OK.

7 If you want to specify positions to whom you will send the message, do the following: 

a Click the Recipients view tab. 

b Select Recipient People in the Show drop-down list. 

c In the Recipients list, click the menu button, and then click New Record. 

The Add Positions dialog box appears. 

d In the dialog box, select the people who will receive the alerts and click OK.

Using Siebel Briefings, Content Services, and Content 
Broker
The Briefings screen of the Siebel PRM Portal lets your partners use the following communication 
methods: 

■ Siebel Briefings. This method aggregates relevant business information from inside and outside 
your organization into personalized Web pages. Siebel Briefings displays enterprise data from the 
Siebel database, such as opportunities, service requests, and contacts, plus news and other 
information from external content providers. 

■ Siebel Content Services. This method aggregates news and company information from 
multiple sources and distributes it to Siebel Briefings customers. Customers who subscribe to 
Siebel Content Services receive out-of-the-box integration with external news and company 
information. Siebel Content Services includes the leading newswires, business magazines, 
newspapers, trade journals, company profiles, corporate profiles, corporate relationship 
information, market data, and other relevant content in context with Siebel data.

■ Siebel Content Broker. Siebel Content Broker can display content from any external source 
that is properly configured. You can configure additional third-party information sources using 
Siebel Tools to configure applets and business components so that they can handle external 
content. These configuration tasks include:

■ Configuring a business component to handle external data

■ Configuring an applet to display external data

■ Modifying the table of contents applet
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■ Adding the applet to a view

Partner employees can also use the Tracking Profile views of the Briefings screen to choose accounts, 
competitors, industries, or products that they want to track. These tracked items appear in the 
Briefings screen in views separate from the personalized briefing that you set up, such as the 
Accounts Briefings view and the Competitors Briefings view. 

The information displayed is personalized for each partner employee. You set up this screen to 
specify the information that appears. 

For example, you can configure the Siebel PRM Portal home page so it shows Company In the News 
or New Products, to help partner employees stay up-to-date on the latest news and product 
information from the brand owner company.

Then, whenever partner employees log onto the Siebel PRM Portal, they immediately see this 
information, which can help them on sales calls. On the home page, the partner agent clicks these 
new product and news hyperlinks to get more detailed information. In addition, partner employees 
can use their own personalized My Briefings screens to see information about accounts, competitors, 
and finance and industry news. 

You set up Siebel Briefings for partner employees in the same way that you set up Siebel Briefings 
for your own employees. 

For more information on Siebel Briefings, see Siebel Briefings Administration Guide.

Administering Partner Satisfaction Surveys
Partner satisfaction surveys allow you to measure how satisfied your partners are with their working 
relationship with your company. 

Partners employees can go to the Partner Satisfaction screen of the Siebel PRM Portal, click a link to 
display the survey, answer a series of multiple-choice questions, enter free-form comments, and 
submit the survey. 

Viewing the Results of Partner Satisfaction Surveys
The brand owner can use the Partners screen to display the results of these surveys. These results 
help them develop plans to improve their working relations with their partners. 

To view the results of partner satisfaction surveys

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner company whose training courses you want to see.

3 Click the Survey view tab.

A list of all surveys submitted by employees of that partner company appears, with fields that 
represent overall satisfaction and the questions in each survey. 
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4 Select a record in the Survey list and scroll down to see the Partner Satisfaction Survey form, 
which includes the full questions and answers for the survey, and the Satisfaction Level form, 
which lets you view several charts of the overall satisfaction level for the survey. 

Configuring Partner Satisfaction Surveys
You can use the partner satisfaction surveys that are provided with Siebel PRM, or you can change 
these surveys by configuring them using Siebel Tools. 

For more information about using Siebel Tools, see Using Siebel Tools. 
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16 Reporting on Partner 
Performance 
This chapter describes the ways that you can use Siebel PRM to produce reports about partner 
companies, and to analyze partner performance. 

This chapter contains the following topics:

■ “About Partner Performance and Reporting” on page 317

■ “Using CHAMP Planning” on page 318

■ “Using Partner Performance Reports” on page 318

■ “Using Assessments to Evaluate Partner Performance” on page 319

■ “Using Siebel PRM Reports” on page 320

■ “Siebel Analytics” on page 321

About Partner Performance and 
Reporting
Siebel PRM gives you a number of ways to analyze partner performance, including the following: 

■ CHAMP Planning and Partner Performance Reports. CHAMP planning lets you create 
initiatives and joint business plans with your partners. Because these plans have clearly defined 
objectives and action plans, you can create and use CHAMP metrics to measure the success of 
each partner company in achieving its objectives. You can also use the Partner Performance view 
of the Partners screen to see reports about a partner’s performance.

■ Assessments. Assessments let you evaluate partner performance based on criteria that you 
specify in assessment templates. They let you define any criteria that meet your needs. 

■ Siebel PRM Reports. Siebel PRM includes many built-in reports that let you integrate 
information and performance results from different tools. These prebuilt reports include Smart 
Reports, which incorporate best practices from sales and call center applications, and 
Parameterized Reports, which let the user customize the report at runtime. 

■ Partner Analysis. Partner Analysis uses Siebel Analytics and the Siebel Data Warehouse. 
Partner Analysis includes nearly 200 prebuilt, partner-specific reports to help brand owners 
assess individual partner performance and the success of the partnership program as a whole. 
In addition, Siebel PRM includes hundreds of prebuilt reports for sales analysis, service analysis, 
marketing analysis, and executive analysis within your organization. The reports focus on key 
performance indicators across a large number of predefined metrics. Siebel Analytics also lets 
users design new reports using a drag-and-drop interface.

You can use one or more of these methods of reporting or evaluating partner performance, 
depending on your business needs. 
Siebel Partner Relationship Management Administration Guide Version 7.8,
Rev. A

317



Reporting on Partner Performance ■  Using CHAMP Planning
Using CHAMP Planning
Channel and Alliance Management Process (CHAMP) is an established process that allows brand 
owners to work collaboratively with partner organizations and evaluate the partner’s performance. 

CHAMP planning involves creating partnership initiatives and partner plans with clearly defined 
objectives and action plans, so you can measure the success of each partner company in achieving 
these objectives.

After you execute the plan, you measure partner performance against the established objectives. 

For more information about CHAMP planning and reporting, see Chapter 7, “CHAMP Planning.”

Using Partner Performance Reports
Performance reports measure partner performance as you do in CHAMP planning, without going 
through the entire process of setting up CHAMP initiatives and action plans. You have to enter 
objectives and metrics only. 

These reports are read-only. In order to create objectives for a partner and measure them, you have 
to first create a dummy CHAMP Plan for this partner in the CHAMP Planning screen and add objectives 
to this plan. At the end of the objective time period, you should enter the actual values. The Partner 
Performance Reports will display the objectives that you created for this partner. You can filter these 
objectives based on the Plan, Plan Period, and the Metric fields. 

The advantage of using these performance reports is that you do not have to create comprehensive 
CHAMP plans with highlights and action plans, and you do not have to work closely with the partner 
to jointly approve the plans. This approach would make sense when you have hundreds or thousands 
of second- or third-tier partners and you want to track their performance, but you do not want to 
engage in detailed planning sessions with each partner. 

The Partner Performance view is driven by CHAMP objectives. It uses the objectives’ metrics, target 
number and actual number, target amount and actual amount, condition clause and condition met in 
the same ways as CHAMP objectives. 

Each partner performance report measures the success of one or more objectives, which work like 
CHAMP objectives. The report is based on the target number or target amount that you entered when 
you created the objective. For example, if the objective is to sell computers, the target number might 
be 1000 computers sold in the quarter, or the target amount might be $2 million in sales for the 
quarter. 

At the end of the performance report period, you can manually enter the actual number or actual 
amount for the objective (for example, if 1124 computers were sold, or if $2,231,426 of computers 
were sold). However, it is best to create workflow rules or business services to calculate the actual 
values automatically based on transactional data such as opportunities, service requests, orders, and 
so on. 

The sample database includes an example of such a workflow. Its name is CHAMP Update Metrics 
workflow. The name of the corresponding business service is eChannel CHAMP Services.

To create performance reports, you go through the following process: 
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■ Create a sample CHAMP plan. In this case, the user is creating this plan just to serve as a 
placeholder for the performance objectives. The plan must be created because performance 
objectives cannot exist without being associated with a plan. For more information on creating a 
CHAMP plan, see Chapter 7, “CHAMP Planning.”

■ Create performance objectives. Use the Plan Objectives view to create performance 
objectives. For more information on creating performance objectives, see Chapter 7, “CHAMP 
Planning.”

■ View the partner’s performance. Use the Partner Performance view of the Partners screen to 
see reports on the performance of the partner company.

Use the following procedure to view partner performance.

To view partner performance 

1 Navigate to the Partners screen. 

2 In the Partners list, choose the partner whose performance you want to evaluate. 

3 Click the Partner Performance view tab. 

4 In the Partner Performance list, choose Performance Over Time. 

5 In the Performance Over Time (Amount) or the Performance Over Time (Quantity) list, use the 
drop-down lists to choose the time periods for which you want to display a chart and the type of 
chart you want to display. 

Charts are displayed showing the partner’s performance during the time period as measured by 
an amount metric or by a quantity metric.

6 In the Partner Performance list, choose Performance On A Metric. 

7 In the Plan Objectives list, use the drop-down lists to choose the metric, the partner, the plan, 
and the plan period that you want to measure performance on. 

8 In the Performance On a Metric (Amount) or the Performance On a Metric (Quantity) list, use the 
drop-down lists to choose the chart you want to display. 

Charts are displayed showing the partner’s performance against this metric for an amount metric 
or for a quantity metric.

Using Assessments to Evaluate Partner 
Performance
Assessments give you a quick way to evaluate the performance of partner companies based on the 
criteria that you specify. First, your Siebel applications administrator must create one or more 
assessment templates that specify the factors to use to evaluate the partner. You can then attach a 
template to the partner’s record and see how well the partner scores. 

You can use assessments to evaluate accounts, opportunities, and contacts based on the criteria in 
the assessment template. You can define any criteria that meet your needs. 
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For information about creating assessment templates, see the section on setting up assessment 
templates in Applications Administration Guide.

To enter a partner company assessment

1 Navigate to the Partners screen. 

2 In the Partners list, select the partner that you want to assess. 

3 Click the Assessments view tab.

The Assessments list appears. 

4 In the Assessments list, click the menu button, and then click New Record to add a new record 
to this list. 

5 Fill in the fields with the details of the assessment. In the Template field, choose an existing 
assessment template. 

The factors that are evaluated by that template and the score for each factor are listed in the 
Assessment Attributes list.

6 In the Assessment Attributes list, enter the actual values for the assessment attributes.

7 To see how well the partner did overall, view the values in the Score, Percent, and Max Possible 
Score fields of the Assessments record.

To work with partner assessments
■ Modify a record by selecting a field and changing the information. 

■ Delete a record by clicking the menu button and then clicking Delete Record.

Using Siebel PRM Reports 
Siebel PRM lets your employees and partner employees run and distribute reports in batch or 
interactive mode. Users can schedule reports so they run periodically at a specified time, or can run 
long reports at off-peak times. 

Siebel applications’ prebuilt reports include Smart Reports, which incorporate best practices from 
sales and call center applications, and Parameterized Reports, which let the user customize the 
report at runtime. 

To optimize performance, report output is generated in DHTML format and sent to the browser one 
page at a time.

There are a wide variety of reports available that Siebel PRM shares with other Siebel applications. 
The following reports are specific to Siebel PRM:

■ Partner List. This report shows the partners currently displayed in the Partner list. You can filter 
it using queries. It is available in the Siebel PRM Manager’s partner list views (My Partners, My 
Team’s Partners, and so on).
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■ Partner Profile. This report gives the full partner profile for the current or selected partner 
record. It is available in the Siebel PRM Manager’s partner list views (My Partners, My Team’s 
Partners, and so on).

■ Partner Report Card. This is a full report of how the partner has met its CHAMP objectives, 
including lists of objectives for each plan in which the partner participates and charts of the 
partner’s targets and actuals. It is available in the Siebel PRM Manager’s partner list views (My 
Partners, My Team’s Partners, and so on), CHAMP Plan view.

■ CHAMP Partner Plan. This is a summary of a partner’s CHAMP plans, including each plan and 
the objectives associated with each plan. Action and Opportunity plans are also included. It is 
available in the Siebel PRM Manager’s partner list views (My Partners, My Team’s Partners, and 
so on), CHAMP Plan view.

■ Marketing Funds Detail. This is a report that lists the funds and gives details on each fund, 
including the fund type, the current balance, totals for debits and credits, and a list of 
transactions. It is available in the Siebel PRM Manager’s Fund Design view. 

■ Partner Operations. This report that the partners currently displayed in the Partners list and 
the transactional data that each partner is working on, including accounts, opportunities, orders, 
quotes and service requests. You can filter it using queries. It is available in the Siebel Partner 
Manager’s Partner Operations view. 

■ Fund Request Summary. This report lists market development funds and summarizes the fund 
requests for each one, including request details such as amount requested, amount approved, 
approver, and status. It is available in the Siebel Partner Manager’s Fund Request view and the 
Siebel PRM Portal’s Fund Request view. 

To produce a report

1 Navigate to one of the screens where that report is available. 

2 If necessary, perform a query to filter the data.

3 If you are using the Siebel PRM, select View > Reports. 

■ If you are using the Siebel PRM Portal, click the Reports button. 

4 In the Reports list, select the report that you want to run and click Run. 

Siebel Analytics
The Siebel PRM Manager and Siebel PRM Portal use Siebel Analytics to provide a variety of different 
types of reports. 

For more information about Siebel Analytics, see Siebel Analytics User Guide and Siebel Analytics 
Installation and Configuration Guide. 
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Siebel Partner Analysis 
Siebel Partner Analysis includes predefined reports that you can use to gain insight into your 
company’s and partners’ performance. It also includes the ability to create ad hoc reports so you can 
produce the reports you need.

Siebel Analytics’ predefined reports cover most business reporting needs. 

The following is a scenario showing how a marketing manager, channel manager, or other executive 
at the brand owner company might use Siebel Partner Analytics to analyze partner performance: 

■ The channel manager at a brand owner company wants to evaluate performance of partner 
organizations, in order to find out the following: 

■ Which partners are bringing in the most revenue 

■ Which types of partners are bringing in the most revenue 

■ Which partner tiers have the highest margins and the greatest sales volume 

■ Which products and product lines partners are selling

■ Which partners are closing deals most quickly 

■ Which partners are responding to service requests quickly 

■ Which partners are creating the most quotes 

■ Which partners are engaging in the most (or fewest) activities per deal

■ Which partner territories have the greatest number of opportunities

■ Which partners have the greatest expected revenue this quarter

■ In the Siebel PRM Manager, the brand owner’s channel manager navigates to the Partner 
Analytics screen to view available prebuilt reports. The brand owner clicks on the view tab for 
the report category to display a list of reports in that category, and then clicks on a report 
hyperlink to bring up that report with charts. 

■ The brand owner can analyze information further by using filters based on business objects. For 
example, if all partners are displayed in the report initially, the brand owner can analyze 
information by partner type (such as reseller, consulting partner, VAR), tier (such as Platinum, 
Gold, Silver), and territory. The brand owner also can analyze information by account, product, 
month, quarter, and year.

■ If there is not a prebuilt report that displays the information the brand owner wants, the brand 
owner can click the Ad Hoc Analysis view tab to create a new report. This view includes drag-
and-drop tools used to develop the new report.

Viewing Available Siebel Analytics Reports
In addition to Partner Analytics, the Siebel PRM Manager has several screens with Siebel Analytics 
reports for a variety of purposes. Visibility to these analytics screens and views depends a user’s 
role, so all users might not see all screens. 

Use the following procedure to view available Siebel Analytics reports.
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To view available Siebel Analytics reports

1 Navigate to one of the following screens:

■ Executive Analytics 

■ Commerce Analytics 

■ Marketing Analytics

■ Partner Analytics

■ Sales Analytics

■ Service Analytics 

■ Segmentation Analytics

■ Partner Marketing Analytics

2 Select the categories of the reports you want to view. 

Siebel Portal Analytics 
The Siebel PRM Portal provides Siebel Analytics reports for your partners which they can use to 
analyze their performance in sales, service, marketing, commerce, and training. 

The PRM Portal Analytics incorporates visibility rules to ensure that one partner does not have access 
to another partner's reports.

The PRM Portal Analytics screens and views visible to the user depends on the user’s role, so all users 
might not see all of these views. 

To view available Siebel Analytics reports

1 The partner navigates to one of the following PRM Analytics screens: 

■ Executive Analytics

■ Sales Analytics

■ Service Analytics

■ Marketing Analytics

■ Commerce Analytics

■ Training Analytics

2 The partner selects a report category on that screen. 
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fund request status, viewing 276
Fund Request Summary report, 

described 321
fund request, checking balance in fund 275
fund request, reviewing by changing partner 

manager 270
fund request, reviewing using Status 

picklist 274
fund request, table of status values 276
funds, types and about adding to MDF 266
initiating, about 270
new fund record, creating 264
partner company, adding to 265
partner company, viewing all fund requests 

for 276
types of funds 263

Marketing Funds Detail report, 
described 321

marketing, managing
collaborative marketing campaigns, 

managing 240
collaborative marketing, planning 240
partners, eNewsletter, sending to 243
partners, making campaign offers to 242

mass updates 142
master data, sharing data with partners

access groups, adding partner companies 
to 186

categories and access groups, about creating 
and examples 186

categories, about adding master data 
to 187

categories, using Literature Administration 
screen to associate literature 188

described 36
individual partners, making visible to 103
price lists, about assigning to partner 

companies 189

price lists, assigning to partner 
organization 189

types of and about controlling visibility 185
Microsoft

PowerPoint, about generating presentations 
in 216

Word, about generating proposals in 217
mixed fund

about 264
Marketing Development Fund, about adding 

funding to MDF 266
mobile phones, about using Siebel PRM 21
Mobile Web Client, about using through 

Partner Manager 20
More Info form fields, table of 264

N
notes

note types 166
plan, adding to 166

O
objectives

about and entering plan objectives 161
action plan and resources, adding 164
action plan, defined 164
revenue, associating opportunities 

with 163
online help, about customizing 28
opportunities

modifying and deleting 173
new opportunity, entering through Partner 

Portal 194, 204, 217, 247, 
248, 250

partner company, manually assigning 
to 173

partner company, viewing all opportunities 
of 199

partner employee, manually assigning 
to 173

partner, about assigning to 172
partner’s opportunities, about viewing 173
partner’s opportunities, tracking 195
revenue objective, associating with 163

Opportunities screen, using to view partner 
opportunities 174

orders
partner company, assigning to 181
partner employee, assigning to 180

Organization Analysis applet, displaying 
Contacts list 300

organization chart
partner company, creating 300
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partner company, viewing and 
maintaining 301

organizations
dividing your business into, about 30
individual partner data access, note 103
partner company, about placing in 

hierarchy 109

P
partner agreements 296
partner alerts

about and types of messages 310
key words, creating 311

partner commerce
partners, shopping for themselves 247
Quotes screen without product catalog, 

using 250
Partner communities, described 186
partner companies, enrolling new

about and process steps 106
channel partner, adding to an access 

group 113
new delegated administrator, contacting 

about responsibilities 115
new partner registration and enrollment, 

about 99
partner company, assigning positions 112
partner employees, types of and 

about 114
prospective partners and their profiles, 

viewing 107
responsibilities, about assigning and 

example 111
partner company

access groups, adding to 186
assessment, entering 319
assessment, modifying and deleting 320
attachments displaying, modifying, and 

deleting 297
attachments entering 297
contacts, assigning to 178
customer accounts, assigning to 177
customer accounts, modifying and 

deleting 177
customer accounts, viewing all 

accounts 177
enrolling and registering, about 99
fund request, reviewing all fund requests 

for 276
initiative, adding as participant in 158
leads, assigning to 193
manager, displaying your report’s 

leads 199
Marketing Development Fund, adding 

to 265
Marketing Development Fund, viewing 

attachments to fund request 272
notes, entering 299
notes, modifying and deleting 300
opportunities, manually assigning to 173
opportunities, viewing all 199
order, assigning to 181
organization chart, creating 300
organization chart, viewing and 

maintaining 301
partner manager, about specifying 109
partnership profile, entering or 

viewing 293
price lists, about assigning to 189
profile, entering or viewing 292
profile, modifying 293
registering 110
service requests, about assigning to 226
service requests, manually assigning 

to 175
service requests, viewing 176

Partner Contacts view, accessing Siebel 
PRM 298

partner employees
activities, assigning to 179
activities, tracking, modifying, and 

deleting 179
adding, about 114
contacts, assigning to 178
contacts, modifying and deleting 178
customer accounts, assigning to 176
fund request, authorizing approval 269
leads, assigning to 193
opportunities, manually assigning to 173
order, assigning to 180
quotes, viewing 180
service requests, about assigning to 226
service requests, manually assigning 

to 175
service requests, modifying and 

deleting 175
Partner Finder, using 260
partner interactions, managing

See partner manager; Siebel Partner Manager
partner led sales scenarios

brand owner, leads created by and assigned 
to partner 192

partner, leads created by and logged for 
tracking purposes 197

Partner List report, described 320
partner manager
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changing 270
partner company, about specifying for 109

partner operations administrator, about 
assigning partner company 
responsibilities 111

Partner Operations report, described 321
Partner Operations screen

partner company service requests, 
viewing 176

partner opportunities, using to view 174
partner opportunities

about viewing 173
tracking 195

partner organization, assigning price 
to 189

partner performance
analyzing, description of ways 317
assessments, about using to evaluate partner 

performance 319
assessments, entering a partner company 

assessment 319
assessments, modifying and deleting a 

partner company assessment 320
CHAMP reports, about 318
evaluating, about and example 167
reports, about 318
reports, producing 321
reviewing 170
Siebel Analytics, using to report partner 

performance 322
Siebel PRM reports, list of 320

partner planning
action plan and resources, adding for 

objective 164
action plan, defined 164
defined and example 159
new plan and highlights, adding 159
notes, about adding 166
notes, adding to plan 166
objectives, about and entering plan 

objectives 161
partner performance, about evaluating and 

example 167
partner performance, reviewing 170
revenue objective, associating an opportunity 

with 163
Partner Portal

browsers supported by 20
high and low interactivity, about 

configuring 27
levels of access 99
login page, about and screen example 14

new service request, partner entering 226
partner training 302
screens, described 15

Partner Profile form fields, table of 292, 
294

Partner Profile report, described 321
partner profile, described 291
Partner Progams

Eligibility Administration 135
Partner Program

Setting up Partner Program 
application 131

Partner Program Memberships 147
Partner Programs

About 129
adding literature 133
applying to 134
catalog translations 134
Process for setting up 130
program tier groups 132
relate programs 133
Setting Up 130
workflows 148

Partner Programs Administration 129
partner records, adding

new partner record, manually 119
Web site, clicking Approve button 119

Partner Report Card report, described 321
partner scenarios

assets, assigned by brand owner 233
assets, logging service requests 

against 234
publishing service solutions 237
viewing asset history 234

partner service requests
assigned by brand owner 225
service request type described 221
tracking 227
ways to assign 235

partner training courses, managing
about administrating 303
training from the partner’s 

perspective 302
partners

campaigns, making campaign offers 
to 242

eNewsletters, sending to 243
opportunities, about assigning to 172
partners, identifying other partners to work 

with 260
Quotes screen without product catalog, 

using 250
responsibilities, about defining 31
service requests, about assigning to 174
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shopping by themselves 247
transactional data, about sharing with 171
troubleshooting with SmartScripts, 

scenario 236
viewing service requests 226

Partners Activities view, using 179
Partners Organization Analysis view, 

viewing Organization Analysis 
applet 300

Partners screen
activities, about entering 295
activity Plans, assigning to employees or 

partner employees 296
attachments, sharing with partners 297

partners, communicating with
eBriefings, using 313
partner alerts, about and types of 

messages 310
partner alerts, creating partner alert key 

words 311
partners, managing

certifying partners, about and process 
steps 304

certifying partners, about certification 
templates 305

certifying partners, checking partner’s 
progress 308

certifying partners, creating certification 
metrics 305

certifying partners, recording partner’s 
progress 308

notes about partner company, 
entering 299

notes about partner company, modifying and 
deleting 300

partner agreements, entering 296
partner agreements, modifying and 

deleting 297
partner company attachments, displaying, 

modifying, and deleting 297
partner company attachments, 

entering 297
partner company organization chart, 

creating 300
partner company organization chart, viewing 

and maintaining 301
partner company profile, entering or 

viewing 292
partner company profile, modifying 293
partner management activity plans, 

displaying and deleting 296
partner management activity plans, 

entering 295
partner management activity, 

entering 295
partner management activity, modifying, 

deleting, and displaying 295
partnership contacts, about entering 298
partnership contacts, entering 298, 299
partnership profile, entering or 

viewing 293
partners, sharing information with

automatic routing, about setting up 37
partnership contacts

about entering 298
entering 298, 299

partnership profile, described 291
performance

analyzing, description of ways 317
assessments, about using to evaluate partner 

performance 319
assessments, entering a partner company 

assessment 319
assessments, modifying and deleting a 

partner company assessment 320
CHAMP reports, about 318
partner performance reports, about 318
reports, producing 321
Siebel Analytics, using to report partner 

performance 322
Siebel PRM reports, list of 320

personalization
about 28
factor determining data access, about 103

Plan Objectives list, table of fields 162
positions, assigning to the partner 

company 112
PowerPoint, about generating presentation 

in 216
presentations

about and example 216
process steps 217

price lists
partner companies, about assigning to 189
partner organization, assigning to 189

private notes, about 299
proposals

about and example 216
process steps 217

prospective partners, viewing 107
public users

described and access to Partner Portal 99
home page, described and example 100

Q
Quantity metric, defined 161
quotes
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Quotes screen

without product catalog, using 250

R
referential data, described 36
registering

individual partners, about thanking for 
registering 105

new partners, about 99
reports

CHAMP, about 318
partner performance reports, about 318
reports, producing 321
Siebel Analytics, using to report partner 

performance 322
Siebel PRM reports, list of 320

responsibilities
factor determining data access, about 103
partner company, assigning and 

example 111
partner, about defining 31

revenue objective, associating with 
opportunity 163

S
sales manager

your report’s leads, displaying 199
scenarios

collaborative selling, brand owner identifies 
lead and works with partner in joint 
selling effort 199

collaborative selling, partner identifies lead 
and transfers it to the brand 
owner 204

forecasting, about and options 207
partner identifies lead and works with brand 

owner in joint selling effort 202
partner led sales, leads created by brand 

owner and assigned to partner 192
partner led sales, leads created by partner 

and logged for tracking 
purposes 197

problem solving with SmartScripts 236
search, ways to search and process steps for 

advanced search 28
seed data, about defining partner 

responsibilities 32
Self-registered Partner Agent

responsibility visibility to views, note 105
views available to individual partner, 

showing 105
service agreements, distinction from partner 

agreements 296
service requests

assignment, responding to 235
new service request, entering through partner 

portal 226
partner company, manually assigning 

to 175
partner employee, manually assigning 

to 175
partner employee, modifying and 

deleting 175
partner service requests, viewing 176
partner, about assigning to 174
partner’s service requests, tracking 227
types of 221

service requests, scenarios
brand owner assigns service request to 

partner 225
brand owner entering service requests 225
brand owner trackers partner service 

request 226
brand owner tracking service requests 224
collaborative customer service 

requests 227
partner managers tracking service 

requests 224
partner-led requests 222
partners assigning service requests 223
partners entering service requests 223
partners fulfilling service requests 224
viewing through Siebel Partner Portal 226

Service screen
partner service requests, viewing 176

service solutions, publishing 237
setting up

access groups and categories, about and 
example 36

CHAMP, about using 38
organizations, about dividing your business 

into 30
partner companies and employee, about 

adding 38
partner responsibilities, about defining 31
process steps 29
sharing information, about 37

Setting up a program account’s first 
snapshot 283

shared notes, about 299
Siebel Advanced Search, defined 28
Siebel Analytics Setup Workflow 138
Siebel Analytics, using to report partner 

performance 322
Siebel Assignment Manager, assigning to 

assign service requests 235
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Siebel eBriefings, using to communicate with 
partners 313

Siebel Mobile Web client
Partner Manager, about using through 20

Siebel Partner Manager

browsers, supported by 20
Mobile Web Client, about using through 20
screens, specific to 19
screens\information shared with other 

applications 18
Siebel Partner Portal

scenario, brand owner tracking service 
request 224

scenario, partner assigning service 
request 223

scenario, partner entering service 
request 223

scenario, partner fulfilling service 
request 224

scenario, partner managers tracking service 
request 224

scenario, partner-led requests 222
scenarios, collaborative customer service 

requests 227
Siebel Wireless client, about using Siebel 

PRM 21
SmartScripts

publishing 237
service request scenario 236
troubleshooting scenarios 236

Status field, using to review fund 
request 274

T
templates

certification templates, about 305
training

partner training, about administering 303
partner’s perspective, from 302

transactional data, sharing data with 
partners

activities, assigning to partner 
employee 179

activities, tracking, modifying, and 
deleting 179

contacts, assigning to partner 
company 178

contacts, assigning to partner 

employee 178
contacts, modifying and deleting 178
customer accounts, assigning to a partner 

company 177
customer accounts, assigning to partner 

employee 176
customer accounts, modifying and 

deleting 177
customer accounts, viewing all account of 

partner company 177
described 36
individual, assigning to and not 

organization 172
opportunities, about assigning to 172
opportunities, manually assigning to partner 

company 173
opportunities, manually assigning to partner 

employee 173
opportunities, modifying and deleting 173
order, assigning to partner company 181
order, assigning to partner employee 180
partner service requests, viewing 176
partner’s opportunities, about viewing 173
partners, about sharing with 171
quotes, viewing of partner employee 180
service requests, about assigning to 174
service requests, manually assigning to 

partner company 175
service requests, manually assigning to 

partner employee 175
service requests, modifying and 

deleting 175

V
views

individual partner, showing views 
available 105

visibility, using Self-registered Partner Agent, 
note 105

W
Word, about generating proposals in 217
WordPro, about generating proposal 

in 217
workflow

HTIM MDF Period Ending Process 
workflow 289
TechPubs Draft Modified: April 4, 2005 2:44 pm

Siebel Partner Relationship Management Administration Guide Version
7.8, Rev. A

■ 333



Index ■  W
TechPubs Draft Modified: April 4, 2005 2:44 pm

Siebel Partner Relationship Management Administration Guide Version 
7.8, Rev. A

334 ■


	Contents
	1 What’s New in This Release
	What’s New in Siebel Partner Relationship Management Administration Guide, Version 7.8, Rev. A

	2 About Siebel PRM
	What Is Siebel PRM?
	The Siebel PRM Portal
	Siebel PRM Portal Login Page
	Siebel PRM Portal Screens

	The Siebel PRM Manager
	Screens the Siebel PRM Manager Shares with Other Siebel Applications
	Screens That Are Specific to the Siebel PRM Manager

	Supported Browsers
	The Siebel Mobile Web Client
	The Siebel PRM Wireless Client

	3 Setting Up Siebel PRM
	About Siebel PRM Setup Processes
	Installing and Configuring Siebel PRM
	Installing Siebel PRM
	Activating Workflows
	Activating the Registration Workflows
	Activating the Commerce Workflows
	Activating the Opportunity Management Workflows
	Activating Other Workflows

	Configuring High Interactivity
	Configuring Siebel PRM
	Configuring Online Help

	Personalizing Siebel PRM
	Setting Up Advanced Search

	Setting Up Analytics

	Setting Up Siebel PRM
	Setting Up the Organization Structure
	Defining Partner Responsibilities
	Administering Roles
	Assigning Roles to Brand Owner Employees
	Assigning Roles to Partner Employees
	Making Roles Available to Partner-Delegated Administrators
	Associating Users with Roles in the Siebel PRM Manager


	Setting Up Access Groups and Categories
	Creating Price Lists
	Setting Up Automatic Routing of Information
	Adding Partner Companies and Employees
	Creating CHAMP Metrics

	Configuring Visibility
	About Visibility Enhancements in Siebel PRM
	Configuring Visibility of Pop-Up or Pick Applets
	Setting Visibility of the Pick List Object
	Using the Visibility Auto All Property
	Using the Special Frame Class and User Property
	Configuring Visibility of Child Objects in Views

	Allowing Users to Change the Primary on a Visibility Team

	Siebel Partner Web Services
	Installing Siebel Partner Web Services Servers
	Installing Under MS Windows
	Installing on a Solaris Platform
	Installing on an AIX Platform


	Siebel Tools for Partner Web Services
	Installing Siebel Tools for Partner Web Services
	Installing Under MS Windows
	Installing on a Solaris Platform
	Installing on an AIX Platform
	Troubleshooting Installation



	4 Setting Up Application Services Interfaces
	About Application Services Interfaces
	Setting Up ASIs
	Setting Up Opportunity Transfer
	Setting Up Web Services for Opportunity Transfer
	Assigning a Partner Port for Real-Time Opportunity Transfer
	Additional Setup Tasks
	Setting Up the Partner

	Setting Up Shopping Cart Transfer
	Setting Up Web Services for Shopping Cart Transfer
	Assigning a Partner Port for Real-Time Shopping Cart Transfer
	Change the PRM Portal Configuration File
	Global Product Identifiers
	Checking Setup of ATP
	Additional ATP Setup Tasks

	General Setup for ASIs
	Activate Workflows
	Assigning D-U-N-S Numbers


	ASI Workflows
	Opportunity Transfer Workflows
	Workflows to Transfer an Opportunity
	Workflows to Update an Opportunity
	Workflows to Receive an Opportunity Update
	Update of the Status Field by These Workflows
	Opportunity Sharing Build Siebel Message
	Opportunity Sharing External Create
	Opportunity Sharing External Query
	Opportunity Sharing External Update
	Opportunity Sharing Inbound or Outbound
	Opportunity Sharing Pick Partner
	Opportunity Sharing Receive Create Response
	Opportunity Sharing Receive Update Response
	Opportunity Sharing Set Update Status
	Opportunity Sharing Siebel Create
	Opportunity Sharing Siebel Query
	Opportunity Sharing Siebel Update
	PRM ANI Inbound Create Account Process
	PRM ANI Inbound Addressing Change Process

	Shopping Cart Transfer Workflows
	Workflows for Outbound Shopping Cart Transfer
	Workflows for Inbound Shopping Cart Transfer
	Transfer Cart Outbound Initial Process
	Transfer Cart Outbound Request Process
	Transfer Cart Outbound Create Header Process
	Transfer Cart Outbound Create and Append Process
	Transfer Cart Outbound Receive Acknowledgment Process
	Transfer Cart Inbound Receive Process
	Transfer Cart Inbound Create Cart Process
	PRM ANI Inbound Create Account Process
	Transfer Cart Inbound Create Contact Process
	Transfer Cart Inbound Create Quote Process
	PRM ANI Inbound Addressing Change Process

	Business Services Used by ASIs
	Conventions for Hierarchy Paths
	Append Hierarchy
	Create Empty Hierarchy
	Generate Key
	Get Child Type
	Get Hierarchy Value
	Get System Preference
	Isolate Integration ID
	Load Child Hierarchy
	Parse Key
	Query Business Component
	Detach Hierarchy
	Set Child Type
	Set Hierarchy Value



	5 Working with New Partners
	About Partner Registration and Enrollment
	The Siebel PRM Portal Home Page
	Providing Information for Public Users
	Applying for User IDs
	Partner Company Identifier
	Registering for a User ID (Employee)
	Applying for Partnership (Company)
	Configuring the Individual Partner Homepage
	Controlling Individual Partners’ Access to Data
	Assigning Master Data to Individual Partners
	Controlling the Screens Visible to Individual Partners

	Thanking Individual Partners for Registering

	Enrolling New Partner Companies
	Enrollment Process
	Displaying and Assessing Prospective Partner Companies
	Adding a Partner Record by Qualifying a Partner Company
	Registering the Partner Company
	About Placing the Partner Company in the Organization Hierarchy
	About Specifying the Partner Manager for a Partner Company
	Registering the Partner Company

	Assigning Responsibilities to the Partner Company
	Assigning Positions to the Partner Company
	Assigning Master Data to the Partner Company
	Adding User Assignments at the Partner Company
	Assigning Roles to the Partner Company
	Contacting the New Delegated Administrator
	Adding Locations for the Partner Locator
	Completing the Partner Profile
	Entering the Partner's Competitors and Existing Partnerships
	Entering the Partnership Profile
	Giving Your Employees Access to the Partner in My Partners View

	Other Ways of Adding Partner Records
	Adding a New Partner Record Manually
	Adding a Qualified Partner Manually
	Adding a Prospective Partner Manually

	Converting a Customer Account to a Partner


	Delegated Administration
	Delegated User Administration
	Adding Positions
	Adding Users
	Giving Users Visibility to Different Organizations

	Delegated Catalog Administration
	Adding Items to Catalogs

	Delegated Communication Administration
	Setting Up Drivers and Parameters
	Associating a Driver with Partner Employees



	6 Partner Programs Administration
	About Partner Programs
	Setting Up Partner Programs
	Process for Setting Up Partner Programs
	Setting Up a Partner Program Catalog
	Setting Up a Partner Program
	Setting Up a Partner Program Application
	Setting Up and Associating Program Tier Groups
	Setting Up Related Programs
	Adding Literature to a Partner Program
	Setting Up Catalog Translations

	Applying to Partner Programs
	About Applying to Partner Programs

	About Eligibility Administration
	Creating an Eligibility List Manually
	Creating an Eligibility List Using Analytics Data Load
	Creating a Refresh Schedule
	Using Analytics Data Load
	Siebel Analytics Setup Workflow
	Setting Up a Siebel Analytics Report

	About Mass Updates
	Creating a Mass Update List


	About Application Approval
	Process for Approving an Application
	Reviewing Application Detail Inbox Information
	Reviewing Application Detail
	Reviewing Application Attachments
	Reviewing Application Activities
	Reviewing the Application Audit Trail
	Reviewing Application MDF Programs

	Accepting a Program Application
	Approving an Application
	Rejecting an Application
	Notifying Partner of Application Approval by Email

	Administering Partner Program Memberships
	Associating MDF Programs

	Partner Programs Workflows

	7 CHAMP Planning
	About CHAMP Planning
	Business Scenario
	Using the Siebel PRM CHAMP Planning Module

	Creating CHAMP Metrics
	Viewing CHAMP Metrics
	Adding New CHAMP Metrics

	Creating Initiatives
	Adding an Initiative
	Adding Partners as Participants in an Initiative

	Using Partner Plans
	Adding a Plan and Its Highlights
	Adding Objectives to the Plan
	Associating Opportunities with Each Revenue Objective
	Adding an Action Plan and Resources for Each Objective

	Approving the Plan Internally and Publishing It to the Partner
	Approving the Plan Jointly with the Partner
	Adding Notes to the Plan

	Executing the Plan and Evaluating Performance
	Evaluating Partner Performance
	Reviewing Partner Performance


	8 Sharing Data with Partners
	About Transactional and Master Data
	Sharing Transactional Data with Partners
	Assigning Opportunities to a Partner
	Viewing a Partner’s Opportunities
	Assigning Service Requests to a Partner
	Viewing Partner Service Requests
	Assigning Customer Accounts to a Partner
	Assigning Contacts to a Partner
	Assigning Activities to a Partner
	Viewing a Partner’s Quotes
	Assigning an Order to a Partner Employee
	Assigning Assets to Partners
	Assigning Inventory to Partners
	Sharing Files with Partners

	Sharing Master Data with Partners
	Creating Categories and Access Groups
	Adding Partner Companies to Access Groups
	Adding Master Data to Categories
	Assigning Price Lists to Partner Companies


	9 Managing Sales
	About Managing Sales
	Scenarios for Partner-Led Sales
	Brand Owner Creates Opportunities and Assigns Them to Partners
	Step 1: The brand owner enters opportunities
	Step 2: The brand owner assigns opportunities to partners
	Step 3: Partners view and work on the opportunity
	Step 4: The brand owner tracks the opportunity

	Brand Owner Creates Opportunities and Transfers Them to Partners
	Step 1: The brand owner sets up the ASIs for opportunity transfer
	Step 2: The brand owner enters an opportunity and transfers it to a partner
	Step 3: Partners view and work on the opportunity
	Step 4: The brand owner tracks the opportunity

	Partners Create and Work on Opportunities
	Step 1: Partners enter opportunities
	Step 2: Partners share opportunities
	Step 3: Partner company managers track opportunities
	Step 4: The brand owner channel manager tracks opportunities


	Scenarios for Collaborative Selling
	Brand Owner Creates Opportunities and Brand Owner and Partner Work Together on Them
	Step 1: The brand owner enters the opportunities
	Step 2: The brand owner assigns opportunities to brand owner sales agents
	Step 3: The brand owner assigns opportunities to partners
	Step 4: The brand owner and partners work together on opportunities

	Partner Creates Opportunities and Brand Owner and Partner Work Together on Them
	Step 1: The brand owner uses Assignment Manager to add its employees to the sales team
	Step 2: Partners enter opportunities
	Step 3: The brand owner and partners work together on opportunities

	Partner Creates Opportunities and Assigns Them to Brand Owner
	Step 1: Partners enter the opportunities
	Step 2: The brand owner assigns opportunities to its sales agents
	Step 3: The brand owner notifies sales agents
	Step 4: Brand owner sales agents view and work on the opportunities
	Step 5: The brand owner tracks opportunities

	A Customer Transfers a Shopping Cart From the Brand Owner’s Web Site to a Partner
	Step 1. The Brand Owner Sets Up a Web Site to Sell to Customers
	Step 2. A Customer Makes a Purchase at the Brand Owner’s Web Site
	Step 3. A Partner Fulfills the Order


	Opportunity Management Workflows
	Scenarios for Forecasting Partner Sales
	Brand Owner Forecasts Partner Revenue
	The Brand Owner Creates a Direct Quarterly Forecast of All Partner Revenue
	Step 1: Creating the forecast series
	Step 2: Creating the forecast

	The Brand Owner Creates a Direct Annual Forecast of Revenue for One Partner Organization
	The Brand Owner Creates a Rollup Forecast of Annual Revenue for a Partner Organization
	Step 1: Setting up the reporting hierarchy
	Step 2: Creating the forecast series
	Step 3: Creating the forecast


	Partner Managers at the Brand Owner Forecast Revenue for Multiple�Partners
	The Brand Owner Forecasts Revenue for All Partners that a Partner Manager Oversees
	Step 1: Creating the forecast series
	Step 2: Creating the forecast


	Partners Forecast Their Revenue Without the Brand Owner Viewing Forecasts
	The Channel Manager Creates a Direct Partner Forecast Series
	Multiple Partner Employees Create Rollup Forecasts


	Using Presentations and Proposals
	Using Incentive Compensation

	10 Managing Service Requests
	About Managing Service Requests
	Managing Customer Service Requests
	Scenarios for Partner-Led Customer Service
	Partner Receives Service Requests and Logs Them for Tracking Purposes
	Step 1: Partners log service requests
	Step 2: Partner assigns service requests
	Step 3: Partners fulfill service requests
	Step 4: Partner company managers track service requests
	Step 5: The brand owner channel manager tracks service requests

	Brand Owner Receives Service Requests and Assigns Them to the Partner
	Step 1: The brand owner enters service requests
	Step 2: The brand owner assigns service requests to partners
	Step 3: Partners view and work on service requests
	Step 4: The brand owner tracks service requests


	Scenarios for Collaborative Customer Service
	Partner Logs Service Requests and Works on Them with the Brand Owner
	Step 1: Partners log service requests
	Step 2: Partners use self-service to get help
	Step 3: The brand owner responds to the partner’s self-service request

	Partner Logs Service Requests and Transfers Them to the Brand Owner
	Step 1: Partners enter service requests
	Step 2: The brand owner assigns service requests to its employees
	Step 3: Brand owner employees view and work on service request
	Step 4: The brand owner tracks the service request


	Scenarios for Field Service
	The Brand Owner and Partner Manage Inventory
	Step 1: The brand owner sets up an inventory location for the partner
	Step 2: The brand owner transfers products to the inventory location
	Step 3: The partner transfers inventory to inventory sublocations
	Step 4: The partner service agent finds needed parts
	Step 5: The brand owner monitors partner inventory level

	The Partner Responds to Service Requests for Assets
	Step 1: The brand owner assigns assets to a partner
	Step 2: The partner logs a service request against the asset
	Step 3: The partner looks at the history of the asset
	Step 4: The brand owner monitors a partner’s service of assets



	Managing Partners’ Service Requests
	Assigning Service Requests
	Business Example Using Partner Self-Service

	Using Solutions and SmartScripts to Help Partners Solve Problems
	Business Example Using Solutions and SmartScripts
	Making Solutions Available to Partners
	Making Troubleshooting or Instruction SmartScripts Available to Partners


	11 Managing Marketing Campaigns
	About Managing Marketing Campaigns
	Collaborative Marketing with Partners
	Planning Collaborative Marketing
	Managing Collaborative Marketing Campaigns

	Marketing to Partners
	Creating and Executing Campaigns
	Making Campaign Offers to Partners

	Marketing by Your Partners

	12 Managing Partner Commerce
	About Partner Commerce
	Setting Up Partners for Standard, Power, and Personal Commerce
	Scenarios for Partner Commerce
	Partners Shopping for Themselves
	Partners Shopping for Customers
	Shopping for Customers Using Standard Partner Commerce
	Shopping for Customers Using Power Partner Commerce
	Using the Shopping Cart and Product Catalog
	Using the Quotes Screen and the Product Catalog
	Using the Quotes Screen Without the Product Catalog



	Disabling Partner Commerce Workflows
	Removing the PRM Portal Shopping Cart Toolbar

	13 Partner-to-Partner Collaboration
	About Partner-to-Partner Collaboration
	Partner Collaboration
	Step 1: A Partner Locates Other Partners and Sends Collaboration Requests
	Step 2: An Invitee Partner Accepts the Collaboration Request
	Step 3: The Initiating Partner Creates a Collaboration
	Step 4: Both Partners Add Resources to the Collaboration
	Step 5: The Partner Companies Share Opportunities
	Step 6: Partners Monitor their Collaborations
	Step 7: The Brand Owner Monitors All Collaborations

	Siebel Projects
	Step 1. The Partner Creates a New Project
	Step 2. The Partner Locates Other Partners and Adds Them to this Project
	Step 3. Partners Add Their Employees to the Project
	Step 4. The Partners Work Together on the Project
	Step 5. The Brand Owner Tracks the Partners’ Work


	14 Using Market Development Funds
	About Market Development Funds
	Creating and Using MDFs
	Creating a New Fund Record
	Adding Partner Companies as Fund Participants
	Adding Funding to the Market Development Fund
	Setting Up Fund Approval Authorization
	Authorizing Employees to Approve Fund Requests

	Changing the Partner Manager Field
	Initiating a Fund Request
	Adding Attachments to Fund Requests
	Adding Activities to Fund Requests
	Adding Activity Plans to Fund Requests
	Reviewing a Fund Request
	Viewing Fund Requests for a Partner Company
	Viewing the Status of a Fund Request

	Viewing a Fund’s Checkbook

	Managing the Advanced MDF Option
	Overview of Advanced MDF Option
	Key Features of MDF Management
	Scenario for MDF Management
	Process of Setting Up MDF Programs
	Creating MDF Snapshot Periods
	Making Partners Eligible for MDF Participation
	Enabling the HTIM MDF Period Ending Process Workflow
	Setting Up MDF Approval Authority Limits

	Creating an MDF Program and Program Account
	Setting Up a Program Account’s First Snapshot
	Adding a Credit to a Program Account
	Creating a Preapproval
	Reviewing a Preapproval
	Creating a Claim
	Reviewing a Claim
	HTIM MDF Period Ending Process Workflow


	15 Managing Your Partners
	Tracking Partner Information
	Using the Partner and Partnership Profile
	Using the Partner Profile
	Entering the Partnership Profile

	Entering Partner Management Activities
	Entering Partner Management Activity Plans

	Entering Partner Agreements
	Adding Partner Company Attachments
	Entering Partner Contacts
	Entering Partnership Contacts
	Adding Notes About a Partner Company
	Creating a Partner Company Organization Chart
	Uploading Partner Logos

	Managing Partner Training Courses
	Training From the Partner’s Perspective
	Administering Partner Training
	Tracking Partner Training
	Displaying the Training Courses a Partner Has Taken
	Displaying the Partners Who Have Taken a Training Course


	Certifying Your Partners
	Creating Certification Metrics
	Creating Certification Templates
	Associating Certifications with a Partner Company
	Recording Partners’ Progress
	Checking a Partner’s Progress
	Displaying Certified Partners
	Displaying Certifications Across Partners
	Configuring Autopopulation of Partner Certification Criteria

	Communicating with Your Partners
	Using Partner Alerts
	Creating Partner Alert Keywords
	Creating Partner Alerts
	Using Siebel Briefings, Content Services, and Content Broker
	Administering Partner Satisfaction Surveys
	Viewing the Results of Partner Satisfaction Surveys
	Configuring Partner Satisfaction Surveys



	16 Reporting on Partner Performance
	About Partner Performance and Reporting
	Using CHAMP Planning
	Using Partner Performance Reports
	Using Assessments to Evaluate Partner Performance
	Using Siebel PRM Reports
	Siebel Analytics
	Siebel Partner Analysis
	Viewing Available Siebel Analytics Reports
	Siebel Portal Analytics


	Index

